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2 Introduction
The U.S. Army Corps of Engineers (USACE) operates about 700 storage reservoir and lock and dam projects constructed 
under the USACE's Civil Works water resources program. The USACE water management mission is to regulate river flow 
with these projects to provide national benefits of flood control, navigation, hydroelectric power generation, water 
supply, irrigation, erosion control, water quality, environmental enhancement, and other authorized purposes. The 
Corps Water Management System (CWMS) is a real-time decision support system that expands and enhances the data 
and information available to USACE staff members who must make decisions about the operation of Federal water 
management facilities or who must monitor and approve such decisions made by operation partners. The data and 
information made available through CWMS includes precipitation data and forecasts as well as data and information 
about the current state of watersheds, likely future state of watersheds, and consequences of management actions. The 
data and information help water managers and others make informed operation decisions.

The Hydrologic Engineering Center's (HEC) Real Time Simulation (HEC-RTS) software is based on the CWMS software for 
use by non-USACE offices. HEC-RTS still provides the same data and information that CWMS does, HEC-RTS just 
performs these functions in a different manner than CWMS. This document is the User's Manual for Version 3.1.1 of the 
HEC-RTS software. This manual describes the capabilities of the software and illustrates its graphical user interface 
(GUI). The manual details how HEC-RTS is configured to use analysis software that is part of the system. The manual 
explains the flow of data and information between analysis software and the data components used within HEC-RTS.

2.1 Data and Information Needed by Water Managers

To make informed operation decisions, water managers need:

Current and potential future scenarios of precipitation.
Data that describes the current state of watersheds, channels, and water management facilities, including 
reservoirs, diversions, and other controllable features of the system.

An HEC-RTS watershed is a set of data, information, models, and images that represent 
watershed lands and the channels, gages, and water control features within the 
watershed.

Information about the likely future state (e.g., one hour to two weeks) of the watersheds, channels, and 
management facilities.
Information about the consequences of management actions that alter future states of the natural and managed 
systems.

Data that describes the current state of the system comes from a network of environmental sensors. These sensors, 
which are owned and operated by Federal, state, and local government agencies, utility companies, and commercial 
enterprises, measure:

Weather conditions, including air temperature, precipitation depths and rates, and evaporation depths and 
rates.
Watershed states, including snow accumulation.
Depth, velocity, and other conditions in streams, rivers, canals, and other waterways.
Lake or reservoir level (from which storage volume may be inferred), rates of release of water through outlets, 
settings of spillway gates, and other conditions of lakes, reservoirs, and diversions.
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Data from sensors are transmitted by radio, satellite, telephone, the Internet, and other media to receiving sites, and 
then to water managers. There, the data are decoded, transformed, checked for quality (validated), and stored in 
databases. With this data, water managers have near-real-time reports on the current state of the watersheds, 
channels, and management features. 
Using the environmental data from the databases, as well as forecasts, as inputs to models of watershed and channel 
processes, water managers can forecast future availability of water. A water manager can predict the runoff from a 
watershed, hours or even days into the future because of observed and forecasted precipitation values within the 
watershed. To do so, the water manager uses a mathematical model that simulates infiltration, overland flow, 
baseflow, channel flow, and other relevant watershed and channel processes.

A forecast is a simulation of watershed processes and consequences of flooding based on 
input data and information and hydrologic, reservoir operation, hydraulic, and impact 
analysis models. Forecast results include flow and stage in the channel from watershed 
runoff, reservoir release schedules, floodplain inundation maps, floodplain consequence 
reports, and reports listing actions for emergency responders to take. These results inform 
water management decision making.

With models of water control facilities, water managers can simulate and assess the impact of operation alternatives. 
For example, a water manager can determine which of two operation alternatives will more likely result in higher 
downstream water levels due to a large storm. The forecast of future inflow, combined with a mathematical model of 
the behavior of the reservoir and the downstream channel, makes this possible.

One operation alternative could be to release water now from a rapidly filling reservoir to accommodate future inflows. 
Another alternative could be to delay release in anticipation that inflows will diminish, and large releases will not be 
required. The manager has, with analysis software, the capability to compare these operation alternatives in a 
quantitative manner. Information from the simulation permits the manager to assess the economic, environmental, life 
safety, and other consequences of the operation alternatives. This information will lead to better-informed decisions.

2.2 HEC-RTS Overview

HEC-RTS provides data and information needed to water managers readily through DSS (HEC's Data System Storage) 
files. The HEC-RTS GUI provides a user with the ability to configure watersheds, view and edit data/information, create, 
and run forecasts, and view results. The functions of HEC-RTS are organized into four groups (modules) - setup, 
acquisition, visualization, and modeling.

The Setup Module contains commands for watershed setup. These commands include: configuring inputs, models, and 
outputs that describe a watershed's behavior. A visual representation of the watershed is developed and displayed in 
the GUI that is map-based.

The Acquisition Module contains the commands for data acquisition. These are commands for monitoring receipt of 
data from DSS files, validating the quality of incoming data, transforming the data (e.g., stage to flow), and editing the 
data, as required.

The Visualization Module contains the commands for data visualization. These commands include displaying observed 
and forecast data to evaluate the hydrometeorological state of the watershed. Water managers may need to review 
hourly data from hundreds of gages as they make decisions. In the visualization module, HEC-RTS provides tools to 
facilitate review of large amounts of data, including summaries presented as graphs, tables, spreadsheets, charts, river 
profiles, maps, or sometimes a combination of these. Within the Visualization module, the summaries are linked to a 
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watershed map, so that a user can click on an icon and immediately view the data associated with that location or also 
view computational results.

The Modeling Module contains the commands for model execution. These commands assist with setting up and 
executing the analysis software for forecasting and viewing results. HEC-RTS links the analysis software so that 
individual models are executed in an orchestrated manner. Data and other inputs are passed to each piece of software 
with the DSS data exchange software.

HEC-RTS links the selected analysis software for a forecast, so that the selected software applications are executed in 
an orchestrated manner. Data and other inputs are passed to each piece of analysis software through the DSS data 
exchange software. The available analysis software in HEC-RTS meets modern software standards, including an easy-
to-use GUI, and executes within operating systems selected by USACE. The analysis software available in HEC-RTS 
Version 3.1.1 is:

MFP Meteorologic Forecast Processor - processes meteorological forecasts for input to HEC-HMS. Inputs are 
forecasted meteorological data such as precipitation and temperature. These forecasts can be entered 
manually or obtained from external sources such as NWS (National Weather Service). Outputs are 
forecasted meteorological time series formatted for compatibility with HEC-HMS.

HEC-HMS Hydrologic Modeling System - simulates watershed response to precipitation. Inputs may include 
observed or forecasted precipitation, temperature, snowpack, and other environmental conditions. 
Outputs include flows throughout the watershed, including inflows to reservoirs and local flows below 
the reservoirs.

HEC-
ResSim

Reservoir System Simulation - simulates behavior of reservoirs and linking channels, following user-
specified operations for reservoir release decision making. Inputs include flows into reservoirs and 
unregulated flows downstream of reservoirs (from HEC-HMS). Outputs include reservoir releases, 
downstream regulated flows, and reservoir storage conditions.

HEC-RAS River Analysis System - simulates behavior of channels and adjacent floodplains. The simulation of 
channels is performed one-dimensionally, while the simulation of adjacent floodplains can be 
performed one- or two-dimensionally. The output from HEC-RAS permits determination of water 
surface elevations corresponding to flows computed by HEC-HMS or HEC-ResSim. Inputs include flows, 
and outputs include water surface elevations, depth grids, and inundation maps.

HEC-FIA Flood Impact Analysis - estimates the consequences of flow or water surface elevations in the system. 
Inputs include computed or observed flows or water surface elevations throughout the flood plain. 
Outputs include economic, life loss, or other measures of impact, or optionally, information on actions 
to be taken in response to flows or water surface elevations that will be experienced.

HEC-RTS ensures that those who need to know the current state of the defined watershed and likely future states have 
ready access to that information. The capability to access this information is accomplished using information sharing 
technology, including specially designed websites for display. The flow of data and information through HEC-RTS is 
displayed in Figure 1.
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1 Figure 1 Flow of Data and Information through HEC-RTS

2.3 What’s New About HEC-RTS Version 3.1.1

HEC-RTS Version 3.1.1 has been enhanced from previous versions. Version 3.1.1 has the following new features:

Updated Analysis Software. Version 3.1.1 includes the latest version: HEC-HMS - 4.5; HEC-ResSim - 3.4.1 Dev; 
HEC-RAS - 5.0.7; and, HEC-FIA - 3.1 (modified version).
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Team Modeling. Several new features were added to the Team Modeling capabilities, such as: a visual indicator 
when items are out-of-sync with a master watershed; Save to Master item was added when closing a 
forecast; and, highlighting of forecasts that are not downloaded.
HEC-RAS New Capabilities. HEC-RAS storage areas and two-dimensional display support are now available in 
HEC-RTS Version 3.1.1. Also, HEC-RTS Version 3.1.1 supports an HEC-RAS restart file.

2.4 Organization of User's Manual
This manual is generally organized in parallel with the HEC-RTS workflow and could be separated into four sections. 
The section focused on using HEC-RTS precedes the section focused on configuration because using HEC-RTS is a 
routine task while setting up watersheds is an infrequent task. Supplemental materials are also included in the manual 
for additional topics and where more detail is needed.

Section I: The Basics

Useful for all staff.
Overview of the basic HEC-RTS 
“infrastructure”.
Walkthrough of HEC-RTS and introduction 
layers.

HEC-RTS Interface
Understanding Layers
Primary Layers
Map Layers

Section II: Using HEC-RTS

Targeted toward operations staff.
How to view and monitor data.
How to validate and edit data
How to run a forecast.
How to view, manage, and post results

Using HEC-RTS – Overview
Acquisition Module
Data Status Lists
Data Validation Editor
Visualization Module
Modeling Module
HEC-RTS Forecasts
HEC-RTS Results

Section III: Configuring HEC-RTS

Targeted toward modeling staff.
How to configure a watershed.
How to configure model alternatives.
How to configure forecast alternatives.
How to edit model parameters.

Configuring HEC-RTS
Setup Module
Program Order
Time Series Icons
Time Series Icons Layers
Model Alternatives and Forecast Runs
Model Linking Editor
Data Extract and Post Editors
Team Modeling
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Section IV: Supplemental Materials

Supplemental information not covered in the 
preceding documentation.
More in-depth explanation of features.

Glossary
HEC-RTS Application Settings
Setting Up the Coordinate System
Using Map Editors
Using the Color Chooser
Using HEC-DSSVue
Scripting
Plots
Printing and Copying HEC-RTS Data
Stream Alignment
WISKI Extract and Post
KiWIS Write Extension

Screenshots were captured using example watersheds. In the GUI, some dialog titles and menu options correspond 
with the names of items that a user might have specified in the watershed created by a user. Thus, dialog titles and 
menu options shown in the user's watershed may vary from what is shown here.

2.5 Additional Documentation

This user's manual is the first volume in a series of HEC-RTS documentation. In addition to this manual, other HEC-RTS 
documentation includes:

HEC-RTS Quick Start Guide Steps the user through the development of an HEC-RTS watershed.

HEC-RTS Applications Manual This document is a combined engineering applications/technical 
reference manual intended to assist engineers in the development 
of models and the implementation of HEC-RTS.

Analysis Software Documentation Documentation on the analysis software that is part of the system, 
such as HEC-HMS, HEC-ResSim, HEC-RAS, and HEC-FIA, are available 
on HEC's website: http://www.hec.usace.army.mil/. 

However, Version 3.1.1 may include versions of the analysis software 
that have not been released to the public. For those, version-specific 
documentation is available from HEC upon request.

http://www.hec.usace.army.mil/
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1.

3 HEC-RTS Interface
Chapter 1 describes how HEC-RTS creates data and information that is readily available to water managers and 
introduces the analysis software. The GUI is the steering wheel of HEC-RTS, and features graphical menus and tools 
organized by function, or modules. The four modules include:

Setup for configuring a watershed (coordinate system, map layers, program sequence, model alternatives, 
forecast runs, extracts, posts).
Acquisition for data acquisition, monitoring, validation, and editing.
Visualization for viewing data.
Modeling for setting up and executing analysis software for forecasting and viewing results.

This chapter provides an overview of the GUI and other basic functions of the HEC-RTS software. Here are three 
navigation tips:

For simplicity, the GUI "hides" commands that are not applicable to the module or element the user is working 
on. Thus, if an option appears to be missing, make sure that the correct module or element has been selected 
and that the option is applicable for that selection.
Directory trees list elements configured in the watershed. When a user configures a new element, it will be 
added to the directory tree.
Commands related to a selected element are typically accessible by right-clicking on the element.

3.1 Starting HEC-RTS
When starting HEC-RTS, double-click the HEC-RTS icon on a user's desktop, or from the taskbar click Start, point to All 
Programs, point to HEC, point to HEC-RTS, and click HEC-RTS. The HEC-RTS splash dialog box appears for a few 
seconds, and then the main window of HEC-RTS displays. The user is now ready to start using HEC-RTS.

3.2 Opening an Existing Watershed

In HEC-RTS, a watershed is a set of data, information, models, and images that represent watershed lands and the 
channels, gages, and water control features within the watershed. A user may open an existing watershed from any of 
the modules. (If the user needs to create a new watershed, refer to Creating a Watershed.) There are two methods 
available to open a watershed. First, if the user has opened the watershed before, the user can select the watershed 
from the File menu, point to Recent Watersheds, and click on the watershed name. The second way to open a 
watershed follows:

From the HEC-RTS main window (Figure 1), from the File menu, click Open Watershed, the Open Watershed
dialog will open (Figure 2).
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2. From the Available Watersheds box, select the watershed, click OK. The Open Watershed dialog will close 
(Figure 2), and the watershed will display in the HEC-RTS main window (Figure 1) 

There can only be one watershed open at a time. Therefore, if a watershed is open and an attempt is made to 
open another watershed, HEC-RTS will close the initially opened watershed. HEC-RTS first prompts the user to 
save the watershed.
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3.3 HEC-RTS Main Window
From the HEC-RTS main window, each module - Setup, Acquisition, Visualization, and Modeling - has menus, tools, 
and a map window specific to each module. Following are the basic elements of the HEC-RTS main window:

Title Bar Displays the name of the active watershed.

Menu Bar Contains general and module-specific menus.

Main 
Toolbar

Contains shortcut icons for menu commands.

Module 
Tabs

Each tab represents an HEC-RTS module. Clicking a module tab opens that module in the HEC-RTS 
main window.

Watershed 
Pane

The area where the module specific commands and items are located.

Map 
Window

A map window displays the watershed representation, which is geographically-referenced (geo-
referenced).

Map 
Window 
Toolbar

Contains tools to navigate within the map window, and setup time series icons.

Message 
Pane

Displays a scrolling list of messages. System output log information appears in this window from the 
time you start HEC-RTS until you exit. Messages related to incoming data are colored coded based on 
the quality of the data. Messages may also report a problem with a system component; problems with 
field equipment; a caution, warning, or flood event; or other critical situations.

Status Bar Displays map coordinates when the select tool is hovering over a location in the map window.

3.3.1 Menu Bar
The File, View, Maps, Scripts, Tools, Window, and Help menus (HEC-RTS Main Window) contain commands you can 
access from all four modules. Some of these menus also contain module-specific commands that appear only within 
individual modules. The following are descriptions of the commands and options that are common to all four modules.
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File From this menu, you can create, open, or close a watershed, save data associated with 
the watershed, and exit HEC-RTS. In addition, your most recently used watersheds are 
located after the ability to open a watershed in the File menu (Open Watershed 
Dialog). Available commands are: New Watershed, Open Watershed, Recent 
Watersheds, Save Watershed, Close Watershed, and Exit.

View This menu is used to add or remove screen items (toolbars, module tabs, message 
pane, status bar); display watershed units; display time zone; zoom map window to 
the defined maximum extents; and save, restore and manage layouts. Available 
commands are: Zoom to All, Displayed Units, Displayed Time Zone, Toolbars, 
Messages, Status, Module Tabs, Save Layout, Restore Layout, and Layout 
Manager.

Maps This menu is used to adjust the how the map panel of the HEC-RTS main window is 
displayed including map layers, map background, and whether coordinates are 
displayed. In addition, you can save the image in the map window as a graphics file, 
and you can print the image in the map window. Available commands are: Map 
Layers, Default Map Properties, Add Internet Map, Display Map Coordinates, Save 
Map Image, and Print Map.

Scripts This menu allows you to execute existing scripts, create, test new scripts and run 
scripts. Available commands are: Editor, Schedule Script Job, Script Job Status, and 
Run.

Tools This menu allows you to access data (HEC-DSSVue), set options for the HEC-RTS 
software, specify plug-in editor locations to use, view the console.log file, view the log 
file for the software applications being used (HMS, ResSim, RAS, FIA) and the log file 
for DSS processes, and view memory usage. Available commands are: HEC-DSSVue, 
Applications, Options, Model Version Editor, Console Output, Logs, and Memory 
Monitor.

Window This menu allows you to select how you want to view and select multiple windows, 
which modules you want to view. Available commands are: Duplicate Window, 
Detach Window, New Map Window, Map Window Settings, Sync Map Windows, 
Tile, Cascade, Next Window, and Previous Window.

Help Displays current version information about HEC-RTS and accesses the HEC-RTS User's 
Manual. Available commands are User's Manual and About.

3.3.2 Main Toolbar
The main toolbar of the HEC-RTS interface provides quick access to the most frequently used option from the HEC-RTS 
menu bar and consists of the following six toolbars:
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Standard Toolbar 
From this toolbar you can create a new watershed; open a watershed; close a watershed; save a watershed; and, print 
what is displayed in the Map Window.

Map Toolbar 
From this toolbar you can open a new map window; set the zoom level for all open map windows to the selected map 
window's zoom level; in the Map Panel, tile all open map windows; and, in the Map Panel, stack all open map windows.

Modules Toolbar 
From this toolbar you can select the individual Module Tabs – Acquisition, Visualization, Modeling, and, Setup.

Modeling Toolbar 
From this toolbar you can open MFP (need to have an MFP alternative selected); open HEC-HMS; open HEC-ResSim; 
open HEC-FIA; open the Supplemental Program dialog; open the Scripting Program dialog; and, open HEC-RAS.

Tools Toolbar 
From this toolbar you can open HEC-DSSVue.

Animation Toolbar 
This toolbar is only available in the Visualization module, and when you have created a grid set. The Animate button 
will open the Animate dialog and the grid set will display in the map window.

3.4 Module Tabs

There are four modules in HEC-RTS, each module has its own unique set of functions. The four modules are – 
Acquisition, Visualization, Modeling, and Setup.

3.5 Watershed Pane
The Watershed Pane contains information that is pertinent to each of the HEC-RTS modules. For example, when you 
click the Setup tab (Figure 1), the Watershed Pane, will contain the Watershed Tree. Depending on what you have 
selected in the Watershed Tree, a Content Pane in the lower portion of the Watershed Pane, will display information 
about selected items in the Watershed Tree. 
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3.6 Time Series Icon Controls
Time Series Icon Controls allows you to select the attributes for the time series layers that are displayed within the 
watershed. The Time Series Icon Controls box displays in the Watershed Pane when the Acquisition and 
Visualization tabs have been selected. For the Modeling tab (HEC-RTS Main Window), from the Forecast Tabs (HEC-
RTS Main Window), click the Icon Layers tab, the Time Series Icon Controls box will display in the Watershed Pane. If 
nothing displays, then you need to create a time series layer and data must be available in at least one of the time series 
icons associated with the time series layer. There are three attributes available - Icons Type, Values, and Layers.

Icons forces all icons within the map window to display as the selected Icon Type in the Type list. Selecting the Default
option in the list will display the icons as they were set in the Time Series Icon Editor dialog.
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Values allows you to display the time series data as labels. You will select what data to display from the Values list 
(Figure 1) and the information will display next to the associated time series icons. Multiple values can be selected at 
once. Setting up the color associated with a value is detailed in Time Series Icons.

2 Figure 2 Value Labels

Layers allows you to select which layer or layers are visible in the map window. Multiple layers can be selected at once.

3.7 Forecast Tabs

When you are in the Modeling module, at the bottom of the Watershed Pane are the Forecast Tabs. There are six tabs - 
Actions, Reports, Scripts, Icon Layers, Workflow, and Team. Each tab provides you with different commands that will 
allow you to compute a forecast; view extract results; run scripts; select the attributes for the time series layers that are 
displayed within the watershed; view the workflow of the selected forecast runs; and, provides information on team 
modeling for the selected watershed. For example, click the Icon Layers tab, the Time Series Icon Controls display, 
which are also available from the Acquisition and Visualization modules.

3 Figure 1 Modeling Module - Watershed Pane
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3.8 Message Pane
The Message Pane (HEC-RTS Main Window) is a record of CWMS software activities, records the opening of a 
watershed, opening map windows, accessing DSS files, and many other HEC-RTS activities. System output log 
information displays in the Message Pane from the time you start HEC-RTS until you exit. Messages related to incoming 
data are colored coded based on the quality of the data. Messages may also report a problem with a system 
component; problems with field equipment; a caution, warning, or flood event; or other critical situations.

3.9 Map Window
Map windows are used to graphically display a watershed, map layers, model alternative schematics, time series icons, 
visualize data and grid sets, track the acquisition of data, and forecast information. Each module has its own map 
window, for example, in Figure 1, for the Setup module you have chosen to display the stream alignment and the 
schematic for a forecast run. From the map window for the Setup module you can edit elements from each of the 
model alternatives that are part of the selected forecast run.

4 Figure 1 Map Windows for Each Module
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From the map window for the Modeling module (Figure 1), you are viewing the schematic for the selected forecast run, 
and from the map window you can view results for each of the model alternatives that are part of the forecast run.

3.9.1 Map Window Toolbar
The primary set of tools in the map window toolbar includes the Select Tool, Zoom Tool, and Time Series Icon Tool. 
The tools change the appearance and functionality of the mouse. Other tools appear in the toolbar depending on which 
module has been selected. Each tool's functions are described in context in other chapters of the manual.

 Select Tool
The Select Tool allows you to select elements in the map window. Also, after zooming in, the user can use the Select 
Tool to pan.

Zoom Tool
The Zoom Tool allows you to zoom in and out of the map window. To zoom in, hold the mouse button down and 
outline the area that needs to be enlarged. Right-click to zoom out.

Time Series Icon Tool
The Time Series Icon Tool allows you to select time series icons (Time Series Icons and Time Series Icons Layers) on the 
map window. To select multiple icons, hold down the SHIFT key, and click on the time series icons that need to be 
selected. You can access commands related to a time series icon by right-clicking on the time series icon.

When you request to display the stream alignment in a Setup module map window (Figure 1), two additional tools 
become available that are pertinent to only the stream alignment:

Stream Alignment Tool
The Stream Alignment Tool allows you to create, delete, and edit stream elements that make up the stream alignment. 
A stream alignment is a representation of the stream network in the watershed.

Stream Node Tool
The Stream Node Tool allows you to create and edit stream nodes and junctions that make up a stream alignment. 
Stream nodes are the beginning and ending points for each stream element. Stream nodes are points where stream 
elements meet (stream junctions).

3.9.2 Map Window Elements
The elements of a map window represent the watershed data visually in a geo-referenced context and interact with 
associated data. You can create elements (stream alignment, time series icons) and edit those element's properties in 
the Setup module. Also, in the Setup module, if you have displayed a model alternative in the map window, you can 
edit elements specific for that model alternative. In the Acquisition and Visualization modules, you can plot, tabulate, 
and view the data associate with time series icons. For the Modeling module, you can plot, tabulate, and view results at 
time series icons and at elements that represent the model alternatives associated with a forecast run. Additional 
commands are available according to module and are discussed throughout this manual.
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3.10 Viewing HEC-RTS Data and Results
Data can be viewed from the Acquisition and Visualization modules, from plots or tables. Results are viewed from the 
Modeling module through plots and reports (detailed information is provided in HEC-RTS Results)

3.10.1 Plots
HEC-RTS plots offer data and results specific to the active module. Data you can view was defined in the Setup module 
at time series icon locations (Time Series Icons). Modeling results can also be viewed at time series icons or at individual 
modeling elements (e.g., reservoirs). For example, in the Acquisition module, the plot for one time series icon might 
open a two-dimensional graph of incoming data at a specific location, while, in the Modeling module, the same time 
series icon might plot reservoir modeling results at that location (Figure 1).

5 Figure 1 Sample Plot - Reservoir Modeling Results

The plot displays the location name in the title bar, has axis labels, and a color-coded legend for the data contained in 
the plot. When a plot depicts results of a model alternative, as in Figure 1, a dashed vertical line represents the time of 
forecast. The Zoom Tool from the plot window operates the same as described in Map Window.

You can customize the appearance of plots through the use of several editors. To access these editors, use the Select 
Tool and right-click on different elements of the plot (e.g., lines, axis). You can also access these editors through the 
Edit and View menus in the Plot dialog (Figure 1). The following gives an overview of the different editors (Working with 
Plots provides further details on customizing plots):
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Curve Properties Right-clicking on a plot curve or point allows you to open a curve 
properties editor where you can edit curve colors, styles, and weights as 
well as labels and quality symbols.

Viewport Properties Right-clicking on the viewport of a plot allows you to open an editor 
where you can customize the border, background, and gridlines of the 
plot.

Title Properties Right-clicking on a plot axis allows you to open a title properties editor 
where you can customize the title of a plot.

Axis Properties Right-clicking on a plot axis allows you to open an axis properties editor 
where you can customize the axis scale and tic marks.

Legend Properties Right-clicking on the legend of a plot allows you to open an editor where 
you can add a title and add icons and text to the left and right blocks of a 
plot.

Label Properties Right-clicking on an axis label or plot legend allows you to open a label 
properties editor where you can add or change the background color of 
labels or add a border to the labels.

Spacer Properties If you have multiple plots in your plot window, you can right-click on the 
space between the plots to access this editor. The spacer properties 
editor lets you adjust the space between plots.

Polygon Properties Right-clicking on a polygon allows you to open a polygon properties 
editor where you can customize borders and backgrounds.

3.10.2 Tables
The same data and information viewed from a plot can also be viewed in tabular form (Figure 2). As with plots, the type 
of data and results displayed depends on the properties you have defined for each time series icon. 
You can customize the appearance of tables through the use of commands available from the menu bar of the table 
dialog. You can add commas, separate date/time into two separate columns, make the year four digits, specify the 
decimal precision of the data, show the quality of the data, show missing data as a value (e.g., -901.0), copy selected 
cells or the whole table, print, plot, resize the columns of the table, and export the table to an ASCII file.
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6 Figure 2 Data in Tabular Form

3.10.3 Photos and Webcam Images
Photos, webcam images, web pages, or documents can be assigned to time series icons. By adding them to an icon in 
the Setup module, you can access them in the Visualization, Acquisition, and Modeling modules through the icon 
shortcut menu. Images and webcams can be viewed in their own separate dialog or as icons on the map window. Figure 
3 displays an image that can be viewed from a time series icon. If a time series icon represents a dam, links can be 
assigned to the icon that could be a webcam that displays a real-time video of an actual outlet on that dam. The time 
series icon could also have access to pictures of the dam and reports providing details about the dam. For more 
information on how to set these features up see Time Series Icons.
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7 Figure 3 Viewing an Image from a Time Series Icon (https://www.sonomacounty.com/outdoor-activities/lake-
sonoma-recreation-area)

3.10.4 Scripts
Scripts can be assigned to individual time series icons. The scripts can be used to update the data at given intervals, 
compute other information from the data, or complete other tasks. Scripts are assigned to the icons in the Setup
module, through the Time Series Icon Editor. They may also be created in the Script Editor. For more detailed 
information on assigning and using scripts, see Scripting. 



HEC-RTS User Manual  – Understanding Layers

Understanding Layers
                             – 

4 Understanding Layers
Layers in the HEC-RTS interface are like transparencies laid one on top of the other. Each includes representations of 
physical images such as roads, county and state boundaries, rivers, and subbasins. These are layered in the map 
window as color pictures. Each of these images, along with its associated data, is a layer. This chapter describes how to 
create and manage layers so that required data and information are easily viewed.

There are two types of layers: primary layers and map layers. Primary layers are automatically generated when a new 
watershed is created and are present in all HEC-RTS watersheds (although some primary layers may be empty in some 
watersheds) and are module specific. HEC-RTS creates primary layers when a stream alignment, time series icons, map 
window elements, and gridded precipitation data are created. (A time series icon is a symbol in the map window that 
provides quick access to time-series data and information that has been assigned to the icon.) HEC-RTS also creates a 
primary layer when a forecast alternative has been selected for computation. Primary layers can contain sub-layers, for 
example, the Time Series Icons Layer can have several user-defined sub-layers that represent various types of data and 
information such as flow and precipitation.

Map layers are optional and are loaded into the watershed by the user. Map layers are physical images, which help 
visualize a watershed. In HEC-RTS there are several formats for map layers, and include maps from the Internet, such as 
a Google street map. With the Display Map Coordinates function in the Maps menu, the user can set which coordinates 
the Map Window will use (watershed or loaded Internet map). 

4.1 Map Layers Dialog
The Map Layers dialog allows the user to add map layers, organize layers, view all the layers associated with the 
watershed, and add sub-layers to primary layers. The Map Layers dialog can be accessed from any of the modules. 
From the HEC-RTS main window, from the Maps Menu, click Map Layers. The Map Layers dialog will open. The 
following sections describe the commands available in the Map Layers dialog.
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8 FIgure 1 Map Layers Dialog

4.1.1 Menu Bar
The menu bar of the Map Layers dialog contains commands for managing watershed layers. The following is a 
summary of the available menus and the commands associated with each one.

Layers From this menu, you can add map layers; import images; remove map layers; and, 
close the Map Layers dialog.

Edit From this menu, based on your selection in the Layer Tree (Figure 1), you can 
rearrange layers, access each layer's properties, and, other items specific to the 
selected layer.

View This menu has one command, Always On Top, which keeps the Map Layers dialog 
on top of the HEC-RTS main window.
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4.1.2 Layer Tree
The Map Layers dialog contains a tree (Layer Tree) for controlling the display of layers in a watershed. The Layer Tree
represents the hierarchical arrangement of the available layers (primary, map). With the top level of the tree being the 
Map Layers folder (Figure 1) which contains all layers in the watershed. Beneath the Map Layers folder is a branch for 
each of the identified layers in a watershed - primary or map layer. To expand a branch, click the plus (+) sign, 
depending on the layer type you might see sub-layers appear or a legend for the layer appears (Figure 2). When a minus 
sign (collapses) is displayed, clicking the minus sign collapses the branch. By double-clicking on a layer, the user can 
expand/collapse the branch and open the selected layer's Properties Editor.

From the Layer Tree (Figure 2), the checkbox turns the display of a layer or sub-layer on or off. If a layer is unchecked, 
any sub-layers associated with that layer will not display, even if the sub-layers are checked.

9 Figure 2 Map Layers Dialog - Setup Module - Expanded Layer
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4.1.3 Layer Organization
Layers in a Map Window can be organized with the Map Layers dialog. By default, the primary layers are at the top of 
the layer tree, while map layers are added to the bottom of the layer tree. Typically background images (map layers) are 
on the bottom, and layers containing smaller, more-detailed items such as time series icons, gages, and rivers are on 
top. Layers are drawn in the order that they are displayed in the Map Layers dialog. You might want to rearrange the 
order of layers, because either you cannot view a layer you want to display, or you might need to "hide" a layer.

To rearrange the order of layers:

From the Map Layers dialog (Figure 2), from the Layer Tree, select the layer that you wish to rearrange. From 
the Edit menu or by right-clicking on the selected layer, a shortcut menu will display. From either menu, choose 
Move Up, Move Down, Move to Top (moves the selected layer to the top of the layer tree), or Move to Bottom
(moves the selected layer to the bottom of the tree).
Continue to change the position of the selected layer until the layer is in the desired position. Click OK, and the 
Map Layers dialog will close.

4.2 Module Map Windows
For each HEC-RTS module, there is an associated map window, and for each map window, the layers available are 
different. When you click on a module tab, in the HEC-RTS main window, a Map Window will display. From the Map 
Layers dialog, from the Currently Opened Maps box, the currently opened module map windows are listed. Selecting a 
module, will display the associated layers with that module in the Layer Tree.

10 Figure 1 Map Layers Dialog - Currently Opened Maps Box

4.3 Layer Visualization Scaling
Layers may be set to become visible or invisible as zooming in or out occurs in a map window (Primary Layers and Map 
Layers). This allows you to display finer levels of detail as you zoom in on regions in a map window and avoid clutter 
when displaying the full area. This might include time series icons not appearing for less significant gages, detailed map 
layers becoming visible, and raster or other images appearing that are not as distinguishable at a coarser zoom level.

4.4 Time Series Icons Layer
For the Visualization, Acquisition, and Modeling modules, you can change the order of the sub-layers in the primary 
layer Time Series Icons (Figure 1). Expand the Time Series Icons layer, all sub-layers are now visible within the map 
window quickly. You can set specific sub-layers to display, edit the properties of a sub-layer, and set visualization 
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scaling. Further details on setting up sub-layers under the Time Series Icons layer is available in Time Series Icons 
Layers.

11 Figure 1 Map Layers Editor - Acquisition Module - Time Series Icons Layer
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5 Primary Layers
Primary Layers are created when a watershed is created (Time Series Icons layer); when a stream alignment is created 
(Stream Alignment layer); when a grid set is created (Gridded Data layer); and, when forecast alternatives and 
forecasts are created (Model Schematic layer). Primary layers are present in all HEC-RTS watersheds (although some 
layers may be empty in some watersheds) and are foundational to HEC-RTS (whereas map layers are optional, see Map 
Layers). This chapter describes how primary layers are configured and managed. The primary layers display in the Map 
Layers dialog (Figure 1) and are usually listed at the top of the Layer Tree (Understanding Layers contains further 
information on the Map Layers dialog).

12 Figure 1 Map Layers Dialog

5.1 Time Series Icon Layer
The Time Series Icons layer is created for the Acquisition, Visualization, and Setup modules when an HEC-RTS 
watershed is created. At first, this layer is blank, but as you create time series icons, the Time Series Icons layer 
includes all of the time series icons that you have defined for your watershed. Time series icons are available in the 
modules Acquisition, Visualization, and Setup modules, once forecast alternatives and forecasts have been created 
then the Time Series Icons layer will display in the Modeling module.

5.2 Stream Alignment Layer
The Stream Alignment layer is available in the Setup module (also is available in the Modeling module when a forecast 
is open) once a stream alignment has been defined for a watershed (Appendix J). This layer has sub-layers for each 
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stream alignment element. Expanding the Stream Alignment layer node in the Map Layers dialog (Figure 1) displays its 
sub-layers (Stream Junctions, Streams, and Stream Nodes).

13 Figure 1 Map Layer Dialog - Stream Alignment Layer

5.2.1 Stream Alignment Layer Properties
You can change the appearance of streams and their labels; change the appearance of stream junctions and stream 
nodes; and, set the visualization scale for the Stream Alignment layer. From the Map Layer dialog (Figure 1), right-click 
on Stream Alignment, from the shortcut menu, click Properties. The Stream Alignment Properties dialog will open 
(Figure 2).

14 FIgure 2 Stream Alignment Properties Dialog
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5.2.2 Stream Alignment – Streams
The following are instructions for changing the appearance of Streams in the stream alignment:

You can set the width of the lines that represent streams from the Stream Width list (Figure 3).

You can select the color of the lines that represent the streams from the Stream Color list (Figure 2). The default 
color is orange. There are several colors to choose from, and you can also create custom colors. From the 
Stream Color list, click Custom. The Choose A Color dialog will open (Figure 4). See Appendix E for further 
details on the Choose A Color dialog. 

A preview of the stream color change is displayed (Figure 5) in the Stream Alignment Properties dialog. Click 
Apply to apply the changes. 

By default, stream labels appear in the map window. If you do not want the labels displayed, from the Stream 
Alignment Properties dialog (Figure 2), uncheck Show Stream Name, and click Apply. 
To change the font of the stream labels, from the Stream Alignment Properties dialog (Figure 2), click Choose 
Font. The Font Chooser dialog will open (Figure 6). Select the font type from the Font list, and select a size using 
the Size slider. Click OK, the Font Chooser dialog will close. Click Apply on the Stream Alignment Properties
dialog (Figure 2). All the stream labels will appear in the font and size you choose.
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Tic marks appear on a stream representing the stream stationing. There are two types of tic marks, minor and 
major. The following are instructions for changing the appearance of tic marks:
If you do not want to display the tic marks, from the Stream Alignment Properties dialog (Figure 2), uncheck 
Draw Station Tics (Figure 7), and click Apply. 

From the Tic Length list (Figure 7), you can set the length of the minor tic marks. To change the length of the 
major tic marks, use the Major Tic Length list. Click Apply, and the map window displaying the stream 
alignment will update. 
To change the font of the tic mark labels, from the Stream Alignment Properties dialog (Figure 2), click Choose. 
The Font Chooser dialog will open (Figure 6). Select the font type from the Type list, and select a size using the 
Size slider. Click OK, the Font Chooser dialog closes (Figure 6). From the Stream Alignment Properties dialog 
(Figure 2), click Apply. All the tic mark labels will appear in the font and size you chose. 

5.2.3 Stream Alignment – Stream Nodes
The following are instructions for changing the appearance of all Stream Nodes in the stream alignment:

If you do not want to display stream nodes, from the Stream Alignment Properties dialog (Figure 2), uncheck 
Draw Stream Nodes (Figure 8), and click Apply. 

You can select the color for stream nodes from the Node Color list (Figure 8). The default color is green. Similar 
to streams, you can also create a custom color.
You can select the outline color of stream nodes from the Node Outline Color list (Figure 8). The default color is 
dark green. Like streams, you can also create a custom color.



HEC-RTS User Manual  – Primary Layers

Primary Layers –  31

4.

1.

2.

3.

You can set the width of stream nodes from the Node Width list (Figure 8).

5.2.4 Stream Alignment – Junctions
The following are instructions to change the appearance of all Stream Junctions in the stream alignment: 
1. If you do not want to display stream junctions, from the Stream Alignment Properties dialog (Figure 2), uncheck 
Draw Junctions (Figure 4.10), and click Apply. 

2. You can select the color of stream junctions from the Junction Color list (Figure 9). The default color is dark green. 
Like streams, you can also create a custom color. 
3. You can set the width of Stream Junctions from the Junction Width list (Figure 9).

5.2.5 Stream Alignment - Scale
The visualization Scale feature allows you to customize stream alignment display settings as you are zooming in and 
out on the map window. The following are instructions to set the visualization scale for the Stream Alignment layer:

To set the visualization scale for the stream alignment to a default, from the Stream Alignment Properties
dialog (Figure 2), click Scale, click Set to Defaults. The visualization scale is set automatically.
To enter your own scale factor, from the Stream Alignment Properties dialog (Figure 2), click Scale, click New. 
The Create New Scale dialog will open (Figure 10). In the Scale box, enter values for the scale factor. 

Click OK. This creates a new tab in the Stream Alignment Properties dialog (Figure 2), from the new tab, you 
can configure the stream alignment's appearance. 

5.3 Gridded Data Layer
The Gridded Data layer (Figure 1) is available in the Visualization and Modeling modules, only when gridsets are 
included or computed for the watershed. A gridset is a sequence or time series of precipitation grids. The Gridded Data
layer contains the gridsets for the watershed that have been created outside of HEC-RTS using the HEC-GridUtil or HEC-
MetVue software.
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15 Figure 1 Gridded Data Layer

5.3.1 Gridded Data Layer - Properties
You can change the appearance of a girdset and set the visualization scale for the Gridded Data layer. From the Map 
Layer dialog (Figure 1), right-click on the name of the gridset (Obs – Interpolated 15 min), from the shortcut menu, click 
Properties. The Grid Display Options dialog will open (Figure 2).

From the Grid Display Options dialog (Figure 2) you can choose a color contour scheme (default is Precipitation), tic 
interval, and override the minimum/maximum values for the contour limits. There are several advanced features. These 
features are accessed by clicking Advanced, which expands the Grid Display Options dialog (Figure 2). The advanced 
options are:
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16 Figure 2 Grid Display Options Dialog

Brightness: The relative lightness or darkness of a color, from full color to black.
Saturation: The relative intensity of the color, from white to full color.
Transparency: The relative opacity of the color from opaque to translucent to transparent.
Aspect Shading: Enabling this feature causes the display color to change based on the viewing angle.
Adjust Color Scale to Clipping Area: Enabling this feature causes the displayed color ramp to rescale to the 
maximum and minimum clipping thresholds.

5.3.2 Gridded Data Layer - Scale
To set the visualization scale for the Gridded Data layer:

From the Grid Display Options dialog (Figure 2), click on the Scale tab, the Grid Display Options dialog (Figure 
3) will change. By default, the gridded data layer is set for Always show layer (Figure 3). 
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To set visualization scales click show layer in the following scale range (Figure 3). To set the scale so that the 
gridded data layer becomes visible as you zoom-in, you can set the scale to the current scale by clicking Set to 
Current. If you wish to enter a value, in the Only visible below 1: box (Figure 3) enter the scale factor.
To set the scale so that the Gridded Data layer becomes visible as you zoom-out, you can set the scale to the 
current scale by clicking Set to Current. If you wish to enter a value, in the Only visible above 1: box (Figure 3) 
enter the scale factor.
Click OK, the Grid Display Options dialog closes (Figure 3), and the visualization scale is set for the gridded data 
layer.

5.4 Model Schematic Layer
Once you have created forecast alternatives, created a forecast, and have made the forecast active, the Model 
Schematic layer (Figure 1) will display in the Map Layers dialog for the Modeling module. The Model Schematic layer 
contains graphic representations of computational models for the active forecast alternative. HEC-RTS Forecasts
provides detailed information on forecast alternatives, forecasts, and the different computational models represented 
in the Model Schematic layer.

17 Figure 1 Model Schematic Layer

When you expand the tree, you can see the different sub-layers for some of the models that are part of a forecast. For 
example, if you did not want to see the impacts for the HEC-FIA model, from the Map Layers dialog, from the Map 
Layers tree, expand Model Schematic (Figure 1). Clear (uncheck) FIA:Real-time, and the impact areas defined for the 
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HEC-FIA model will no longer display in the map window. To view the impact areas, click FIA:Real-time. This procedure 
applies to all of the sub-layers.

5.5 Shortcut Menu for Primary Layers
This shortcut menu is accessed by a right-click on primary layers in the Map Layers dialog (Map Layers Dialog). The 
shortcut menu provides several ways to manipulate the primary layers. The available commands are:

Move to Top Move the layer to the top of the tree.

Move Up Move the layer up the tree one position.

Move Down Move the layer down the tree one position.

Move to Bottom Move the layer to the bottom of the tree.

Properties Opens a properties dialog associated with the selected layer. Depending on 
the selected layer, the properties dialog may be editable or not. See 
Appendix D for further information on the available map editors.

Import This command is only available for the Stream Alignment layer. Import
allows you to import a stream alignment from a shapefile (*.shp); opens the
Import Stream Alignment dialog.

Export This command is only available for the Stream Alignment layer. Export
allows you to export the stream alignment for a watershed to a shapefile 
(*.shp); opens a Save browser.

Add Icon Layer This command is only available for the Time Series Icons layer. Add Icon 
Layer allows you to create a time series icon layer; opens the New Time 
Series Icon Layer dialog.

Show Legend This command is only available for the Gridded Data layer. Show Legend
allows you to display the legend for a gridded dataset in the Map Layers
dialog.
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6 Map Layers
To help visualize a watershed, HEC-RTS has the capability to display various maps of watershed features. These various 
maps are called map layers, which are displayed in HEC-RTS as color pictures, layered one over the other like 
transparencies. The map layers (optional) also provide a geographical reference for the watershed. This chapter 
describes the formats of map layers and shows how the layers are configured and managed.

6.1 Map Layer Formats

Digital maps (GIS layers) are referred to as map layers in HEC-RTS. When a map layer is included in a watershed, the 
software displays the map layer as GIS features, points, lines, and polygons. The map layer formats that HEC-RTS can 
display are listed in Table 1.

Table 1 Map Layer Formats Supported by HEC-RTS

 Description Common Filename Extension

Arc shapefile .shp

AutoCAD DXF .dxf

Raster Image (*.img) .png, .gif, .jpg, .bmp

Virtual Format .vrt

GeoTIFF .tif

Mr SID .sid

Open Street Maps .osm

USGS DLG .dlg

USGS DEM .dem, .flt

SMRMP .smrmp

ASCII NetTIN .net
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ArcInfo® DEM .asc

6.1.1 Arc Shapefiles (.shp)
This file type is the native data structure for the ArcGIS® program. Shapefiles store non-topological geometry and 
attribute information for the spatial features of a data set in a particular format. Usually there are three component files 
associated with a shapefile: .dbf, .shp, and .shx. The .shp file contains the shapes (points, polylines, or polygons) that are 
displayed in the layer.

Each shape has a record in the .dbf file containing descriptive data called "attributes". The .shx file contains an index 
that links each shape to its record in the .dbf file. For more information on shapefiles, see the ESRI Shapefile Technical 
Description available here: http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf

6.1.2 AutoCAD® DXF (.dxf)
A Drawing Interchange File (.dxf) is created by a Computer-Aided Design (CAD) package, AutoCAD®. This format is a 
tagged-data representation of an AutoCad® drawing file. Tagged data refers to each data element being preceded by a 
group code. A group code is an integer indicating the type of data element. The file created is a vector-based graphic. 
The DXF format is commonly used for data exported from other CAD and GIS programs.

6.1.3 Raster Image
The raster image formats supported by HEC-RTS are: JPEG format (.jpg or .jpeg), Graphics Interchange Format (.gif), 
Portable Network Graphic (.png), bitmap (.bmp), and Multi-resolution Seamless Image Database (MrSID or .sid). This
.img file should not be confused with the format for raster images used by the ERDAS Imagine image processing 
program. HEC-RTS cannot display files in the ERDAS Imagine .img format.

6.1.4 Virtual Format (.vrt)
The *.vrt format is a format driver for GDAL (Geospatial Data Abstraction Library) and allows for a virtual GDAL dataset 
to be composed of other GDAL datasets. The primary use of this format is to group together a series of grids that should 
be associated together. This file format allows multiple depth grids for the same event to create a mosaic single grid. 
Relative file paths are saved in an XML format, as well as a histogram describing the frequency of cell values across all 
grids within the *.vrt.

6.1.5 GeoTIFF (.tif)
A metadata standard which allows geo-referencing information to be embedded into a TIF (Tagged Image File Format) 
file. The added metadata could be map projection datums, coordinate systems, and any other information that will 
establish spatial references. A TIF file stores raster graphic images and data within a single file.

http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf
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6.1.6 Mr SID (.sid)
The MrSID® (multi-resolution seamless image database) is a propriety geo-referenced image file format developed by 
LizzardTech® for use with. This format compresses large raster images files like aerial photographs or satellite imagery 
for easier viewing. Some MrSID images contain geo-referencing and positioning information and can be placed in the 
watershed (from the Map Layers dialog, from Layers, click Import Image(s)).

6.1.7 OpenStreetMap (.osm)
This is an XML file created in the OpenStreetMap (OSM) file format, which is used for saving street map information. This 
file is generated by HEC-RTS in the watershed's map folder and should not be placed or edited by the user.

6.1.8 USGS Digital Line Graph (.dlg)
U.S. Geological Survey (USGS) Digital Line Graphs (DLGs) are created from two sources using manual and automated 
digitizing methods. The two sources are aerial photographs or cartographic sources. DLG files are vector 
representations of the data. When HEC-RTS interacts with a .dlg file it automatically creates a .dlgbin file for use.

6.1.9 USGS DEM (.dem)
USGS publishes the file format USGS DEM. A raster file format, .dem files usually contain terrain elevations, but the file 
format can be used for representing any surface. The format allows for internal documentation of the coordinate 
system, date of publication, etc. These values are referenced horizontally either to a Universal Transverse Mercator 
(UTM) projection or to a geographic coordinate system.

6.1.10 SMRMP (.smrmp)
Segmented Multi-Resolution Multi-Parameter (SMRMP) file (HEC-FIA) created to operate gridded data (namely, digital 
terrain grids, inundation depth grids, and arrival time grids) more efficiently.

6.1.11 ASCII NetTIN (.net)
This is an ASCII file format used to represent a triangulated irregular network (TIN). TIN data are stored in a simple 
format that defines the nodes, edges, and triangles contained in the TIN. This format is common for transferring TIN 
data between software.

6.2 Adding Map Layers
You can add as many types of map layers as needed. In HEC-RTS Version 3.1.1, HEC-RTS can transform coordinates "on-
the-fly" as long as a map layer's coordinate system is defined properly. For example, for an Arc shapefile there is an 
associated projection (.prj) file. The projection file contains the mathematical formulas that relate to the spherical 
coordinates on the globe to flat, planar coordinates.
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Map layers are added from the Maps menu in any of the HEC-RTS modules. When a map layer is added to the 
watershed, HEC-RTS reads the coordinates of points, lines, and polygons on the map layer and resets the geographic 
extents of the watershed equal to the smallest rectangle that will contain all objects in the map layer. When adding 
more than one map layer, you must ensure that each map layer is projected in the same coordinate system (Setting Up 
the Coordinate System). For example, if an Arc shapefile (.shp) is added that displays the major streams in a watershed 
area, the geographic extents will change according to the projection of that shapefile. If the shapefile is projected in 
State Plane Coordinates in feet, HEC-RTS will set the geographic extents accordingly, and the units of the stream 
alignment will be in feet.

To add map layers:

From the HEC-RTS main window, from the Maps menu, click Map Layers, the Map Layers dialog will open 
(Figure 1).

From the Layers menu, click Add Maps, the Select Map to Add browser (Figure 2) will open.
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Select the desired map layer format from the Files of type list. Select the filename, and click Open. The Select 
Map to Add browser will close (Figure 2). The selected map layer will display in the map window, and in the Map 
Layers dialog (Figure 1), the map layer will display under the Map Layers tree.

When enabled, the Create Copy checkbox (default) on the Select Map to Add browser (Figure 2) will copy the selected 
map layer to the active watershed's directory structure under the maps folder.

6.3 Removing Map Layers
To remove map layers:

From the Map Layers dialog, from the Layers menu, click Remove Map Layer. The Remove Map Layers from 
Watershed dialog will open (Figure 1). Select the map layer to remove from the watershed, click Remove. A 
warning window will display asking you if you really want to remove the selected map layer, click Yes.

The Remove Map Layers from Watershed dialog will close (Figure 1), and the selected map layer will no longer 
display in the Map Layers dialog.

6.4 Shortcut Menu for Map Layers
Right-click on a map layer (non-primary) in the Map Layers dialog, a shortcut menu displays (Figure 1). The shortcut 
menu provides several ways to manipulate a map layer. This ability to manipulate depends on the type of map layer 
(Figure 1), since HEC-RTS does not provide the same capabilities to all recognized map layer formats. The available 
commands are:
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Move to 
Top

Move the layer to the top of the tree.

Move Up Move the layer up the tree one position.

Move Down Move the layer down the tree one position.

Move to 
Bottom

Move the layer to the bottom of the tree.

Show 
Legend

Show the legend for the layer.

Hide 
Legend

Hide the legend for the layer.

Change 
Label

Change the label of the layer in the Map Layers dialog. This does not change the filename of the 
layer.

Properties Displays the properties editor specific to the selected layer. Depending on the format of the layer, 
this dialog may be editable or not. See Using Map Editors for further information on the available 
map editors.

Set Scale 
for Zoom-in

Set the zoom-in visualization scale for the layer as detailed in Setting the Visualization Scale.
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Set Scale 
for Zoom-
out

Set the zoom-out visualization scale for the layer as detailed in Setting the Visualization Scale.

Remove 
Scale 
Factors

Disable or clear all scale settings for the layer as detailed in Setting the Visualization Scale.

Copy To Copy the layer to another folder.

Attributes 
Table

Opens the Attributes Table window, which displays the attributes of the selected layer.

6.5 Geographic Reference for Map Layers
To maintain a geographic reference (also called a geo-reference), HEC-RTS uses a user-selected and customizable 
coordinate system, called the World Coordinate System (WCS). This superimposes a grid on layer features to establish x 
and y coordinates in WCS for each point on the layer. The x-coordinate is referred to as "easting", and the y-coordinate 
is referred to as "northing". You can select the extent of this grid, the dimensions of the cells of the grid, the units of 
measurement of the grid, and the location of the origin of the grid. Because of this flexibility, the user can specify and 
use virtually any grid coordinates convenient for HEC-RTS model integration. To establish geographic reference:

From the HEC-RTS main window, from the Maps menu, click Default Map Properties. The Default Map 
Properties dialog (Figure 1) will open.
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2. The Default Map Properties dialog contains two tabs: Map Extents and Default Map Layers. The Map Extents
tab includes:

Coordinate 
System

This field identifies the established coordinate system for the watershed. To view the 
coordinate system, click View. The Map Coordinate Information dialog (Figure 2) will 
open, providing you with information about the coordinate system that was established 
when the watershed was created. You are not able to edit this information.

Extents Easting Minimum and Maximum; Northing Minimum and Maximum. These values (Figure 
1) indicate the location of the left, right, bottom, and top borders (respectively) of the grid in 
the map window. 

18 Figure 2 Map Coordinate Information Dialog

Set Map 
Extents to 
Display

This will set the limits of the map window. If you zoom in on an area and click Set Map 
Extents to Display, the extents on the Default Map Properties dialog (Figure 1) will change 
to the zoomed area.

Grow to Map 
Extents

When selected, HEC-RTS automatically sets the geographic extents to define the smallest 
rectangle that encompasses all the objects in the watershed.

The geographic extents of map layers must be selected carefully to ensure that the entire watershed is included. 
HEC-RTS can transform map layer coordinates "on-the-fly" if coordinate systems are defined properly in ways 
that HEC-RTS can determine the coordinate system. For example, for an Arc shapefile there is an associated 
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projection (.prj) file. The projection file contains the mathematical formulas to relate spherical coordinates on 
the globe to flat, planar coordinates. Therefore, you may need to use GIS tools to identify or transform the layers 
from one coordinate system to another before using them with HEC-RTS.
The Default Map Layers tab (Figure 1) includes a list of map layers that are being displayed in a map window. 
You use check boxes to display or hide map layers.

6.6 Map Layer Properties
As described in Map Layer Formats, HEC-RTS supports several map layer formats, each with its own properties. To edit 
those properties:

From the Map Layers dialog, right-click on a layer to edit, from the shortcut menu, click Properties.
The appropriate properties editor will display (Figure 1). For example, in Figure 1, you have selected a map layer 
that is a polygon shapefile. The Edit Polygon Properties editor will open (Figure 1). Here, you can specify the 
visual style for the layer and its labels. Properties dialogs vary depending on the type of layer you are editing.

6.7 Setting the Visualization Scale
The easy way to set the visualization scale for map layers is outlined below:

From a map window, zoom in to a point at which you want a map layer to become visible.
From the Map Layers dialog, right-click on that map layer to set its visualization scales. From the shortcut menu, 
click Set Scale for Zoom-in. This sets the visualization scale for the map layer. If you go to the map window and 
zoom out, the layer will no longer appear.
Inversely, if you want the layer to become visible as you zoom out, from the shortcut menu, click Set Scale for 
Zoom-out.
Visualization scale settings can be cleared or disabled. From the shortcut menu, click Remove Scale Factors. 
The visualization scale for the layer is cleared.
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7 Using HEC-RTS - Overview
This chapter describes the typical workflow involved in the routine use of HEC-RTS to support the water management 
process. This chapter will provide information on running models, analyzing results, and, providing information to the 
user on how to run models when an extreme event occurs.

At this point, you have the ability to configure a watershed, now you are ready for the routine tasks of running forecast 
models; viewing and analyzing results; revising model data, as needed; and posting results to HEC-RTS DSS files to 
prepare for the next forecast.

7.1 Managing Data for HEC-RTS
Data in the watershed that needs to be monitored will be selected from the time series icon layers, which have already 
been configured (Time Series Icons and Time Series Icons Layers). The time series icons will be placed at locations in 
the watershed that correspond with data that needs to be monitored, and will be organized into layers (groups), which 
will make the data readily visible. Time series icons are available in the Acquisition, Visualization, and Setup modules 
in HEC-RTS and provide access to functions related to data. This includes acquiring, monitoring, validating, and editing 
data by using the Acquisition module. The Visualization module provides a flexible set of tools that allows 
visualization of data (i.e., gridded precipitation data). These visualization tools help you evaluate the current state of 
the watershed by comparing the data to threshold values that define normal conditions. For example, let's say an upper 
threshold value for precipitation data of three inches has been defined. If a precipitation value is four inches, then the 
time series icon will alert you using a visual indicator.

7.1.1 Acquiring Data
In the Acquisition module, you will retrieve time-series data from gages. This data will typically include precipitation; 
river flows and stages; temperature; and, reservoir releases and elevations. One way you can view this data, is by 
defining a time window that is relative to the current time by setting look back and look ahead times (in days or hours). 
Another way to view data is historically, you specify a starting and ending date and time. An example of defining time 
window relative to current time is displayed in Figure 1.
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19 Figure 1 Acquisition Tab - Time Window

7.1.2 Monitoring and Validating Data
In the Acquisition module, you will monitor and validate your time-series data. Several tools are available to show the 
quality and quantity of the data. Quality color bars (Figure 2) and thumbnail plots (Figure 3) provide you with a quick 
overview of the acquisition processes by showing you the quality (missing values needing to be filled-in) and quantity 
(magnitude of data and possible data outliers) of your data. If the quality color bar or thumbnail plot for a location 
indicates that the data are questionable, then you can check the data using plots (Figure 4) and tables (Figure 5).
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You can use the Data Status Summary (Figure 6) to view groups of data (e.g., all precipitation data, all flow data). Refer 
to Acquisition Module and Data Status Lists for additional details for monitoring and validating data in HEC-RTS.

20 Figure 6 Data Status Summary
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7.1.3 Editing Data
When you are checking the validity of data to verify its accuracy, you might need to edit questionable data and fill-in 
missing data. You use the Data Validation Editor (Figure 7) in the Acquisition module to edit time series data. Refer to 
Data Validation Editor for further details.

21 Figure 7 Data Validation Editor

You can use text-entry editing or graphical editing to make data revisions. When there are data gaps (i.e., missing data), 
this tool is also convenient for estimating values using the graphical editor or the table of data values. After editing the 
data, you can choose to accept the changes and store the revised data values back to a DSS file. Refer to Data Validation 
Editor for additional details for editing data.

7.1.4 Visualizing Data
The Visualization module allows you to view current conditions in your watershed and the associated 
hydrometeorological data in a georeferenced context (e.g., gridded precipitation), as shown in Figure 8. Grid animation 
controls allow you to view precipitation grids for the time window you have chosen in the Visualization module. These 
controls (Figure 9) function as you would expect the controls to work for a video player.
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22 Figure 8 Visualization Module - Gridded Precipitation Displayed

23 Figure 9 Visualization Module - Grid Animation Controls

Like the quality color bars used in the Acquisition module, you can use threshold color bars (Figure 10) in the 
Visualization module to compare current data against threshold values that you set for a location. For example, in the 
Acquisition module you may wish to display quality color bars to identify missing data, while in the Visualization
module, you may wish to use threshold color bars or thumbnail plots to understand your watershed's 
hydrometeorological or operational conditions.
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24 Figure 10 Visualization Module -Threshold Color Bars

For example, in Figure 10, the upper left threshold color bar displays red for the parts of the time window when a gage 
downstream of the reservoir exceeds an operational flow threshold. The other three threshold color bars (Figure 10) 
display the times when key downstream gages exceed the NWS (National Weather Service) "monitor" stage (blue) or 
flood stage (red). You can also use thumbnail plots and tables to visualize your time-series data. For example, in Figure 
10, thumbnail plots display hydrographs at gages upstream and downstream of the reservoir, and on a lateral branch of 
the river. Refer to Visualization Module for additional details for visualizing data.

7.2 Running Forecast Models
Now that the quality of the time-series data has been validated, you are ready to create an HEC-RTS forecast. An HEC-
RTS forecast is a simulation of watershed processes and consequences of potential flooding from various software 
applications configured in HEC-RTS. The meteorological data processor, MFP, combines observed and forecasted 
meteorological data into gridded datasets for use in HEC-HMS. The hydrologic software application, HEC-HMS, 
computes flow from forecasted and observed meteorological time-series. The reservoir operation software application, 
HEC-ResSim, computes flow and release schedules. The hydraulic software application, HEC-RAS, computes stage and 
inundation maps. The impact analysis software application, HEC-FIA, computes flood consequences and action reports. 
Prior to creating an HEC-RTS forecast, you will have already configured an HEC-RTS watershed. Specifically, Model 
Alternatives will have been configured, Model Alternative Keys (Model Alternatives and Forecast Runs) assigned, 
Program Order and Forecast Runs defined, and Model Linking (Model Linking Editor) configured.

An HEC-RTS forecast might be configured using a typical forecast run that includes something similar to the following 
model alternatives: Winter Nextrad QPF (for MFP), normal conditions (for HEC-HMS), normal reservoir operations (for 
HEC-ResSim), normal river conditions (for HEC-RAS), and no flooding consequences (for HEC-FIA). If a high rainfall event 
is forecasted, an HEC-RTS forecast might be created using a forecast run with model alternatives similar to the 
following: HRRR QPF (for MFP), wet basin conditions (for HEC-HMS), restricted downstream channel capacity (for HEC-
ResSim), high channel flow (for HEC-RAS), and evacuate with warning (for HEC-FIA).
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In the Modeling module, the user will specify a forecast time window, create and manage forecast extract and post lists, 
extract time-series data for the forecast, create and manage forecast runs, edit model parameters, and run the models. 
Figure 1 displays the data flow concepts through the five standard HEC-RTS analysis applications (MFP, HEC-HMS, HEC-
ResSim, HEC-RAS, and HEC-FIA).

25 Figure 1 Data Flow Between Models
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7.2.1 Hydrologic Modeling (MFP, HEC-HMS) 
The meteorological preprocessor MFP will be used to combine observed precipitation data and future precipitation 
information into a single precipitation dataset that can be used by the watershed runoff model, HEC-HMS. Using the 
observed and future precipitation data, HEC-HMS computes runoff, including uncontrolled local flows that are typically 
used by HEC-ResSim. The types of data typical that need to be changed for a forecast are loss rates and baseflow.

7.2.2 Reservoir Simulation (HEC-ResSim) 
After the upstream boundary flows and uncontrolled local flows have been computed by HEC-HMS, you will run the 
reservoir simulation application HEC-ResSim to use those flows during the operation of the reservoirs to compute 
regulated flows. Reservoir operations might include zones and rules for day-to-day operations, along with zones and 
rules for extreme events. 
The types of data that might typically be changed for a forecast are the starting conditions for reservoirs. As long as the 
reservoir starting conditions are linked to real-time data (starting elevations or storages, reservoir or outlet releases, 
and any other boundary conditions needed by the model), then the user shouldn't have to make any revisions to the 
HEC-ResSim model in order to run routine HEC-RTS forecasts.

7.2.3 River Analysis (HEC-RAS) 
Regulated flows computed by HEC-ResSim are typically used as boundary conditions to the hydraulic routing model, 
HEC-RAS. Computed flows from HEC-HMS or supplemental models can also be used as input to HEC-RAS. In turn, HEC-
RAS computes stage, which is input to HEC-FIA. The types of data that might typically be changed for a forecast are n
values at selected cross sections to match profile information better throughout the lookback period.

7.2.4 Impact Analysis (HEC-FIA) 
HEC-FIA analyzes impacts within inundated areas based on computed hydrographs from HEC-ResSim and stages from 
HEC-RAS. HEC-FIA calculates flood damage determined by rising stage in a stream, river, lake, or reservoir. HEC-FIA also 
computes action reports that tell responders what actions need to done based on the computed stage values. The 
types of data that might typically be changed for a forecast are adjustments to the levee failure stages to see the 
associated damage and impacts during an event.

7.3 Viewing and Analyzing Results
Viewing of modeling results occurs from the Modeling module by using plots and reports. You can view results at 
individual modeling elements (e.g., computation points, reservoirs, impact areas, etc.). Typical results include 
tabulated subbasin precipitation depths, subbasin hyetographs, stage and flow hydrographs, reservoir release 
decisions, hydraulic plots and tables, floodplain inundation maps, and impact reports. Refer to HEC-RTS Results for 
more details on results.
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7.4 Editing Model Data
After application results have been reviewed, revisions might be needed to model data. The active forecast run in the 
Modeling module, indicates which software applications are being used in the forecast. For each software application, 
the user can edit some of the data by clicking on the appropriate software application layer in the forecast tree and 
using the buttons located in the Actions tab (Figure 1). Alternately, the user can click on the appropriate application 
icon in the Modeling module's toolbar to open that application's native interface.

26 Figure 1 Example of Editing Model Data (HEC-ResSim Alternative Editor)

For example, if the user wants to change the lookback storage (i.e., starting condition) for a reservoir, the user needs to 
edit the HEC-ResSim model alternative being used in the forecast run. From the Modeling module (Figure 1), from the 
Forecast Run Details section (Figure 1), click on the HEC-ResSim model alternative (RT-Normal). From the Forecast
tabs (Figure 1), click on the Actions tab. A list of HEC-ResSim commands will display, you want to edit the HEC-ResSim 
model alternative, so click Edit Alternatives (Figure 1). At this point, you now have access to HEC-ResSim's Alternative 
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Editor, the Lookback tab (Figure 1) contains the reservoir starting storage (and elevation) values (among other initial 
conditions).

Once you have made your model alternative revisions, be sure to save the watershed. The example, provided you with 
one way to edit model alternatives, there are several other ways in HEC-RTS to edit model alternatives. If revisions are 
made to a model alterantive from the Forecast Run Details area (Figure 1) of the Modeling module, the revisions are 
only applicable for the forecast run that is part of the selected forecast. Other forecast runs (as well as other forecasts 
that have been run with the selected forecast run) will not contain the revisions. If the user wants the forcast run 
revisions to be available for subsequent forecasts, then you will need to save the revisions to the "base" data. To save 
"base data", select the forecast run (Daily – Interpolated Obs and Manual Entry QPF) that contains the revisions, click the 
Actions tab (Figure 1), click Save To Base (located on the Actions tab).

7.5 Posting or Saving Forecast Results
Now that you have run a forecast and are satisfied with the results, you will want to post (save/store) forecast results to 
a DSS file. HEC-RTS provides many options for posting results - by forecast, post only certain results, post by model 
alternative, and many other ways. Refer to HEC-RTS Forecasts for additional details for posting forecast results.

As an example, you might want to only store the reservoir elevation and release time-series values (remember, this is 
just a simple example). From the HEC-RTS main window, click on the Setup tab, from Models menu, click Edit Post. 
The Post Editor (Figure 1) will display, from the Available Output box, select the appropriate pathnames for reservoir 
elevation. Click Add To Group (Figure 1), if no other post groups have been defined the New Post Group dialog will 
display (Figure 1). In the Name box enter a name, and from the File list select a DSS file, click OK. The New Post Group
dialog box will close, and the Post Editor will display information about the created post group (Figure 1).

27 Figure 1 Edit Post
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After the post group is created, from the HEC-RTS main window, click on the Modeling tab (Figure 2), from the Forecast
tabs, click Actions. Click Post, the Run Post dialog will open (Figure 2). Select a post group, click Run Now, a Post tab is 
added to the Message Pane, and the results of the post are displayed.

28 Figure 2 Running a Post
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8 Acquisition Module
The Acquisition module allows you to examine data, evaluate the quality of data, and quickly identify problem 
locations for a watershed. HEC-RTS keeps you apprised of the quality of data in DSS files by displaying color bars and 
thumbnail plots that dynamically convey the quality of data at individual locations; uses plots and tables to provide 
detailed views of data; and, provides a mechanism to group gages for viewing (such as precipitation or flow), which 
allows you to view details for more or fewer gages than appear in the geo-referenced map display.

Once issues with data have been identified, the Data Validation Editor can be used to validate the data. The Data 
Validation Editor allows the user to select specific locations for validation (ad hoc mode) or to use pre-defined 
validation lists (list mode). The Data Validation Editor can filter data to identify and display only those data time series 
with questionable, missing, and/or rejected data. Additionally, the Data Validation Editor offers tools for both text-
entry editing and graphical editing. With the former, the user can enter corrected values in a table. With the latter, the 
user can use the mouse to create line segments in a plot to replace questionable or missing data. Also, automated 
estimates can be used to edit data.

8.1 Acquisition Module Overview
The Acquisition module (Figure 1) contains buttons that execute commands specific to data acquisition. These 
commands include setting up a time window, updating time series icons in the map window, and access to the Data 
Validation Editor. A detailed discussion of common screen components is presented in HEC-RTS Interface.
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29 Figure 1 Acquisition Module

8.1.1 Menu Bar
The following is an overview of the menu bar (Figure 1) for the Acquisition module. The File, View, Maps, Scripts, Tools, 
Windows, and Help menus are discussed in HEC-RTS Interface. The commands available from the menus will facilitate 
the acquisition and management of time series data for a watershed.

Edit From this menu the user can edit color bar settings; access the Data Validation 
Editor; create a validation list from selected icon time series; and, delete validation 
lists. Available commands are: Icon Quality Colors, Data Validation, Create 
Validation List, and Delete Validation List.

Note: For HEC-RTS, validation lists are not used, and the subject is not discussed in 
this User's Manual
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Reports From this menu the user can view the quality of data in the form of data status lists. 
The user can select from existing files of data status lists, or create new data status 
lists, and save the data status for future use. The only available command is Data 
Status Summary.

8.1.2 Map Window
The Map Window (Figure 1) of the Acquisition module contains map layers and layers of time series icons that allow 
viewing of data acquisition processes in a geo-referenced context. The user can customize how time series icons appear 
according to the needs and objectives of the watershed being studied. For example, time series locations that need to 
be evaluated daily for an individual watershed may appear as quality color bars to facilitate quick review of data. On the 
other hand, the use of time series icons to monitor data provides space-conserving graphical images on the schematic. 
Customizing the time series icon layers is done in the Setup module (Time Series Icons Layers).

Quality color bars and/or thumbnail plots are normally used in the Acquisition module because these icons allow you to 
quickly scan the displayed gages and determine where problems may exist. Both icons can be set to update 
dynamically to reflect the relative quality of the data.

8.1.3 Time Series Icon Controls
The Time Series Icon Controls (Figure 2) allow you to select attributes for the time series icon layers that are displayed. 
The time series icon controls are located on the Acquisition tab near the bottom of the pane (Figure 1). There are three 
attributes available: Icons Type, Values, and Layers (Figure 2).

30 Figure 2 Time Series Icon Controls

Icons 
Type

forces all icons within a map window to display as the selected Icon Type in the list. Selecting the Default
option in the list will display the icons as they were set originally in the Setup module (Time Series Icons).

Value
s

allows you to display the time series icon's data as labels, which display next to or on the location of their 
associated time series icons. For example, you can choose to display the data's total, minimum, and 
maximums values as labels. Multiple values can be selected at once.

Layer
s

allows you to select the sub-layers that are visible in the map window. Multiple layers can be selected at 
once.

By selecting the attributes, you can change how time series icons are displayed within the Acquisition module. For more 
detailed information on how to configure the properties that control the threshold color bar icons displayed (Time 
Series Icons Layers).
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8.2 Set Time Window
You can either set a specific (i.e., fixed) time window (for reviewing a historical event) or you can set a time window 
relative to the current time (the default setting, used for reviewing data). To set or change the time window:

From the Acquisition module (Figure 1), for the default time window, HEC-RTS assumes that you want to view 
current data, so Relative to Current Time is selected (Figure 1). If you want to view historical data, you must 
select Specific Time Window (Figure 1).

31 Figure 1 Acquisition Module - Time Window Setup

If you would like to set the Time Window (Figure 1) relative to the current date and time, select the Relative to 
Current Time and enter the Look Back Time and select either Days or Hours as the time unit. Normally you will 
set the time window to extend backward one to thirty days from the current time. Optionally, you can enter a 
Look Ahead Time and select either days or hours; this allows you to look ahead at data. 
If you would like to set a historical Time Window (Figure 1), select Specific Time Window and enter the Start 
Date and Time of the time window and the End Date and Time of the time window for the historic data. 
Click Refresh (Figure 1) to complete the time window change. 

8.3 Time Series Icon Shortcut Menu
From the Map Window, the time series icons display, by right-clicking on a time series icon, a shortcut menu (Figure 1) 
will display that allows you to view the data associated with a selected time series icon either in a plot, table, or using 
Microsoft Excel®. Also, from the shortcut menu you can access the Data Validation Editor to edit the data associated 
with the selected time series icon. Another option is that you can view the legend of the selected time series icon. The 
shortcut menu is the same for all available time series icon types (i.e., for the color bars, thumbnail plots, graphics, or 
dots).
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32 Figure 1 Time Series Icon Shortcut Menu

8.4 Reviewing Data Quality
Reviewing the quality of the data is the primary task during the HEC-RTS data acquisition process. There are four 
primary ways to assess the quality of data, to identify specific locations with data issues.

Use of quality color bars and thumbnail plots. HEC-RTS can display time series icons as quality color bars or 
thumbnail plots representing gages where data has been collected. Quality color bars are color coded according 
to the quality of data at a location. This allows you a quick visual overview of data that has been acquired in the 
watershed for the specified time window.
Use of plots and tabular data. When you have identified locations where issues exist, plots and tables provide 
detailed views of data, helping you determine the nature of the issue.
Use of Data Summary Lists. Data summary lists allow you to view gages in groups (such as all precipitation or 
all flow gages) and see details for more or fewer gages than display in the geo-referenced map window (Data 
Status Lists).

8.4.1 Quality Color Bars
Quality color bars (Figure 1) offer a quick overview of acquired data in the watershed, reflecting the status of data at 
each location as being acceptable, missing, or questionable.

HEC-RTS attaches quality flags to the data based upon thresholds that have been set.

33 Figure 1 Quality Color Bars

A quality color bar (Figure 1) is a thick, segmented line representing the history of the data quality at a specific location 
within the time window you have established. The name of the location appears adjacent to the color bar, and the 
length of the color bar represents a timeline equal to the duration of the time window. Segments along the color bar 
reflect time intervals, with colors corresponding to the data quality legend you have defined. The quality color bars are 
updated dynamically at the time interval that you entered in the Time Window. As part of your daily routine, you should 
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review quality color bars to determine if data is good and which data needs to be validated. To view the legend for 
quality color bars:

Right-click on a time series icon in the Map Window, from the shortcut menu, click Icon Legend, the Quality 
Color Bar Legend dialog (Figure 2) will open.
The legend displays the quality flags for the data and the colors that represent each quality flag. You can change 
the color associated with the quality flags.
From the HEC-RTS main window, from the Acquisition tab, from the Edit menu, click Icon Quality Colors, the 
Quality Color Bar Editor (Figure 3) will open. 

To change the color of a quality flag, in the Color column of the table click the drop-down list and a list of 
available colors appears. 
Click the color you wish to change, and the color appears in the cell of the Color column. 
The Show no report after flag (Figure 3) is a quality check for irregular time series datasets only and is not used 
in HEC-RTS. 
Click OK, the Quality Color Bar Editor (Figure 3) closes, and the Map Window refreshes all quality color bars. 
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8.4.2 Thumbnail Plots
In some cases, you may wish to use thumbnail plots to represent gages and time series locations. Thumbnail plots 
(Figure 4) provide a miniature version of the full-size plots available in HEC-RTS, displaying data for the time window. 
The name of the location appears adjacent to the thumbnail plot. As the time window updates, HEC-RTS refreshes the 
data and updates the thumbnail plot. The thumbnail plots are updated dynamically at the time interval that you 
entered in the Time Window.

To view the legend for thumbnail plots:

From the Map Window, right-click a thumbnail plot, from the shortcut menu (Figure 4), click Icon Legend. The 
Thumbnail Plot Legend dialog (Figure 5) will open. 

 
The legend displays the pathname, the color of the curve, and the minimum and maximum values of the curve. 
The Thumbnail Plot Legend dialog (Figure 5) provides you with information, to edit the color of the curve 
shown in the thumbnail plot (Time Series Icons).
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8.5 Using Plots
If the quality color bar or thumbnail plot for a location indicates that the data is questionable or bad, viewing the data in 
a plot can help you to determine the nature of the problem. To access plots for data:

From the Map Window, right-click a time series icon, from the shortcut menu, click Plot.
This opens a two-dimensional plot(s) (Figure 1) that contains the data for that location for the current time 
window. Figure 1 shows sample plots for both flow and stage gages. Use the Zoom Tool to zoom in on a specific 
portion of the plot. See Map Window for a more detailed description of the Zoom Tool. In addition, a more 
detailed description on the plots can be found in Viewing HEC-RTS Data and Results. 

8.6 Using Tables
If the quality color bar or thumbnail plot for a location indicates that the data is questionable or bad, viewing the data in 
a table can help you to determine the nature of the issue. To access tables of data:

From the Map Window, right-click a time series icon, from the shortcut menu, click Tabulate.
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This opens a table that contains data for that location for the current time window. Figure 1 shows a sample 
table of the data for a flow and stage gages. 

If you have already opened a plot, you can also tabulate the data displayed in the plot from the Plot dialog 
(Sample HEC-RTS Plot). From the File menu, click Tabulate. For more details on tabular data in HEC-RTS, see 
Visualizing Data. For printing and exporting tabular data, see Printing and Copying HEC-RTS Data. 
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9 Data Status Lists
Data status lists provide the capability to review time series data by groups (such as all precipitation or all flow gages) 
and see details for more or fewer time series data than what appears in the geo-referenced map display. These lists can 
help you assess data and identify specific locations where problems may exist in the acquired data.

9.1 Data Status Summary Dialog
To manipulate data status lists, from the Acquisition tab, from the Reports menu, click Data Status Summary, the 
Data Status Summary dialog (Figure 1) will open. If a data status list has been displayed before, the Data Status 
Summary dialog displays the previously viewed data status list.

34 Figure 1 Data Status Summary Dialog

From the Data Status Summary dialog (Figure 1), the user can create data status lists, select data status lists, copy a 
data status list, review the quality color bars, review how many values are missing, and find the time and date of the last 
valid data value for that particular time series data.

Data status lists allow the user to organize time series data for specific needs. For example, a data status list might be 
created that displays all precipitation gages, all stream gages, or a mix of precipitation and stream gages that are 
needed for a specific forecast. A data status list contains time series data (pathnames) from DSS files.

9.1.1 Menu Bar
Following is an overview of the Menu Bar for the Data Status Summary dialog (Figure 1). The commands available are:
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File From this menu you can create a data status list, open a data status list, save a data status 
list, or copy one data status list to another. Available commands are: New, Open, Save, 
Save As, and Close.

Edit From this menu you can edit the table of information that represents a data status list. You 
can insert and delete rows, and get data from DSS files. Available commands are: Insert 
Row(s), Delete Row(s), and Browse DSS.

View From this menu you can plot and tabulate specific time series data, view the missing data 
segments of time series data, validate data associated with a time series pathname, view 
the quality color bar legend, and refresh time series data when the time window for the 
Data Status Summary dialog has changed. Available commands are: Plot, Tabulate, 
Missing Segments, Validate, Quality Color Legend, Time Window, and Refresh.

9.1.2 Shortcut Menu
From the table in the Data Status Summary dialog (Figure 1), select a time series pathname (a row in the table), then 
right-click on the selected time series pathname, a shortcut menu will be displayed (Figure 2). From the shortcut menu 
the user can plot, tabulate, view missing data, or validate data for the selected time series pathname.

35 Figure 2 Shortcut Menu

9.2 Data Status List
Data status lists allow you to review time series data by groups (such as all precipitation or all flow gages) and provide 
details for more or fewer time series data than what appears in the geo-referenced map display. You can create a data 
status list by retrieving time series data from a DSS file. Once a data status list has been created, review the data to 
determine the time window for your forecast, add or delete time series pathnames to the data status list, and edit data 
specific to the time series data.

9.2.1 Creating a Data Status List
To create a data status list:
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From the Data Status Summary dialog, from the File menu, click New. The Data Status Summary dialog will 
now be blank. From the Edit menu, click Browse DSS, the Select Pathnames dialog will open (Figure 1).

From the File menu, click Open, an Open HEC-DSS File browser will open (Figure 2). Navigate to the location of 
a DSS file, double-click on the name of a DSS file, the Open HEC-DSS File browser will close (Figure 2).
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The Select Pathnames dialog (Figure 3), will now display the available pathnames in the selected DSS file.

To add DSS pathnames to a data status list, highlight a row(s) in the table, click Select, your selection(s) will 
display in the selection box.
Since the selected DSS file can contain many pathnames, to assist you in finding the correct pathnames, several 
filter lists are available in the Search By Parts area of the Select Pathnames dialog (Figure 3).
When you are finished selecting your pathnames, click Add Pathnames (Figure 3). From the File menu, click 
Close, the Select Pathnames dialog (Figure 3) will close. The Data Status Summary dialog will now contain the 
selected pathnames.
To save the data status list, from the File menu (Data Status Summary Dialog), click Save. A Save File browser 
will open (Figure 4). In the File name box (Figure 4), by default, HEC-RTS will save to the default data status list 
(CriticalData.dataStatus). If you want to save to the default data status list, click OK. The Save File browser will 
close (Figure 4), and the default data status list (CriticalData.dataStatus) will now contain your selected 
pathnames.
If you do not want to save to the default data status list, from the Save File browser, enter a name in the File 
name box (Figure 4). The Folder box (Figure 4) will contain the default location (C:\Users\xxxx\Documents\HEC-
RTS\v3.1.1\watershed\WS10_HEC_RussianRiver\shared) on your workstation where the new data status list will 
be saved. Click OK, the Save File browser will close (Figure 4), an information window will display telling you 
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that the data status list has been saved. Click OK, the information window will close. 

9.2.2 Open an Existing Data Status List
To open an existing data status list, from the Data Status Summary dialog, from the File menu, click Open, and an 
Open File browser (Figure 5) will open. From the Files box select a data status list from the available files. Click OK, the 
Open File browser will close, and the selected data status list will display in the Data Status Summary dialog. 



HEC-RTS User Manual  – Data Status Lists

Data Status Lists –  71

1.

2.

3.
4.

5.

6.

9.2.3 Make a Copy of an Existing Data Status List
To make a copy of an existing data status list, from the Data Status Summary dialog, from the File menu, click Save As, 
the Save File browser (Figure 4) will open. From the File name box, enter a filename for the new data status list. Click 
OK, the Save File browser will close (Figure 4), an information window will display telling you that the data status list 
has been saved. Click OK, the information window will close.

9.2.4 Adding DSS Pathnames to a Data Status List

To add DSS pathnames to a data status list:

From the Data Status Summary dialog, from the File menu, click Open, and an Open File browser (Figure 5) will 
open. From the Files box select a data status list from the available files. Click OK, the Open File browser will 
close, and the selected data status list will display in the Data Status Summary dialog.
From the Edit menu, click Browse DSS, the Select Pathnames dialog (Figure 2) will open. From the File menu, 
click Open, an Open HEC-DSS File browser will open (Figure 2). Navigate to the DSS file that contains the 
pathnames you want to add to the selected data status list. Select the DSS file, click Open, the Open HEC-DSS 
File browser will close.
The Select Pathnames dialog (Figure 2), will display all the available pathnames in the selected DSS file.
To add DSS pathnames, highlight the pathnames in the table by clicking on a row, click Select, the selection will 
display in the selection box (Figure 3). Continue adding pathnames by selecting them in the table and clicking 
Select.
When all pathnames have been selected, click Add Pathnames. From the File menu, click Close, the Select 
Pathnames dialog will close (Figure 3).
From the Data Status Summary dialog, click Save. A Save window will open (Figure 6). The Save window is 
asking do you want to replace the selected data status list. Click Yes, the Save window will close, and an 
information window will open. This window lets you know the selected data status list has been saved. Click OK, 
the information window will close.

9.2.5 Delete a DSS Pathname from a Data Status List
To delete a DSS pathname from a data status list, from the Data Status Summary dialog, from the Data Set column of 
the table, select a pathname. From the Edit menu (Data Status Summary Dialog), click Delete Row(s). The selected 
pathname will no longer display in the table on the Data Status Summary dialog. From the File menu, click Save, a 
Save window will open (Figure 6). The Save window is asking do you want to replace the selected data status list. Click 
Yes, the Save window will close, and an information window will open. This window lets you know the selected data 
status list has been saved. Click OK, the information window will close.
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9.3 View Missing Data Segments
HEC-RTS offers another way to focus in on problem data by filtering missing data segments for individual time series 
pathnames. To view details about missing data segments for time series data, from the Data Status Summary dialog, 
from the table, select a DSS pathname(s). From the View menu, click Missing Segments, the Missing Data Segments
dialog (Figure 1) will open.

36 Figure 1 Missing Data Segments Dialog

Another way to view details about missing data segments for time series data, is from the Data Status Summary
dialog, from the table, from the Data Set column, right-click on a pathname, from the shortcut menu. click Missing 
Segments, the Missing Data Segment dialog will open (Figure 1).

For the selected pathnames, the Missing Data Segments dialog (Figure 1) reports internal missing gaps for each 
selected pathname. The missing gaps are periods in the time series data where data values were expected, but are not 
present, and data values are present before and after these periods to form each gap. For time series data that are 
defined to have a regular interval (e.g., 1Hour) data values are expected at each interval.

For time series data with an undefined or irregular interval (i.e., the time series interval is set to 0) an interval will need 
to be defined. To set this interval, from the Data Status Summary dialog, enter a value (in hours) in the Consider 
missing when no report after hours box.

Missing data in critical time series data status lists has an impact on HEC-RTS decision support activities. After analyzing 
the information displayed in the Missing Data Segments dialog (Figure 1), the user may decide to open the Data 
Validation Editor for the analyzed information to appropriately edit/correct the missing data values.
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10 Data Validation Editor
The Data Validation Editor (Figure 1) allows the user to select specific time series locations for data validation (see 
Data Status List for further details). Before manually validating data, a good idea, is to filter selected time series 
datasets so that only those time series datasets with identified problems will be displayed. Additionally, the Data 
Validation Editor offers tools for both text-entry editing (corrected values in a table) and graphical editing (graphically 
changing values in a plot).

37 Figure 1 Data Validation Editor
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From the Selected Data Set list (Figure 2), the user can select the specific time series dataset that will be viewed or 
modified.

38 Figure 2 Selected Data Set List

By default, the Data Validation Editor (Figure 1) only allows the editing of data that has been marked as being rejected, 
questionable, or missing. The R (rejected), Q (questionable), and M (missing) fields (Figure 3) are related to the quality 
flags of the data and displays counts of the data values in the Original column of the tabular data area for the selected 
dataset and time window. If the user needs to edit the data, from the Data Validation Editor (Figure 1), click Edit All 
Data, or from the Options menu (Figure 1), click Edit All Data.

39 Figure 3 Data Quality Flags

To view comparison time series datasets from the Data Validation Editor (Figure 1) click Show Comparison in Plot, or 
from the View menu, click Show Comparison Data.

To save the revised data values to DSS file(s), click  , or, from the File menu (Figure 1), click Save. To undo all of the 

changes made to either the graphical or tabular data areas since the last Save, click  . (Note: Once you click Save, 
you cannot undo any previous changes.)

10.1 Menu Bar
Following is an overview of the Menu Bar for the Data Validation Editor. The commands available are:

File Provides options for printing and saving changes to DSS file(s) and closing the Data 
Validation Editor. Available commands are: Save, Print Table, Print Graph, Page 
Setup, and Close.

Edit During an editing session, you can set flags for restoring original data, and 
automatically make can estimate for missing data. In addition, you an extend the 
selected time series dataset before the time window start date and/or after the end 
data. Available commands are: Restore Original Data, Always Estimate Missing, and 
Add Data.

View Allows comparison data if a comparison time series dataset has been included, and 
you can specify the number of decimal places that will be displayed in the Data 
Validation Editor. Available commands are: Show Comparison Data and Show 
Decimal Places.
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Options Provides you with an option for editing any of the displayed data; an option that 
allows you to continue working while data is being saved; by default, scale plots so 
that all data values are visible in a plot; and, provides an option that allows you to 
specify how changes will be saved to DSS file(s). Available commands are: Edit All 
Data, Save in Background, Scale Plot to Raw Data, and Storage Rule.

From Storage Rule, you have the following commands available:

Delete Insert removes all unprotected data from the data's 
time window, merges time values between 
protected data, and updates unprotected data at 
corresponding times with data. Data is discarded 
when protected data exists at corresponding 
times.

Replace All merges time values between data and replaces 
unprotected data at corresponding times with 
data. Data is discarded when there is protected 
data at corresponding times.

Do Not Replace merges time values between data and discards 
data when there is existing data at corresponding 
times.

Replace Missing Values Only merges time values between data and replaces 
unprotected missing data at corresponding times 
with data. Data is discarded when protected data 
exists at corresponding times.

Replace with Non Missing merges time values between data and replaces 
unprotected data at corresponding times with 
non-missing data. Data is discarded when 
protected data exists at corresponding times.

10.2 Time Window
The time window used by the Data Validation Editor is the same time window that is set for monitoring data in the 
Acquisition module. See Set Time Window for information for more information.

10.3 Graphical Editing Area
The graphical editing area (Figure 1) displays the selected dataset graphically. By default, a blue line represents data 
values that have been validated, and a green line represents the original data values in DSS file(s). 
By default, the data shown in the plot, scales so that all data values are visible in the plot, this is because the data could 
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contain erroneously large or small data values. From the Options menu (Data Validation Editor), if the user turns off the 
Scale Plot to Raw Data flag, the plot window will scale to the validated data, potentially leaving any original data 
beyond the validated value bounds outside of the plot window.

40 Figure 1 Graphical Editing Area

The data that is visible in the tabular data area is highlighted as a green-hatched column in the graphical editing area 
(Figure 1). A vertical black line (Figure 1) in the graphical editing area, or running through the green-hatched column in 
the graphical edit area, indicates the specific record in the tabular data area you have selected.
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10.3.1 Graphical Editing Tools
The Graphical Editing Tools on the Data Validation Editor allow viewing and editing of data in the graphical editing 
area. The available tools are: 

 Pointer/Selector Tool
The Pointer/Selector Tool allows the user to navigate in the graphical editing area and move quickly through a large 
dataset. Select one data point then hold the shift key and select another point in the graphical editing area to select a 
range of data points.

 Zoom Tool
The Zoom Tool allows the user to magnify specific sections in the graphical editing area. To use the Zoom Tool, click 
and drag a rectangle around the area to be magnified. If the user needs to zoom out, right-clicking repeatedly will 
progressively reverse the zoom magnification.

 Single Point Edit Tool
The Single Point Edit Tool allows the user to select an individual or a range of data points  , execute estimates 
, and to set quality flags in the graphical editing area.

 Multi-Point Edit Tool
With the Multi-Point Edit Tool, the user can edit data by drawing new plot lines in the graphical editing area.

10.3.2 Shortcut Menus
The user can customize the appearance of the graphical editing area by using several properties editors (Figure 2). 
These properties editors are accessed by right-clicking on the different elements of the plot, and from the shortcut 
menu, clicking Edit Properties. The available shortcut menus and properties editors are listed below:
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41 Figure 2 Graphical Editing Area - Shortcut Menus

Polygon 
Properties

This editor (Figure 2) will allow you to customize borders and backgrounds of the green-hatched 
column in the graphical edit area (G2dPolygon shortcut menu) of the Data Validation Editor.

Viewport 
Properties

This editor (Figure 2) will allow you to customize the border, background, and gridlines of the 
graphical edit area, and also add markers (Viewport shortcut menu) to the Data Validation Editor.

Axis 
Properties

This editor (Figure 2) will allow you to customize the axis scale, tic marks, and axis type (Axis Tics
shortcut menu) of the Data Validation Editor. Also, if you click on an axis title, from this editor 
(Figure 2), you will be able to view the axis label, change the font, alignment of the axis title, add a 
border, and add color (Axis Label shortcut menu) to the Data Validation Editor.

Legend 
Properties

This editor (Figure 2) will allow you to move the legend to the right of the plot or to the bottom of 
the plot, or hide the legend (Legend Panel shortcut menu) of the Data Validation Editor. 

Curve 
Properties

This editor (Figure 2) will allow you to edit various properties of the displayed curves in the Data 
Validation Editor. You can display, remove, change the color, add label, show in legend, and many 
other properties that can be manipulated (Curve Name shortcut menu).

Specific 
Record 
Properties

This editor (Figure 2) will allow you to customize the vertical red line (Figure 2) that indicates the 
specific record in the tabular data area of the Data Validation Editor that you have selected 
(ScrollView Data shortcut menu).
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10.4 Tabular Data Area
The tabular data area (Figure 1) is a table that allows you to do text-entry data editing. The following is a description of 
the columns available from the table:

42 Figure 1 Tabular Data Area

The Date/Time column (Figure 1) specifies the time zone for the data and lists the specific date and time for 
each data point.
The Raw column (Figure 1) will display the data that was originally entered into a DSS file(s), along with any 
quality flags.
The Original column (Figure 1) contains the validated data that you are reviewing, again along with any quality 
flags.
The Estimate/Entry column (Figure 1) allows you to modify data values. When cells in this column are white, 
you may edit the data. When cells in this column are gray, the rows are protected as being acceptable, having 
passed validation testing. To allow editing, select Edit Acceptable Data or select Edit Acceptable Data from the 
Options menu.
The Revised column (Figure 1) displays the values you have accepted. The corrected values appear in the 
Revised column, along with quality flags.

Table 1 Quality Flags for Data Validation

Quality 
Flag

* no quality (data has not been validated)

Q Questionable

P Protected
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K keyboard entry

E estimate (graphical)

I interpolated estimate

NI negative incremental (rate of change)

R Rejected

M set to missing

A explicit form of blank for manual entry of quality

+ inserted value

blank; indicates value passed all tests

10.4.1 Inserting/Deleting Values
To add or delete data values in the tabular data area, from the Data Validation Editor, first from the Options menu, 
select Edit All Data. When selected the Add Data and Delete Data buttons become visible (Figure 1). To insert a data 
value, click Add Data (Figure 1). The Extend Data Set dialog (Figure 2) will open.

43 Figure 2 Extend Data Set Dialog

Through the Extend Data Set dialog (Figure 2) you can insert data into the time window before the time window dates 
or append data to the time window.

Insert BeforeIn the Insert Before DD MMM YYYY, HH:MM and DD MMM YYYY, HH:MM section (Figure 2) of the Extend 
Data Set dialog, select the number of rows you would like to insert using the Number Rows selector. The Start Date
and Time fields will adjust their values according to the number of rows you select to enter. Click OK, the Extend Data 
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1.

Set dialog closes (Figure 2) and your new rows will be generated and added to the beginning of the table. You may then 
enter values in the table for the added time periods.

Append AfterIn the Append After DD MMM YYYY, HH:MM section (Figure 2) of the Extend Data Set dialog, select the 
number of rows you would like to append after the time window end date using the Number Rows selector. The End 
Date and Time fields will adjust their values according to the number of rows you select to enter. Click OK, the Extend 
Data Set dialog closes (Figure 2) and your new rows will be generated and added to the end of the table.

You may then enter values in the table for the added time periods.

If you wish to delete a data value, select a row from the table, click Delete Data (Figure 1), the row will no longer appear 
in the table. When deleting you will not be warned, so be sure you know that you want to delete the data value before 
clicking Delete Data.

For selected rows, Accept (Figure 1), will accept the changes for those selected rows and copy the information to the 
Revised column (Figure 1) of the tabular data area. Your changes are stored in memory and are not yet saved to DSS 
file(s). Additionally, you can use the Accept All (Figure 1) to save and accept all applicable data within the table.

10.4.2 Other Editing Commands
Estimate (Figure 1) will automatically compute a data value for selected rows based on acceptable surrounding data in 
the Original column (Figure 1). You can also multi-select rows (tabular editing) or data values (graphical editing) for 
estimation, provided that the selected rows are bracketed by acceptable values. Additionally, you can use the Estimate 
All (Figure 1) to apply the estimate to all applicable data within the table.

10.5 Validation Mode - Icons
There are two data validation modes, the Icons mode, and the List mode. For HEC-RTS, you will be using the Icons 
mode only. The List mode is based on validation lists, which are not available in HEC-RTS.

The Icons mode is where the selection of time series gages for manual validation occurs from the map window or from 
the color bars in the Data Status Summary dialog. A validation mode is selected from the Select Data Validation Data 
Sets dialog (Figure 1). In addition, the user can control whether a long list of time series datasets should be filtered to 
only include those time series datasets with specific data quality indicators. These filters are available in the Display 
Options group of the Select Data Validation Data Sets dialog (Figure 1). This dialog opens any time the validation of 
data occurs in the watershed.

By default, all the datasets associated with all the defined time series icons in the map window will be selected.
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If you just want a selected subset of datasets, you simply select the time series icons you want to validate. From 
the map window, hold down the SHIFT key, and then click on the time series icons you want to manually 

validate.
Right-click on a time series icon that you have selected, from the shortcut menu click Validate.
The Select Data Validation Sets dialog (Figure 1) opens. Icons has been selected, click OK. The Select Data 
Validation Sets dialog will close, and the Data Validation Editor will open.
The Data Validation Editor will display data from the time series icons that you selected.

10.6 Editing Data
From the Data Validation Editor the user can edit data graphically (graphical editing area); enter data in the table 
(tabular data area); have HEC-RTS estimate data values based on surrounding data; and, you can accept questioned or 
rejected data. When you have finished editing data, you can save (i.e., commit) results back to DSS file(s). Whether 
editing the data graphically or via the tabular display, HEC-RTS keeps the graphical and tabular areas synchronized as 
the user navigates and make changes.

10.6.1 Graphical Editing
Edit data graphically by using the graphical editing tools. However, the user cannot execute estimates for acceptable 
quality data with the graphical editing tools. Editing data graphically can also be accomplished by using the Single 
Point Edit Tool or the Multi-Point Edit Tool. 

To change an existing point with the Single Point Edit Tool  : 

From the Data Validation Editor, select the Single Point Edit Tool. The Data Validation Editor needs to be in 
the edit mode.
From the bottom of the Data Validation Editor, select Edit All Data, for the Options menu, click Edit All Data.
Point to a location in the graphical editing area and double-click, the point becomes a pink triangle.
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To move the point, select the Pointer/Selector Tool , click and drag the pink triangle. You will only be able 
to move the point up and down. As you move the point, the numerical value of the data point will change (see 
the tabular data area).
When you get the place where you want the point, right-click on the pink triangle. From the shortcut menu, click 
Accept. The Quality Flag will automatically be set to estimate, and the data will be protected.
A red line will be drawn where the old data value for the point was, and the blue line will connect to the new 
position of the point.
If you know that the new data value is correct, click   to save the new data value to the selected DSS file.

With the Multi-Point Edit Tool , the user can produce estimates for data along multi-point lines:

From the Data Validation Editor, select the Multi-Point Edit Tool. The Data Validation Editor needs to be in 
the edit mode.
From the bottom of the Data Validation Editor, select Edit All Data, for the Options menu, click Edit All Data.
Click the mouse where you want multiple new values added along a line. You must move progressively right, 
moving ahead in time.
At the end of the line, click and then right-click. You will now have a pink triangle wherever you clicked the 
mouse.
If you are satisfied with the values, click Accept. The Quality Flag will automatically be set to estimate, and the 
data will be protected.
A red line will be drawn where the old data values were, and the blue line will connect to the new position of the 
points.
If you know that the new data values are correct, click  to save the new data values to the selected DSS file.

10.6.2 Tabular Editing
When the Data Validation Editor opens, you are directly on the first problem data point, if any. In the tabular data area, 
the Estimate/Entry column allows the modification of numerical data values. When cells in this column display with 
white backgrounds, data can be edited.

To edit data in the table:

Be sure to put the Data Validation Editor in edit mode, if you need to edit data that is flagged acceptable, from 
the Options menu (Data Validation Editor), click Edit All Data.
To edit data, enter values in the Estimate/Entry column (data is given a quality flag of keyboard, K), or select a 
cell and click Estimate (data is given a quality flag of estimate, E), this will create a data value that is based on 
the surrounding data values.
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If satisfied with the values, click Accept. The new data value will display in the Revised column (Figure 1) with a 
Quality Flag of keyboard (K) or estimate (E), and the data will be protected.

A red line will be drawn where the old data values were, and a blue line will connect to the new position of the 
points.
If the new data values are correct, click   to save the new data values to DSS file(s).

From the tabular data area there is a shortcut menu (Figure 1) that allows the user to set quality flags on data, whether 
the data is protected or not, and, provides two ways to fill in data values on the table. 
Using Fill - Linear:

This will produce a linear interpolation of values between two values in the Estimate/Entry column (Figure 1). 
Enter values in the first and last rows of the range of interest to create two base values (or use Estimate to create 
the new values).
Select the range of rows, starting with the first base value and ending with the second base value. Select a range 
of rows either by clicking on a row and dragging, or by clicking one row and then selecting another by holding 
down the SHIFT key.
Right-click, from the shortcut menu click Fill – Linear (Figure 1). The cells in the Estimate/Entry column of the 
selected rows will now contain data values produce from a linear interpolation between the two base values.
If satisfied with the values, click Accept. The new data values will appear in the Revised column (Figure 1) with a 
Quality Flag of keyboard (K) or estimate (E), and the data will be protected.
A red line will be drawn where the old data values were, and a blue line will connect to the new position of the 
points.
If the new data values are correct, click   to save the new data values to DSS file(s).

Using Fill - Repeat:

This will duplicate the selected value in all the selected cells in the Estimate/Entry column (Figure 1).
Enter a new value in the first row (or use Estimate to create the new value).
Select the range of rows, starting with the base value. Select a range of rows either by clicking on a row and 
dragging, or by clicking one row and then selecting another by holding down the SHIFT key.
Right-click, from the shortcut menu (Figure 1), click Fill – Repeat. The cells in the Estimate/Entry column of the 
selected rows will now contain the same value as the data that was entered for the base value.
If satisfied with the values, click Accept and the new data values will appear in the Revised column with a 
Quality Flag of keyboard (K) or estimate (E), and the data will be protected.
A red line will be drawn where the old data values were, and a blue line will connect to the new position of the 
points.
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7. If the new data values are correct, click   to save the new data values to DSS file(s).
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11 Visualization Module
The Visualization module (Figure 1) of HEC-RTS displays observed data and results of computations. This module 
allows you to monitor and evaluate the current state of the watershed. Spatial data, such as contours or grid cells, and 
time series data, such as hydrographs, are displayed in the Map Window (Figure 1). As in the Acquisition module, time 
series icons (thumbnail plots) in the Map Window can be set up to change color, allowing you to visualize changes in 
the watershed's hydrology. For further details refer to Time Series Icons and Time Series Icons Layers.

44 Figure 1 Visualization Module

11.1 Visualization Module Overview
The Visualization module allows you to view current conditions in a watershed and the associated hydrometeorological 
data in a georeferenced context. From the HEC-RTS main window, click the Visualization tab (Visualization Module). 
The map window and components of the Visualization module are illustrated in Visualization Module. A detailed 
discussion of common screen components is presented in HEC-RTS Interface.
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11.1.1 Menu Bar
Following is an overview of the menu bar for the Visualization Module. The File, View, Maps, Scripts, Tools, Windows, 
and Help menus are discussed in HEC-RTS Interface. The commands available from the menus will allow you to view 
current conditions in a watershed and the associated hydrometeorological data in a geo-referenced context.

Data 
Visualiz
ation

This menu provides access to the gridded data, which represents the precipitation for the watershed. 
The only available command is GriddedData, which includes a sub-menu that allows you to add/edit/
delete grid sets (a sequence or time series of grids); cumulate the gridded precipitation for the 
established time window; provide a list of grid sets, with the active grid set having a check mark; and, do 
not display grid sets. Available commands are: New Grid Set, Edit Grid Set, Delete Grid Sets, 
Cumulative Display, Animation Delay, and None. Also, if any grid sets have been created, those 
available grids sets will be displayed above the None command.

11.1.2 Commands
The Visualization tab (Visualization Module) contains commands specific for the Visualization module. These 
commands include updating time series icons (Refresh) in the map window and grid animation controls for visualizing 
gridded precipitation for the watershed.

11.1.3 Map Window
The map window (Visualization Module) in the Visualization module contains map layers and layers of time series icons 
that allow you to visualize the current conditions of a watershed in a geo-referenced context. The primary function of 
the Visualization module is to provide you with a meaningful visual representation of your observed data. Threshold 
color bars or thumbnail plots are used to reflect the current conditions of a watershed, and, are usually used/configured 
for those time series locations that you watch daily or are of critical importance within your watershed. On the other 
hand, you might wish time series icons to display as space-conserving graphical images or dots if you are monitoring 
data acquisition for an entire office. Customizing the time series icon layers is done in the setup module, which is 
described in Time Series Icons Layers.

In most cases, for the Visualization module, you should configure time series icons to display as threshold color bars. 
Threshold color bars display data in multi-colored strips, such as green, amber, and red (colors can be specified by the 
user), that allow you to quickly home-in on those locations that are exceeding critical threshold limits.

11.1.4 Scripts Box
In HEC-RTS, scripts provide a way to automate HEC-RTS for the purpose of executing a prescribed set of actions with a 
simple trigger. Scripting simplifies user operation, ensures repeatability and consistency of results, reduces time 
required to generate results, and permits schedules of an operation in the future. Once scripts have been defined 
(Scripting), the user can run the scripts from the Scripts Box (Figure 1). The user defines which scripts will be run from 
the Scripts Box; Scripting provides further details on the management of scripts in HEC-RTS.
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45 Figure 1 Scripts Box

11.1.5 Time Series Icon Controls
The Time Series Icon Controls (Figure 2) allows you to select attributes for the time series icon layers that are 
displayed. The time series icon controls are located on the Visualization tab near the bottom of its pane (Visualization 
Module). There are three attributes available: Icons Type, Values, and Layers (Figure 2).

46 Figure 2 Series Icon Controls

Icons Type forces all icons within the map window to display as the selected Icon Type in 
the list. Selecting the Default option in the list will display the icons as they were 
originally defined during setup (Time Series Icons).

Values allows you to display the time series icon's data as labels, which display next to 
or on the location of their associated time series icons. For example, you can 
choose to display the data's total, minimum, and maximums values as labels. 
Multiple values can be selected at once.

Layers allows you to select the time series icon sub-layers that are visible in the map 
window. Multiple layers can be selected at once.

By selecting the attributes, you can change how time series icons are displayed within the Visualization module. For 
more detailed information on how to configure the properties that control the time series icons displayed, refer to Time 
Series Icons Layers.

11.2 Preparing to Review Current Conditions
To begin reviewing current conditions in a watershed, you will need to set the time window for viewing and updating 
the color bars and plot icons in your map display.
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11.2.1 Set Time Window
You can either set a specific (i.e., fixed) time window (for reviewing a historical event) or you can set a time window 
relative to the current time (the default setting, used for reviewing data).

To set or change the time window:

From the Visualization tab (Figure 1), for the default time window, HEC-RTS assumes that you want to review 
current data in the watershed, so Relative to Current Time is selected. If you want to view historical data, you 
must select Specific Time Window (Figure 1). 

If you would like to set the Time Window (Figure 1) relative to the current date and time, select the Relative to 
Current Time and enter the Look Back Time and select either Days or Hours as the time unit. Normally you will 
set the time window to extend backward one to thirty days from the current time. Optionally, you can enter a 
Look Ahead Time and select either days or hours; this allows you to look ahead at data.
If you would like to set a historical Time Window (Figure 1), select Specific Time Window and enter the Start 
Date and Time of the time window and the End Date and Time of the time window for the historic data. 
4. Click Refresh (Figure 1) to complete the time window change.

11.2.2 Time Series Icon Shortcut Menu
From the Map Window (Visualization Module), the time series icons display, by right-clicking on a time series icon, a 
shortcut menu (Figure 2) will display that allows you to view the data associated with a selected time series icon either 
in a plot, table, or using Microsoft Excel®. Also, from the shortcut menu you can access the Data Validation Editor 
(Validate) to edit the data associated with the selected time series icon (Data Validation Editor). Another option is that 
you can view the legend of the selected time series icon. The shortcut menu is the same for all of the available time 
series icon types (i.e., for the color bars, thumbnail plots, graphics, or dots).
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47 Figure 2 Time Series Icon Shortcut Menu

11.3 Visualizing Data
The Visualization module provides tools for evaluating the current state of the watershed. The module's main display 
has several visualization tools that help to identify whether critical conditions exist. Time series icons, plots and graphs, 
and animated background images can all be used for reviewing observed data for a watershed.

Time series icons in the Visualization module provide a flexible set of tools to facilitate evaluating the current state of 
the watershed. To view current conditions at a glance, you can use thumbnail plots and threshold color bars that 
change color to reflect the status of various parameters at a particular location.

11.3.1 Threshold Color Bars
A Threshold Color Bar (Figure 1) is a thick, segmented line representing a linear histogram that compares current data 
against threshold values set for a location. Because threshold color bars are location dependent, you must set the 
values for each time series icon individually (Time Series Icon Editor). The name of the location appears adjacent to the 
threshold color bar, and the length of the Threshold Color Bar represents a timeline equal to the duration of the time 
window. Segments along the color bar reflect time intervals, with colors corresponding to the limits you have defined. 
The threshold color bars are updated dynamically at the time interval that you entered in for the time window 
(Visualization Tab – Time Window Setup). 

As part of your daily routine, you should review threshold color bars to determine if the current data is good and which 
data needs to be validated. To view the legend for threshold color bars:
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From the Map Window, right-click a thumbnail plot, from the shortcut menu, click Icon Legend. The Thumbnail 
Plot Legend dialog (Figure 2) will open. 

The legend shows the threshold values for the current data and the colors that represent each threshold value. 

As conditions change at a location, the threshold color bar automatically changes colors. For example, at a 
precipitation location, DarkGreen might represent precipitation between .01 to .11 inches, corresponding to normal 
conditions. DarkBlue might represent values greater than .51 inches, but less than 1.0 inch, which indicate a flood 
warning level. DarkRed would represent values above 1.0 inch, signaling flows above flood stage.

11.3.2 Thumbnail Plots
In some cases, you may wish to use thumbnail plots to represent gages and time series locations. Thumbnail Plots
(Figure 3) are miniature versions of the full-size plots available in HEC-RTS, showing data for the set time window. The 
name of the location appears adjacent to the thumbnail plot. As the time window updates, HEC-RTS refreshes the data 
and updates the thumbnail plot.

48 Figure 3: Thumbnail Plots - Shortcut Menu

To view the legend for thumbnail plots:
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From the Map Window, right-click on a thumbnail plot, from the shortcut menu (Figure 3), click Icon Legend. 
The Thumbnail Plot Legend dialog (Figure 4) will open. 

The legend displays the pathname, the color of the curve, and the minimum and maximum values of the curve. 
The Thumbnail Plot Legend dialog (Figure 4) provides you with information, to edit the color of the curve 
shown in the thumbnail plot (Time Series Icons).

11.3.3 Using Plots
If the threshold color bar or thumbnail plot for a location indicates that data is questionable or bad, viewing the data in 
a plot can help you to determine the nature of the problem.

To access plots of incoming data:

From the Map Window, right-click a time series icon, from the shortcut menu (Figure 3), click Plot.
This opens a two-dimensional plot (Figure 5) that contains the data for that location for the current time 
window. Figure 5 shows a sample plot for a precipitation gage. Use the Zoom Tool to zoom in on a specific 
portion of the plot. See Map Window for a more detailed description of the Zoom Tool. In addition, a more 
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detailed description on the plots can be found in Viewing HEC-RTS Data and Results.

11.3.4 Using Tables
If the threshold color bar or thumbnail plot for a location indicates that data is atypical or unexpected, viewing the data 
in a table can help you to determine the nature of the problem.

To access tables of incoming data:

From the Map Window, right-click a time series icon, from the shortcut menu (Figure 3), click Tabulate.
This opens a table that contains data for that location for the current time window. Figure 6 shows a sample 
table of the data for a flow gage.
If you have already opened a plot, you can also tabulate the data displayed in the plot from the Plot dialog 
(Figure 5). From the File menu, click Tabulate. For more details on tabular data in HEC-RTS, see Visualizing Data. 
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For printing and exporting tabular data, see Printing and Copying HEC-RTS Data. 

11.4 Precipitation Grids
Precipitation data can be reviewed at time series icons to examine individual gage reports, identify problems, and 
confirm the validity of the data. The Visualization module also allows precipitation data to be viewed as grids (Figure 1), 
which gives a view of the precipitation over the whole watershed for an interval of time.
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49 Figure 1 Precipitation Grids

Precipitation grids are created by interpolation between gages or by loading radar precipitation reports from the 
National Weather Service or other external sources. Individual precipitation grids are grouped into sequences called 
"grid sets" using the HEC-GridUtil software. To view grid sets in HEC-RTS you will use the grid animation controls in the 
Visualization module.

11.5 Grid Animation Controls

The grid animation controls (Figure 1) allow you to view precipitation grids for the time window you have chosen. The 
controls are located from the Visualization module. Above the slider bar (Figure 1), is displayed the name of the active 
grid set (Obs – Interpolated 15 min). Beneath the slide bar, the date and time of the data currently being displayed is 
shown. A slider bar and video-player-style buttons control the animated playback. The slider allows you navigate the 
active precipitation grid set for a specific time during the time window. With these playback controls, you can play an 
animation of the active precipitation grid set from the beginning to the end of the current time window.
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The video-player-style buttons (Figure 1) function as follows:

 Skip to Beginning: Sets the slider at the beginning of the time window and displays the status of data at that 
time.

 Step Back: Steps the image back one-time interval.

 Pause: Pauses playback.

 Stop: Stops playback.

 Play: Plays the animation, one-time interval at a time, starting at the location of the slider.

 Step Forward: Steps the image forward one-time interval.

 Fast Forward: Plays through the animation in fast forward mode.

 Skip to End: Moves the slider and the image to the status at the end of the time window.

For playback to occur, you must define the coordinate system for both the watershed 
layers and the grid set and there must be data present for the time window specified. If no 
grid is available for the time step, the label centered over the grid animation controls will 
end with No Data.

Use HEC-DSSVue to check for available grids in $HEC-RTS_HOME/dated/db/grid/precip. 
YYYY.MM.dss. You may need to run gageInterp or your grid-loading program to populate 
the DSS files for this time interval.

11.6 Precipitation Grid Sets
A grid set can be thought of as a sequence or time series of grids. Since a single DSS record of grid data contains data 
for only a one-time interval, you must create grid sets before you can view the precipitation grids changing through 
time over the watershed. Grid sets are created by HEC-GridUtil.
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11.6.1 Add a Grid Set
Once a grid set has been created for a watershed, you can add it to the Visualization Module for viewing in the Map 
Window.

To add a grid set to the watershed:

From the HEC-RTS main window (Visualization Module), from the Data Visualization menu, point to Gridded 
Data, from the menu click New Grid Set (Figure 1). 

The Create New Grid Set dialog will open (Figure 2). In the Name box enter a name for the grid set. A 
description for the grid set is optional and can be entered in the Description box (Figure 2).
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Click OK, the Create New Grid Set dialog will close (Figure 2), and the Edit Grid Set dialog will open (Figure 3). 

Click Add File(s), an Open browser will open. Navigate to the location where available precipitation grids are. 
Click on a grid set (precip.yyyy.mm.dss), click Open, the Open browser will close, and the pathname and the 
filename will display in File List (Figure 3).
From the Grid Set Identifier box (Figure 3), you will need to select the individual identifiers from the available 
lists (i.e., Grid Type (A-Part); Location (B-Part), etc.). You also need to select the time interval from the Time 
Interval list (Figure 3). Click OK, the Edit Grid Set dialog will close. From the GriddedData menu (Figure 1). the 
name of the grid set that was just created will display.

11.6.2 Delete a Grid Set
To delete a grid set from the watershed:

From the HEC-RTS main window (Visualization Module), from the Data Visualization menu, point to Gridded 
Data, from the menu click Delete Grid Sets (Figure 1).
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The Delete Grid Sets dialog will open (Figure 4). From the Existing Grid Sets list, select the grid sets that you 
wish to delete; the name(s) of the grid set will display in the Name box (Figure 4). 

Click Delete, a Warning window will display, asking you if you really want to delete the selected grid set, click 
Yes. The Warning window and the Delete Grid Sets dialog (Figure 4) will both close. The grid set will no longer 
display in the Gridded Data menu (Figure 1) and will be removed from the watershed.

11.6.3 Selecting a Grid Set
To select a grid set:

From the HEC-RTS main window (Visualization Module), from the Data Visualization menu, point to Gridded 
Data. From the menu (Figure 1), at the bottom of the menu, the names of the grid sets that have been added to 
the watershed are displayed, along with None.
To select a grid set for viewing in the Visualization module, click on the grid set name (e.g., FebGrids). The name 
of the selected grid set will display in the Active Grid Set section of the HEC-RTS main window (Visualization 
Module). Also, the Animation Controls will become active, and the Grid Set Legend will display in the Map 
Window (Visualization Module).
To unselect a grid set, from the Gridded Data menu (Figure 1), click None.

11.6.4 Properties of a Grid Set
You can control the visibility and color scheme of the grid set through the Map Layers dialog (Understanding Layers). In 
the Visualization module, the Map Layers dialog (Figure 5) displays the selected grid set layer, from which you can edit 
various properties of the grid set. These properties include color scheme, tic intervals, and the minimum/maximum 
values for the contour.
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50 Figure 5 Map Layers Dialog - Grid Set Shortcut Menu

Changing a grid set's properties:

From the Maps menu, click Map Layers and the Map Layers dialog (Figure 5) opens. From the tree, right-click on 
the grid set layer name (FebGrids), from the shortcut menu, click Properties. The Grid Display Options dialog 
(Figure 6) opens. 

The name of the active grid set is displayed at the top of the Grid Display Options dialog.
From the Properties tab (Figure 6), the list at the top left contains six pre-set color contour schemes, with the 
default being Precipitation.
From the Tic Interval box (Figure 6), you can set the tic interval for the selected grid set.
In the Contour Limits box (Figure 6), you can set the minimum and maximum contour values for the selected 
grid set. By default, HEC-RTS automatically determines the minimum and maximum contour values. If you wish 
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to enter these values manually, clear System Specified Min/Max Values. Then enter values in the Maximum
and Minimum boxes.
For other settings to adjust, click Advanced. The Grid Display Options dialog expands (Figure 7) to include 
options for brightness, saturation, transparency, aspect shading, maximum clipping, and minimum clipping. 

You can control the Brightness (the amount of white, measured from 0.0 to 1.0), Saturation (the amount of 
black, measured from 0.0 to 1.0), and Transparency (the level of opacity or alpha, measured from 0.0 to 1.0) of 
your gridded data layer either by moving the sliders or by typing values into the white text fields. The color scale 
to the right will update according to your selections.
If you are using elevation maps, you may wish to choose Aspect Shading as your color contour scheme. Use the 
Aspect Shading option to make the elevation map appear in relief by placing an imaginary light source above 
the map and shading the elevation contours. When the Aspect Shading option is selected, you can use the 
Angle slider to adjust the angle of the light source.
By default, the Maximum Clipping and Minimum Clipping options are deselected. If you activate these options, 
the Value sliders and Color buttons become available. The Value sliders allow you to specify the amount of 
clipping within the contour limits you have specified; you can also type values into the boxes. When you click on 
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the Color buttons, the Color Chooser appears, for more information on the Color Chooser see Using the Color 
Chooser.

11.6.5 Visualization Scale of a Grid Set
To set the visualization scale for a grid set:

From the Maps menu, click Map Layers, the Map Layers dialog (Figure 5) opens. From the tree, right-click on the 
grid set layer name (FebGrids), from the shortcut menu, click Properties. The Grid Display Options dialog 
(Figure 6) opens.
Click the Scale tab (Figure 8). Both zoom-in and zoom-out scale factor can be set from the Grid Display Options
dialog. By default, the Gridded Data Layer is set for Always show layer. To see visualization scales, click Only 
show layer in the following scale range. 

To set the scale so that the gridded data layer becomes visible as you zoom-in, you can set the scale to the 
current scale by clicking Set to Current. If you wish to enter a value, from the Only visible below 1 field, enter 
the scale factor.
To set the scale so that the gridded data layer becomes visible as you zoom-out, you can set the scale to the 
current scale by clicking Set to Current. If you wish to enter a value, from the Only visible above 1 field enter 
the scale factor.
Click OK, the Grid Display Options dialog (Figure 8) closes, and the visualization scale is set for the gridded data 
layer.

Another way to set the visualization scale for a grid set:

From the HEC-RTS main window (Visualization Module), from the Data Visualization menu, point to Gridded 
Data, from the menu click Edit Grid Set (Figure 1).
An Open dialog will open (like Figure 4). From the Existing list, select a grid set, click Open. The Open dialog will 
close, the Edit Grid Set dialog will open (Figure 3).
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3. From the Set display scale limits box (Figure 9), you can set the minimum and maximum scale values for the 
selected grid set. 
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12 Modeling Module
The Modeling module for HEC-RTS is the grouping of commands for performing forecasts for a watershed. These 
commands include: creating and managing forecast alternatives, editing selected model parameters, executing 
alternatives, and evaluating results. Figure 1 displays the flow of data and information through the software 
applications involved in a forecast. HEC-RTS has five standard software applications available: the meteorological 
preprocessors MFP, the watershed runoff model HEC-HMS, the reservoir simulation model HEC-ResSim, the hydraulic 
routing model HEC-RAS, and the flood consequences analysis model HEC-FIA. These software applications and their 
inputs and outputs are described in HEC-RTS Overview.

51 Figure 1 HEC-RTS Workflow
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The meteorological preprocessor MFP combines observed precipitation data and future precipitation information into a 
single precipitation dataset that can be used by the watershed runoff model (HEC-HMS). Using the observed and future 
precipitation from a meteorological preprocessor (MFP), HEC-HMS computes runoff. HEC-ResSim uses uncontrolled 
flows (typically computed by HEC-HMS) as input and simulates reservoir releases. In turn, controlled flows (computed 
by HEC-ResSim) are used as boundary conditions to the hydraulic routing model HEC-RAS. (HEC-RAS can also use flows 
computed by HEC-HMS or supplemental models as input). HEC-RAS computes stage, which is input to HEC-FIA. HEC-FIA 
analyzes flood consequences. (HEC-FIA can also use flow computed by HEC-HMS, or HEC-ResSim as input.) Results 
include impact and action reports from HEC-FIA, inundations maps that can be viewed with RAS Mapper (tool that is 
part of the HEC-RAS software), and simulated release schedules from HEC-ResSim.

12.1 HEC-RTS Forecast Workflow
The following is a typical workflow for forecasting:

Check that critical data are available - Acquisition module.
Create a new HEC-RTS forecast. An HEC-RTS forecast is a simulation of watershed processes and consequences 
of flooding based on input data and information and hydrologic, reservoir operation, hydraulic, and impact 
analysis applications configured in HEC-RTS. During a forecast, a forecast run is run at a specific forecast time. 
(Recall that, a forecast run is a single forecast scenario defined by a specific set of data, information, and HEC-
RTS alternatives.) HEC-RTS copies all the necessary files to a dated forecast directory (HEC-RTS Application 
Settings). You should check the data for errors and ensure that the data were extracted properly.
Compute the forecast and check results. Forecast results include flow and stage in the channel from watershed 
runoff, reservoir release schedules, floodplain inundation maps, floodplain consequence reports, and reports 
listing actions for emergency responders to take. These results inform water management decision making. You 
can view results tables and plots in the Modeling module. Compute messages provide information about each 
step of the computation process. Model-specific reports provide details about the individual models. RAS 
Mapper allows you to view HEC-RAS inundation maps. If your models alternatives require adjustment, you can 
access model editors your model forecast runs and override controls. These features are discussed in Model 
Alternatives and Forecast Runs.
Manage forecast information. When model results have been reviewed and validated, HEC-RTS provides tools to 
assist in managing information. Forecast results and data can be posted to DSS file(s), save modeling data, and 
protect your forecast from further editing. 

12.2 Overview
The Modeling module is the grouping of commands for performing forecasts for a watershed. From the HEC-RTS main 
window, click the Modeling tab (Figure 1). A detailed discussion of common screen components is presented in HEC-
RTS Interface. The Modeling tab (Figure 1) displays the time window; current date and time of the active forecast; 
details, about the current forecast run; provide easy access to commands and processes for the user; display the 
selected forecast run in a map window; and, provide information about the execution of a forecast.
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52 Figure 1 HEC-RTS Main Window - Modeling Module

12.3 Modeling Module Menu Bar
The File, View, Maps, Scripts, Tools, Windows, and Help menus are discussed in HEC-RTS Interface. The commands 
available from the Forecast menu will allow you to create/edit/delete forecasts; run forecasts daily so you can review 
conditions during an event; and, post results to DSS files. Refer to HEC-RTS Forecasts for further details.

Forecast From this menu you can create, edit, open, save, delete, and archive forecasts; review information about the 
active forecast; post active forecast results to DSS files; and compute all model alternatives (forecast run) or compute 
individual model alternatives. Available commands are: New, Open, Recent, Continue, Compute Manager, Run 
Selector, Edit Time Window, Information, Extract, Post, Logs, Close, Save, Archive, Delete, Restore, Default Time 
Window, Model Linking, Forecast Scheduler, and Scheduled Forecast Manager.

The Logs sub-menu allows you to view the log files from extract, post, and compute processes. Available commands 
are: Extract Report, Post Report, and Compute.
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12.4 Time Window Details

The Time Window Detail area (HEC-RTS Main Window - Modeling Module) of the Modeling module, provides you with 
details about the time window for the selected forecast. Information includes forecast time; extract time; start and end 
time of the time window; and, the display time zone. You can also edit the time window for the selected forecast:

From the Modeling tab (Figure 1), from the Forecast menu, click Edit Time Window. The Forecast Time 
Window dialog (Figure 1) will open. 

You can now edit the time window for the selected forecast. You can edit the Forecast Time date and time; 
Extract Start date and time; Start Time date and time; and, End Time date and time.
Once you have entered your new time window, click OK. The Forecast Time Window dialog (Figure 1) will close. 
The Time Window Detail area (HEC-RTS Main Window - Modeling Module) will update with the new forecast 
time window information.

12.5 Forecast Run Details
The Forecast Run Details area (HEC-RTS Main Window - Modeling Module) of the Modeling module provides you with 
details about the forecast runs that are available for the selected forecast. Information includes: the name of the 
forecast runs; and, for each forecast run, the model alternatives associated with a forecast run. 

For the forecast runs you can perform various processes (e.g., Compute, Post, etc.) from either a shortcut menu or from 
the Forecast Tabs. Further details on these processes is available in HEC-RTS Forecasts. Also, for the individual model 
alternatives associated with a forecast run, you can perform various process (e.g., Compute, view Log File, etc.). or by 
the elements (e.g., Edit, Plot, etc.) associated with each model alternative. Further details on these processes is 
available in HEC-RTS Forecasts.

12.6 Modeling Module Map Window
In the Modeling module, the Map Window (HEC-RTS Main Window - Modeling Module) contains the model schematic 
elements for the active forecast in a geo-referenced context. In addition, time series icons are available that provide 
access to additional model data or other time series data. Time series icons are setup in the Setup module.
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12.6.1 Time Series Icon Shortcut Menu

In the Modeling module, from the Map Window (HEC-RTS Main Window - Modeling Module), click  (Time Series 
Icon Tool). Right-click on a time series icon in the map window, a shortcut menu will display (Figure 1). From this 
shortcut menu (Figure 1), you can view the data and results associated with a selected time series icon in a plot, 
tabulate table, or open the Microsoft Excel® application, so you can view data or results in a spreadsheet format.

53 Figure 1 Modeling Module - Map Window - Time Series Icon Menu

12.6.2 Edit and Review Results by Models

In the Modeling module, from the Map Window (Figure 11.2), click   (Select Tool). From the schematic, right-click 
on individual model elements, from the shortcut menu (Figure 2), you can edit and review results for the individual 
models of the selected forecast.
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54 Figure 2 Modeling Module - Map Window - Individual Model Elements

12.7 Modeling Module Forecast Tabs
The Forecast Tabs (HEC-RTS Main Window - Modeling Module) in the Modeling module provide easy access to 
commands and processes for the user. There are six tabs – Actions, Reports, Scripts, Icon Layers, Workflow, and 
Team. The Icon Layers tab, in the Modeling module, allows you to select attributes for the Time Series Icons Layer, 
Forecast Tabs provides further details. The other five tabs contain information and/or commands based on whether 
you have selected a model alternative or an element of that model alternative, Forecast Tabs will provide an example 
using the Actions tab.

12.7.1 Icon Layers Tab
From the Forecast Tabs (HEC-RTS Main Window - Modeling Module), click the Icon Layers tab, the Time Series Icon 
Controls display (Figure 1). The Time Series Icon Controls allows you to select attributes for the time series icon layers 
that are displayed. There are three attributes available: Icons Type, Values, and Layers (Figure 1).

55 Figure 1 Forecast Tabs - Icon Layers Tab - Time Series Icon Controls
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Icons Type forces all icons within the Map Window (HEC-RTS Main Window - Modeling Module) to display as the 
selected Icon Type in the list. Selecting the Default option in the list will display the icons as they were set 
originally during setup (Time Series Icons).

Values allows you to display the time series icon's data as labels, which display next to or on the location of their 
associated time series icons. For example, you can choose to display the data's total, minimum, and maximums 
values as labels. Multiple values can be selected at once.

Layers allows you to select the sub-layers that are visible in the map window. Multiple layers can be selected at 
once.

By selecting the attributes, you can change how time series icons are displayed within the Modeling module. For more 
detailed information on how to configure the properties that control time series icons, see Time Series Icons.

12.7.2 Actions Tab
Like several other of the Forecast Tabs, the Actions tab (Figure 2) is influenced by the user's choices in the Forecast 
Run Details area (HEC-RTS Main Window - Modeling Module). From the Forecast Run Details area, if you select a model 
alternative (Daily Forecasting – 15MIN), the Actions tab (Figure 2) displays the ability to compute the individual model 
alternative, and gives you access to several editors that are specific to the selected model alternative (e.g., HEC-HMS). 
This mean the user can make changes to the selected model alternative without having to go to the Setup module to 
make edits.
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56 Figure 2 Actions Tab - Selected Forecast Run - Daily Forecasting - 15MIN

If the user expands (clicks +) the model alternative (Figure 3), a list of elements specific to that model alternative will 
display (e.g., source, reservoir, subbasin, etc.). For example, in Figure 3, you have selected Calpella (a subbasin), from 
the Actions tab, you can access an editor specific to that element type and you can make changes specific to that 
element. This means the user can make changes to the specific model alternative element without having to search the 
Map Window for the element to make edits.
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57 Figure 3: Actions Tab - Selected Forecast Run Elements - Daily Forecast - 15MIN

12.8 Modeling Module Message Pane
The Message Pane (HEC-RTS Main Window - Modeling Module) contains messages that the HEC-RTS software is 
providing for informational purposes. The information in the Message Pane is a record of HEC-RTS activity, recording 
the opening of a watershed, opening map windows, accessing DSS files, and many other HEC-RTS activities.

12.9 Preparing to Forecast
Before you forecast, you will need to set up the Program Order, create Model Alternatives, assign Model Alternative 
Keys, and create at least one Forecast Run. You will also set the default time window for your forecast and ensure that 
data is available for your forecast. Remember, it is essential that you setup the program order, before forecasting.

MFP Model Alternative contains information on how to create MFP model alternatives. For the other software 
applications, refer to Model Alternatives and Forecast Runs and the individual user documentation (HEC-HMS, HEC-
ResSim, HEC-RAS, and HEC-FIA).



HEC-RTS User Manual  – HEC-RTS Forecasts

HEC-RTS Forecasts –  113

13 HEC-RTS Forecasts
In HEC-RTS, a forecast is where a forecast run is computed for a specific time window, with boundary condition data 
available. Forecasts are created and edited in the Modeling module. Before you begin your forecast, you should check 
your critical data and make sure it is available for the time window of your forecast (Preparing to Review Current 
Conditions). In addition, you need to setup your Program Order, create Model Alternatives, and, assign Model 
Alternative Keys.

13.1 Forecast Runs
A forecast run is a set of model alternatives that run sequentially during a forecast. As with model alternatives, forecast 
runs exist independent of time. Therefore, you can use a forecast run for any forecast time window. You create a 
forecast run by selecting a model alternative for each software application that could be part of an HEC-RTS forecast. 
There are five standard software applications in HEC-RTS, a typical forecast run will include a combination of five model 
alternatives. When you execute a forecast, HEC-RTS executes the software applications in sequential order.

The table below provides suggested forecast runs. The codes are the names HEC-RTS automatically assigns to each 
forecast run based on the one-character model alternative keys you have assigned to the model alternatives. This 
coding is program order dependent.

Example Forecast Runs

Name Code

No future precip NNNNN

QPF QNNNN

Two times QPF SWRBE

In the following example (Figure 1), the forecast run - Two times QPF has a key code of SWRBE. Each character is the key 
code that was assigned to each model alternative for each of the five standard software applications in HEC-RTS.

Before creating a forecast run, you must have model alternatives. Model Alternatives and Forecast Runs provides details 
on how to create model alternatives. Creating forecast runs occurs in the Setup module. Further details on managing 
forecast runs (e.g., opening, deleting) is provided in Model Alternatives and Forecast Runs.
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Creating a forecast run:

From the HEC-RTS main window, click the Setup tab, from the Models menu, click Forecast Runs. The Forecast 
Run Editor (Figure 2) will open. 

Click New Run, enter a new forecast run name in the Name box (required), a description in the Description box 
(optional).
From the Program Order list (Figure 2), select a program order. Program Order provides detailed information on 
program order.
From the software applications list (Figure 2), select the individual model alternates required for the forecast 
run. As you are selecting those model alternatives, in the Key box (Figure 2), HEC-RTS is automatically creating 
the key for the forecast run, based on the individual model alternative keys (Setup Module).
From the File menu, click Save. The new forecast alternative appears in the table on the Forecast Run Editor
(Figure 2). Click OK, the Forecast Run Editor closes.
It is recommended at this point to save your watershed. From the HEC-RTS main window, from the File menu, 
click Save Watershed.
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13.2 Forecasts
A forecast is a time window, that is associated with one or more forecast runs. Following are the steps for creating a 
forecast:

From the HEC-RTS main window, click the Modeling tab, from the Forecast menu, click New. The Create New 
Forecast dialog (Figure 1) will open. 

By default, from the Select Type list (Figure 1) you are creating a new forecast (New Forecast). From the list you 
have the following options: 

New Forecast This is the default option in which you specify the Forecast Time, 
Extract Start, Start Time, End Time and Forecast Run(s) used in 
the forecast.

From Existing Forecast This option copies the Forecast Time, Extract Start, Start Time, 
End Time and Forecast Run(s) from a forecast already created. 
Here you select a forecast already created and saved in the 
watershed.
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From Archived Forecast This option copies the Forecast Time, Extract Start, Start Time, 
End Time and Forecast Run(s) from a forecast that has been 
archived. Here you select the zip file containing the archived 
forecast. For more information on archiving your forecast see 
Managing Forecast Data.

From Imported Forecast This option copies the Forecast Time, Extract Start, Start Time, 
End Time and Forecast Run(s) from a forecast file stored to disk. 
Here you specify the *.forecast file to use.

By default, HEC-RTS creates a forecast name, based on the time window (Figure 1). In addition, by default, HEC-
RTS creates a time window based on the current date and time; for examples in this user's manual, the time 
window is an historical event.
You will enter a forecast date and time that you determined in the Acquisition module, this would be the latest 
time a complete set of reliable data is available (Figure 2). For example, in Figure 2, a Forecast Date of 
26Jan2017 has been entered along with a Forecast Time of 2000. 

Once the Forecast Date/Time has been entered, HEC-RTS creates a forecast name. As illustrated in Figure 2, in 
the Name box, by default, the forecast name of 2017.01.26-2000 has been generated. Also, by default, HEC-RTS 
creates a folder based on the forecast date and time. As illustrated in Figure 2, the Folder box contains the 
generated pathname and file for the forecast name – C:/Users/xxxxx/Documents/HEC-RTS/forecast/
2017.01.26-2000/WS10_HEC_RussianRiver. WS10_HEC_RussianRiver is the name of the watershed. The Folder box 
(Figure 2) is non-editable.
The selected Start Time and Extract Start dates (Figure 2) should be far enough in the past to meet the 
following:
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Allow enough time steps to pass between the Start Time date and the Forecast Time date to allow 
routing reaches in the reservoir model to show correct flows at the time of forecast.
Generally, the Start Time and the Extract Start dates should be before the start of the event for 
calibration of loss rates for HEC-HMS. If this is not practical, then a time after the initial losses have been 
satisfied should be chosen. In most cases these dates and time are equal. However, from time to time, 
the forecaster may wish to extract data prior to the simulation window or may wish to update only the 
last few hours of data (for example when re-computing a forecast later in the day after more observed 
data are available).

The Extract Start, Start Time and End Time fields will default to dates based on information given in the 
Default Time Window dialog (Figure 3). To view this information from the Forecast menu, click Default Time 
Window, the Default Time Window dialog will open (Figure 3). 

From the Create New Forecast dialog (Figure 2) you can override the default time window. You will also need to 
enter times for the corresponding dates. 
From the Forecast Runs table (Figure 4) on the Create New Forecast dialog (Figure 2) select the already defined 
forecast runs you wish to simulate for the forecast. Clicking the check box in the Selected column of the table 
selects a forecast run. You can select multiple forecast runs. 

Click OK, and the Create New Forecast dialog closes (Figure 2). A Progress window will open (Figure 5), which 
provides information on the creation of the forecast, its associated directory, and the copying of the appropriate 
files to that directory. 

In addition, HEC-RTS retrieves (extracts) data from defined DSS file(s) based on the entered times. These DSS 
file(s) are identified in an Extract Group, the Extract Group should be defined before creating a forecast. Extract 
groups are defined in the Setup module. The data is copied to a DSS file (forecast.dss) for use by the model 
alternatives. Check the Extract Report (Review Forecast Data) for any issues that might have occurred. 
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12. The Modeling tab (Figure 6) will display the created forecast (with a forecast run selected) in the Map Window
(Figure 6). In addition, the name of the forecast; time window information about the forecast; and forecast run(s) 
information are displayed.

13.3 Managing Forecasts
HEC-RTS provides many options for managing forecasts - opening an existing forecast; deleting a forecast; closing an 
active forecast; editing the active forecast time window; rerun extracts; add or remove forecast runs from an active 
forecast; and, saving an active forecast. The following sections provide details on managing forecasts.

13.3.1 Open a Forecast
To open a forecast:
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From the HEC-RTS main window, click the Modeling tab, from the Forecast menu, click Open. The Open 
Forecast dialog (Figure 1) will open. 

From the Existing list of available forecasts for the watershed, select the forecast you wish to open.
Click Open, the Open Forecast dialog closes (Figure 1). HEC-RTS will load all the information associated with the 
selected forecast. In the Modeling tab (Modeling Module - Forecast Information Displayed), the top checkbox of 
the tree will display the name of the selected forecast and the forecast runs associated with the selected 
forecast. The Map Window will display the model representations of the active forecast run.

13.3.2 Delete a Forecast
Delete a forecast:
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From the HEC-RTS main window, click the Modeling tab, from the Forecast menu, click Delete. The Delete 
Forecast dialog (Figure 2) will open. 

In the Existing Forecasts box (Figure 2) is a list of the forecasts that have been created for the watershed, select 
a forecast from the list.
Click Delete, a Warning window will open asking you if you really want to delete the forecast. Click Yes, the 
Warning window closes, and the forecast is removed from the watershed. This process does not physically 
delete any files; it only deletes the reference of the forecast from the watershed.
If you wish to delete the associated directory of the selected forecast, from the Delete Forecast dialog (Figure 2), 
click Delete forecast directory. This option will delete the whole forecast directory.

13.3.3 Close a Forecast
To close a forecast, from the HEC-RTS main window, click the Modeling tab, from the Forecast menu, click Close. If you 
have made changes to the forecast, you will be given options on how to manage those change, further details are 
provided in Managing Forecast Data of this chapter. HEC-RTS will unload all information associated with the active 
forecast and the Modeling module (Modeling Module - Forecast Information Displayed) will be blank.

13.3.4 Edit the Time Window
If you want to change any of the dates or times associated with the active forecast, from the HEC-RTS main window, 
click the Modeling tab, from the Forecast menu, click Edit Time Window. The Forecast Time Window dialog (Figure 3) 
will open. In the Forecast Time Window dialog, enter the new information in the corresponding date and time fields. 
Click OK, the Forecast Time Window dialog (Figure 3) will close.
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58 Figure 3 Forecast Time Window Dialog

13.3.5 Run Extracts
If you want to retrieve data from the defined DSS file(s) contained in the extract groups again, from the Forecast menu, 
click Extract, the Run Extract dialog will open (Figure 4). In the table are displayed the extract groups that have been 
defined for the watershed. Information about extract groups is detailed in Data Extract and Post Editors. 

Select an extract group(s) the you wish to rerun, and un-select the extract group(s) that you do not want to run. Click 
Run Now (Figure 4), the Run Extract dialog will close. Progress of the extract is displayed in the Message Pane
(Modeling Module - Forecast Information Displayed), from the Extract tab.

13.3.6 Add Forecast Runs
If you wish to add already defined forecast runs to the selected forecast, from the Forecast menu, click Run Selector, 
the Forecast Run Selector dialog (Figure 5) opens. In the Forecast Run Selector dialog, select the defined forecast 
runs you wish to add to the forecast by clicking check boxes in the Selected column. Click OK, the Forecast Run 
Selector dialog (Figure 5) closes, a Progress window will open displaying the progress of adding the forecast run to the 
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13.3.7 Remove Forecast Runs
To remove a forecast run from a forecast, from the Forecast Run Selector dialog (Figure 5) clear the check box in the 
Selected column (Figure 5) next to the name of the forecast run you wish to remove from the active forecast. Click OK, 
the Forecast Run Selector dialog closes, the forecast run no longer displays on the HEC-RTS main window (Modeling 
Module - Forecast Information Displayed).

13.3.8 Save the Active Forecast
To save the active forecast, from the Forecast menu, click Save, and HEC-RTS will save information for the active 
forecast.

13.4 HEC-RTS Forecast Run Details
From the Forecast Run Details section of the Modeling module (Figure 1), you can view what forecast runs are part of 
the forecast that has been selected. In addition, you can view the individual model alternatives for a forecast run. By 
default, the first forecast run displays in the Map Window and the name of the forecast run is bolded (Figure 1) in the 
Forecast Run Details section. When a forecast run is bolded, this means that the forecast run is being displayed in the 
active Map Window of the Modeling module (Modeling Module - Forecast Information Displayed).
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59 Figure 1 Modeling Module - Forecast Run Details Section

When you have clicked the checkbox next to a forecast run (Figure 1), you are indicating that you want to view output 
from the model schematic that is displayed in the Map Window for multiple forecast runs. In this version of HEC-RTS, 
the only software application that displays output results for multiple forecast runs is HEC-ResSim. In addition, the time 
series icons will display output for multiple forecast runs. MFP will display separate summary reports for each forecast 
run.

13.4.1 Forecast Runs – Shortcut Menu
From the Forecast Runs Detail section (Figure 2) of the Modeling module, when you right click on a forecast run name, 
a shortcut menu will display (Figure 2). From this shortcut menu, you can perform many processes. Further details 
about these processes are detailed in Model Alternatives and Forecast Runs.
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13.4.2 Model Alternatives – Shortcut Menu
From the Forecast Runs Detail section (Figure 3) of the Modeling module, under a forecast run name, is the list of 
model alternatives that are associated with the forecast run. When you right-click on a model alternative name, a 
shortcut menu will display (Figure 3). From this shortcut menu, you can perform many processes. Further details about 
these processes are detailed in Model Alternatives and Forecast Runs.

From the shortcut menu you can compute individual model alternatives by clicking Compute (Figure 3). You can also 
identify whether you want a model alternative to be skipped during a forecast run or have the forecast run compute 
through a selected model alternative.

To skip a model alternative computing in a forecast run, right-click on a model alternative, from the shortcut menu 
(Figure 3), click Skip Compute. The icon of the model alternative will now have a down blue arrow drawn through it 
(Figure 4), and the Skip Compute item in the shortcut menu will have a have checkmark.

To have a forecast run compute through a selected model alternative, from the shortcut menu (Figure 3), click 
Compute Through. The icon of the model alternative will now have a red line and a red up arrow drawn through it 
(Figure 4), and the Compute Through item in the shortcut menu will have a have checkmark.

60 Figure 4 Model Alternative - Shortcut Menu - Skip Compute and Compute Through

13.4.3 Model Alternative Map Schematic Element – Shortcut Menu
From the Forecast Runs Detail section (Figure 5) of the Modeling module, you can expand a model alternative (an MFP 
alternative does not have map schematic elements), which lists the map schematic elements associated with that 
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model alternative. When you right-click on an element, a shortcut menu will display (Figure 5). Depending on the model 
alternative and the map schematic element, the shortcut menu will display different options. In addition, on the Model 
Schematic that is displayed in the Map Window, the selected element will be highlighted.

61 Figure 5 Model Alternative Map Schematic Element - Shortcut Menu

13.5 Review Forecast Data
Now that you have created a forecast, you are ready to compute the forecast runs associated with that forecast. Before 
you do a compute, you need to check the data that was retrieved from the defined DSS file(s) contained in the extract 
groups that will be used during the compute.

To review forecast data:

From the HEC-RTS main window, click the Modeling tab, from the Forecast tabs (Modeling Module - Forecast 
Information Displayed), click Reports, click Extract Report. Another way to review forecast data, from the 
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Forecast menu, point to Logs, click Extract Report. Either way will open the Extract Report dialog (Figure 1). 

 
The Extract Report displays the log file that was generated when the extract process was executed. The name of 
the active forecast appears in the title bar of the Extract Reports dialog (Figure 1). The location of the log file is 
displayed in the File box (Figure 1).
Displayed are the results from the retrieval of precipitation data and the data needed by the models associated 
with the selected forecast. The model data is displayed in the first part, with the precipitation data being display 
last.
If errors are shown, correct the data using HEC-DSSVue. Remember you are only correcting or editing the data 
for the active forecast.
When you have finished reviewing the extract results, from the File menu (Figure 1), click Close, the Extract 
Report dialog closes.

13.6 Model Linking
Now that you have created forecast runs, created a forecast, and have reviewed the data for a forecast, you need to link 
the model alternatives that are part of the forecast runs that are associated with the forecast. From the HEC-RTS main 
window, click the Modeling tab, from the Forecast menu, click Model Linking. The Model Linking Editor will open 
(Figure 1), for each defined forecast run, you will be linking each model alternative. For example, you will want to use 
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output from your HEC-HMS and HEC-ResSim models alternatives as input to your HEC-RAS model alternative. Model 
Linking Editor provides further details on model linking.

62 Figure 1 Model Linking Editor

13.7 Executing an HEC-RTS Forecast
Now you are ready to compute an HEC-RTS forecast. The Modeling module (Modeling Module - Forecast Information 
Displayed) displays the time information associated with an active forecast, and a list of forecast runs associated with 
that active forecast. For the active forecast, you can compute for a single forecast run or for compute multiple forecast 
runs. There are several ways to compute an HEC-RTS forecast and the following sections describe in detail how you 
would execute a single forecast run or execute multiple forecast runs.

You can also change the behavior of a forecast run compute, by telling the compute to skip a model alternative 
(Forecast Run Details) or tell the compute to execute through a specific model alternative (Forecast Run Details).

13.7.1 Computing a Single Forecast Run
When a forecast run is highlighted, from the HEC-RTS main window, click the Modeling tab, from the Forecast Tabs, 
click Actions (Figure 1). Click Compute (Figure 1), the Compute Progress dialog will open (Figure 2) and the highlighted 
forecast run will be computed.
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63 Figure 1 Forecast Tab - Actions

64 Figure 2 Compute Progress Dialog

Another option for computing a single forecast run is, from the Forecast Run Details Area of the Modeling module, 
right-click on a forecast run, from the shortcut menu, click Compute. The Compute Progress dialog will open (Figure 2) 
and the highlighted forecast run will be computed. 

An additional way to compute an individual forecast is, from the HEC-RTS main window, click the Modeling tab, from 
the Forecast menu, click Compute Manager. The Compute Manager dialog (Figure 3) will open, select the forecast run 
your wish to compute, click Compute. The Compute Progress dialog will open (Figure 2) and the highlighted forecast 
run will be computed.
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13.7.2 Computing Multiple Forecast Runs
HEC-RTS provides you with a way to execute more than one forecast run at one time, from the main window, click the 
Modeling tab, from the Forecast menu, click Compute Manager. The Compute Manager dialog (Figure 3) will open, 
select all forecast runs you want to compute, click Compute. The Compute Progress dialog will open (Figure 2) and the 
highlighted forecast run will be computed.

13.7.3 Recompute Forecast Runs
When a forecast run is executed, HEC-RTS remembers what HEC-RTS models executed for that forecast run. If changes 
were made to a model in the forecast sequence, HEC-RTS will re-compute the model when you compute the sequence. 
If no changes were made to a model and the model was previously computed, HEC-RTS will not recompute the model 
in the sequence. If for some reason you need to recompute the entire model sequence for a forecast run, from the 
Modeling module, from the Actions tab (Figure 1), click the Force Recompute check box. This will "force" a full 
recompute of the selected forecast run when you click Compute (Figure 1). The Compute Progress dialog (Figure 2) will 
open and all the models will be run.

13.8 Viewing Results
After you have computed your active forecast runs, you can now review the results in the Modeling module. Results 
include the log files, which display computational messages from some of the HEC-RTS software applications, reports 
from the individual HEC-RTS software applications, and some of the HEC-RTS software applications have results 
available in a graphical form from the Map Window. More detail on viewing results can be found in HEC-RTS Results. 

13.9 Calibrating and Editing Models
You may want to run the models individually for calibration before doing a full compute of the forecast run. This is 
particularly important for HEC-HMS because there are event-dependent parameters (loss rate and baseflow) that you 
will need to adjust for the forecast. HEC-HMS will produce simulation hydrographs, which you can compare with 



HEC-RTS User Manual  – HEC-RTS Forecasts

HEC-RTS Forecasts
                             – 

1.

2.

observed hydrographs up to the time of forecast. These comparisons will determine if you need to adjust your HEC-HMS 
model.

In the case of HEC-ResSim, you are using the simulated releases as a guide. After reviewing the releases, you might 
decide that you need to adjust the releases to better simulate actual reservoir operations. For HEC-RAS, you are 
checking profile information throughout the lookback period; if results are not satisfactory, you can calibrate HEC-RAS 
by modifying "n-values" at selected cross sections. In the case of HEC-FIA, you might need to adjust the levee failure 
stages to see the associated damage and impacts during an event.

Each HEC-RTS software application has its own individual editor; these editors are described in detail in Model 
Alternatives and Forecast Runs. For each HEC-RTS software application, there are only certain parameters that you can 
edit. If you need to make additional changes beyond those specific parameters, you will have to revise the model 
alternative using the model's standalone application and re-import the model into your HE-RTS watershed.

In Version 3.1.1, you can edit any of the model data because of the native module interface used. Care should be 
exercised when editing calibrated models configured in HEC-RTS to prevent models from "breaking".

13.9.1 Computing Individual Model Alternatives
To run a forecast through an individual model:

From the Forecast Runs Detail section (Model Alternative - Shortcut Menu) of the Modeling module, right-click 
on a model alternative of a forecast run. From the shortcut menu, click Compute. Note that the models are 
computed in the same order as the Program Order you have set up. For example, if you want to compute a 
forecast run through the HEC-ResSim model alternative, right-click on the HEC-ResSim model alternative.
The Compute Progress dialog (Compute Progress Dialog) opens and HEC-RTS begins execution of the HEC-RTS 
software applications up to the model that you have chosen. For example, if you choose to run through HEC-
ResSim, HEC-RTS will compute the MFP, HEC-HMS, and HEC-ResSim model alternatives.

After the completion of the computation, you will need to review reports to help in your calibration. HEC-RTS Results
describes in detail the available reports for each individual model.

13.9.2 Editing Individual Model Parameters
After you have made your initial run and reviewed results, you might decide you need to edit parameters for an 
individual model. From the Forecast Runs Detail section (Model Alternative - Shortcut Menu) of the Modeling module, 
depending on the model alternative that you have right-click on, the shortcut menu displays a range of editing options 
(Model Alternative - Shortcut Menu). The editor associated with that forecast run, opens and you can edit the necessary 
parameters. Each model has its own individual editor, which are described in detail in Model Alternatives and Forecast 
Runs.

13.10 Managing Forecast Data
HEC-RTS facilitates archiving and sharing of forecast data through four different mechanisms. One way is to save 
changes to your selected forecast's model alternatives to the base directory to make them available for other forecasts. 
Another way is to replace an HEC-RTS model alternative for a specific forecast with the version in the base directory. In 
addition, you can post your results to the defined DSS file(s) contained in the extract groups, to make the results 
available to other users; and, the forecast can be frozen to prevent additional computes and further editing of HEC-RTS 
model alternatives.
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13.10.1 Saving Changes to the Base Directory
When you have edited parameters, your changes apply only to an individual forecast run and are saved in the forecast 
directory (see HEC-RTS Application Settings for an overview of the HEC-RTS directory structure). If you want your 
changes to be available for subsequent forecasts, you will need to save the changes back to the base directory.

To save data to the base directory:

From the Forecast Runs Detail section (Forecast Run - Shortcut Menu) of the Modeling module, right click on a 
forecast run name, from the shortcut menu, click Save To Base. The Copy Model Changes dialog (Figure 1) 
opens. 

The Copy Model Changes dialog (Figure 1) displays the name of the Forecast and Forecast Run that are active. 
The table displays the Programs, Model Alternatives, and Model IDs that makeup the active forecast run.
From the Copy Data column (Figure 1) of the table, select the check boxes beside the Model Alternative you 
wish to copy from the forecast directory to the base directory.
When you have selected the appropriate Model Alternatives, click Copy to Base (Figure 1). HEC-RTS will now 
save all files associated with the selected model alternative back to the base directory. When HEC-RTS is 
finished, a confirmation message will appear telling you that all selected model alternatives were successfully 
saved.

Note that when you have edited model parameters, the Copy Model Changes dialog (Figure 1) will also display when 
you leave the current forecast by exiting HEC-RTS, creating a new watershed, creating a new forecast, opening an 
existing forecast, or closing the current forecast. If you want your changes to be available for subsequent forecasts, you 
will need to save the data back to the base directory. If you do not want to save your changes for later forecasts, click 
Close.

13.10.2 Replacing Data from the Base Directory
If, while editing a model alternative, you need to revert to the original model alternative (or propagate modifications 
made through to the forecast), you can replace the changed model alternative in your forecast directory with the model 
alternative from the base directory.
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To replace a model alternative from the base directory:

From the Forecast Runs Detail section (Forecast Run - Shortcut Menu) of the Modeling module, right click on a 
forecast run name, from the shortcut menu click Replace from Base, and the Replace From Base dialog (Figure 
2) opens. 

The Replace From Base dialog (Figure 2) displays the name of the Forecast and Forecast Run that are active. 
The table displays the Programs, Model Alternatives, and Model IDs that makeup the active forecast run.
From the Restore Data (Figure 2) column of the table, select the check boxes beside the Model Alternative you 
wish to restore from the base directory to the forecast directory.
When you have selected the appropriate Model Alternative, click Replace from Local (or Replace From 
Server) (Figure 2). The program will now restore all files associated with the selected Model Alternative from 
the base directory to the forecast directory. When HEC-RTS is finished, a confirmation message will display 
telling you that all selected HEC-RTS model alternatives were successfully replaced.

13.10.3 Posting Results to the HEC-RTS Watershed
Once you have run the forecast runs associated with your forecast and you are satisfied with the results, you will have 
one or more forecast runs that represent final forecast results. At this stage, you will want to post your modeling results 
to the defined DSS file(s) contained in the post groups again to make them available to other users. You will need to 
create Post Groups, which are detailed in Data Extract and Post Editors.
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From the Modeling module, from the Forecast menu, click Post, the Run Post dialog will open (Figure 3). 

All defined Post Groups associated with the active forecast appear in the table. In the Group column, select the 
Post Groups that will post results to the defined DSS file(s).
Click Run Now, the Message Pane on the Post Forecast Results dialog (Model Alternative - Shortcut Menu - 
Skip Compute and Compute Through) will notify you that a post action has been sent to the DBI.
When the data has been successfully posted to the defined DSS file(s), the Message Pane of the HEC-RTS main 
window (Modeling Module - Forecast Information Displayed) will now contain a new tab - Post. This will notify 
you that a post action has been successful.

13.10.4 Archive a Forecast
Once you have a configured a forecast you may want to keep an archive your forecast for future retrieval. To archive a 
forecast:

If you have the forecast you are going to archive open, close the forecast. From the Modeling module, from the 
Forecast menu, click Close.
From the Forecast menu, click Archive, the Select Forecast dialog (Figure 4) opens. 
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Select the forecast name you wish to archive from the list in the Existing box (Figure 4), click Select. The Enter 
Archive Comments dialog (Figure 5) opens. 

Enter your comments in the field at the top of the dialog box and from the Archive Folder box (Figure 5) enter a 
folder to save the archived forecast.
Click OK, an Archiving progress window will display while the archiving process is working. When finished the 
Archiving progress window will close and an Archive Complete window will display (Figure 6). Click OK, the 
Archive Complete window will close. 

 
If the forecast has multiple forecast runs, the Save Models to Base dialog (like Figure 2) will open. If this dialog 
opens, you must select the model alternatives you wish to include in the archive. Once the model alternatives 
are selected click Save to Local and the Progress widow will open as well as the archiving dialog will be 
displayed for a short while archiving the forecast files and closes.
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14 HEC-RTS Results
After a forecast has been executed, results can be reviewed from the Modeling module. Results include log files 
(forecast; forecast run; individual software application); a report on the extract process (forecast); a report on the post 
process (forecast); access to the forecast DSS file; and, reports from the individual software applications. From the Map 
Window some of the software applications (HEC-HMS, HEC-ResSim, HEC-RAS) have results available in a graphical 
form; and from time series icons, results are available in a graphical or tabular form. If the HEC-RAS model included the 
creation of inundation data, this data can be viewed from the RAS Mapper Tool, available through the HEC-RAS 
software application.

14.1 HEC-RTS Results Overview
From the Modeling module (Chapter 11), open an existing forecast, once the forecast is loaded, the Forecast Runs 
Details area (Figure 1) will display the forecast runs associated with the selected forecast. When a forecast run is bolded 
(Daily – Interpolated Obs and Manual Entry), this means that the forecast run is being displayed in the active Map 
Window of the Modeling module.

65 Figure 1 Modeling Module - Forecast Run Details Section

When you have clicked the checkbox next to a forecast run (Figure 1), you are indicating that you want to view output 
from the model schematic that is displayed in the Map Window for the selected forecast run. You can select multiple 
forecast runs, however, in this version of HEC-RTS, the only software application that displays output results for 
multiple forecast runs is HEC-ResSim. In addition, the time series icons will display output for multiple forecast runs. 
MFP will display separate summary reports for each forecast run.
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14.2 General Reports
There are three general reports - Extract Report, Post Report, and Compute Log. The Compute Log report can 
provide details on the forecast compute; the compute for each forecast run associated with a forecast; and, the 
compute for each model alternative associated with a forecast run. There are several ways to access these general 
reports in the Modeling module. From the HEC-RTS main window, from the Forecast menu, point to Logs (Figure 1), the 
three reports are available.

From the Forecast Runs Detail section (Figure 2) of the Modeling module, when you right click on a forecast run name 
(Daily – Interpolated Obs and Manual Entry QFP), a shortcut menu will display (Figure 2). From this shortcut menu, you 
can access two of the general reports - Extract Report and Compute Log.
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66 FIgure 2 Forecast Runs Detail Section - Forecast Run - Shortcut Menu

From the Forecast Runs Detail section (Figure 3) of the Modeling module, under a forecast run name (Daily – 
Interpolated Obs and Manual Entry QFP), is the list of model alternatives that are associated with the forecast run. When 
you right-click on a model alternative name, a shortcut menu will display (Figure 3). From this shortcut menu, you can 
access the Compute Log (Log File) for the selected model alternative.

67 FIgure 3 Forecast Runs Detail Section - Model Alternative - Shortcut Menu

In addition, from the Forecast Runs Details section when you select a forecast run or a model alternative, from the 
Forecast Tabs (Figure 4), click Reports, the Compute Log and the Extract Report (only forecast runs) are available.
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68 Figure 4 Forecast Runs Detail Section - Forecast Tabs - Reports Tab

14.2.1 Extract Report
The Extract Report provides details on what occurred during the extract process for each extract group included in the 
extract process. To access the Extract Report (Figure 5):
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69 Figure 5 Extract Report Dialog

From the HEC-RTS main window, access the Extract Report from one of the ways detailed above, click Extract 
Report, the Extract Report dialog will display (Figure 5). The name of the active forecast appears in the title bar 
of the Extract Reports dialog (Figure 5). The location of the log file is displayed in the File box (Figure 5).
Displayed are the results from the retrieval of precipitation data and the data needed by the models associated 
with the selected forecast. The model data is displayed in the first part, with the precipitation data being 
displayed last.
When you have finished reviewing the extract results, from the Extract Report dialog, from the File menu 
(Figure 5), click Close, the Extract Report dialog closes.

14.2.2 Post Report
The Post Report provides details on each post group included in the post process. To access the Post Report (Figure 6) 
for a forecast:
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70 Figure 6 Figure 13.7 Post Report Dialog

From the HEC-RTS main window, from the Forecast menu, point to Logs, click Post Report, the Post Report
dialog will display (Figure 6). The name of the active forecast appears in the title bar of the Post Report dialog 
(Figure 6). The location of the log file is displayed in the File box (Figure 6).
Displayed are the results from the posting of precipitation data and data generated by the models associated 
with the selected forecast. The model data is displayed in the first part, with the precipitation data being 
displayed last.
When you have finished reviewing the post results, from the Post Report dialog, from the File menu (Figure 6), 
click Close, the Post Report dialog closes.
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14.2.3 Compute Log – Forecast Run
When computing a forecast, you select which forecast runs to compute. Once the compute is complete, detailed 
information regarding the forecast selected forecast run(s) and associated model alternatives that were computed, is 
available from a Compute Log report (Figure 7). To view this report, make sure you have an active forecast and at least 
one forecast run selected.

To view the Compute Log for a forecast run:

From the HEC-RTS main window, click the Modeling tab, from the Forecast Runs Detail section (Figure 2) right 
click on a forecast run name (Daily – Interpolated Obs and Manual Entry QFP), a shortcut menu will display (Figure 
13.3), click Compute Log. Another way is once you have selected a forecast run, from the Forecast tabs, click 
Reports (Figure 4). Either way, click Compute Log, the Log File dialog will open (Figure 7).
The Log File dialog (Figure 7) displays the key code name of the selected forecast run; displays the location and 
name of the file, which contains the log file; and displays the results of the computation.
When you have finished reviewing the forecast compute log, from the Log File dialog, from the File menu (Figure 
7), click Close, the Log File dialog closes.
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14.2.4 Compute Log – Model Alternative
When computing a forecast, you select which forecast runs to compute. Once the compute is complete, if the 
associated model alternatives software application generates a log file (MFP does not), that detailed information is 
available from a Compute Log report (Figure 8). To view this report, make sure you have an active forecast and at least 
one forecast run selected.

To view the Compute Log for a model alternative:

From the HEC-RTS main window, click the Modeling tab, from the Forecast Runs Detail section (Figure 2) select 
a forecast run (Daily – Interpolated Obs and Manual Entry QFP), select a Model Alternative, right-click on the 
model alternative, a shortcut menu will display (Figure 3), click Log File. Another way is once you have selected 
a model alternative, from the Forecast tabs, click Reports (Figure 4). Either way, click Log File, the Log File
dialog will open (Figure 8).
The Log File dialog (Figure 8) displays the name of the software application associated with the selected model 
alternative; displays the location and name of the file, which contains the log file along the bottom of the Log 
File dialog (Figure 8); and displays the results of the computation.
When you have finished reviewing the model alternative compute log, from the Log File dialog, click , the 
Log File dialog closes.
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14.3 Model Alternative Results
For the selected forecast run(s), the associated model alternatives can provide results in either a tabular form (report) 
or in a graphical form. Results are only available for model alternatives if the associated software application provides 
those results to HEC-RTS. From the Modeling module, model alternative results are available from the Forecast Runs 
Detail section, the Forecast tabs, or the Map Window.

From the Forecast Runs Detail section (Figure 1), you can review results by the selected model alternative, or by the 
individual model elements associated with a model alternative. For a selected forecast run, select a model alternative, 
right-click on the model alternative, from the shortcut menu (Figure 1), there are several reports available. Another way 
to review model alternative results from the Forecast Runs Detail section, is select a model alternative, from the 
Forecast tabs, click Reports (Figure 1). From the Reports tab, there are several reports available for the selected model 
alternative.

71 Figure 1 Forecast Runs Details Section - Model Alternative - Reports

To review results for individual model elements (e.g., reservoirs, reaches, sinks, cross sections, etc.) from the Forecast 
Runs Details section (Figure 2), next to a model alternative, click  . For an HEC-HMS, HEC-ResSim, and HEC-RAS 
model alternative, the individual model elements will display (Figure 2). An MFP alternative does not have any 
individual model elements, and for an HEC-FIA model alternative, individual model elements will display, but results 
are only provided at the model alternative level. For a model alternative, right-click on an individual model element, 
from the shortcut menu (Figure 2), there are several reports available. Another way to review individual model element 
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results from the Forecast Runs Detail section, for a model alternative, select an individual model element, from the 
Forecast tabs, click Reports (Figure 2). 

72 Figure 2 Forecast Runs Details Section - Individual Model Elements - Reports

From the Reports tab, there are several reports available for the selected individual model element. In addition, when 
certain individual model elements are selected, in the Map Window, on the schematic (Figure 3), the selected individual 
model element is highlighted in yellow.
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 In the Modeling module, from the Map Window (Figure 4), you can also review individual model elements. From 
the Map Window, click (Select Tool). From the schematic, right-click on an individual model element, from the shortcut 
menu (Figure 4), you can review results for the associated model alternatives for a selected forecast run. The available 
results are either reports or graphical.
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73 Figure 4 Modeling Module - Map Window - Individual Model Element Results

So, as you can see, in HEC-RTS there are various ways to review results. How to access those results will vary, since as 
this section has detailed, there is just not one way to access results in HEC-RTS.

14.4 MFP Results
The MFP Summary dialog (Figure 1) displays information regarding the MFP model alternative associated with a 
forecast run. The report displays the location and name of the file, which contains the MFP Summary. In addition, the 
report displays the name of the forecast run, the time window used, the date and time of the execution of the MFP 
model alternative, and the creation of the precipitation grids for observed and future.
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74 Figure 1 MFP Summary Report

To view the MFP Summary report:

To view this report, make sure you have an active forecast and at least one forecast run selected (checkbox) for 
viewing results.
From the HEC-RTS main window, click the Modeling tab, from the Forecast Runs Details section, right-click on 
an MFP model alternative (Interpolated Obs – Manual Entry QPF), from the shortcut menu, click Summary.
In Figure 1, the MFP Summary report, displays results for the MFP model alternative Interpolated Obs – Manual 
Entry QPF. The report displays the sequence of precipitation depths entered by zone, and summaries of each 
grid used in the forecast. Summaries include the maximum, minimum, and average precipitation depth values, 
and the number of cells in the grid showing precipitation depths greater than zero. Note that the precipitation 
depths shown in this log file are given in millimeters, regardless of the unit system of the watershed.
From the File menu, click Close, and the MFP Summary dialog (Figure 1) closes.

14.5 HEC-HMS Results
HEC-HMS may be used in HEC-RTS to compute watershed runoff, given initial system states and watershed 
precipitation. HEC-HMS results available from the HEC-RTS interface include a forecast summary report; a table of time-
series parameter data, and a plot of the time-series data. These results are available from the individual watershed 
elements as defined in the HEC-HMS model alternative.

14.5.1 Graphical Results
To view graphical results for individual HEC-HMS model elements (e.g., reaches, sinks):
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From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Details section, next to an HEC-HMS model 
alternative (Daily Forecasting – 15MIN), click . The individual model elements for the selected HEC-HMS 
model alternative will display.
Select an HEC-HMS model element (Calpella Gage), from the Forecast tabs, click Reports. Click Graph, a dialog 
will open (Figure 1), displaying a graph of the selected HEC-HMS model element. The graph provides the name 
and type of the HEC-HMS model element; you can zoom in/out on graph; make adjustment to the graph's 
properties; and, print the graph.

 From the graphical dialog (Figure 1), click  , the dialog will close.

14.5.2 Time-Series Results
To view time-series results for individual HEC-HMS model elements (e.g., reaches, sinks):

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Details section, next to an HEC-HMS model 
alternative (Daily Forecasting – 15MIN), click . The individual model elements for the selected HEC-HMS 
model alternative will display.
Select an HEC-HMS model element (Calpella Gage), from the Forecast tabs, click Reports. Click Time-Series 
Table, the Time-Series Results dialog will open (Figure 2). For the selected HEC-HMS model element, the Time-
Series Results dialog, provides information on the watershed; name of the HEC-HMS model alternative; the 
HEC-HMS model alternative key code (variant); what type of HEC-HMS model element and name; time window 
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information for the compute; HEC-HMS basin model that is used; HEC-HMS meteorologic model that is used; 
and, a table of time-series results. 

From the Time-Series Results dialog (Figure 2), click , the dialog will close.

14.5.3 Summary Results
To view a summary of results for individual HEC-HMS model elements (e.g., reaches, sinks):

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Details section, next to an HEC-HMS model 
alternative (Daily Forecasting – 15MIN), click . The individual model elements for the selected HEC-HMS 
model alternative will display.
Select an HEC-HMS model element (Calpella Gage), right-click on the model element, from the shortcut menu, 
click Summary Table. The Summary Results dialog will open (Figure 3). For the selected HEC-HMS model 
element, the Summary Results dialog, provides information on the watershed; name of the HEC-HMS model 
alternative; the HEC-HMS model alternative key code (variant); what type of HEC-HMS model element and name; 
time window information for the compute; HEC-HMS basin model that is used; HEC-HMS meteorologic model 
that is used; volume units; computed results; and, in some cases information about the observed hydrograph at 
a gage.
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From the Time-Series Results dialog (Figure 3), click , the dialog will close. 

14.6 HEC-ResSim Results
HEC-ResSim may be used in HEC-RTS to simulate operation of a watershed, given inflow and local flow forecasts from 
HEC-HMS. There are several reports available from HEC-ResSim for the HEC-ResSim model alternative, and for HEC-
ResSim model elements. From an HEC-ResSim model alternative you have a series of summary results reports (i.e., 
reservoir, flow, power, etc.). At HEC-ResSim model elements (i.e., reach, junctions, reservoirs), you can review plots of 
gage information; plots of inflow/outflow information; plots that provide information on power, releases, and 
operations at reservoir model elements; and a release decision report.

14.6.1 Reservoir Summary Report
The Reservoir Summary Report summarizes the reservoirs for the active forecast run. Results include the storage, 
elevation, controlled release, and uncontrolled spill parameters for each reservoir, and are reported as average, 
maximum, minimum values for each parameter.

To view the Reservoir Summary Report:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-ResSim 
model alternative (RT-Normal), from the Forecast tabs, click Reports.
Click Reservoir Summary, the Reservoir Summary Report (Figure 1) dialog will open. This report provides 
information about the reservoirs in a watershed. Information includes storage, elevation, controlled release, and 
uncontrolled spill for each reservoir in a watershed. For each parameter, the report displays the average, 
maximum, and minimum values. In addition, the report provides information on the time window for the HEC-
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ResSim model alternative (key code 10Q0N0) compute. You can also print the Reservoir Summary Report. 

From the File menu, click Close, and the Reservoir Summary Report (Figure 1) dialog will close.

14.6.2 Flow Summary Report
The Flow Summary Report summarizes the flow at reservoirs and non-reservoir locations for the active forecast run. 
Results include regulated flow, unregulated flow, and cumulative local flow for each location, and are reported as the 
average, maximum, minimum values for each parameter.

To view the Flow Summary Report:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-ResSim 
model alternative (RT-Normal), from the Forecast tabs, click Reports.
Click Flow Summary, the Flow Summary Report (Figure 2) dialog will open. This report summarizes the flow at 
reservoirs and non-reservoir locations. Information includes regulated flow; unregulated flow; and cumulative 
local flow. For each parameter, the report displays the average, maximum, and minimum values. In addition, the 
report provides information on the time window for HEC-ResSim model alternative (key code 10Q0N0) compute. 
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You can also print the Flow Summary Report. 

From the File menu, click Close, and the Flow Summary Report (Figure 2) dialog will close.

14.6.3 Power Summary Report
The Power Summary Report summarizes the hydropower information at a reservoir for the active forecast run. Results 
include generation efficiency, power head, hydraulic losses, energy generated per time step, power generated, plant 
factor, and flow power for each power plant, and are reported by the average, maximum, minimum values for each 
parameter. If the appropriate data (hydropower plant) has not been entered this report will be blank.

To view the Power Summary Report:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-ResSim 
model alternative (RT-Normal), right-click on the model alternative. From the shortcut menu, click Power 
Summary.
The Power Summary Report (Figure 3) dialog will open. This report summarizes the hydropower information 
for reservoirs in a watershed. Information includes regulated generation efficiency, power heard, hydraulic 
losses, energy generated (time step), power generated, plant factor, and flow power. For each parameter, the 
report displays the average, maximum, and minimum values. In addition, the report provides information on the 
time window for HEC-ResSim model alternative (key code 10Q0N0) compute. You can also print the Power 
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Summary Report. 

From the File menu, click Close, and the Power Summary Report (Figure 3) dialog will close.

14.6.4 Gate Summary Report
The Gate Summary Report summarizes the gates defined for the reservoirs in the active forecast run. Reported is the 
average, maximum, minimum value for the gate opening at each reservoir where a gate has been defined. If the 
appropriate data (gates) has not been entered this report will be blank.

To view the Gate Summary Report:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-ResSim 
model alternative (RT-Normal), right-click on the model alternative. From the shortcut menu, click Gates 
Summary.
The Gate Summary Report (Figure 4) dialog will open. This report summarizes the gate information for 
reservoirs in a watershed. For each parameter, the report displays the average, maximum, and minimum values. 
In addition, the report provides information on the time window for the HEC-ResSim model alternative (key code 
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10Q0N0) compute. You can also print the Gate Summary Report. 

From the File menu, click Close, and the Gate Summary Report (Figure 4) dialog will close.

14.6.5 Stage Summary Report

The Stage Summary Report summarizes the stage at reservoirs and non-reservoir locations for the active forecast run. 
These results include the regulated stage, unregulated stage, and cumulative local stage for each location, and are 
reported by the average, maximum, minimum values for each parameter. If the appropriate data has not been entered 
(rating curves) this report will be blank.

To view the Stage Summary Report:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-ResSim 
model alternative (RT-Normal), right-click on the model alternative. From the shortcut menu, click Stage 
Summary.
The Stage Summary Report (Figure 5) dialog will open. This report summarizes the stage at reservoirs and non-
reservoir locations in a watershed. Information includes regulated stage, unregulated stage, and cumulative 
local stage for each location. For each parameter, the report displays the average, maximum, and minimum 
values. In addition, the report provides information on the time window for the HEC-ResSim model alternative 
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(key code 10Q0N0) compute. You can also print the Stage Summary Report. 

From the File menu, click Close, and the Stage Summary Report (Figure 5) dialog will close.

14.6.6 Release Decision Report
The Release Decision Report provides release decision information for reservoirs in a watershed. The release decision 
information is based on operational rules and physical constraints defined in an HEC-ResSim model alternative that 
was defined for a watershed.

To view the Release Decision Report:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-ResSim 
model alternative (RT-Normal), from the Forecast tabs, click Reports. You can also access this report from an 
HEC-ResSim reservoir model element. From the Map Window, locate an HEC-ResSim reservoir model element 
(Coyote), right-click on the model element, from the shortcut menu click Release Decision Report.
The Release Decision Report (Figure 6) dialog will open. This report summarizes the release decisions for a 
reservoir in a watershed. Information provided in this report is based on the operational rules and physical 
constraints defined in an HEC-ResSim model alternative. There is a legend for this report, so you can understand 
what the acronyms mean (GC = Guide Curve). In addition, the report provides information on the time window for 
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HEC-ResSim model alternative (key code 10Q0N0) compute. 

This report is for a single reservoir (Coyote) in the watershed for a certain time window. You can change the time 
window for the information being displayed, or switch to another reservoir in the watershed. From the Release 
Decision Report (Figure 6), from the Options menu, click Edit Options, the Release Decision Report Options
dialog (Figure 7) will open. 

From the Reservoir list, select a different reservoir, click OK, the Release Decision Report Options dialog 
(Figure 7) will close. The Release Decision Report will now display results for the selected reservoir. You can 
also specify a different time window from the Release Decision Report Options dialog. From the Time Window
box, select Specify, now you can enter different start and end dates.
You can also print the Release Decision Report. From the File menu, click Close, and the Release Decision 
Report (Figure 6) dialog will close.

14.6.7 Graphical Results
From the Modeling module, to review HEC-ResSim graphical results for individual model elements (e.g., reservoirs, 
reaches, junctions, etc.) from the Forecast Runs Details section, next to an HEC-ResSim model alternative, click . 
The HEC-ResSim model elements will display. Right-click on an HEC-ResSim model element, from the shortcut menu, 
depending on the HEC-ResSim model element, there are several graphical results available for review. Another way to 
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review HEC-ResSim model element results from the Forecast Runs Detail section, for an HEC-ResSim model 
alternative, select an individual model element. From the Forecast tabs, click Reports. From the Reports tab, there are 
several graphical results available for the selected HEC-ResSim model element. In addition, when some of the 
individual model elements are selected, in the Map Window, on the schematic, the selected individual model element 
is highlighted in yellow.

Another way to review HEC-ResSim graphical results from the Modeling module, is from the Map Window. From the 

Map Window, click   (Select Tool), from the schematic, right-click on an HEC-ResSim model element. From the 
shortcut menu (Figure 8), you can review HEC-ResSim graphical results for the selected model element. Since the 
shortcut menu (Figure 8), will display any available model alternative results for the forecast run, HEC-ResSim results 

are identified with the HEC-ResSim icon ( ).

75 Figure 8 Map Window - HEC-ResSim Model Elements - Reservoir and Junction

14.6.7.1 Reservoirs
To view the graphical results from an HEC-ResSim reservoir:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-ResSim 
model alternative (RT-Normal). Next to the selected HEC-ResSim model alternative, click . The HEC-ResSim 
model elements will display.
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Select an HEC-ResSim reservoir model element ( ), from the Forecast tabs, click Reports. From the Reports
tab, there are several graphical results available for a HEC-ResSim reservoir model element.
From the Reports tab, to view the default plot for an HEC-ResSim reservoir, click Plot. The Default Plot dialog 
will open (Figure 9). This plot displays various information about a reservoir (operations) for the active forecast 
run. 

From the Reports tab, to view the power plot for an HEC-ResSim reservoir, click Plot Power. The Power plot 
dialog will open (Figure 10). This plot displays the hydropower information at a reservoir for the active forecast 
run.
From the Reports tab, to view the releases plot for an HEC-ResSim reservoir, click Plot Releases. The Releases
plot dialog will open (Figure 11). This plot displays the release information at a reservoir for the active forecast 
run. 
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6. From the Reports tab, to view the operations plot for an HEC-ResSim reservoir, click Plot Operations. The 
Operations plot dialog will open (Figure 12). This plot displays the operations information at a reservoir for the 
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active forecast run. 

You can print, save as a graphics file, and view tabular data of the plot from the File menu (Figure 12). 
See Working with Plots for details on how you can manipulate plots available in HEC-RTS.
To close a plot dialog, from the File menu (Figure 12). click Close. The active plot dialog will close.

14.6.7.2 Routing Reaches
To view the graphical results from a HEC-ResSim routing reach:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-ResSim 
model alternative (RT-Normal). Next to the selected HEC-ResSim model alternative, click . The HEC-ResSim 
model elements will display.
Select an HEC-ResSim routing reach model element ( ), from the Forecast tabs, click Reports. From the 
Reports tab, click Plot.
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The Default Plot dialog for an HEC-ResSim routing reach will open (Figure 13). 

You can print, save as a graphics file, and view tabular data of the plot from the File menu (Figure 13). See 
Working with Plots for details on how you can manipulate plots available in HEC-RTS.
To close a plot dialog, from the File menu (Figure 13). click Close. The active plot dialog will close.

14.6.7.3 Junctions
To view the graphical results from an HEC-ResSim junction:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-ResSim 
model alternative (RT-Normal). Next to the selected HEC-ResSim model alternative, click  . The HEC-ResSim 
model elements will display.
Select an HEC-ResSim junction model element ( ), from the Forecast tabs, click  Reports. From the Reports
tab, there are two graphical results available for an HEC-ResSim junction model element.
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From the Reports tab, to view the default plot for an HEC-ResSim junction, click Plot. The Default Plot dialog 
will open (Figure 14). 

From the Reports tab, to view the inflow-outflow plot for an HEC-ResSim junction, click Plot Inflow/Outflow. 
The Inflow-Outflow Plot dialog will open (Figure 15). This plot provides a graphical representation of flow into 
and the flow leaving the selected HEC-ResSim junction (Cloverdale Gage).
You can print, save as a graphics file, and view tabular data of the plot from the File menu (Figure 15). 
See Working with Plots for details on how you can manipulate plots available in HEC-RTS.
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To close a plot dialog, from the File menu (Figure 15). click Close. The active plot dialog will close. 

14.6.7.4 Diverted Outlets
To view the graphical results from an HEC-ResSim diverted outlet:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. You may need to zoom in on the Map window, select the Zoom Tool
and zoom-in on an area where there is an HEC-ResSim diverted outlet model element (line leaving a reservoir 
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pool with an arrowhead); an example is shown in Figure 16.

From the Map Window (Figure 16), click   (Select Tool), from the schematic, right-click on an HEC-ResSim 
diverted outlet model element. From the shortcut menu, click Plot.
The Default Plot dialog (Figure 17) will open, displaying the graphical results for the diverted outlet. 

You can print, save as a graphics file, and view tabular data of the plot from the File menu (Figure 17). See 
Working with Plots for details on how you can manipulate plots available in HEC-RTS.
To close a plot dialog, from the File menu (Figure 17). click Close. The active plot dialog will close.
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14.7 HEC-RAS Results
HEC-RAS may be used in HEC-RTS to simulate the behavior of channels in a watershed, given flow rates predicted with 
HEC-HMS. There are several reports available from HEC-RAS for the HEC-RAS model alternative, and for HEC-RAS model 
elements. From an HEC-RAS model alternative you have a series of reports, that provide you with results for key 
variables; distribution of flow (left and right overbank, main channel); steady flow results; unsteady flow results; rating 
curves; and, much more. There are two HEC-RAS model elements (cross sections, routing reach), you can review plots of 
cross sections; and, plots from routing reaches (profiles, XYZ).

14.7.1 Standard Table 1
The Standard Table 1 is the default summary table (Figure 1). This table provides you a summary of key HEC-RAS 
output variables. To view the Standard Table 1:

76 Figure 1 HEC-RAS - Profile Output Table - Standard Table 1 Dialog

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-RAS model 
alternative (Russian River Real-Time), from the Forecast tabs, click Reports.
Click Summary Output Table, the Profile Output Table - Standard Table 1 dialog (Figure 1) opens. This report 
displays several hydraulic variables for stream stations. You can change certain parameters that are displayed, 
from the Options menu (Figure 1), you can choose which profiles and reaches to display, you can add a column 
to the report that includes the profile name, and you can choose which system units you wish to view the report 
in.
From the File menu, click Exit, and the Profile Output Table - Standard Table 1 dialog (Figure 1) closes.

14.7.2 Standard Table 2
The Standard Table 2 (Figure 2) is the second of the standard summary tables. This table provides information on the 
distribution of flow between the left overbank, main channel, and right overbank. This table also shows the friction 
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losses, as well as contraction and expansion losses that occurred between each section. Energy losses displayed at a 
cross section are for the losses that occurred between that section and the next section downstream.

To view the Standard Table 2:

77 Figure 2 HEC-RAS - Profile Output Table - Standard Table 2 Dialog

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-RAS model 
alternative (Russian River Real-Time), from the Forecast tabs, click Reports.
Click Summary Output Table, the Profile Output Table - Standard Table 1 dialog (Figure 1) opens. From the 
Std. Tables menu, click Standard Table 2, the Profile Output Table - Standard Table 2 dialog (Figure 2) will 
open. The report displays several hydraulic variables for stream stations. You can change certain parameters 
that are displayed, from the Options menu (Figure 2), you can choose which profiles and reaches to display, you 
can add a column to the report that includes the profile name, and you can choose which system units you wish 
to view the report in.
From the File menu, click Exit, and the Profile Output Table - Standard Table 2 dialog (Figure 2) closes.

14.7.3 Detailed Output Table
Detailed output tables display hydraulic information at a single location for a single profile, for an HEC-RAS node type 
(i.e., cross section, culverts, bridges, etc.). For HEC-RTS version 3.1.1, the default node type is SA/2D Connections. For 
the example, in this User's Manual, for the HEC-RAS model alternative, there are no SA/2D Connections nodes. The user 
will need to select an appropriate node type to display information in a detailed output table.

To view a Detailed Output Table:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-RAS model 
alternative (Russian River Real-Time), from the Forecast tabs, click Reports.
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Click Detailed Output Table, the SA/2D Connection Output dialog (Figure 3) opens. This is the HEC-RAS default 
node type (storage area connection), which is not used in the example watershed for this User's Manual. 

From the Type menu (Figure 3), click Cross Sections, the Cross Section Output dialog (Figure 4) will open. The 
report displays detailed hydraulic information about a single cross section (14.28) in the HEC-RAS model 
alternative. You can view information for other cross sections in the HEC-RAS model alternative, by manipulating 
the River, Reach, Profile, and RS lists (Figure 4). For further details on this HEC-RAS report, refer to the HEC-RAS 
User's Manual (Chapter 9). 
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There are several other node types available in HEC-RAS - culvert, bridge, multiple opening, inline structure, 
lateral structure, storage area, storage area connection, pump stations, and flow distribution in cross sections. 
For further details, refer to the HEC-RAS User's Manual (Chapter 9).
From the File menu, click Exit, and the Cross Section Output dialog (Figure 4) closes.

14.7.4 Profile Plot
The result of a steady flow HEC-RAS model alternative is the calculation of water surface profiles. To view the water 
surface profile plot:

From the Modeling module, to view this report, make sure you have an active forecast and at least one forecast 
run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-RAS model 
alternative (Russian River Real-Time), from the Forecast tabs, click Reports.
Click Profile Plot, the Profile Plot dialog (Figure 5) opens. The Profile Plot displays the water surface profile for 
the first reach (routing) in the river system. To view other water surface profiles, you will need to manipulate the 
reaches and profiles. This manipulation is done by either clicking on Reaches or Profiles (Figure 5) and selecting 
what you want changed; change reaches by manipulating the up and down arrow to the right of the Reaches
button; view profiles by using the animation controls; and, by changing various parameters that are available 
from the Options menu (Figure 5). For further details on this HEC-RAS report, refer to the HEC-RAS User's Manual 
(Chapter 9, Tabular Output section). 

From the File menu, click Exit, and the Profile Plot dialog (Figure 5) closes.

14.7.5 Stage & Flow Hydrograph
During an HEC-RAS unsteady flow compute, stage and flow hydrographs are generated. To view the stage and flow 
hydrographs for a selected HEC-RAS model:
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From the Modeling module, to view stage and flow hydrographs, make sure you have an active forecast and at 
least one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an 
HEC-RAS model alternative (Russian River Real-Time), from the Forecast tabs, click Reports.
Click Stage & Flow Hydrograph, the Stage and Flow Hydrographs dialog (Figure 6) opens. You can plot stage, 
plot flow, plot observed stage, plot observed flow, and plot stage using a reference stage. By default, as 
displayed in Figure 6, the node type is cross sections, allowing you to view hydrographs at cross sections only. 

There are several other node types available in HEC-RAS - bridges/culverts, inline structures, lateral structures, 
storage areas, storage area connections, pump stations, ground water interactions, and storage area 
connections flow are with BC lines. You can view information by manipulating the River, Reach, and River Sta.
lists (Figure 6). For further details on this HEC-RAS report, refer to the HEC-RAS User's Manual (Chapter 9).
Additional, from the Stage and Flow Hydrographs dialog (Figure 6), besides viewing data in a plot, from the 
three available tabs you can also view data in a tabular form (Table), and plot a rating curve of the selected 
event (Rating Curve). For further details on this HEC-RAS report, refer to the HEC-RAS User's Manual (Chapter 9).
From the File menu, click Exit, and the Stage and Flow Hydrographs dialog (Figure 6) closes.

14.7.6 Rating Curve Plots
During an HEC-RAS compute, if information for rating curves has been defined, rating curves can be viewed. To view 
rating curves for a selected HEC-RAS model alternative:

From the Modeling module, to view rating curves, make sure you have an active forecast and at least one 
forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-RAS 
model alternative (Russian River Real-Time), from the Forecast tabs, click Reports.
Click Rating Curve, the Rating Curve dialog (Figure 7) opens. The Rating Curve plot displays the water surface 
elevation versus flow rate for the water surface profiles that were computed. To view other rating curves, 
manipulate the River, Reach, and River Sta. lists (Figure 7). For further details on this HEC-RAS report, refer to 
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the HEC-RAS User's Manual (Chapter 9). 

From the File menu, click Exit, and the Rating Curve dialog closes (Figure 7).

14.7.7 Cross Section Plot
During an HEC-RAS compute, at each defined cross section, data is generated. A cross section plot will display results 
from an HEC-RAS compute. To view cross section information for a selected HEC-RAS model alternative:

From the Modeling module, to view cross section information, make sure you have an active forecast and at 
least one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an 
HEC-RAS model alternative (Russian River Real-Time), from the Forecast tabs, click Reports.
Click Cross Section Plot, the Cross Section dialog (Figure 8) opens. The Cross Section plot displays the 
computed results (i.e., maximum water surface elevation; energy grade) at the selected cross section (14.28). To 
view other cross sections, manipulate the River, Reach, and River Sta. lists (Figure 8). For further details on this 
HEC-RAS report, refer to the HEC-RAS User's Manual (Chapter 9). 
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3. From the File menu, click Exit, and the Cross Section dialog closes (Figure 8).

14.7.8 X-Y-Z 3-D Plots
Once an HEC-RAS compute is complete, you can review multiple cross section within a reach from an X-Y-Z 3-D plot for 
the selected HEC-RAS model alternative. To view an X-Y-Z 3D plot:

From the Modeling module, to view multiple cross section within a reach, make sure you have an active forecast 
and at least one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, 
select an HEC-RAS model alternative (Russian River Real-Time), from the Forecast tabs, click Reports.
Click X-Y-Z 3-D Plot, the X-Y-Z Perspective Plot dialog (Figure 9) opens. The 
X-Y-Z Perspective Plot displays multiple cross section within a reach. You can select which reaches to be 
plotted; the range of the cross sections (Upstream RS, Downstream RS lists); and, which HEC-RAS pans and 
profiles will be displayed. For further details on this HEC-RAS report, refer to the HEC-RAS User's Manual 
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(Chapter 9). 

From the File menu, click Exit, and the X-Y-Z Perspective Plot dialog closes (Figure 9).

14.7.9 General Profile Plot
Once an HEC-RAS compute is complete, for a profile, you might want to plot variables other than water surface profile. 
Any variable that is computed at a cross section can be displayed in a profile. To view a general profile plot:

From the Modeling module, to view a general profile plot, make sure you have an active forecast and at least one 
forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-RAS 
model alternative (Russian River Real-Time), from the Forecast tabs, click Reports.
Click General Profile Plot, the General Profile Plot - Velocities dialog (Figure 10) opens. The General Profile 
Plot - Velocities displays velocity versus distance for a profile by default. There are predefined plots from the 
Standard Plots menu (Figure 10) the you can plot (i.e., flow, area, top width, weighted n, Froude number, 
hydraulic depth, shear, surface area, volume, steam power). For further details on this HEC-RAS report, refer to 
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the HEC-RAS User's Manual (Chapter 9). 

You can also create your own plots, from the Options menu (Figure 10), click Plot Variables. The Y Axis Variable
dialog will open, from the Y Axis Variable dialog you choose which variables to plot and then save the plot (User 
Plots) for future use. For further details on this HEC-RAS report, refer to the HEC-RAS User's Manual (Chapter 9).
From the File menu, click Exit, and the General Profile Plot - Velocities dialog closes (Figure 10).

14.7.10 Hydraulic Properties Tables
Once an HEC-RAS compute is complete, you can view the computed curves based on the hydraulic table parameters 
that have been entered for the cross section and structures, for the selected HEC-RAS model alternative. To view 
hydraulic table curves:

From the Modeling module, to view hydraulic table curves, make sure you have an active forecast and at least 
one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-
RAS model alternative (Russian River Real-Time), from the Forecast tabs, click Reports.
Click Hydraulic Properties Table, the View Hydraulic Property Tables dialog (Figure 11) opens. The View 
Hydraulic Property Tables default plot displays curves for each variable that you have selected by cross section 
(14.28). Click Variables (Figure 11), from the available list you can turn on/off what variables to plot. To view 
other cross sections, manipulate the River, Reach, and Riv Sta lists (Figure 11). For further details on this HEC-
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RAS report, refer to the HEC-RAS User's Manual. 

From the Type menu (Figure 11), you can change the type of values that are displayed. You have a choice 
between cross sections, internal boundaries, and storage area connections. For further details on this HEC-RAS 
report, refer to the HEC-RAS User's Manual (Chapter 9). From the File menu, click Exit, and the View Hydraulic 
Property Tables dialog closes (Figure 11).

14.7.11 RAS Mapper Results
Within the HEC-RAS software application, when performing an unsteady flow analysis, RAS Mapper is a tool that you can 
use to be build various type of inundation maps (Depth(max), Velocity(max), WSE(max), D*V(max), Arrival Time). If the 
HEC-RAS model alternative in an HEC-RTS forecast run, includes running RAS Mapper, and an HEC-RTS forecast 
compute is successfully, then you will have inundation map(s) that you could view in the Map Window. To view RAS 
Mapper inundation maps:

From the Modeling module, to view RAS Mapper inundation maps, make sure you have an active forecast and at 
least one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an 
HEC-RAS model alternative (Russian River Real-Time), from the Forecast tabs, click Reports.
From the Reports section, there are three buttons – Depth (Max), D_V(Max), and Arrival Time (2ft hrs). These 
buttons are toggles, which will cause the RAS Mapper inundation maps to display in the Map Window (Figure 
12). For example, in Figure 12, you have clicked Arrival Time (2ft hrs), which will cause the associated 
inundation map to display. If you click Arrival Time (2ft hrs) again, the inundation map will no longer display. 
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For further details on the RAS Mapper tool, refer to the HEC-RAS User's Manual (Chapter 20). 

14.8 HEC-FIA Results
HEC-FIA may be used in HEC-RTS to predict the consequences associated with conditions predicted with HEC-HMS, 
HEC-ResSim, and HEC-RAS. This section briefly describes the HEC-FIA reports accessible from the CAVI. For more detail 
about the reports, please see the HEC-FIA users manual.

14.8.1 Individual Structure Damage Report
The Individual Structure Damage Report (Figure 1) provides information by individual structure, this information 
includes structure, content, car, other, total damage for each structure, depth of flooding, population at risk (day and 
night), percent not mobilized, percent caught evacuating, percent clear, and loss of life (day and night) information is 
also available for each structure. If your alternative is set to run a deterministic computation, this will display a single 

https://www.hec.usace.army.mil/software/hec-fia/documentation/HEC-FIA_31_Users_Manual_2019-Dec.pdf
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deterministic answer. However, if your HEC-FIA model alternative is set to run a Monte Carlo computation, this report 
will display the average for all iterations.

To view the Individual Structure Damage Report:

78 Figure 1 HEC-FIA - Individual Structure Damage Report

From the Modeling module, to view the Individual Structure Damage Report, make sure you have an active 
forecast and at least one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail
section, select an HEC-FIA model alternative (Real-Time), from the Forecast tabs, click Reports.
Click Individual Structure Damage Report, the Individual Structure Damage Report (Figure 1) opens. The 
Individual Structure Damage Report displays by structure the damages, flooding depth, life loss and other 
consequences associated with the defined forecast. For further details on this HEC-FIA report, refer to the HEC-
FIA User's Manual.
From the File menu, click Close, and the Individual Structure Damage Report closes (Figure 1).

14.8.2 Aggregated Consequence Damages
The Aggregated Consequence Report (Figure 2) allows you to view damage by emergency planning zones, damage 
categories, and structure occupancy types. The report provides an Urban Damage Summary; Structures Flooded 
Summary; Agriculture Summary; Life Loss Report, and, a Summary Report.
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79 Figure 2 HEC-FIA - Aggregated Consequence Report - Urban Damage Summary

To view the Urban Damage Summary:

From the Modeling module, to view urban damage summary, make sure you have an active forecast and at least 
one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-
FIA model alternative (Real-Time), from the Forecast tabs, click Reports.
Click Aggregated Consequence Damages, the Urban Damage Summary (Figure 2) opens. The Urban Damage 
Summary report displays, by default the Economic damage (Economic tab) by Emergency Planning Zones
(View By). This report provides structure damage, content damage, car damage, other damage, and total 
damage by emergency planning zones.
From the View By list (Figure 2) you can also view the Urban Damage Summary by Damage Category and 
Occupancy Type.
To close the Urban Damage Summary, click Close, and the Aggregated Consequence Report will close (Figure 
2).

To view the Structures Flooded Summary:

From the Modeling module, to view structures flooded summary, make sure you have an active forecast and at 
least one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an 
HEC-FIA model alternative (Real-Time), from the Forecast tabs, click Reports.
Click Aggregated Consequence Damages, the Urban Damage Summary (Figure 2) opens. Click the Structure
tab, the Structures Flooded Summary displays (Figure 3), by Emergency Planning Zones. This report provides 
structure damage, content damage, car damage, other damage, and total damage by emergency planning 
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zones. 

From the View By list (Figure 3) you can also view the Structures Flooded Summary by Damage Category and 
Occupancy Type.
To close the Structures Flooded Summary, click Close, and the Aggregated Consequence Report will close 
(Figure 2).

To view the Agriculture Summary:

From the Modeling module, to view agriculture summary, make sure you have an active forecast and at least one 
forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-FIA 
model alternative (Real-Time), from the Forecast tabs, click Reports.
Click Aggregated Consequence Damages, the Urban Damage Summary (Figure 2) opens. Click the Agriculture
tab, the Agriculture Summary displays (Figure 4), by Emergency Planning Zones. This report provides total 
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crop damage and total acreage flooded by emergency planning zones. 

From the View By list (Figure 4) you can also view the Agriculture Summary by Damage Category and 
Occupancy Type.
To close the Agriculture Summary, click Close, and the Aggregated Consequence Report will close (Figure 4).

To view the Life Loss Report:

From the Modeling module, to view the life loss report, make sure you have an active forecast and at least one 
forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-FIA 
model alternative (Real-Time), from the Forecast tabs, click Reports.
Click Aggregated Consequence Damages, the Urban Damage Summary (Figure 2) opens. Click the Life Loss
tab, the Life Loss Report displays (Figure 5), by Emergency Planning Zones. This report provides life loss and 
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total population by emergency planning zones. 

From the View By list (Figure 5) you can also view the Life Loss Report by Damage Category and Occupancy 
Type.
To close the Life Loss Report, click Close, and the Aggregated Consequence Report will close (Figure 5).

To view the Summary Report:

From the Modeling module, to view the summary report, make sure you have an active forecast and at least one 
forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-FIA 
model alternative (Real-Time), from the Forecast tabs, click Reports.
Click Aggregated Consequence Damages, the Urban Damage Summary (Figure 2) opens. Click the Summary
tab, the Summary Report displays (Figure 6), by Emergency Planning Zones. This report provides information 
on urban damage, agricultural damage, total damage, acreage flooded, structures floods, and population 
impacted.
From the View By list (Figure 6) you can also view the Summary Report by Damage Category and Occupancy 
Type. 
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4.To close the Summary Report, click Close, and the Aggregated Consequence Report will close (Figure 6).

14.8.3 Detailed Life Loss Report
The Detailed Life Loss Report is dependent on the HEC-FIA model alterative being setup to compute life loss. This 
report provides information about how HEC-FIA calculated life loss for the watershed.

To view the Detailed Life Loss Report:

From the Modeling module, to view the Detailed Life Loss Report, make sure you have an active forecast and at 
least one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an 
HEC-FIA model alternative (Real-Time), from the Forecast tabs, click Reports.
Click Life Loss, the Detailed Life Loss Report (Figure 7) displays by Total. The Detailed Life Loss Report
provides information about how HEC-FIA calculated life loss for the watershed. For further details on this HEC-
FIA report, refer to the HEC-FIA User's Manual.
From the View By list (Figure 7) you can also view the Detailed Life Loss Report by Emergency Planning Zone, 
Damage Category, and Occupancy Type.
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To close the Detailed Life Loss Report, click Close, and the Detailed Life Loss Report dialog will close (Figure 
7). 

14.8.4 ECAM Reports
The ECAM Report is dependent on the HEC-FIA model alterative being setup to compute life loss and ECAM. For the 
example HEC-RTS watershed being used in this User's Manual, the HEC-FIA model alternative (Real-Time) is not setup 
for an ECAM compute, therefore no results.

To view ECAM reports:

From the Modeling module, to view the ECAM reports, make sure you have an active forecast and at least one 
forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, select an HEC-FIA 
model alternative (Real-Time), from the Forecast tabs, click Reports.
There are two ECAM reports (tabs) - Output and Employment. When the Output tab is selected, the ECAM 
Indirect Economics Output Report displays. The ECAM Indirect Economics Output Report provides 
information about the output of the economy, by sector (e.g., forestry, food processing, general manufacturing, 
etc.) for a selected county (County list). When the Employment tab is selected, the ECAM Indirect Economics 
Employment Report displays. The ECAM Indirect Economics Employment Report provides information 
representing the changes in labor employed by sector (e.g., forestry, food processing, general manufacturing, 
etc.) for a selected county (County list).
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3. To close either ECAM report, click Close, and the ECAM report will close. For further details on this HEC-FIA 
report, refer to the HEC-FIA User's Manual.

14.8.5 Impact Response By Rule Report
The Impact Response By Rule Report is dependent on the HEC-FIA model alterative having an impact response 
element defined. This report displays the hydrograph at the location of the rule, and the threshold elevation relative to 
the hydrograph. The Impact Response By Rule Report displays each rule independently.

To view the Impact Response by Rule Report (Figure 8):

80 Figure 8 HEC-FIA - Impact Response by Rule Report
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From the Modeling module, to view the Impact Response by Rule Report, make sure you have an active 
forecast and at least one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail
section, select an HEC-FIA model alternative (Real-Time), from the Forecast tabs, click Reports.
Click Impact Response By Rule, a dialog will open (Figure 8). From the list at the top of the dialog (Figure 8), 
select which rule you would like to review (e.g., Russian River near Hopland Moderate Flood Stage (Gage 24.00)). A 
plot of the hydrograph at the location of the rule is displayed (Figure 8). In addition, both the Impact and 
Response boxes provide details. For further details on this HEC-FIA report, refer to the HEC-FIA User's Manual.
To close the Impact Response By Rule Report, click OK, and the dialog will close (Figure 8).

14.8.6 Critical Infrastructure Report
The Critical Infrastructure Report is dependent on the HEC-FIA model alterative having a critical infrastructure 
inventory defined. The report only includes critical infrastructure elements which were inundated.

To view the Critical Infrastructure Report:

From the Modeling module, to view the Critical Infrastructure Report, make sure you have an active forecast 
and at least one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, 
select an HEC-FIA model alternative (Real-Time), from the Forecast tabs, click Reports.
Click Critical Infrastructure, the Critical Infrastructure Report (Figure 9) displays. For each critical 
infrastructure, the Critical Infrastructure Report provides information about elevations at ground, water 
surface, depth, arrival, and duration. For further details on this HEC-FIA report, refer to the HEC-FIA User's 
Manual. 

To close the Critical Infrastructure Report, click Close, and the Critical Infrastructure Report will close 
(Figure 9).
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14.8.7 Flood Damage Reduction Reports
The flood damage reduction reports are dependent on the HEC-FIA model alterative being setup with the necessary 
hydraulic data and holdout inundation configuration. For the example HEC-RTS watershed being used in this User's 
Manual, the HEC-FIA model alternative (Real-Time) is not setup properly for generating flood damage reduction reports.

To view flood damage reduction reports:

From the Modeling module, to view the flood damage reduction reports, make sure you have an active forecast 
and at least one forecast run selected (checkbox) for viewing results. From the Forecast Runs Detail section, 
select an HEC-FIA model alternative (Real-Time), from the Forecast tabs, click Reports.
Click Flood Damage Reduction Aggregated Report, the Flood Damage Reduction Aggregated Report
displays. The Flood Damage Reduction Aggregated Report by default displays the computed impacts by the 
holdout distribution area and by reservoirs for the structure damage reduction allocation.
Click Flood Damage Reduction Project Report, the Flood Damage Reduction Project Report displays. The 
Flood Damage Reduction Project Report by default displays the computed impacts by project and by 
reservoirs for the structure damage reduction allocation. For each project damage reduced is reported, and 
whether a project is a USACE project or not.
To close either flood damage reduction reports, click Close, and the flood damage reduction report will close. 
For further details on this HEC-FIA report, refer to the HEC-FIA User's Manual. 



HEC-RTS User Manual  – Configuring HEC-RTS

Configuring HEC-RTS –  187

15 Configuring HEC-RTS
In this chapter, we describe a workflow to configure the model alternatives within HEC-RTS. This workflow description 
assumes previous development of the HEC-RTS study and the individual models in their native software applications 
(HEC-HMS, HEC-ResSim, HEC-RAS, and HEC-FIA) are complete.

15.1 Setting Up Your HEC-RTS Study
In HEC-RTS, you setup a watershed to reflect a collection of data, information, application models and images that 
represent a watershed and water control features within a watershed. The basic setup of your HEC-RTS study is done in 
the Setup module (Figure 1) of HEC-RTS. You will setup items that describe a watershed's physical arrangement. When 
you create a new watershed, a directory structure is generated where all files associated with the watershed are stored.

Once you have created a new watershed, you are able to import maps from external sources, specify the unit system 
and time zone for the watershed, add layers containing additional information about the watershed such as streams. 
This chapter will discuss the main items that you will be doing in the Setup module: create watersheds; define the 
computing sequence for forecast runs; create time series icons; create time series layers; import and define keys for 
model alternatives; create forecast runs; setup the model linking between model alternatives in a forecast run; and, 
manage extract and post groups. For further details, refer to Setup Module.
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15.2 Defining the Order of Application Programs
The order of program execution within HEC-RTS is a fundamental part of the watershed setup, which you defined from 
the Setup module. You need to decide on the program order (Figure 1) early on in your setup, and if you change the 
order after a forecast has been configured, then the flow of data will be disrupted and results will be invalidated. Refer 
to Program Order for additional details for defining the order for application programs.

15.3 Developing Time Series Icons
You develop time series icons in the Map Window of the Setup module. Time series icon are used by the other modules 
to display data and information availability. The information can be time series data, images, web pages, webcams, 
scripts, and document files. You can link time series icons to data from DSS files. Time series icons provide you easy 
access to analyzing incoming data and for providing location specific information.

You can represent time series icons as symbols, thumbnail plots, or color-coded data quality bars. You should define 
and setup the time series icons early in the watershed development so data can be readily viewed. Occasionally, you 
may need to make changes to the time series icons to accommodate additional data development. Refer to Time Series 
Icons and Time Series Icons Layers for additional information describing time series icons.
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15.4 Developing Model Alternatives
A model alternative is a single configuration with a specific set of input and parameters. A second model alternative 
would be defined by a different configuration, different input, or different parameters. Since model alternatives do not 
include time-specific data, you can use a model alternative with any time window.

Initially, you develop alternatives using the software of the native model (e.g., HEC-HMS, HEC-ResSim, HEC-RAS, and 
HEC-FIA). Then, you import these alternatives into HEC-RTS. Once the model alternatives have been imported, from the 
Setup module you can configure and edit specific model alternatives for use in HEC-RTS.

For example, since MFP deals with future precipitation, you can configure model alternatives to use in conjunction with 
HEC-HMS to compute a variety of future precipitation scenarios. Since HEC-HMS simulates watershed response to 
precipitation, then you can use HEC-HMS alternatives to forecast future flows. These future flows can be used with the 
reservoir software application HEC-ResSim, to compute reservoir releases. Regulated flows and stages from HEC-
ResSim can be input to HEC-RAS and HEC-FIA model alternatives. Basically, all individual model alternatives created in 
the native programs are available to HEC-RTS.

In the Setup module, you will create model alternative keys that will be used in creating a forecast run. Each key is a 
single alpha-numeric identifier that represents a model alternative. For example, the Key N might represent normal 
conditions, the Key W might represent wet conditions, and the Key D might represent dry conditions. Refer to Model 
Alternatives and Forecast Runs for additional information on model alternatives.

15.5 Creating Forecast Runs
A forecast run is a single forecast scenario defined by a specific set of data, information, and model alternatives. You 
create forecast runs in the Setup module. You use the previously defined model alternative keys to create a forecast run 
key that consists of a collection of the model alternative keys.

As an example, you might name a forecast run MFP-HMS-ResSim. For this example, the forecast run key might be 
R0B0N0---- which could reflect Radar precipitation data for MFP, Base data for HEC-HMS, and Normal Operations for 
HEC-ResSim. In this example, the dashes indicate that HEC-RAS and HEC-FIA are not being run. Refer to Model 
Alternatives and Forecast Runs for additional information on forecast runs.

15.6 Linking Models
After a forecast run has been created you need to link the models, which is accomplished through the Model Linking 
Editor (Figure 1). From this editor you select a forecast run you wish to configure. Then you select each model 
alternative that is associated with the selected forecast run. For each model alternative you will determine where you 
will be getting data from another model alternative. For example, in Figure 1, you specify which model alternative the 
input comes from and the DSS pathname associated with the model results. For example, you may set the precipitation 
input data for HEC-HMS to come from an MFP precipitation grid. Refer to Model Linking Editor for additional 
information on model linking.
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15.7 Data Extract and Posting
Once the models have been linked the next step is to configure the data extract groups. A data extract group specifies 
the location of the gridded and time series data required for the different model alternatives. For example, this could be 
gridded precipitation data in DSS or observed flow data from another DSS file. Once you have completed computing 
your forecast, you might want to post results back to the HEC-RTS DSS study file. This task is completed by creating 
post groups that specify what time series data needs to be save. Refer to Data Extract and Post Editors for additional 
information.
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16 Setup Module
In HEC-RTS, a watershed is a set of data, information, models, and images that represent watershed lands and the 
channels, gages, and water control features within the watershed. The Setup module is the grouping of commands for 
watershed setup. These are commands for configuring inputs, models, and outputs that describe a watershed's 
behavior. You develop a visual representation of the watershed to display in HEC-RTS that is map-based. This chapter 
describes the Setup module, which includes an overview of the Setup module interface, how to create a new 
watershed, and reports on watershed setup.

In the Setup module, you configure a watershed's physical arrangement, including maps and geo-extents, time series 
icons, and other geo-referenced data. Once you have setup a watershed, you will be able to use the data you have 
defined within HEC-ResSim, HEC-FIA, and other geo-referenced HEC-RTS applications.

Because the order of program execution (Program Order) is a fundamental part of the watershed setup, you should 
define it early in the process of constructing datasets for your watershed. You establish the program order in the Setup 
module. This involves determining the set of programs that HEC-RTS might execute, the order of program execution, 
and the data flow for forecasting. You may also define supplemental software applications and add the supplemental 
software applications to the program order. A supplemental program is a software application or script that you 
develop and by default is not included with HEC-RTS.

16.1 Setup Module Overview
The Setup module is the grouping of commands for configuring an HEC-RTS watershed. From the HEC-RTS main 
window, click the Setup tab (Figure 1). A detailed discussion of common screen components is presented in HEC-RTS 
Interface. The Setup tab (Figure 1) displays the name of the watershed, the tree of the watershed, and the schematic of 
the watershed. The following sections provide an overview of the Setup module interface.
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81 Figure 1 Setup Module

16.1.1 Menu Bar
The following is an overview of the Menu Bar (Figure 1) for the Setup module. The File, View, Maps, Scripts, Tools, 
Window, and Help menus and their commands are common to all modules and are discussed in HEC-RTS Main 
Window.

Water
shed

From this menu, you can view the watershed properties; view a tree of the watershed files; manage stream 
reach aliases; view a list of the streams in the watershed; import or export stream alignment files (refer to 
Stream Alignment); import a CWMS 2.1 watershed; and, team modeling. The available commands are: 
Watershed Properties, Files, Stream Reach Alias Editor, List of Streams, Stream Alignment (refer to 
Stream Alignment), Import 2.1 Watershed, and Team.
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Model
s

From this menu you can review the steps of the Setup module; establish the program order; import model 
alternatives; specify model alternative keys; configure forecast runs; setup model linking; and, access the 
extract and post editors. Available commands are: Next Steps, Program Order, Import, Model 
Alternative Keys, Forecast Runs, Model Linking, Edit Extract, Edit Post, and commands related to 
models configured in the watershed (e.g., HMS).

16.1.2 Map Window
The map window in the Setup module (Figure 1) displays a schematic of the watershed. Depending on where you are at 
in the creation of a watershed, the map window will display the current status of the watershed. From the Watershed 
Tree, you can also influence what is displayed in the Setup module map window. The map window tools allow the user 
to access and configure elements (time series icons, stream alignment, stream nodes) within your watershed. A 
description of the map and stream alignment tools is included in Map Window.

16.1.3 Watershed Tree
The Watershed Tree (Figure 2) provides a visual of the selected watershed in a tree format. At the top of the tree is the 
name of the watershed (WS10_HEC_Russian River). There are three main nodes (folders) to the watershed tree – Models, 
Stream Alignments, and Forecast Runs. You can expand ( ) or collapse ( ) the folders to view further details 
about the selected watershed. For example, in Figure 1, the Forecast Runs folder has been expanded, which displays 
the available forecast runs for the watershed. Double-click on a forecast run (Daily – Interpolated Obs and Manual Entry 
QPF), the map window (Figure 1) will now display the schematic for the selected forecast run.

82 Figure 2 Watershed Tree

16.1.4 Content Pane
The Content Pane (Figure 3) displays information based on selections made in the Watershed Tree. For example, in 
Figure 2, a forecast run (Daily – Interpolated Obs and Manual Entry QPF) has been selected. The Content Pane (Figure 3) 
displays information about the forecast run that includes the name of the forecast run, the key code of the forecast run, 
and the model alternatives that make-up the forecast run.
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83 Figure 3 Content Pane

16.2 Creating a Watershed
The first thing you must do when creating a watershed is to give the watershed a name and description, specify the 
watershed's location, and establish the system of units and the time zone for the watershed. Once you have configured 
the new watershed, HEC-RTS generates a new directory hierarchy in the specified watershed directory. The new 
watershed becomes active in the main window, and the tools needed to configure watershed components become 
available. At this point you may continue to configure the new watershed by adding layers, setting preferences for the 
map window, creating time series icons, establishing the database connectivity, and configuring models and model 
alternatives.

To create a watershed:
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From the HEC-RTS main window, click on the Setup tab (Setup Module), from the File menu, click New 
Watershed. The Create New Watershed dialog (Figure 1) will open. 

From the Watershed box (Figure 1), enter a name for the watershed. The watershed name must be less than 
thirty-two (32) characters and cannot contain any of the following characters: , | / : * ? " < > - {}.
Enter a description for the new watershed in the Description box that clearly explains what it is.
From the Watershed Location list, select the watershed location to save the new watershed or add a new 
location.
For system units, select either English (U.S. customary units) or SI (System International) from the Unit System
list. System units cannot be changed once a watershed is created.
To add map layers to a watershed, click Add Map Layers button, a Select Map to Add browser (Figure 2) will 
open. To save the selected map layers to the watershed's map folder, be sure that Create Copy (Figure 2) has 
been selected. Browse to the location where map layers for the watershed are located. Select a map layer(s), 
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8.

click Open, the Select Map to Add browser will close. 

A Set Watershed Coordinate System window (Figure 3) will open. This window asks would you like to set the 
watershed's coordinate system to the selected map layer's coordinate system. If you click Yes, the Set 
Watershed Coordinate System window will close, and in the Coordinate System box (Figure 1), the watershed 
coordinate system is displayed, skip Step 8. If you click No, the Set Watershed Coordinate System window will 
close, and no coordinate system will be set for the watershed, you will need to do Step 8. 

To set the coordinate system of the watershed, click Edit (Figure 1), the Map Coordinate Information dialog will 
open (Figure 4). Click Load from file, an Open browser will open. Browse to the location of watershed maps, 
click on a .prj file that is associated with a map layer that is in the correct coordinate system. Click *Open, 
the Open browser will close, and the Map Coordinate Information dialog (Figure 4) will display the coordinate 
system. Click OK, the Map Coordinate Information dialog will close, and the Coordinate System box (Figure 1) 
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10.

will display the selected coordinate system. 

For the watershed time zone, by default, U.S. Time Zones is selected. From the list (Figure 5), there are eight 
choices. Select the time zone appropriate for your watershed. See Specifying Time Zones for further discussion 
on time zones. 

Click OK, the Create New Watershed dialog (Figure 1) will close. A Watershed Summary dialog will open 
(Figure 6), which will provide you with information about the watershed that is being created. Review this 



HEC-RTS User Manual  – Setup Module

Setup Module
                             – 

11.

information, click OK, the Watershed Summary dialog will close (Figure 6). 

The watershed will be created and the Next Steps dialog (Figure 7) will open. This dialog provides with 
information on the next steps to take to configure your new watershed. 

16.3 Import a CWMS Version 2.1 Watershed
An option of importing a CWMS Version 2.1 watershed into HEC-RTS Version 3.1.1 is available during the creation of a 
watershed. From the Create New Watershed dialog, next to the Import CWMS 2.1 Watershed box, click Browse, a 
Select Workspace File browser will open (like Select Map to Add Browser). Browse to the location of a CWMS Version 
2.1 watershed, select a .wksp, click *Select. The Select Workspace File browser will close, from the Create New 
Watershed dialog click OK. The Watershed Summary dialog will open, click OK. The Import CWMS 2.1 Watershed
dialog will open, when the import is complete, click Close. The watershed will be created and the Next Steps dialog will 
display. This dialog provides with information on the next steps to take to configure your new watershed. Further 
details on importing a CWMS watershed is provided in Model Alternatives and Forecast Runs.

16.4 Specifying Units
All modeling data and information, time series data, geometric and reservoir information must use the same system 
units. Therefore, it is crucial that you are certain of the units when you specify either English or SI as the unit system for 
your watershed when you create the watershed. The watershed system units cannot be changed once a watershed has 
been created.
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16.5 Specifying Time Zones
When a new watershed is configured, you must select the appropriate time zone that is representative of the 
watershed. This typically would be the time zone for the outlet or a major portion of the watershed. Internally, HEC-RTS 
will store time series data using the fixed "standard time offset from GMT" for the selected watershed time zone. Thus, 
internally, the data will be held in standard time only. However, when viewing data or model results, you may select 
local or any other time zone for display purposes (which provides standard and daylight time labels, as appropriate, 
throughout the year). The default time zone setting is U.S. Time Zones. If your watershed is outside the United States, 
you can change your time zone setting. In the Create New Watershed dialog, select the International Time Zones. The 
list will now contain time zones for the world.

NOTE: You cannot change the watershed time zone once a watershed has been created. However, at any time you can 
customize the display of data from the View menu (HEC-RTS Main Window).

16.6 Watershed Properties
Once you have your watershed created, you can review the basic properties of the watershed. From the Setup module, 
from the Watershed menu, click Watershed Properties. The Watershed Properties dialog (Figure 1) will open. 
Information about the watershed is provided and includes the watershed name; watershed description; the watershed 
filename (WS10_HEC_RussianRiver.wtrshd); selected unit system; coordinate system for the watershed; watershed time 
zone; user who created the watershed; and, the date and time when the watershed was created.

To the right of the Watershed File box (Figure 1), click , a Windows File Explorer will open, displaying the 
directory and file structure for the watershed. The Watershed Properties dialog (Figure 1) also contains two tabs - Map 
Properties and Team. The Map Properties tab is selected by default, this allows you to synchronize or not synchronize 
map windows; to either display a grid or not on map window; and to change the background color of map windows. The 
default background color of map windows is white, to change the color, to the right of Background Color (Figure 1), 
click  , a Color Chooser will open which will allow you to change the background color of map windows.
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84 FIgure 1 Watershed Properties Dialog

The Team tab (Figure 2) is setup for the HEC-RTS Team Modeling concepts for collaboration between modelers working 
with the same watershed and forecast. From this tab, if you want the watershed to be available to other modelers, you 
will select Team Watershed, and define the network location of the master watershed. Further information and details 
about the team modeling concept in HEC-RTS is provided in Team Modeling.

85 Figure 2 Watershed Properties Dialog - Team Tab
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16.7 Setup Module - Team Modeling
Team modeling facilitates collaboration between modelers working with the same watershed and forecasts. Multiple 
modelers may be sharing responsibility within a complex watershed containing several models. One modeler may only 
be responsible for the HEC-HMS model, while another modeler may be responsible for HEC-ResSim and HEC-RAS 
models. Team modeling allows each modeling team member to contribute expertise and participate in real-time 
synchronized activities. Team modeling consists of a master watershed and its associated forecasts, which are stored in 
a shared location (such as a networked drive). Team members share data by uploading and downloading changes to 
and from a master watershed, interacting with a local copy that resides on their computer. When watershed files are 
updated on the master watershed, team members working on the same watershed are notified of the changes by a real-
time notification system. For further details on team modeling refer to Team Modeling.

16.8 Configuring a Watershed
Now that a watershed has been created you will need to configure the watershed. Configuration steps include: define 
the program order; create time series icons; create time series layers; import model alternatives; define keys for model 
alternatives; create forecast runs; setup the model linking between model alternatives in a forecast run; and, manage 
extract and post groups. The following sections provide further information on the configuration of your watershed.

16.8.1 Program Order
The order of program execution within HEC-RTS is a fundamental part of the watershed setup, which you define from 
the Setup module. You need to decide on the program order early on in your setup, and if you change the order after a 
forecast has been configured, then the flow of data will be disrupted, and results will be invalidated. Refer to Program 
Order for additional details for defining the order for application programs.

16.8.2 Developing Time Series Icons
You develop time series icons in the Map Window of the Setup module. Time series icons are used by the other modules 
to display data and information availability. The information can be time series data, images, web pages, webcams, 
scripts, and document files. You can link time series icons to data from DSS files. Time series icons provide you easy 
access to analyzing incoming data and for providing location specific information. Refer to Time Series Icons and Time 
Series Icons Layers for additional information describing time series icons.

16.8.3 Import Model Alternatives
There are two methods for importing model alternatives into your waters. Import a CWMS Version 2.1 Watershed
describes importing an entire watershed, which includes model alternatives. From the Setup module, you can import 
model alternatives separately for each software application that will be used in your watershed. From the Setup 
module, from the Models menu, point to Import, click on the software application that you want to import a model 
alternative into your watershed. Another way is from the Watershed Tree, under the Models folder, right-click on the 
software application that you want to import a model alternative into your watershed. Refer to Model Alternatives and 
Forecast Runs for further details.
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16.8.4 Create Model Alternative Keys
A model alternative is a single configuration with a specific set of input and parameters. A second model alternative 
would be defined by a different configuration or different input or parameters. Since model alternatives do not include 
time-specific data, you can use a model alternative with any time window. In the Setup module, you will create model 
alternative keys that will be used in creating a forecast run. Each key is a single alpha-numeric identifier that represents 
a model alternative. Refer to Model Alternatives and Forecast Runs for additional information.

16.8.5 Create Forecast Runs
A forecast run is a single forecast scenario defined by a specific set of data, information, and model alternatives. You 
create forecast runs in the Setup module. You use the previously defined model alternative keys to create a forecast run 
key that consists of a collection of the model alternative keys. Refer to Model Alternatives and Forecast Runs for 
additional information.

16.8.6 Link Models Alternatives
After a forecast run has been created you need to link the models, which is accomplished through the Model Linking 
Editor. From this editor you select a forecast run you wish to configure. Then you select each model alternative that is 
associated with the selected forecast run. For each model alternative you will determine where you will be getting data 
from another model alternative or from an extract list. Refer to Model Linking Editor for additional information.

16.8.7 Data Extract and Posting
Once the models have been linked the next step is to configure the data extract groups. A data extract group specifies 
the location of the gridded and time series data required for the different model alternatives. For example, this could be 
gridded precipitation data in DSS or observed flow data from the HEC-RTS main DSS file. Once you have completed 
computing your forecast, you might want to post results back to the HEC-RTS main DSS file. This task is completed by 
creating post groups that specify what time series data needs to be save. Refer to Data Extract and Post Editors for 
additional information. 
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17 Program Order
HEC-RTS allows for a flexible set of software applications (programs), computation order, and data flow for forecasting. 
The order of execution of software applications is a fundamental part of the watershed setup. You can also define 
supplemental programs and add them to the computation order so that they are executed from HEC-RTS. The program 
order is defined in the Setup module. This chapter provides details on the program order.

17.1 Establishing Program Order
HEC-RTS generates a default program order (Figure 1) that contains HEC software applications. If you change the order 
of programs after a forecast run has been configured, you may disrupt the orderly flow of data and the results and 
invalidate any existing work. For HEC-RTS Version 3.1.1, during the creation of a forecast run, the only program order 
that you can select is the default program order.

17.2 Program Order Dialog
To change, delete, or add software applications to a watershed's program order, you use the Program Order dialog. 
The Program Order dialog also establishes computation order and data flow for forecasting. In addition, the Program 
Order dialog provides the mechanism for defining supplemental programs, adding the supplemental programs to the 
program order, and establishing data flow for supplemental programs. To access the Program Order dialog, from the 
HEC-RTS main window, click on the Setup tab, from the Model menu, click Program Order. The Program Order
dialog will open.
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17.3 HEC Software Applications in the Program Order
By default, the program order for a watershed is: MFP, HMS, ResSim, RAS, and FIA. Additional software applications or 
plugins may also be added or removed from the program order, along with additional HEC software applications.

17.3.1 Add an HEC Program
The default program order is displayed in the table on the Program Order dialog. To add an HEC software application:

Click a row on the table of the Program Order dialog where you would like to add the program.
From the Edit menu, click either Insert Before or Insert After. The Select Program dialog opens (Figure 1).

From the Name list, select a program, click OK. The Select Program dialog will close, and the selected software 
application will display in location you selected in the table.
Click Apply, a Confirm Save window will display (Figure 2). This window is warning you that changing a program 
order after it is being use can affect existing forecast runs.

 
Click Yes, the Confirm Save window will close. You now have added a software application to the program 
order.

17.3.2 Remove an HEC Program
To remove an HEC program from the program order: 

Click a row on the table of the Program Order dialog where you would like to remove a program.
From the Edit Menu, click Remove. A Confirm Removal window will display asking you if it is okay to remove 
the program from the program order. Click Yes, the Confirm Removal window will close.
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The selected row has been deleted from the table. A Confirm Save window will display (Figure 2). This window is 
warning you that changing a program order after it is being use can affect existing forecast runs.
Click Yes, the Confirm Save window will close. You now have removed a software application from the program 
order.

17.4 Supplemental Program in the Program Order
You can define supplemental programs that can be added to the program order. A supplemental program is a software 
application that is not included with HEC-RTS. A supplemental program is usually something that has been created by 
you or your office for use in water control management forecasting. For example, an office might have a locally 
developed software application that is used to model the unsteady flow regime of one or more rivers. This software 
application, and the river model associated with it, could be used in addition to or in place of HEC-RAS in the program 
order.

17.4.1 Supplemental Program Interface
A supplemental program must adhere to a specific interface for communicating with HEC-RTS during the execution of a 
forecast. This interface includes how to receive arguments for the supplemental program from HEC-RTS, how to output 
messages to the forecast compute log, and how to inform HEC-RTS about the exit status of the supplemental program.

17.4.1.1 Receiving Arguments
During a forecast computation, HEC-RTS executes a supplemental program by running its executable with a single 
command line parameter. The parameter is the fully qualified name of a file that contains the arguments for the 
supplemental program. This arguments file contains standard HEC-RTS arguments in keyword=value format – one 
keyword/value pair per line – plus any alternative-specific arguments defined for the supplemental program model 
alternative being executed. 

The standard HEC-RTS argument keywords available in the arguments file are listed:

ComputeType Type of computation, "Forecast" for HEC-RTS

ProgramName Supplemental program name

ProgramAlternative  Supplemental program model alternative name

ModelAlternative  Model alternative identifier

Alternative  Forecast run identifier

RunTimeWindow Lookback, forecast, and end times of forecast
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IOTimeStep Interval of data in a forecast DSS file

TimeZoneOffset Offset in hours from UTC to watershed time zone

InputPosition  Number of characters contained in the InputFPart name

ModelPosition  Number of characters contained in the OutputFPart name

ForecastPath Forecast directory of current forecast

ForecastDSSFile Fully qualified name of forecast HEC-DSS file

InputFPart  The F pathname part of data to be read from the forecast HEC-DSS file

OutputFPart  The F pathname part of data to be written to the forecast HEC-DSS file

User The name of the HEC-RTS user executing the forecast

ClientDisplay The X-Windows server address of the user's display

ForceRecompute "true" or "false" specifying whether the supplemental program must be 
executed – if "false", the supplemental program can decide whether it 
should execute

An example of a Supplemental Program Arguments File is shown in Figure 1.

17.4.1.2 Outputting Messages to the Forecast Compute Log
The supplemental program architecture allows the executable to output normal messages and error messages to the 
forecast compute log by writing these messages to a supplemental program log file.
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The supplemental program log file:

Has the same name as the arguments file name (passed as the only command line parameter to the 
supplemental program executable) with the ".args" extension replaced by ".log".
May contain special message type lines that instruct HEC-RTS how to process the following lines:

[No Message] specifies that the following lines will not be included in the compute log
[Log Message] specifies that the following lines will be treated as a normal compute log message
[Error Message] specifies that the following lines will be treated as a compute log error message

The message type lines are case insensitive, but must include the brackets ({*}\[* and *\]{*}) without any 
adjoining whitespace and may not appear on a line with any other text. The message type remains in force until 
another message type line is encountered. An implicit *\[No* *Message\]* line is processed at the beginning of 
the log file, so text in the log file before a message type line will not be included in the compute log.

17.4.1.3 Informing HEC-RTS of the Exit Status of a Supplemental Program
HEC-RTS uses the exit code returned from the executable to the operating system to determine the status of the 
supplemental program execution. The exit code is interpreted as follows:

0 The supplemental program completed successfully

1 The supplemental program skipped computation - the executable should not return 
this value if the ForceRecompute argument is set to "true"

other An error occurred during execution - the executable should output some diagnostic 
message(s) to the compute log if it returns a value other than 0 or 1

17.4.2 Create a Supplemental Program
To create a supplemental program: 

From the Watershed Tree (Figure 2); right-click Supplemental, from the shortcut menu, click New. The Create 
New Supplemental Program dialog opens (Figure 3).
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86 Figure 2 Watershed Tree - Models Folder - Supplemental Shortcut Menu
In the Name box (Figure 3), enter the name of the supplemental program.

Enter a description in the Description box and click OK.
The Supplemental Program dialog (Figure 4) opens. In the Supplemental Program dialog, specify the location 
of the software application that implements the supplemental program in the Executable box or click  . An 
Open browser will open, browse to the location of the software application's executable, select the appropriate 
file, click Open. The Open browser will close, the executable name will display in the Executable box (Figure 4).

87 Figure 4 Supplemental Program Dialog
If needed, enter command line arguments in the Arguments box (Figure 4). Click OK, the Supplemental 
Program dialog closes. From the Watershed Tree, from the Models folder, expand Supplemental, the name of 
the supplemental program will display.

17.4.3 Add a Supplemental Program - Program Order
Once you have defined a supplemental program, you can add it to the program order. To do this, follow the instructions 
for adding an HEC program in HEC Software Applications in the Program Order. Instead of selecting an HEC program, 
you will select the supplemental program that you created and the appropriate input for the program.
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17.4.4 Remove a Supplemental Program - Program Order
The steps to remove a supplemental program from the program order are the same as for removing an HEC program 
(HEC Software Applications in the Program Order).

17.5 Scripting in the Program Order
If you want to add a script to the computing sequence you must add the script to the program order.

17.5.1 Create a Scripting Program
To create a scripting program: 

From the Watershed Tree; right-click Scripting, from the shortcut menu, click New. The Create New Scripting 
Program dialog opens (Figure 1).

88 Figure 1 Create New Scripting Program Dialog
In the Name box (Figure 1), enter the name of the script.
Enter a description in the Description box and click OK.
The Scripting Program dialog (Figure 2) opens. In the Scripting Program dialog, specify the location of the 
script that implements the scripting program in the Jython Script box or click . An Open browser will open, 
browse to the location of the script (.py), select the script file, click *Open. The Open browser will close, and 
the executable name will display in the Jython Script box (Figure 2). 

17.5.2 Add a Scripting Program – Program Order
Once you have defined a supplemental program, you can add it to the program order (Program Order Dialog). To do 
this, follow the instructions for adding an HEC program in HEC Software Applications in the Program Order. Instead of 
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selecting an HEC program, you will select the supplemental program that you created and the appropriate input for the 
program.

17.5.3 Remove a Scripting Program – Program Order
The steps to remove a supplemental program from the program order are the same as for removing an HEC program 
(HEC Software Applications in the Program Order).

17.6 Multiple Program Orders
By default, HEC-RTS allows only a single program order to be used. If desired, the user can enable the use of multiple 
program orders (RTS Options Tab). To enable multiple program orders: 

From the HEC-RTS main window, click on the Setup tab, from the Tools menu, click Options. The Options
dialog will open, click the RTS Options tab (Figure 1).

89 Figure 1 Options Dialog - RTS Options Tab - Advanced Options
On the RTS Options page (Figure 1), Advanced Options is not selected. To enable Multiple Program Orders,
select Advanced Options (this also adds the Map folder to the Watershed Tree.
Click OK, the Options dialog (Figure 1) will close, and now you will be able to define multiple program orders for 
your watershed.

Care must be exercised when using multiple programs orders. When a model alternative is linked to a program for its 
input information, it remembers the position of the model it is receiving its data from, not the name or program of the 
specified model alternative. This can lead to potential conflicts if a model alternative is used in two different program 
orders. The recommended practice when using multiple programs orders is to configure a different model alternative 
for use in each different program order.
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18 Time Series Icons
Time series icons are displayed in the Map Window of the HEC-RTS main window and indicate sites for which data and 
information are available. The information can be time series data, images, websites/webpages, webcams, scripts, 
spreadsheets, or other files. Time series data for the icons can be linked to data from DSS files. Time series data can 
appear as thumbnail plots or color bars. The icons provide easy access for analyzing data and providing location-
specific information (e.g., frequently updated pictures of gages, reports on the location).

In the Setup module, you will use the Time Series Icon Tool to create and manipulate time series icons. Map Window
provides a description of the Time Series Icon Tool.

18.1 Create a Time Series Icon
To create a time series icon:

From the HEC-RTS main window, open a watershed, click the Setup tab, from the Map Window that displays, 
from the toolbar, click   (Time Series Icon Tool) (Figure 1).

Find a location on the Map Window where you want to place a time series icon (Figure 2), hold down the CTRL
key, and click the left mouse button. A time series icon with a default name (Location 61) will display on the Map 
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18.2 Time Series Icon Editor
After you have defined a new time series icon, you need to configure/edit the properties of the time series icon. From 
the Time Series Icon Editor dialog (Figure 1), properties include the name of the time series icon (view only), 
description, type of time series icon, position of the time series icon label, the location and the data associated with the 
time series icon, and the appearance of the time series icon in the different HEC-RTS modules. In addition, you can 
associate images, websites, webcams, documents, and scripting information with a time series icon.

90 Figure 1 Time Series Icon Editor

18.2.1 Associate Data with a Time Series Icon
Within HEC-RTS, time series data can be accessed from DSS files. You can either enter the pathnames (time series 
identifiers) associated with the data or select the time series identifiers from a DSS file. Before selecting time series 
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identifiers from a DSS file, you need to make sure that you have a DSS file available. A recommended choice would be 
the DSS file that is created when an HEC-RTS forecast is computed (forecast.dss).

To select time series identifiers from a DSS file:

From the Time Series Icon Editor (Figure 1), be sure the General tab is selected, click Browse, or from the Data
menu, click Browse. Either way, an HEC-DSSVue dialog (Figure 2) will open.

From the File menu, click Open, the Open HEC-DSS File browser (Figure 3) will open.

 
Browse to the location of the appropriate DSS file, click on the DSS file, click Open, the Open HEC-DSS File
browser (Figure 3) will close. The table on the HEC-DSSVue dialog (Figure 4) will now contain the time series 
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identifiers that are available from the selected DSS file.

Click on a time series identifier in the table that contains data that you want to associate with the time series 
icon. Click Select (Figure 4), the time series identifier will display in the selection list at the bottom of the HEC-
DSSVue dialog. Continue adding time series identifiers by selecting them in the table and clicking Select. You 
can also double-click on a time series identifier to add it from the selection list. Another way is to hold down the 
CTRL key and select multiple time series identifiers from the table.
You might want to use the Search By Parts (Figure 4) lists to aide in searching for specific time series identifiers. 
There are six lists that are available, that will aid you in the filtering of time series identifiers. Refer to DSS 
Pathnames for further details on this feature of HEC-DSSVue.
Once you have chosen your time series identifiers, click Add Pathnames (Figure 4), the Time Series Icon Editor
dialog (Figure 1) will display the time series identifiers you have selected in the Associated Data Sets box (Figure 
1). The Source column of the table (Figure 1) will display information about the selected DSS file. When you are 
finished selecting time series identifiers, from the HEC-DSSVue dialog (Figure 4), from the File menu, click Close,
the HEC-DSSVue dialog will close.
The Time Series Icon Editor (Figure 1) now displays what data has been associated with the selected time series 
icon.

18.2.2 Remove Data from a Time Series Icon
To remove data from a time series icon:
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From the Time Series Icon Editor dialog (Figure 5), be sure the General tab is selected. Select a row(s) in the 
Associated Data Sets table (Figure 5), that should no longer be associated with the selected time series icon.

From the Edit menu (Figure 5), click Delete Rows. The selected rows will be deleted from the Associated Data 
Sets table, and the data will no longer be associated with the time series icon.

18.2.3 Icon Types and Layers Tab
Now that you have created time series icons, HEC-RTS provides you with two ways to organize time series icon, for 
display purposes. The first is the concept of time series icon layers. By default, HEC-RTS creates an "All" time series icon 
layer, and by default, time series icons are assigned to the "All" time series icon layer when created. Time series icon 
layers make refining the display of data faster by allowing selection of the displayed layers by their data types. From 
HEC-RTS, you can create your own time series icon layers. For example, a gage may report stage, precipitation, and 
compute flow from stage. If time series layers are created for each one, "Stage", "Flow", and "Precipitation", then the 
appropriate datasets for that location can be placed in a corresponding time series icon layer. The procedure to create 
time series icon layers is described in Time Series Icons Layers.

The following steps describe how to assign datasets to time series icon layers:
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From the Time Series Icon Editor, click the Icon Types and Layers tab (Figure 6). From the Data Set list, for the 
selected time series icon (Hopland), select a dataset (/RUSSIAN R/HOPLAND CA/FLOW/05DEC2013/15MIN/USGS/).

From the Layers box (Figure 6), is a list of time series icon layers. Select and de-select times series icon layers for 
the selected dataset (/RUSSIAN R/HOPLAND CA/FLOW/05DEC2013/15MIN/USGS/) by clicking on the check boxes. 
Repeat this step for all datasets, that you want assigned to time series icon layers.

Now that you are finished with assigning time series icon layers, you now need to setup how the time series icon will be 
display in the individual HEC-RTS modules (Acquisition, Visualization, Modeling). There are seven available icon types:

 Graphic Symbol - provides an at-a-glance reference to the type of location represented and allow direct 
access to data associated with a location (such as model results). This is the only icon type for the Setup module.

 Dot - allows you to mark gages and time series locations without cluttering the map window. Selecting this 
option displays a small red dot along with the icon label ( ) in the map window.

 Thumbnail Plot – is a miniature version of the full-size plots available in HEC-RTS, showing data for the 
duration of the time window. As the time window updates, HEC-RTS refreshes the data and updates the plot. 
Thumbnail plots offer a quick overview of current data for the selected time window.

 Quality Color Bar - are linear histogram that offers a quick view of the quality of data within a set time 
window. Quality color bars reflect the quality of data by displaying bands of color that display quality information 
for datasets that are configured for this icon type. Refer to Reviewing Data Quality for additional information 
regarding quality color bar configuration.
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 Threshold Color Bar - are linear histograms that compare data against threshold values set for a location. 
For example, at a "Flow" location, green might be assigned to flow values less than 5,000, which represent normal 
flow conditions. Yellow may represent values greater than 5,000, but less than 7,000 to indicate flows in a flood 
warning level, and red may represent values greater than 7,000 to indicate flows above flood stage. Because 
threshold color bars are location dependent, you must set the values for each time series icon individually. See 
Visualizing Data on how to configure your threshold color bars.

 Cumulative Threshold Color Bar - are color bars that display accumulated values. For example, display 
precipitation over time or the sum of volumes of inflows to a lake are accumulated values.

None - by selecting None, you can configure the time series icon not to display in a specific HEC-RTS module 
(Acquisition, Visualization, Modeling). This is useful when you only use a time series icon in a specific module, as it 
keeps the map window uncluttered with unnecessary time series icons.

To assign a dataset to an HEC-RTS module (Acquisition, Visualization, Modeling) and select an icon type:

From the Time Series Icon Editor, click the Icon Types and Layers tab (Figure 6). From the Data Set list, for the 
selected time series icon (Hopland), select a dataset (/RUSSIAN R/HOPLAND CA/FLOW/05DEC2013/15MIN/USGS/).
From the module and icon type assignment section (Figure 7), for the selected dataset you need to determine if 
you wish to view the time series icon in that module. In addition, if you want the time series icon displayed how 
you want that time series icon displayed.

For example, in Figure 7, for the selected time series icon and dataset, for the Acquisition module, the time 
series icon will not be displayed, as you have selected an icon type of None. For the Visualization module, the 
time series icon will be display as a Thumbnail plot. Finally, for the Modeling module, the time series icon will 
not be displayed, as you have selected an icon type of None.

18.2.3.1 Configuring a Threshold Color Bar for a Dataset
Threshold color bars (Figure 8) are linear histograms that compare incoming data against threshold values set for a 
location. Because a threshold color bar dataset is dependent, you typically set the color values for the dataset of a time 
series icon. The length of the threshold color bar represents a timeline equal to the duration of the time window. 
Segments along the color bar reflect time intervals, with colors corresponding to the data quality legend you have 
defined. The threshold color bars are updated dynamically at the time interval that has been set for the time window.

91 Figure 8 Threshold Color Bars
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To set the thresholds and colors a threshold color bar associated with a dataset:

From the Time Series Icon Editor, click the Icon Types and Layers tab (Figure 6). From the Data Set list, for the 
selected time series icon (Hopland), select a dataset (/RUSSIAN R/HOPLAND CA/FLOW/05DEC2013/15MIN/USGS/).
Click Threshold Colors, the Threshold Color Bar Editor for Time Series will open (Figure 9).

The dataset's name is displayed on the Threshold Color Bar Editor for Time Series. The default threshold color 
type is Regular Threshold (Figure 9), for Cumulative Threshold color bars you would use the Threshold Color 
Bar Editor for Time Series to create your threshold color bar.
HEC-RTS creates a default threshold for you. For example, the selected dataset is a flow location, you need to set 
DarkGreen (Figure 9) to flow values less than 5000 (normal flow conditions). From the table, for the DarkGreen
row, under the Upper Limit column, double-click on the cell, enter 5000 (do not enter a comma).The entered 
value is displayed for the DarkGreen row, and for the DarkBlue row 5000 is now displayed in the LowerLimit
column of the table.
Now you need to set your next threshold limit for the dataset. For the DarkBlue (Figure 9) row, we want the color 
to be yellow. Click on DarkBlue, from the list select Yellow. For the Yellow row, in the UpperLimit cell, enter 
7000. Values greater than 5000 but less than 7000 indicate flows that are in a flood warning level.
For the DarkRow (Figure 10), you have a threshold of flow values greater than 7000 indicating that flows for this 
dataset are above flood stage.

By default, HEC-RTS will use this as the threshold color scheme (Figure 10) for datasets with the parameter of 
flow (Parameter). You can apply this threshold color scheme to the selected dataset only, to a group, or to all 
other unassigned time series icon (Global Default).
Click OK, the Threshold Color Bar Editor for Time Series will close (Figure 9).
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18.2.3.2 Configuring Thumbnail Plots – Thumbnail Scale
A thumbnail plot (Figure 11) is a miniature version of the full-size plots available in HEC-RTS, showing data for the 
duration of the time window. You can adjust the size of the thumbnail plot.

92 Figure 11 Thumbnail Plots - Visualization Module

To set the scale of a thumbnail plot:

From the Time Series Icon Editor, click the Icon Types and Layers tab (Figure 6). From the Data Set list, for the 
selected time series icon (Hopland), select a dataset (/RUSSIAN R/HOPLAND CA/FLOW/05DEC2013/15MIN/USGS/).
The Thumbnail Scale box (Figure 12) represents the minimum and maximum values displayed with in a 
thumbnail plot. To set these values, first check the checkbox next to Min or Max, and the fields next to the labels 
will become enabled. Once the fields are enabled, enter the numeric values for the items you selected.

Click OK, the Time Series Icon Editor dialog (Figure 1) will close. To save the changes to the watershed, from the 
HEC-RTS main window, from the File menu, click Save Watershed.

18.2.4 Photo/Images Tab
Photos, webcam images, web pages, or documents can be assigned to time series icons. By adding them to a time 
series icon in the Setup module, you can access them in the Visualization, Acquisition, and Modeling modules 
through the icon shortcut menu. Images and webcams can be viewed in their own separate dialog or as icons on the 
map window. For more information on how to set these features up see Time Series Icons.

18.2.5 Scripts/HTML Tab
Scripts can be assigned to individual time series icons. The scripts can be used to update the data at given intervals, 
compute other information from the data, or complete other tasks. Scripts are assigned to the icons in the Setup
module, through the Time Series Icon Editor. For more detailed information on assigning and using scripts, see 
Scripting.
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18.3 Time Series Icons Shortcut Menu
You can move, delete, rename, and add datasets to time series icons in the Setup module. You can also organize time 
series icons for display purposes. All these tasks are accomplished through the time series shortcut menu (Figure 1). 

From the Setup module, from a Map Window, select the Time Series Icon Tool ( ) or the Select Tool ( ), right-
click on a Time Series Icon, a shortcut menu will display (Figure 1).

18.3.1 Move a Time Series Icon
To move a time series icon:

93 Figure 1 Time Series Icon Shortcut Menu

From the Setup module, from a Map Window, select the Time Series Icon Tool ( ) or the Select Tool (
), from the shortcut menu (Figure 1), click Move.
The time series icon now has four little black dots (handles) at each corner. Click and drag the icon to its new 
position.

18.3.2 Copy/Paste Data from Icon to Icon

You can copy all the information associated with a time series icon to another time series icon. This is useful for setting 
up similar time series icons where only the location name is different.

From the Setup module, from a Map Window, select the Time Series Icon Tool ( ) or the Select Tool (
), right-click on a Time Series Icon, from the shortcut menu (Figure 1), click Copy.
Right-click on the Time Series Icon that you want to copy the information to, from the shortcut menu, click 
Paste.
The Paste Icon dialog (Figure 2) will open. In the To column change the location name for the new Time Series 
Icon, click Yes. The Paste Icon dialog (Figure 2) will close. The time series icon will display on the Map Window
with the new name. This copies the contents of the original icon into the new one, changing the location name at 
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the same time.

18.3.3 Delete a Time Series Icon
To delete a time series icon:

From the Setup module, from a Map Window, select the Time Series Icon Tool ( ) or the Select Tool (
), from the shortcut menu (Figure 1), click Delete.
A warning message will appear asking if you really want to delete the time series icon, click Yes. The selected 
Time Series Icon will no longer display on the Map Window.

18.3.4 Rename a Time Series Icon
To rename a time series icon:

From the Setup module, from a Map Window, select the Time Series Icon Tool ( ) or the Select Tool (
), from the shortcut menu (Figure 1), click Rename.
The Rename Time Series Icon dialog will open (Figure 3). In the Name box, enter a name for the selected time 
series icon. Click OK, the Rename Time Series Icon dialog will close. The time series icon will display on the Map 
Window with the new name.

18.3.5 Edit a Time Series Icon
To edit a time series icon, from the From the Setup module, from a Map Window, select the Time Series Icon Tool (

) or the Select Tool ( ), from the shortcut menu (Figure 1), click Edit. The Time Series Icon Editor will open, 
Time Series Icon Editor provides more details. 
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19 Time Series Icons Layers
This chapter describes the creation, configuration, and management of time series icons layers. When you create a new 
watershed, a default layer called Time Series Icons (Figure 1) is created. This layer includes all time series icons that 
you define for your watershed.

94 Figure 1 Map Layers Dialog

You can create additional time series icons layers to separate time series icons by data type. For example, a gage may 
report stage and precipitation (and compute flow from stage). You can create layers for each of these data types and 
name them, for example, Stage, Flow, and Precip. Creating additional layers allows you to focus on the specific data 
type you wish to see.

19.1 Creating Time Series Icons Layers
To create time series icons layers:

From the HEC-RTS main window, click on the Setup tab, from the Maps menu, click Map Layers. The Map 
Layers dialog will open. From the Map Layers tree, right-click on the Time Series Icons layer. From the shortcut 
menu (Figure 1), click Add Icon Layer, the New Time Series Icon Layer dialog opens (Figure 2).
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In the Name field (Figure 2), type a name for the time series icon layer. For example - Flow, Stage, or Precip.
In the Description field (Figure 2), type an optional description for the timer series icon layer.
You can add all of the time series icons that you defined for the watershed to the newly created time series icon 
layer, by selecting Add all Time Series Icons' Data Sets to this Layer (Figure 2). You should only do this if the 
time series icons are of the type that the time series icon layer represents. By default, all icons are part of the 
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"All" time series icon layer. For more detail on how to add individual time series icons to timer series icon layers, 
refer to Time Series Icons.
Another way to create time series icon layers, from the Setup module, from the Map Window, select the Time 

Series Icon Tool ( ) or the Select Tool ( ), right-click on a time series icon, from the shortcut menu, click 
Edit. The Time Series Icon Editor will open, click on the Icon Types and Layers tab (Figure 3).

From the Layers box (Figure 3), click Add. The New Time Series Icon Layer dialog will open (Figure 2). Repeat 
Steps 2 through 4 to create a time series icons layer.
Click OK, and the New Time Series Icon Layer dialog will close (Figure 2).

When you are done creating time series icons layers, you can assign datasets from a selected time series icon, to 
individual time series icons layers (for more details on how to configure time series icons see Time Series Icons).

19.2 Removing a Time Series Icons Layer
To remove a time series icons layer:

 From the Setup module, from the Map Window, select the Time Series Icon Tool ( ) or the Select Tool (
), right-click on a time series icon, from the shortcut menu, click Edit. The Time Series Icon Editor will 

open. Click on the Icon Types and Layers tab.
From the Layers box, select a time series icon layer, click Remove. A Remove Time Series Layer dialog will 
open (Figure 1), asking you if you really want to remove the selected layer. Click Yes, the Remove Time Series 
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Layer dialog will close, and the time series icon layer will no longer display in the Layers box.

19.3 Time Series Icons Layer Properties
You can configure the appearance of a time series icons layer's time series icons and their labels (Global Properties), 
set the visualization scale (Scale), and associate a template (Template) from the Time Series Icon Layer Properties
dialog (Figure 1). From CWMS, there are two ways to access the Time Series Icon Layer Properties dialog. From the 
CWMS CAVI main window, click on the Setup tab, from the Maps menu, click Map Layers. The Map Layers dialog will 
open. From the Map Layers tree, right-click on the Time Series Icons layer. From the shortcut menu, click Properties, 
the Time Series Icon Layer Properties dialog will open (Figure 1).

Another way to access the Time Series Icon Layer Properties dialog, is from the Time Series Icon Editor, click on the 
Icon Types and Layers tab. From the Layers box, right-click on a time series icons layer, from the shortcut menu, click 
Properties, the Time Series Icon Layer Properties dialog will open (Figure 1).

95 Figure 1 Time Series Icon Layer Properties Dialog - Global Properties Tab

19.3.1 Global Properties
The Global Properties Tab (Figure 1) allows you to change the appearance of time series icons and their labels for the 
time series icons layer that has been selected in the Layer list (Figure 1) for only the Acquisition and Visualization 
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modules. Time series icons that have been selected for the Modeling and Setup modules are not affected by changes to 
Global Properties. There are several ways to control the appearance of time series icon labels:

Select a time series icons layer, by default, the time series icons display using the Medium Icon (Figure 1) format. 
From the Icons box, you have five options for displaying time series icons – Small Graphic, Small Icon, Medium 
Icon, Large Icon, and Custom.
By default, the labels for time series icons display, if you do not want the labels for a specific layer to display, 
clear Draw Names (Figure 1). Click Apply, for the selected time series icons layer, the time series icon labels will 
no longer display.
To change the color of a time series icon's labels, click Foreground Color. A Color Chooser opens (Figure 2), 
from this chooser you can select the color you want the labels to display in. Click OK, and the Color Chooser
closes. Click Apply, for the selected time series icons layer, the time series icon labels will display in the color. 
For more information see Color Chooser.

By default, time series icon labels do not have a background color, if you want a time series icon label to have a 
background color, click Draw Background (Figure 1) and click Apply. For the selected time series icons layer, 
the time series icon labels will now display with a background color (light gray). You can change the background 
color by clicking Background Color (Figure 1). The Color Chooser will open (Figure 2), select the color you want 
the background of the time series icon labels to display in, and click OK. The Color Chooser will close, click 
Apply. For the selected time series icons layer, the time series icon labels will now display with a background 
color in the color you choose.
When a module's Map Window displays the whole watershed, some time series icon labels will not display when 
the time series icons overlap other elements. To display a time series icon layer's labels, click Draw Overlapping 
Names (Figure 1), and click Apply. For the selected time series icons layer, the time series icon labels will now 
display when viewing the whole watershed.
To change the font of a time series icons layer's time series icon labels, click Name Font (Figure 1). A Font 
Chooser will open (Figure 3), where you can select the font type from the Font list (Figure 3), and you can select 
a size using the Size slider (Figure 3). In addition, you can select whether to have the font display in Bold and/or 
in Italic. Click OK, and the Font Chooser closes. From the Time Series Icon Layer Properties dialog (Figure 1), 
click Apply. For the selected time series icons layer, the time series icon labels will now display in the font and 
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size you selected.

19.3.2 Scale
The Scale Tab (Figure 4) of the Time Series Icon Layer Properties dialog allows you to specify the map scale, or zoom 
level, at which a time series icon sub-layer becomes visible. By default, Always show layer is selected, which means the 
selected time series icons layer will always be displayed in the Map Window, regardless of the zoom level. However, you 
can select Only show layer in the following scale range, if you want to display the selected time series icons layer only 
when the Map Window scale is zoomed to the specified scale. You can specify scales below, above, or both, for when 
the selected time series icons layer will display time series ions. You can either enter the scale directly into the Only 
visible below 1 and/or Only visible above 1 or click Set to Current to set the scale equal for the current display. 
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96 Figure 4 Time Series Icon Layer Properties Dialog - Scale Tab

19.3.3 Template
Templates are created to save customized plot settings that can be used by other plots and the time series icons layers. 
From the Template Tab (Figure 5) of the Time Series Icon Layer Properties dialog, you can associate a template with 
the Time Series Icons Layer by selecting a template from the Template list. In HEC-RTS, templates are created from 
plot windows.

97 Figure 5 Time Series Icon Layer Properties Dialog - Template Tab
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20 Model Alternatives and Forecast Runs
A model alternative is a single model configuration with a specific set of input and parameters. A second model 
alternative would be defined by a different configuration or different input or parameters. A forecast run is a single 
forecast scenario defined by a specific set of data, information, and model alternatives. A second forecast run would be 
defined by different data, information, or model alternatives. Model alternatives run sequentially during a forecast. 
Model alternatives and forecast runs are described in this chapter. The model alternatives and forecast runs are 
manipulated primarily in the Setup module of HEC-RTS. Setup Module provides a detailed description of the Setup 
module and its interface.

20.1 Model Alternatives
Model alternatives consist of input data sets and configurations for each model. Model alternatives configurations do 
not include time-specific data. Therefore, model alternatives can be used in conjunction with any time window. 
In general, models and their alternatives are created using the software of the native model, for example, HEC-HMS, 
HEC-ResSim, HEC-RAS, and HEC-FIA. Once models and the alternatives created and configured initially, the model 
alternatives are imported into the watershed using the import commands in the File menu of the Setup module. The 
model alternative import process is detailed in Importing Watersheds and Model Alternatives. Once imported, model 
alternatives can be configured and edited in the HEC-RTS interface.

HEC-RTS uses plug-ins that allow interfacing with the software programs of the native model. This means that all 
aspects of model alternatives are configurable using the native model interface of HEC-RTS. For example, you can edit 
HEC-HMS base model parameters directly using the HEC-HMS software.

MFP deals with observed meteorological data and future precipitation. You can configure MFP model alternatives for 
use in conjunction with HEC-HMS to compute a variety of observed or future precipitation scenarios. An HEC-HMS 
model alternative simulates watershed response to precipitation. You can use HEC-HMS Model alternatives to forecast 
future flows. An HEC-ResSim model alternative assists with reservoir operations, consisting of the physical data 
representing a river-reservoir system and operating rules for all controllable elements in the system. HEC-RAS model 
alternatives describe water surface profile and stages at gage locations, geometry information for a river, and defined 
flow data sets. An HEC-FIA model alternative allows you to analyze flood consequences. HEC-FIA model forecast 
alternatives are a combination of impact areas and hydrograph time series sets. You can edit the parameters within 
each model alternative to reflect changing conditions.

20.2 Importing Watersheds and Model Alternatives
There are two ways to import models and their alternatives into an HEC-RTS study: (1) the Import 2.1 Watershed
command found in the Watershed menu, or (2) choose commands from the Import menu option (Figure 1) found in the 
Models menu. To create an HEC-RTS study from a CWMS watershed, the CWMS watershed needs to have been 
configured in CWMS Version 2.1 or higher.
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98 Figure 1 Setup Module - Models Menu - Import

20.2.1 Importing an Entire CWMS Watershed
To create an HEC-RTS study from a CWMS watershed, perform the following steps:

Create a New Watershed as detailed in Creating a Watershed. From the HEC-RTS main window, from the 
Watershed menu, click Import 2.1 Watershed. The Import CWMS 2.1 Watershed dialog (Figure 2) will open.



HEC-RTS User Manual  – Model Alternatives and Forecast Runs

Model Alternatives and Forecast Runs –  231

2.

3.

4.

5.

To the right of the Import CWMS 2.1 Watershed box (Figure 2), click  , the Select Workspace File browser 
will open (Figure 3).

From the Select Workspace File browser (Figure 3), navigate to and select the CWMS workspace file (.wksp) you 
want to import. Click Import, the Select Workspace File browser will close.
A Continue Import window will open, asking you if you want to continue with the import. Click Yes, the 
Continue Import window will close. The import process will start, and the results of the import are displayed in 
the Import CWMS 2.1 Watershed dialog (Figure 2).
When the import is finished from the Import CWMS 2.1 Watershed dialog (Figure 4) click Close, the Import 
CWMS 2.1 Watershed dialog will close. The Next Steps dialog will open, click Close. You now have created an 
HEC-RTS study from a CWMS watershed.
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20.2.2 Importing Model Alternatives
Individual model alternatives can be imported into an HEC-RTS study. A model's alternative (plan, alternative, run) can 
be imported regardless of whether the model is part of an HEC-RTS watershed or exists as a stand-alone model.

To import model alternatives into an HEC-RTS study, complete the following steps:

If an HEC-RTS study does not already exist, create a new watershed as detailed in Creating a Watershed.
Import an MFP alternative as detailed in Section MFP Model Alternative.
Import an HEC-HMS alternative (run) as detailed in Create an HEC-HMS Alternative.
Import a HEC-ResSim watershed as detailed in Create an HEC-ResSim Alternative.
Import a HEC-RAS plan as detailed in Create an HEC-RAS Alternative.
Import an HEC-FIA alternative as detailed in Create an HEC-FIA Alternative.

20.3 Interacting with Model Alternatives

20.3.1 Setup Module
Model alternatives are manipulated primarily in the Setup module. You can access the individual model editors by right-
clicking on a specific model alternative in the watershed tree and using the shortcut menu (Figure 1) that displays.

99 Figure 1 Watershed Tree - Models Folder - Model Alternatives Shortcut Menu

20.3.2 Modeling Module
You can also interact with specific forecast run's model alternatives in the Modeling module. With a forecast alternative 
active, from the forecast runs details section (Figure 2) of the Modeling module, you can also access the individual 
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model editors (Figure 2). From the control panel in the Modeling module, right-click on the active model and a shortcut 
menu will display.

20.3.3 Schematic Elements
From the map window, you can access certain model editors from schematic elements on the display area. For 
example, if your active forecast run has a HEC-ResSim model, on the display area you will see HEC-ResSim model 
elements, such as junctions. Right click on a junction, from the shortcut menu (Figure 3) point to Junction, point to Edit 
Properties, and model alternatives available at a junction will be displayed (Figure 3). For example, if you want to edit 
an HEC-ResSim junction, from the shortcut menu you would click RTops-Healdsburg, and the HEC-ResSim Junction
editor would open. 

20.4 MFP Model Alternative
An MFP alternative consists of an HEC-HMS meteorological model, a zone configuration (based on an HEC-HMS basin 
model) and a set of precipitation forecast data. Your HEC-HMS project can contain more than one meteorological model 
with gridded precipitation from different sources, such as NEXRAD radar, interpolation from gage reports, or results 
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from a grid-based snow model. You will need to create a separate MFP alternative for each source of lookback 
precipitation grids you intend to use in your forecast models.

20.4.1 Import an MFP Alternative
To import an MFP alternative:

From the HEC-RTS main window, click the Setup tab, from the Models menu, point to Import, click MFP, and the 
Choose MFP Version dialog (Figure 1) opens.

Select the MFP version to import from in the list (Figure 1). Available import version choices for MFP alternatives 
are Versions 2.1 and 3.x.
Click OK, the Choose MFP Version dialog (Figure 1) closes, and the Select MFP project file to import from
browser will open.
For MFP Version 2.1, navigate to and select the MFP project file (.conf) you want to import, click Open.
For MFP Version 3.0 or higher, navigate to and select the folder containing the MFP project file (.mfp) you want 
to import, click *Open.
The Select MFP project file to import from browser will close. An Importing progress bar will display, once 
that closes, an MFP model alternative(s) is imported into the watershed. Save your watershed.

20.4.2 Create an MFP Alternative
To create an MFP alternative:

From the HEC-RTS main window, click the Setup tab, from the watershed tree, from the Model folder, right-click 
MFP, from the shortcut menu, click New.
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The Create New MFP Alternative dialog (Figure 2) opens. Enter a name in the Name field and enter a 
description in the Description field (Figure 2).

From the Basin Model list (Figure 2), select a basin model. The choice of basin model will determine which 
precipitation zone configurations will be available for the MFP alternative. Make sure to select a basin model 
that covers the same area covered by any basin models used in MFP alternatives that will combine with this MFP 
alternative.
From the Meteorologic Model list (Figure 2), select a meteorologic model. The meteorologic model determines 
the grids used in the lookback portion of the forecast.
From the Precipitation Zone Configuration list (Figure 2), select a precipitation zone configuration.
Click OK, the Create New MFP Alternative dialog closes. To edit the newly created MFP alternative, from the 
HEC-RTSI main window, click the Setup tab, from the watershed tree, from the Model folder, right-click on the 
newly created MFP alternative. From the shortcut menu, click Edit Alternative, the MFP Alternative Editor
opens (Figure 3).

By default, the MFP Alternative Editor (Figure 3) is set for manual entry of forecast precipitation data by precipitation 
zone. If you have QPF data available, (DSS file) you can enter the data by choosing one of the QPF options.

To add precipitation data for the selected precipitation zone configuration:

From the MFP Alternative Editor (Figure 3), select the precipitation zone configuration from the Zone 
Configuration list.
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Setup your time window. By default, Relative Start Time is selected.

From the Duration of Future Precipitation list (Figure 3), select the duration for future precipitation. This 
choice sets the number of rows in the table where you will enter values for each precipitation zone of the 
selected precipitation zone configuration.
Enter precipitation data in the table. Values are entered by time step, with each cell representing one-time step 
for the zone. A running total of the forecast precipitation is kept at the bottom of the table. You may want to 
prepare a set of forecast values with a spreadsheet program and then copy the values from the spreadsheet to 
the MFP Alternative Editor. Once you have entered your precipitation data, click OK, the MFP Alternative
editor (Figure 3) closes.
From the File menu, click Save Watershed.

20.4.3 MFP Precipitation Zone Configurations
A precipitation zone configuration is required to create an MFP alternative. A zone configuration is a set of zones, a 
zone is a set of subbasins in the watershed. In MFP, precipitation forecasts are assigned by zone, with all subbasins in 
the zone receiving the same precipitation increments. You should group subbasins into zones based on similarity of 
expected precipitation.
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20.4.3.1 Create a Zone Configuration
To create a precipitation zone configuration:

From the MFP Alternative Editor (Figure 3), from the Edit menu, click Zone Configuration. The Zone 
Configuration Manager dialog (Figure 4) opens.

Click New, the Create a New Zone Configuration dialog (Figure 5) opens.

From the Create a New Zone Configuration dialog, enter a name in the Name field and a description into the 
Description field.
From the Element Type list (Figure 5), select either Subbasins or Reaches. Click Create, and the Create A New 
Zone Configuration dialog closes.

20.4.3.2 Create Zones
For each zone configuration, you will need to create at least one zone. To create a zone:

From the Zone Configuration Manager (Figure 4) select the newly created zone configuration.
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Click Zones, the Zones dialog (Figure 6) opens.

Click New, the Create A New Zone dialog opens (Figure 7). Enter a name in the Name field and description into 
the Description field. Click Create, the Create A New Zone dialog closes. The name of the zone you just created 
displays in the Current subbasin zones for selected zone configuration list on the Zones dialog (Figure 6). 
Close the Zones dialog.

20.4.3.3 Add Subbasin to a Zone
Once precipitation zones have been created, you can assign elements (subbasins or reaches) to the zones.

From the Zone Configuration Manager (Figure 4) select the zone configuration you want to configure.
Click Elements, the Elements dialog (Figure 8) opens. From the Zones list (Figure 4), select which zone you want 
to add elements to.
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Now you need to define the elements (subbasins or reaches) that are part of the selected zone. For example, in 
Figure 8, from the Unassigned Subbasins list you will be selecting a subbasin(s) to add to the selected zone. You 
can select individual element(s); select ranges of subbasins by shift-clicking; select discontinuous groups of 
subbasins by control-clicking; or, double-click on element. Click Add, the selected subbasin names will now 
display in the box that is under the Zone list (Figure 8).
You can move elements out of a zone by selecting an element in the box under the Zone list, and then click 
Remove or by double-clicking on that element.
When you have finished assigning elements to zones, close the Elements dialog (Figure 8). Then close the Zone 
Configuration Manager (Figure 4).

20.4.4 Define a QPF Transform Set
In place of manually entered precipitation forecasts, MFP permits you to incorporate a sequence of QPF (quantitative 
precipitation forecast) values into an MFP alternative from an external source. There are two types of QPF data that are 
available from the National Weather Service or from other sources. One type is point QPFs, which consist of a time 
series of forecasted precipitation depths at a single location. The second type is gridded QPFs, which represent a 
spatially distributed forecast of precipitation depths.

MFP can assign point QPF time series to precipitation forecast zones or assign a sequence of QPF grids to cover the 
entire watershed. In either case, QPFs are typically given in six-hour increments covering the next twenty-four hours, 
and a single 24-hour total following the four 6-hour increments. It is necessary to disaggregate these totals into 
increments that match your modeling time step.

To use QPFs in your forecast model, from the MFP Alternative editor (Figure 3), select either Time Series or Gridded. 
Each option (Manual, Time Series, or Gridded) presents a different form of the forecast precipitation table. If you select 
Time Series, the table appears as shown in Figure 9, and once you have defined your QPF data and defined a set of 
disaggregating weights, the table will be filled with precipitation increments for the zone.

100 Figure 9 Time Series Table - MFP Alternative Editor

If you select Gridded, the table appears as shown in Figure 10 and once you have defined your QPF data, the table will 
be filled with the disaggregating weights (not the precipitation values themselves).

101 Figure 10 MFP Alternative Editor - QPF Table - Gridded
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For either type of QPF data, to define QPF data:

From the MFP Alternative Editor (Figure 3), from the Edit menu, point to Precip Transformation Set, click 
New.
The Create a New Precipitation Transformation Set dialog opens (Figure 11). In the Name field, enter a name 
for the QPF distribution set. You can optionally enter a description in the Description field.

Click New, the Transformation Editor (Figure 12) opens. From the Transformation Editor, you can specify the 
Output Time Interval and the Input Time Interval. The Transformation Editor (Figure 12) allows you to 
specify weights for two adjacent blocks of one, six, or twenty-four hours each (based off the Input Time 
Interval). The weights will be normalized for each block, so the two six-hour blocks shown in the example will 
put half of the six-hour QPF in the third and fourth hours of the six-hour blocks. QPF are referenced to UTC so the 
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blocks will shift according to your watershed's time zone.

Once the disaggregation set is defined, you can associate a QPF time series record with a zone defined in the 
precipitation zone configurations associated with the MFP alternative. Click OK, the Transformation Editor
closes (Figure 12).
To associate a QPF time series record with a zone, from the MFP Alternative Editor dialog (Figure 3), click Time 
Series. Select a row in the table and click Pathname.
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The Set Locations for DSS Connections dialog (Figure 19.20) opens. To open a DSS file, click  .

From the Open File browser, locate and open the appropriate DSS file. The lower table will be filled with the DSS 
catalog information. The top table has the list of precipitation zones for the selected MFP zone configuration. 
Select a precipitation zone in the top table by clicking on a row. Select a QPF HEC-DSS pathname by clicking on a 
row in the bottom table. Once a row from each table is highlighted, the HEC-DSS pathname will be assigned to 
the precipitation zone by clicking Select HEC-DSS Pathname.
Once you click OK, the MFP Alternative editor (Figure 3) will read the DSS file and try to find the QPF data.

20.4.5 Edit an MFP Alternative
To edit an MFP alternative:

From the watershed tree (Figure 14), under the Models folder, expand the MFP folder (Figure 14). Right-click on 
the MFP alternative you wish to edit.
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From the shortcut menu (Figure 14), click Edit Alternative, the MFP Alternative Editor (Figure 3) opens.

Use the MFP Alternative Editor to make changes to the MPF alternative you are editing.
Click the OK, and the MFP Alternative Editor closes.

20.4.6 Copy an MFP Alternative
To copy an MFP alternate:

From the watershed tree (Figure 14), under the Models folder, expand the MFP folder (Figure 14). Right-click on 
the MFP alternative you wish to edit.
From the shortcut menu (Figure 14), click Save As, the Save MFP As dialog (Figure 15) opens.

Enter the new name in the Name field and fill out the Description field. (You can specify the directory where you 
save the watershed if you wish to save a copy of the alternative to a directory outside of the watershed.)
Click OK, and the Save MFP As dialog closes.

20.4.7 Delete an MFP Alternative
To delete an MFP alternative, from the watershed tree (Figure 14), under the Models folder, expand the MFP folder 
(Figure 14). Right-click on the MFP alternative you wish to edit. From the shortcut menu (Figure 14), click Delete, a 
Confirm Delete window (Figure 16) opens. Asking you are you sure you want to delete the selected MFP alternative. 
Click Yes, the Confirm Delete window (Figure 16) will close. The MFP alternative is no longer displayed under the MFP 
folder.
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102 Figure 16 Confirm Delete MFP Alternative Dialog

20.5 Create an HEC-HMS Alternative
An HEC-HMS alternative consists of a basin model, loss parameter, transform parameter, baseflow zone configurations, 
and a set of parameter adjustments for each zone. Within an HEC-HMS alternative, you can adjust parameters in the 
HEC-HMS basin model to try to match observed flows at the time of forecast. You can also control blending of model 
results to observed flows where they are available. If the HEC-HMS project contains more than one basin model (for 
summer and winter conditions, for instance), you can build HEC-HMS alternatives around each of them.

20.5.1 Import HEC-HMS Model Alternative
To import HEC-HMS model alternatives:

From the HEC-RTS main window, click the Setup tab, from the watershed tree, from the Model folder, right-click 
on HMS, from the shortcut menu, click Import (Figure 1), a Select Project File browser will open.

From the Select Project File browser, navigate to and select the HEC-HMS project file (.hms) you wish to 
import. Click *Select, and the import process will begin.
If you are importing an HEC-HMS model alternative created in a previous version of HEC-HMS, then the Convert 
HEC-HMS Project dialog (Figure 2) displays prompting you to convert the project. Click Convert Project, and 
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the Convert HEC-HMS Project dialog closes.

Once the import is complete the Message Pane will display "HMS: NOTE 16161: Import finished". Be sure to save 
your watershed.

20.5.2 HMS Loss and Baseflow Zone Configurations
After you import the HEC-HMS model alternatives, you must create zone configurations for loss parameter, transform 
parameter, and baseflow parameter adjustments. A zone configuration is a set of zones, and a zone is a set of 
elements (subbasins or reaches) in the watershed. You should group elements into zones based on similarity of 
hydrologic properties and the availability of observed flows against which to calibrate zone parameters. For example, 
you might group the subbasins in a headwaters area above a reservoir together into a zone. At forecast time, the 
baseflow and loss parameters for the subbasins in that zone will be adjusted together so that the hydrograph 
calculated by HEC-HMS for the inflow to the reservoir fits the observed inflows to the reservoir as well as possible.

20.5.2.1 Create a Zone Configuration
To create a zone configuration:

From the HEC-RTS main window, click the Setup tab, from the watershed tree, from the Model folder, expand 
HMS. Right-click on an HEC-HMS model alternative. From the shortcut menu, click Zone Configurations. The 
Zone Configuration Manager opens.
To create a new zone configuration, from the Zone Configuration Manager, click New. The Create a New Zone 
Configuration dialog opens.
From the Create A New Zone Configuration dialog, enter a name into the Name box and description into the 
Description box.
From the Element Type list, select either Subbasins or Reaches. Click Create, the Create A New Zone 
Configuration dialog closes and the new zone configuration is added to the list of current zone configurations.
Close the Zone Configuration Manager and Save your watershed.

20.5.2.2 Create Zones
For each loss or baseflow zone configuration, you will need to create at least one loss/baseflow zone. You should base 
the zones on similarity of hydrologic properties and the availability of observed flows to calibrate zone parameters 
against.

To create a zone:

From the HEC-RTS main window, click the Setup tab, from the watershed tree, from the Model folder, expand 
HMS. Right-click on an HEC-HMS model alternative. From the shortcut menu, click Zone Configurations. 
The Zone Configuration Manager opens.
From the Current zone configurations box, select a zone configuration. Click Zones, the Zones dialog opens.
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From the Zones dialog, click New, the Create A New Zone dialog opens. Enter a name into the Name field 
(required) and description into the Description field (optional).
Click Create, the Create A New Zone dialog will close. The name of zone you created displays in the Current 
zones for selected zone configuration list on the Zones dialog. Close the Zones dialog and Save your 
watershed.

20.5.2.3 Add Elements to a Loss Parameter
Once loss parameter zones have been created, you can assign elements to the zones.

To assign elements to zones:

From the HEC-RTS main window, click the Setup tab, from the watershed tree, from the Model folder, expand 
HMS. Right-click on an HEC-HMS model alternative. From the shortcut menu, click Zone Configurations. 
The Zone Configuration Manager opens.
From the Current zone configurations box, select a zone configuration. Click Elements, the Elements dialog
opens. From the Zones list, select the zone that you want to add elements to.
Select the elements (subbasins or reaches) you want to add to the zone from the elements (subbasins or 
reaches) listed in the Unassigned Subbasins list. Select one subbasin by clicking on that subbasin; select ranges 
of subbasins by shift-clicking; select discontinuous groups of subbasins by control-clicking.
Click Add and the selected element names display in the box under the Zones list. You can also move a subbasin 
into a zone by double-clicking on the element in the Unassigned Subbasins list.
You can move elements out of a zone by selecting an element in the box under the Zones list and then clicking 
Remove or by double-clicking on that element.
Close the Elements dialog, close the Zone Configuration Manager and Save your watershed.

20.5.3 Forecast for an HEC-HMS Alternative
From the Forecast Alternative editor (Figure 3), you can select the zone configuration for the loss rate, transform, 
baseflow and routing configuration parameters.
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103 Figure 3 HEC-HMS - Forecast Alternative Editor

To set the forecast configuration and zone configuration parameters:

From the HEC-RTS main window, click the Setup tab, from the watershed tree, from the Model folder, expand 
HMS. Right-click on an HEC-HMS model alternative. From the shortcut menu, click Forecast Configuration. The 
Forecast Alternative editor (Figure 3) opens.
Enter a description in the Description field. Enter date and time values in for the Start Date, Forecast Date, and 
End Date. From the Time Interval list, select a time interval
From the Loss Rate Config, Transform Config, Baseflow Config, and Routing Config lists, select the 
appropriate zone configuration.
Click OK, and the Forecast Alternative editor closes (Figure 3). Save your watershed.

20.5.4 Adjust Parameters Using the Combined Parameter Editor
The Combined Parameter Editor (Figure 4) allows you to adjust loss rate, transform, and baseflow parameters to 
calibrate your HEC-HMS model to the forecasted event. It also controls blending (the substitution of observed flows for 
calculated flows in the model) for the HEC-HMS model. An HEC-HMS alternative consists of an HEC-HMS basin model, 
which sets initial values for parameters, and a set of adjustments to those initial parameter values. The methods for the 
parameters are based on what was specified in the HEC-HMS model.
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104 Figure 4 HEC-HMS - Combined Parameter Editor - Blending Tab

To adjust combined parameters:

From the HEC-RTS main window, click the Setup tab, from the watershed tree, from the Model folder, expand 
HMS. Right-click on an HEC-HMS model alternative. From the shortcut menu, click Combined Parameter 
Editor. The Combined Parameter editor (Figure 4) opens.
Click on the Blending tab, adjust the loss rate, transform, and baseflow parameters as needed. Click Apply, the 
Combined Parameter editor will close, save your HEC-RTS study.

20.5.4.1 Loss Parameters
To adjust loss parameters, from the Combined Parameter editor (Figure 5), click on the Deficit Constant Loss tab 
(name is dependent on the loss method selected). For example, in Figure 5, the loss method used was Deficit and 
Constant.
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The upper panel shows a list of the loss zones in the watershed and the zone-average values for the initial soil-moisture 
deficit, the maximum deficit, and the constant loss rates in the HEC-HMS alternative. In the upper panel, for each 
parameter, there is a Zone Average column and an Adjustment column. The leftmost column displays the area-
weighted average value of the parameter over the subbasins in the zone as read from the HEC-HMS basin model. To 
override a zone value, enter the new value in the Adjustment column.

In the lower panel of the editor are the parameters for the individual subbasins in the zone. For each parameter there 
are two columns, the Base Value and Final Value. To edit a loss parameter, select the override box next to the zone 
subbasin. The Final Value cell becomes editable and you can enter your new value. The list in the lower panel will 
contain the subbasins in that zone.

20.5.4.2 Baseflow Parameters
To edit the baseflow parameters, click on the Baseflow tab (Figure 4) of the Combined Parameter editor. For this 
example, the baseflow method used was Bounded Recession. The baseflow panel uses the same parameter 
adjustment method as the loss tab to adjust the baseflow at the time of forecast (this is not the initial baseflow, but the 
initial baseflow minus the recession that occurs between the lookback time and the time of forecast) and the recession 
ratio.

20.5.4.3 Transform Parameters Tab
To edit the transform parameters, select the Transform tab (Figure 4) on the Combined Parameter Editor. For this 
example, the transform method used was ModClark. The transform panel uses the same parameter adjustment 
method as the loss tab to adjust the transform at the time of forecast.

20.5.4.4 Blending Tab

To edit blending parameters, select the Blending tab on the Combined Parameter editor (Figure 4). This contains a list 
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of all locations in the HEC-HMS model where observed flows are available for blending. You can select blending 
methods (Step or Taper), set the taper interval, or turn blending off at each location.

20.5.4.5 Slider Adjustments
From the Combined Parameter editor (Figure 4), click Slider Adjustments, the Forecast Parameters And Blending
dialog (Figure 6) will open. This allows you to adjust zonal, subbasin, and reach element parameters for calibration.

105 Figure 6 HEC-HMS - Forecast Parameters And Blending Dialog

20.5.5 Adjust Parameters Using Slider Adjustments
Sliders in HEC-HMS (Figure 7) allow you to adjust loss rate, transform, baseflow, and routing parameters easily. You 
adjust these parameters so that the simulated watershed response matches observed values (for example stream gages 
and reservoir stages) more closely during the lookback period of the event. An HEC-HMS alternative HEC-RTS consists of 
an HEC-HMS basin model, which sets initial values for parameters, a set of adjustments to those initial parameter 
values, and a metrological model that defines the precipitation input. The methods associated with the basin model 
parameters are based on what was specified in the HEC-HMS model alternative. The following sections describe setting 
up and using slider adjustments. Sliders depict a range of values, increments, or factors on a line and a selector that you 
can drag across the line to select a value, increment, or factor to adjust the parameter by. Sliders allow for quick, small 
adjustments of parameters and allow HEC-HMS to recompute runoff for a subset of basin elements instead of the entire 
watershed. This allows for faster computation when adjustments are made.
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106 Figure 7 HEC-HMS - A Slider Configured to Adjust Loss Parameters

20.5.5.1 Configuring Slider Adjustments
Before you can use slider adjustments, you must first configure slider adjustments. This is a two-step process: First, you 
must specify by zone and/or subbasin/reach which parameters you would like to adjust. Second, you must set the 
adjustment type (how the sliders will adjust the parameters) and limits (the maximum and minimum adjustments) of 
each slider.

20.5.5.2 Slider Adjustment Specification
To specify the parameters, you would like to adjust:

From the HEC-RTS main window, from the main toolbar, click . The HEC-HMS software application will 
display.
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In the Watershed Explorer in HEC-HMS (set of tabs on the lower left), click the Compute tab (Figure 8).

From the Compute tab, expand the Forecast Alternatives folder (Figure 8), and right-click on a forecast 
alternative for which you wish to configure slider adjustments.
From the shortcut menu (Figure 8), click Forecast Slider Adjustments, the Forecast Slider Adjustments dialog 
(Figure 9) will open.

On each tab of the Forecast Slider Adjustments dialog (Figure 9), the zone or subbasin/reach and the 
associated parameters are listed. The tabs in this dialog are named with the loss rate, transform, baseflow, and 
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routing methods used in the basin. (To be able to edit each type of parameter, the Loss Rate Config, Transform 
Config, Baseflow Config, and Routing Config zones must be defined in the HEC-HMS forecast alternative.)
Click Select, the Select Forecast Slider Adjustments dialog (Figure 10) will open.

 
Select the tab with the parameters you wish to adjust. For example, in Figure 10, click the loss tab (Deficit 
Constant Loss) to select loss rate parameters for adjustment.
To select zonal adjustment sliders, in the Parameters for Zones panel (Figure 10), select a zone in the Zones
box. This will populate the available parameters in Parameters box that can be assigned to sliders.
In the Parameters box (Figure 10), select one or more items you wish to adjust using sliders (you can choose 
multiple parameters by using the CTRL or SHIFT keys), click Select. The items selected in the Parameters box 
on the Select Forecast Slider Adjustments dialog (Figure 10) no longer display. The items now display on the 
Forecast Slider Adjustments dialog (Figure 9).
Repeat Steps 8 and 9 to select all desired zonal adjustment sliders.
Next, to select subbasin or reach adjustment sliders (for adjusting parameters for individual elements instead of 
zones), from the Parameters for subbasin overrides panel (Figure 10), select a subbasin or reach in the 
Subbasins box. This will populate the available Parameters box that can be assigned to sliders.
In the Parameters box (Figure 10), select one or more items you wish to adjust using sliders (you can choose 
multiple parameters using the CTRL or SHIFT keys), click Select. The items selected in the Parameters box on 
the Select Forecast Slider Adjustments dialog (Figure 10) no longer display. The items now display on the 
Forecast Slider Adjustments dialog (Figure 9).
Repeat Steps 11 and 12 to select all desired subbasin/reach adjustment sliders.
Repeat Steps 6 through 12 for each of the parameters you wish to adjust (loss rate, transform, baseflow, and 
routing methods). When you have finished selecting slider adjustments, from the Select Forecast Slider 
Adjustments dialog (Figure 10), click Close. The Select Forecast Slider Adjustments dialog will close.
Review your selections in the Forecast Slider Adjustments dialog (Figure 9). If you have selected one in error, 
you can remove it by selecting it in the Parameters column and clicking Remove. When you are satisfied with 
your selections, from the Forecast Slider Adjustments dialog, click Close. The Forecast Slider Adjustments
dialog will close.
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20.5.5.3 Slider Settings
In HEC-HMS parameters have minimum and maximum allowable values. These values are used to initialize the limits of 
the sliders. To setup the type of adjustment and limits of each slider:

 From the HEC-RTS main window, from the main toolbar, click  . The HEC-HMS software application will 
display.
In the Watershed Explorer in HEC-HMS (set of tabs on the lower left), click the Compute tab (Figure 8).
From the Compute tab, expand the Forecast Alternatives folder (Figure 8), and right-click on a forecast 
alternative for which you wish to configure slider adjustments.
From the shortcut menu (Figure 8), click Forecast Slider Settings, the Forecast Slider Adjustments dialog 
(Figure 11) will open.

Each tab has two tables. The upper table shows zonal parameters, and the lower table shows parameters for 
individual elements. The Zone and Subbasin/Reach columns list the zone and subbasin/reach name. The 
Parameter column lists the parameter name of the slider. The Adjustment Type column lists the adjustment 
type. The Units column lists the units for the adjustment. The last two columns list the Minimum and Maximum
values for the parameter adjustment.

To be able to configure loss rate, transform, baseflow, and routing slider settings, they must first be configured as 
detailed in the following section.

Specify an adjustment type using the dropdown in the Adjustment Type column (Figure 12). An Adjustment 
Type can be a new Value, an Increment to be added or subtracted from the parameter value, or a Factor to be 
applied to the parameter value. By default, the zonal adjustment type is Factor, and the subbasin/reach 
adjustment type is Value. If the adjustment type is Factor, the unit's entry will be blank.

Specify the minimum and maximum values for each parameter. These columns are populated by default. 
However, for practical use of the slider adjustments, the limits should be set to a smaller range.
Review your selections in the Forecast Slider Adjustments Settings dialog (Figure 11). When you are satisfied, 
click Apply, and then click Close. The Forecast Slider Adjustments Settings dialog will close, save the HEC-
HMS project.
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20.5.5.4 Adjusting Parameters Using the Sliders
From the HEC-RTS main window, click the Setup tab, from the watershed tree, from the Model folder, expand HMS. 
Right-click on an HEC-HMS model alternative. From the shortcut menu, click Combined Parameter Editor. The 
Combined Parameter editor (Figure 4 will open, click Slider Adjustments. The Forecast Parameters And Blending
dialog will open with slider adjustments displayed (Figure 7).

The dialog (Figure 7) consists of multiple tabs, each containing sliders by zone. (Again, the tabs in this dialog are named 
with the loss rate, transform, baseflow, and routing methods used in the basin.) The zone is selected using the 
dropdown menu located just under the tabs. The upper part of the dialog shows parameter adjustments for the 
selected zone. The lower part of the dialog shows parameter adjustments for the individual subbasin or reach within 
the selected zone (if configured).

Parameter values can be adjusted by moving a slider or by entering a value in the text box to the right of the slider. If a 
value is entered in the text box, it should be consistent with the adjustment type. A factor must begin with an asterisk 
(*), an increment must begin with a plus (+) or a minus (-), and a value adjustment needs no initial symbol. The slider 
will move to the value entered in the text box. If the value in the text box is outside the slider's range, the slider is 
disabled.

In the upper right of the dialog (Figure 7) there is a check box labeled Compute with each slider change. If this box is 
checked, any change in a slider will cause the parameter adjustment to be applied, and the forecast alternative will be 
computed.

If the box is not checked, the parameter adjustment will not be applied until Apply is clicked, and the results will not be 
updated until the forecast alternative is computed. If you prefer, you can configure HEC-HMS to compute automatically 
after clicking Apply. In the HEC-HMS software, select Program Settings from the Tools menu. In the General tab, check 
the box next to Compute after apply in editors, and click OK. This setting applies to both the slider adjustments and 
combined parameter editor.

Clicking Reset will reset the parameter adjustments to their value when the dialog was opened. Close closes the dialog.

Right-clicking a slider (in HEC-RTS) brings up a menu with two options. The first option Reset to Original Value will 
reset the parameter adjustment to the original value when the dialog was opened. The second option Modify Slider 
Limits opens the Forecast Slider Adjustments Settings dialog, so the Adjustment Type and slider Minimum and 
Maximum limits can be changed.

20.5.6 Edit an HEC-HMS Alternative
To edit an HEC-HMS model alternative:

From the HEC-RTS main window, click on the Setup tab, from the watershed tree, from the Models folder, 
expand HMS.
Right-click on an HEC-HMS model alternative, from the shortcut menu, click Forecast Configuration, the 
Forecast Configuration editor will open (Figure 3).
Edit the HEC-HMS model alternative as desired, click Apply button to save your changes. Click Close, the 
Forecast Configuration editor will close, save your HEC-RTS study.
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20.5.7 Copy an HEC-HMS Alternative
To copy an HEC-HMS model alternative:

From the HEC-RTS main window, click on the Setup module, from the Models menu, point to HMS, click 
Forecast Alternative Manager, the Forecast Alternative Manager dialog (Figure 3) opens.
From the Current forecast alternatives box, select the forecast alternative you wish to copy, click Copy.
The Copy Forecast Alternative dialog (Figure 13) opens. Enter a new alternative name in the Name field 
(required) and enter a description in the Description field (optional).

Click Copy, the Copy Forecast Alternative dialog will close. The new HMS alternative will now be display in the 
Current forecast alternatives box. Close the Forecast Alternative Manager dialog (Figure 3).

20.5.8 Delete an HEC-HMS Alternative
To delete an HEC-HMS alternative:

From the HEC-RTS main window, click on the Setup module, from the Models menu, point to HMS, click 
Forecast Alternative Manager, the Forecast Alternative Manager dialog (Figure 3) opens.
From the Current forecast alternatives box, select the forecast alternative you wish to delete, click Delete.
The Delete Confirmation window (Figure 14) opens, asking you if you wish to delete the selected HMS forecast 
alternative.

Click OK, the Delete Confirmation window will close. The HMS forecast alternative no longer displays in the 
Current Forecast Alternatives box. Close the Forecast Alternative Manager dialog (Figure 3).

20.6 Create a HEC-ResSim Alternative
A HEC-ResSim model alternative consists of a watershed schematic, stream and reservoir network, and a set of 
operations for each reservoir. Within a HEC-ResSim alternative, you can override simulated forecasted releases to 
mimic desired operation during the forecast period. If the HEC-ResSim project contains more than one network 
alternative (for summer and winter conditions, for instance), you can build HEC-ResSim model alternatives around each 
of them.
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20.6.1 Import an HEC-ResSim Watershed
To import an HEC-ResSim watershed:

From the HEC-RTS main window, click on the Setup module, from the Models menu, point to Import, click 
ResSim and the Import Type dialog (Figure 1) opens.

To import an HEC-ResSim watershed (stream alignment, network, configurations, and alternatives), click 
Watershed. The Select Watershed File to Import From will open.
Browse to the location of the HEC-ResSim watershed you want to import. Select an HEC-ResSim watershed file 
(.wksp), click *Open. The Select Watershed File to Import From browser will close and the import will 
automatically begin. An Import Progress dialog opens indicating that the import is occurring.
The Import Progress dialog closes automatically once the import is complete and a Message window will 
display letting you know that the import is complete, save your HEC-RTS study.

20.6.2 Import an HEC-ResSim Alternative
To import an HEC-ResSim alternative:

From the HEC-RTS main window, click on the Setup module, from the Models menu, point to Import, click 
ResSim, the Import Type dialog (Figure 1) opens.
Click Alternative, the Import Alternative Wizard (Figure 2) opens.

To select an HEC-ResSim watershed, to the right of the Watershed File box (Figure 2), click  . An Open File
browser will open, browse to the location of the HEC-ResSim watershed you want to import. Select a HEC-
ResSim watershed file (.wksp), click *OK. The Open File browser will close and the location of the selected HEC-
ReSim watershed is displayed in the Watershed File box.
Click Next, select an HEC-ResSim alternative from the Available Alternatives table.
Click Next, if you want you can change the name of the selected HEC-ResSim alternative by entering a name in 
the Name field.
Click Next, if you want you can change the name of the selected HEC-ResSim reservoir network by entering a 
name in the Name field.
Click Next, the elements associated with the HEC-ResSim reservoir network are displayed along with stream 
assignments. Review this table, if you find any "To Stream" assignments that are incorrect, from the To Stream
column in the table, select the correct stream assignment from the list.
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Click Next, the elements associated with the HEC-ResSim reservoir network are displayed along with 
computation point assignments. Review this table, if you find any "Watershed Computation Point" assignments 
that are incorrect, from the Watershed Computation Point column in the table, select the correct computation 
point assignment from the list.\
Click Next, review the Import Summary, to make sure that everything is correct. If needed, you can copy or 
print the summary.
Click Finish, a Continue with Import window will display asking you if you wish to continue with the import 
operation. Click Yes, the Continue with Import window will close, and the HEC-ResSim import of an alternative 
will proceed. Once the import is finished, save your HEC-RTS watershed.

20.6.3 Edit a HEC-ResSim Alternative
To edit a HEC-ResSim alternative: 

From the HEC-RTS main window, click on the Setup module, from the Watershed Tree, from the Models folder, 
expand the ResSim node (Figure 3). This provides you with a list of all the available HEC-ResSim alternatives for 
this HEC-RTS study.

107 Figure 3 HEC-ResSim Model Alternative Shortcut Menu
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Right-click on a HEC-ResSim alternative, from the shortcut menu (Figure 3), click Edit Alternatives, the ResSim 
Alternative Editor opens (Figure 4).

Edit the HEC-ResSim alternative as desired. For further information on how to modify an HEC-ResSim 
alternatives, refer to the HEC-ResSim User's Manual.
To save your changes, from the Alternative menu (Figure 4), click Save.
To close the ResSim Alternative Editor. From the Alternative menu, click Close, the ResSim Alternative 
Editor will close.

20.6.4 Copy a HEC-ResSim Alternative
To copy a HEC-ResSim alternative:

From the HEC-RTS main window, click on the Setup module, from the Watershed Tree, from the Models folder, 
expand the ResSim node (Figure 3). This provides you with a list of all the available HEC-ResSim alternatives for 
this watershed.
Right-click on an HEC-ResSim alternative, from the shortcut menu (Figure 3), click Edit Alternatives, the ResSim 
Alternative Editor opens (Figure 4).
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From the Alternative menu (Figure 4), click Save As, the Save As dialog (Figure 5) opens.

Enter an alternative name in the Name field (required) and a description in Description field (optional).
Click OK, the Save As dialog closes. The new alternative is displayed in the HEC-ResSim Alternative Editor.
To close the ResSim Alternative Editor. From the Alternative menu, click Close, the ResSim Alternative 
Editor will close.

20.6.5 Delete an HEC-ResSim Alternative
To delete an HEC-ResSim alternative:

From the HEC-RTS main window, click on the Setup module, from the Watershed Tree, from the Models folder, 
expand the ResSim node (Figure 3). This provides you with a list of all the available HEC-ResSim alternatives for 
this watershed.
Right-click on an HEC-ResSim alternative the you want to delete, from the shortcut menu (Figure 19.40), click 
Edit Alternatives, the ResSim Alternative Editor opens (Figure 4).
From the Alternative menu (Figure 4), click Delete, a Warning window will display asking you if you really want 
to delete the selected HEC-ResSim alternative. Click Yes, the HEC-ResSim Alternative will no longer display in the 
ResSim Alternative Editor.
To close the ResSim Alternative Editor. From the Alternative menu, click Close, the ResSim Alternative 
Editor will close.

20.7 Create an HEC-RAS Alternative
A HEC-RAS alternative consists of model geometry, set of boundary conditions, and a plan file linking the two. If the 
HEC-RAS project contains more than one plan (for steady flow and unsteady flow conditions, for instance), you can 
build HEC-RAS model alternatives around each of them.

20.7.1 Import a HEC-RAS Alternative
To import a HEC-RAS model alternative:
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From the HEC-RTS main window, click on the Setup module, from the Models menu, point to Import, click RAS,
the Select RAS project to import from browser (Figure 1) opens.

 
Browse to the location of an HEC-RAS project you wish to import. Select an HEC-RAS project file (.prj), click 
*Open, the Select HEC-RAS project to import from browser will close.
The import begins, an Import Progress window will open displaying the progress of the import. The Import 
Progress window will close when the import is complete, and a Message window will open letting you know the 
import is complete. Once the import is complete, save your HEC-RTS study.

20.7.2 Edit a HEC-RAS Alternative
To edit a HEC-RAS alternative:

From the HEC-RTS main window, click on the Setup module, from the Watershed Tree, from the Models folder, 
expand the RAS node (Figure 2). This provides you with a list of all the available HEC-RAS plans for the HEC-RTS 
study.

Right-click on an HEC-RAS alternative, a shortcut menu will display (Figure 2). From the shortcut menu, select 
the HEC-RAS component you wish to modify. Edit the HEC-RAS alternative as desired. For further information on 
how to modify HEC-RAS alternatives, refer to the HEC-RAS User's Manual.
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20.7.3 Copy a HEC-RAS Alternative
To copy a HEC-RAS alternative:

From the HEC-RTS main window, click on the Setup module, from the Watershed Tree, from the Models folder, 
expand the RAS node (Figure 2). This provides you with a list of all the available HEC-RAS plans for the HEC-RTS 
study.
Right-click on an HEC-RAS alternative, from the shortcut (Figure 2), click Plan Data. The HEC-RAS plan for the 
example watershed, is an unsteady flow plan, so the HEC-RAS Unsteady Flow Analysis dialog will open.
From the File menu, select Save Plan As, the HEC-RAS Save Plan Data As dialog (Figure 3) opens.

From the HEC-RAS Save Plan Data As dialog, specify a new plan name in the Title box (Figure 3).
Click OK, the HEC-RAS Plan Identifier dialog (Figure 4) opens.

Enter an identifier in the HEC-RAS Plan Identifier dialog (Figure 4). Click OK to complete the copy process.

20.7.4 Delete a HEC-RAS Alternative
To delete a HEC-RAS alternative:

From the HEC-RTS main window, click on the Setup module, from the Watershed Tree, from the Models folder, 
expand the RAS node. This provides you with a list of all the available HEC-RAS plans for this watershed.
Right-click on an HEC-RAS alternative, from the shortcut (Figure 2), click Plan Data. The HEC-RAS plan for the 
example watershed, is an unsteady flow plan, so the HEC-RAS Unsteady Flow Analysis dialog will open.
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From the File menu, click Delete Plan, the HEC-RAS Delete Plan File dialog (Figure 5) opens.

From the HEC-RAS Delete Plan File dialog, select the plan you want to delete, and click OK. The HEC-RAS Delete 
Plan File dialog will close.
A window will open asking you if you want to delete the selected plan. Click OK to complete the deletion 
process.

20.8 Create an HEC-FIA Alternative
An HEC-FIA alternative consists of information on consequences for a given hazard. An HEC-FIA alternative is a 
combination of an Inundation Configuration, Impact Areas, Structure Inventory, Critical Infrastructure, Impact 
Response Curves, Agricultural Data, and computation settings. If the HEC-FIA project contains more than one 
alternative (for summer and winter crop conditions, for instance), you can build HEC-FIA model alternatives around 
each of them. 
For further information on how to develop the information required in defining an alternative in HEC-FIA, see the HEC-
FIA User's Manual.

20.8.1 Import an HEC-FIA Alternative
To import an HEC-FIA alternative:
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From the HEC-RTS main window, click on the Setup module, from the Models menu, point to Import, click FIA,
the HEC-FIA Import Alternatives dialog will open (Figure 1).

Click Select/Add Project, an Open browser will open. Browse to the location of an HEC-FIA watershed you wish 
to import. Select an HEC-FIA project file (.prj), click *Open, the Open browser will close.
From the HEC-FIA Import Alternatives dialog (Figure 1), the table will display available HEC-FIA alternatives. 
Select the HEC-FIA alternative you wish to import. click Import Alternatives. Once the import is finished, 
confirmation dialog will open. Click OK, and the confirmation dialog will close.
From the Import Alternatives dialog (Figure 1), click Close. The Import Alternatives dialog will close, and you 
should save your HEC-RTS study.

20.8.2 Edit an HEC-FIA Alternative
To edit an HEC-FIA alternative:

From the HEC-RTS main window, click on the Setup module, from the Watershed Tree, from the Models folder, 
expand the FIA node (Figure 2). This provides you with a list of all the available HEC-FIA alternatives for this 
watershed.
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Right-click on an HEC-FIA alternative, from the shortcut menu (Figure 2), click Alternative. The HEC-FIA Edit 
Alternative dialog will open (Figure 3).

 
Edit the HEC-FIA alternative as desired. For further information on how to modify HEC-FIA alternatives, see the 
HEC-FIA User's Manual.
Click OK, the HEC-FIA Edit Alternative will close. Be sure to save your HEC-RTS study.

20.8.3 Copy an HEC-FIA Alternative
To copy an HEC-FIA alternative:

From the HEC-RTS main window, from the Modeling Toolbar, click . The HEC-FIA software will be 
launched.
From the HEC-FIA main window, from the Study Tree, expand the Alternatives folder, right-click on the HEC-
FIA alternative you wish to make a copy of. Right-click on the HEC-FIA alternative, from the shortcut menu 
(Figure 4), click Save As.
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The HEC-FIA Save Alternatives As dialog will open (Figure 5). Specify a new alternative name in the Name field 
and fill out the Description field (if desired). Leave the Directory field alone.

Click OK, to complete the copy process. The copied alternative will now be shown in the HEC-FIA Alternative
editor.

20.8.4 Delete an HEC-FIA Alternative
To delete an HEC-FIA alternative:

From the HEC-RTS main window, from the Modeling Toolbar, click  . The HEC-FIA software will be 
launched.
From the HEC-FIA main window, from Study Tree, expand the Alternatives folder, right-click on the HEC-FIA 
alternative you wish to delete. Right-click on the HEC-FIA alternative, from the shortcut menu (Figure 4), click 
Delete from Study.
An HEC-FIA Confirm Manager Delete window will open (Figure 6), asking do you really want to delete the 
selected HEC-FIA alternative. Click Yes, the HEC-FIA Confirm Manager Delete window, and the HEC-FIA 
alternative will have been removed from the HEC-RTS study.

For further information on how to delete alternatives in HEC-FIA, see the HEC-FIA User's Manual.

20.9 Editing a Model Alternative
You can edit a model alternative by selecting the alternative you wish to edit in the watershed pane and launching the 
associated software from the HEC-RTS main toolbar. This will open the alternative in the native model and allow you to 
edit the model alternative. If you edit the model alternative in this manner and you have configured one or more 
forecast runs using this alternative you will need to make sure your changes propagate through to your forecast run 
configurations as detailed in HEC-RTS Forecasts.

20.10 Configuring Model Alternative Keys
To complete configuration of a model alternative, you must assign each model alternative a Model Alternative Key. 
The Model Alternative Key is an alpha-numeric identifier that will determine the names of your forecast runs.

To assign model alternative keys:
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From the HEC-RTS main window, click on the Setup module, from the Models menu, click Model Alternative 
Keys, and the Model Alternative Keys dialog (Figure 1) opens.

From the Plugin list (Figure 1), select the model for which you wish to assign a key.
In the Key field (Figure 1), enter a single unique alpha-numeric character that will be used to identify the listed 
Model Alternative.
Repeat Steps 2 and 3 for all models and model alternatives. Click OK, and the Model Alternative Keys dialog 
(Figure 1) closes.

Model alternatives for the standard software applications in HEC-RTS might be named like the following:

MFP deals with future precipitation. You can configure model alternatives for use in conjunction with HEC-HMS to 
compute a variety of future precipitation scenarios. For example:

Example Model Alternatives for MFP

ID Name

N No future precipitation

2 2-inches future precipitation

4 4-inches future precipitation

Q QPF

R One-half QPF

S Twice QPF

HEC-HMS model alternatives simulate watershed response to precipitation. You will use HEC-HMS model alternatives 
to forecast future flows. For example:
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Example Model Alternatives for HEC-HMS

ID Name

N Normal conditions

W Wet basin conditions

D Dry basin conditions

HEC-ResSim model alternatives assist with reservoir operations, consisting of the physical data representing a river-
reservoir system and operating rules for all controllable elements in the system. For example:

Example Model Alternatives for HEC-ResSim

ID Name

N Normal operations

R Restricted downstream channel capacity

W White water release schedule

S Fish spawning release schedule

HEC-RAS model alternatives describe water surface profile and stages at gage locations, geometry information for a 
river, and defined flow data sets. For example:

Example Model Alternatives for HEC-RAS

ID Name

N Normal river conditions

H High channel roughness

L Low channel roughness

B Bridge out
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HEC-FIA model alternatives allow you to analyze flood consequences. Its model forecast alternatives are a combination 
of impact area and hydrograph time series sets. For example:

Example Model Alternatives for HEC-FIA 

ID Name

N Normal conditions

E Evacuated with warning

You can edit the parameters within each HEC-RTS model alternative to reflect changing conditions. The beginning of 
this chapter describes how to edit model alternatives for the HEC-RTS software applications.

20.11 Forecast Run
A forecast run is the set of model alternatives that run sequentially during a forecast. As the with model alternatives, 
forecast runs exist independent of time. Therefore, you can use a forecast run for any forecast time window. 
You create a forecast run by selecting a model alternative for each HEC-RTS software application. There are five 
standard software applications in HEC-RTS, a typical forecast run will include a combination of the five model 
alternatives. When you execute a forecast, HEC-RTS executes the software applications in a sequential order (program 
order).

The table shows three suggested forecast runs. The codes are the names HEC-RTS automatically assigns to each 
forecast run based on the one-character Model Alternative Keys you have assigned to the model alternatives. This 
coding is program order dependent.

Example Forecast Run

Name Code

No future precip NNNNN

QPF QNNNN

Two times QPF SWRBE

In the following example, the forecast alternative named Two times QPF has the code SWRBE. Each character in this 
code is the ID of a specific model alternative for each of the five standard software applications in HEC-RTS. The code 
translates as follows:
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20.11.1 Creating Forecast Run
Before this step can be done, you must have created model alternatives.

Creating forecast runs:

From the HEC-RTS main window, click on the Setup tab, from the Models menu, click Forecast Runs, and the 
Forecast Run Editor (Figure 1) opens.

Click New Run (Figure 1), enter a new forecast run name in the Name field (required), and a description in the 
Description field (optional).
Select program order from the Program Order list (Figure 1). See Chapter 16 for information on program order.
From each program list (Figure 1), select the model alternatives for the forecast run.
From the File menu, click Save. The new forecast alternative displays in the table on the Forecast Run Editor
(Figure 1).
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Click OK, and the Forecast Run Editor closes. Be sure to save your HEC-RTS study.

20.11.2 Delete a Forecast Run
Delete a forecast run:

From the HEC-RTS main window, click on the Setup tab, from the Models menu, click Forecast Runs, and the 
Forecast Run Editor (Figure 1) opens.
From the table, select the forecast run you want to delete. From the Forecast Run menu, click Delete. A Delete 
Forecast Runs window will open, asking do you really want to delete the selected forecast run.
Click Yes, the Delete Forecast Runs window will close, and the forecast run will be removed from the table on 
the Forecast Run Editor.
Click OK and the Forecast Run Editor closes. Be sure to save your HEC-RTS study.
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21 Model Linking Editor
After forecast runs have been created, you need to link the model alternatives that are associated with a forecast run. 
For example, you might want to use output from MFP as input to HEC-HMS, and the output of HEC-HMS as the input to 
HEC-ResSim. This linking of the model alternatives is done using the Model Linking Editor (Figure 1). From the HEC-
RTS main window, click the Setup tab, from the Models menu, click Model Linking, the Model Linking Editor will open 
(Figure 1).

108 Figure 1 Model Linking Editor

21.1 Model Linking Editor Overview
At the top of the Model Linking Editor, from the Forecast Run list (Model Linking Editor) you will select the forecast run 
that needs to be linked. The Model Requiring Input list (Model Linking Editor) displays the model alternatives 
configured for use in the selected forecast run. To complete the model linking process for a given forecast run, you will 
need to step through all the model alternatives listed in the Model Requiring Input list. The remaining portion of the 
Model Linking Editor is the table which lists the inputs required by the model alternative selected in the Model 
Requiring Input list and the source of that input. Figure 1 shows an example of the Model Linking Editor for the 
Russian River watershed with an HEC-HMS model alternative requiring input. 
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This table has four columns:

Location. This column identifies the name of the required input. For example, this could be:
The precipitation grid name or discharge gage name specified in the HEC-HMS model alternative.
The local flow name specified in the HEC-ResSim model alternative.
The river station and node name specified in the HEC-RAS model alternative.
Parameter. This column identifies the type of data or information required by the model alternative. For 
example, this could be flow, stage, or precipitation.
Input From. This column consists of lists that identify the source of the input. These lists display each available 
model alternative from the selected forecast runs and Extract List. Extract List is used to bring data and 
information from external sources (i.e., DSS files), into the watershed. Refer to Data Extract and Post Editors for 
additional information on the Extract Editor.
Location/Parameter. If the Input From column displays the name of a model alternative, this column provides 
a list that contains all model alternative results for the parameter specified in Parameter column. For example, 
in Figure 1, the first row in the table indicates that the Interpolation – ID2 precipitation input should come from 
the MFP model alternative named MFP-Interpolated Obs – Manual Entry QPF. If the Input From column displays 
Extract List, this column will display either a DSS pathname or a CWMS database pathname. 

21.1.1 Select Input Model Alternative
The Select Input Model Alternative (Figure 2) provides a user with a way to set all the Input From values equal to a 
specific model alternative or Extract List. For example, you may want all the HEC-ResSim model alternative inputs to 
come from the HEC-HMS model alternative results. Click Select Input Model Alternative, the Select Input Model 
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Alternative dialog (Figure 2) opens. From the Input Model Alternative list (Figure 2), select a model alternative (or 
Extract List), click OK, the Select Input Model Alternative dialog (Figure 2) closes.

109 Figure 2 Select Input Model Alternative Dialog

A Confirm Input Selection window will open, asking do you want to link all unlinked rows to the selected Input Model 
Alternative. Click Yes, the Confirm Input Selection window will close. All rows in the table that were not linked, will 
now be linked to the selected Input Model Alternative.

21.1.2 Select Source Data Location
Are you having difficulty determining for a specific location what the correct parameter might be? From the Model 
Linking Editor (Figure 1), select a Location (i.e., Ukiah Gage – FLOW), click Browse, the Select Source Data Location
dialog will open (Figure 3). In this dialog you can scroll through the entire list of available locations and parameters for 
the selected model alternative (HMS-Daily Forecasting – 15 MIN). Once you have found the correct location (i.e., Ukiah 
Gage), review the available parameters, select the row in the Select Source Data Location dialog (Figure 3) that 
contains the correct parameter (i.e., Flow). Click Set Location (Figure 3), for the selected Location in the Model Linking 
Editor (Figure 1), the Location/Parameter column will display the selected parameter. To close the Select Source 
Data Location dialog (Figure 3), click Close.
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21.2 Model Linking Editor - Model Linking
To link the model alternatives, complete the following:

From the HEC-RTS main window, click the Setup tab, from the Models menu, click Model Linking, the Model 
Linking Editor will open.
Select the Forecast Run you wish to configure in the Forecast Run list (Example Linking).
Select the first model alternative in the Model Requiring Input list (Example Linking).
In the Model Linking Editor table (Example Linking), specify the Input From for each row as either a model 
alternative or Extract List.
For each row that has a model alternative selected in the Input From column, HEC-RTS has compiled a list of 
locations and parameters for the selected model alternative. To specify the Location/Parameter there are two 
ways, from the Location/Parameters cell, from the list, select the correct parameter. Another way to select the 
correct Location/Parameters, click Browse, the Select Source Data Location dialog will open (Model Linking 
Editor Overview).
Repeat steps 3 through 5 for each model alternative in the Model Requiring Input list (Example Linking).
Repeat all steps for each Forecast Run you wish to configure.
When you are finished with model linking, from the Modeling Linking Editor (Example Linking), click OK. The 
Modeling Linking Editor will close, and all changes will be saved.

21.3 Model Linking HEC-RAS Model Alternatives
The location listed in the Model Linking Editor for HEC-RAS inputs will be the river station and node name of the 
boundary condition location. Typically, your HEC-RAS model will not have node names configured and the location will 
display the river station. To configure HEC-RAS node names, complete the following:

From the CWMS CAVI main window, from the Modeling Toolbar, click  , the HEC-RAS software application 
will open.
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From the HEC-RAS main window, from the Edit menu, click Geometric Data, the Geometric Data Editor will 
open.
From the Geometric Data Editor, from the Tables menu, point to Names, click Node Names. The Node Name 
Table (Figure 1) dialog will open.

Specify name for each river station with a boundary condition in the Node Name column. Hint: it may be useful 
to open the boundary condition editor to correlate river stations, node names, and boundary condition 
locations.
When you are finished, click OK, the Node Name Table dialog will close (Figure 1). From the Geometric Data 
Editor, from the File menu, click Save Geometry Data. To close the Geometric Data Editor, from the File
menu, click Exit Geometry Data Editor, the Geometric Data Editor will close.
From the HEC-RAS main window, from the File menu, click Save Project. To close the HEC-RAS software 
application, from the File menu, click Exit.
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22 Data Extract and Post Editors
The extract and post processes denote the retrieval and dissemination of forecast data. The extract provides data to 
model alternatives that is required during a forecast compute. The post process disseminates forecast data after a 
forecast compute is complete. This chapter goes over the HEC-RTS tools used to set up and run extracts and posts.

22.1 Extracts
An extract refers to the process of obtaining data from DSS files or a WISKI database (KiWIS Write Extension) and 
mapping that data to a model alternative's required input record. The extract retrieves the source data and copies the 
data into records stored in a centralized DSS file called the forecast.dss file. The forecast.dss file is then used to provide 
input data during the forecast compute process. Extracts can contain both gridded data and time series data.

22.2 Extract Editor
After you have completed the model linking you will need to configure extracts that are required by model alternatives. 
Configuring an extract is completed using the Extract Editor (Figure 1).

 

The Extract Editor allows you to connect required model alternative input data from multiple sources to the 
forecast.dss file that provides input data to model alternatives during the compute process. The required input data is 
classified into extract groups that link the source data information to the required input records. To access the Extract 
Editor, from the HEC-RTS main window, click on the Setup tab, from the Models menu, click Edit Extract, the Extract 
Editor will open (Figure 1).

The Extract Editor is comprised of two sections: Required Input and Extract Linking (Figure 2). The Required Input
section contains a table that lists the required input records for each model alternatives. The Extract Linking section 
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contains information on defined extract groups, and contains a table, which lists the input records and source records 
assigned to an extract group.

110 Figure 2 Extract Editor - Sections

22.2.1 Required Input Section
The Required Input section (Figure 3) provides a list of the time series that needs to be mapped to a source record to 
provide input data for the forecast compute.

111 Figure 3 Extract Editor - Required Input Section

The Required Input section provides information on the following:

Model this column lists which software application is requesting the required input record.

Alternative this column lists the name of the model alternative that is requesting the input record.
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Location this column displays the name of the model location that is associated with the input record.

Parameter this column displays the parameter associated with the input record.

Type this data column specifies if the record is times series data or gridded data. Types include: GRID or 
TIME_SERIES. GRID represents DSS gridded data. TIME_SERIES represents time series data.

Destination this column displays the actual input record pathname that the model requires. This is the pathname 
that will be written to the forecast.dss file and used by the model during the compute.

Index Each required destination pathname is assigned an Index number when it is loaded into the Extract Editor. 
This number has no real usage except keeping the initial filtered list set. There can be multiple indices for a single 
DSS pathname.

This information does not display by default in the Required Input table, you will need to set up the table view, see 
Model Linking.

22.2.2 Extract Linking Section
The Extract Linking section (Figure 4), displays information on the extract groups. Extract groups link similar typed 
data (gridded or time series) to a single data source. The source can be a DSS file, a CWMS database, or a WISKI 
database (WISKI Extract and Post). The source records will be mapped to the required input records in the extract 
group. During the creation of a forecast, the source records will be copied into the required input pathnames when are 
created in the forecast.dss file.

112 Figure 4 Extract Editor - Extract Linking Section

The Extract Linking section provides information on the following:

From <data_source>this column lists the source data pathnames that will fill the DSS record displayed in the To 
forecast.dss column (Figure 4). 
Model this column lists which software application is requesting the required input record. 
Alternativethis column lists the model alternative that is requesting the input record. 
Location this column displays the location that is associated with the input record. 
Parameter this column displays the parameter associated with the input record's data. 
To forecast.dss this column displays the actual input record pathname that the model requires. This is the 
pathname that will be written to the forecast.dss file and used by the model during the compute. 
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Index each required destination pathname is assigned an index number (Figure 4) when it is loaded into the 
Extract Editor. This number has no real usage except keeping the initial filtered list set. There can be multiple 
indices for a single DSS pathname.

This information does not display by default in the Extract Linking table, you will need to set up the table view, see 
Model Linking.

22.2.3 Table View Options
You can change the amount of information displayed in the tables in both the Required Input and the Extract Linking

sections. Clicking on the magnifying glass icon ( ) at the top right-hand corner of the tables in each section. The 
Pathname Filters for Extract dialog (Figure 5) opens.

From the Column Text Filters box (Figure 5) you can filter the records to display only records that contain a certain 
phrase or string of text. Filtering can be done by Column, Index, Model, Alternative, Location, Parameter, Type, or 
Destination. You can filter for multiple requirements by clicking +. Below are examples of several different ways that 
you can filter:

Filters can be used to retrieve only records that are an exact match. You can do this by typing a string of text in 
the Filter For: box.
Filters can be used to retrieve records that start, end, or contain a specific string. To do this, use an asterisk 
(*) after, before, or inserted into the string of text you want to filter for.

From the Display Columns box (Figure 5) you can select which columns in the table to view. For the examples in this 
chapter, Index, Model, Alternative, Location, Parameters, and Type have been selected for the tables in each section 
of the Extract Editor.

You can condense records that have the same destination to one row, selecting Hide Duplicate Destinations (Figure 5). 
To remove a record from a table that has already been assigned to an extract group, select Hide Assigned Destinations
(Figure 5). The Hide Assigned Destinations option is not available for the Extract Linking section. For the examples in 
this chapter, neither Hide Duplicate Destinations or Hide Assigned Destinations has been selected.

You can also color code the destination records listed in the Required Input section (Figure 3) depending on if the 
destination record is linked to a source record. You can color code by background or text. For example, to add a 
background color to a record that is not linked, from the Background Color box (Figure 5), click Model Not Linked, a 
Color Chooser dialog will open (Using the Color Chooser). Select a color, click OK, the Color Chooser will close, and 
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from the Destination column of the Required Input table, any record that has not been linked will be highlighted in the 
selected color (Figure 1).

You can also color code the records listed in the Extract Linking section (Figure 6) depending on if the destination 
record is missing from a source, not used by a model, or is a duplication. You can color code by background or text. For 
example, in Figure 6, to add a background color to a record that is not used by a model, from the Background Color box 
(Figure 6), click Not Used by Model, a Color Chooser dialog will open (Using the Color Chooser). Select a color, click 
OK, the Color Chooser will close, and from the Extract Linking table, any record that has not been used by a model will 
be highlighted in the selected color (Figure 1).

22.3 Extract Groups
Extract groups define the type of data and the source data that will be copied when an extract is running. Extract groups 
can be created for the following data sources:

Local DSS time series file
Remote DSS time series file
Local DSS gridded data file
Remote DSS gridded data file
CWMS database
WISKI database (KiWIS Write Extension)

From the Extract Editor, from the Extract Linking section, the Extract Groups box (Figure 1), lists the defined extract 
groups for a watershed. From the Extract Groups box, you can create an extract group; delete an extract group; rename 
an extract group; make a copy of an extract group; select which extract groups will run by default in a forecast compute; 
and, determine the order in which extract groups will run in a forecast compute. In addition, you can color code the 
extract groups that will run by default.



HEC-RTS User Manual  – Data Extract and Post Editors

Data Extract and Post Editors
                             – 

1.

2.

3.
4.

5.

113 Figure 1 Extract Groups Box

22.3.1 Create an Extract Group
To create an extract group:

From the HEC-RTS main window, click on the Setup tab, from the Models menu, click Edit Extract, the Extract 
Editor will open.
From the Extract Linking section, from the Extract Groups box (Figure 1), click New Extract Group, the New 
Extract Group dialog will open (Figure 2).
In the Name box (Figure 2), enter a name for your extract group.
From the Type list (Figure 2) select the type of data (i.e., Time Series, Gridded Data) being extracted and 
mapped.
If you selected Time Series as your Type, from the Source list select either DSS if using a DSS file, or KIWIS if 
selecting data from a WISKI database. If you selected Gridded Data for the Type, DSS is the only option (DSS 
file).
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The KiWIS option is detailed in Appendix K and will not be discussed in this chapter.

 For Time Series or Gridded Data types, from the File box (Figure 2), click . An Open browser will open, 
browse to the location of the appropriate file, click on the filename, click Open. The Open browser will close, 
and you will be returned to the New Extract Group dialog (Figure 2).
If you want your extract group to run automatically when a forecast is made, select Run by Default (Figure 2).
Specify the Time Window to extract the data from the Start and End lists; available options are: Extract Start, 
Start of Simulation, Forecast Time, End of Simulation. Offsets for the start and end times can also be 
included, available options are hours, minutes, or seconds. In the Offset box, you will enter the offset 
increment. This time window is relative to the forecast time window that you defined when you created the 
forecast.
When you are done, click OK, the New Extract Group dialog will close (Figure 2). The new extract group will 
display at the bottom of the Extract Groups box, and the information about the extract group will display.

Note: Extract groups are run in the order they are displayed in the Extract Groups box. If you run more than one extract 
group during the extract process and there are records that are mapped in more than one of the selected extract groups, 
the last extract group mapping will replace all previous mappings.

22.3.2 Adding Required Input Data to Extract Groups
Once an extract group is created, you can select what required input data you want to map to the selected source data. 
To include required input data with an extract group:

Select an extract group from the Extract Groups box (Figure 1).
In the Required Input section, select all the records you want to add to the extract group. You can select 
multiple records by selecting a record, then pressing the CTRL key, click any additional records you want to add 
(Figure 3).

After selecting the required input records, click Add to Group (Figure 4).
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The records selected will be displayed in the Extract Linking section in the table (Figure 5).

Select how much information you want to view in the Extract Linking table by clicking the magnifying glass icon 

( ). Refer to Extract Editor for further details on formatting the Extract Linking table. Note: If you have the 
Hide Assigned Destinations selected, the selected records will not display in the Required Input list.

22.3.3 Selecting Source Records
When records are added to an extract group, the records display the name of the record under the From <data_source>
column in the Extract Linking table. HEC-RTS does its best to match the From <data_source> side record names to the 
To forecast.dss side record names, but sometimes HEC-RTS needs some help.

To select records for the From <data_source> record:

Double-click the row in the From <data_source> column you would like to set the time series record for.
Click  , which appears in the right section of the cell with the From <data_source> name. The DSS Time 
Series Record Chooser will open (Figure 6).
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From the File menu, click Open, an Open HEC-DSS File browser will open (Figure 7). Browse to the location of 
the DSS file that contains the records needed, click on filename, click Open. The Open HEC-DSS File browser 
will close, and the DSS Time Series Record Chooser will display its time series records.
From the Search By Parts area (Figure 6), use the various filter lists to locate the desired time series record.
To select a time series record to replace the one displayed in the selected row in the Extract Linking table, click 
the time series record row in the DSS Time Series Record Chooser (Figure 6), click Set Pathnames.

The time series record you selected will display back on the Extract Linking table in the row you original 
selected.
To set another time series record, click on the next row in the Extract Linking table where you would like to 
replace the record. From the DSS Time Series Record Chooser (Figure 6), click on the time series record you 
want, click Set Pathname.
When all the time series records have been set in the Extract Linking table, from the DSS Time Series Record 
Chooser, from the File menu, click Close.

22.3.4 Ad-Hoc Records
Additional input data not listed in the Required Extract table may be required for a forecast compute. You can add 
additional time series records using the Ad-Hoc Record feature. An Ad-Hoc record allows you to add time series records 
to a DSS time series record in the forecast.dss file.

To add an Ad-Hoc record:

From the Extract Editor, click Add Extract Data Set, the Adhoc: DSS Time Series Record Chooser will open 
(Figure 8).
From the Search By Parts area (Figure 8), use the various filter lists to locate the desired time series record.
Select the pathname row for the record, click Set Pathname.
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4. Once you have selected all the pathnames for all the necessary time series records, from the File menu, click 
Close. The Adhoc: DSS Time Series Record Chooser will close (Figure 8).

22.4 Running Extracts
Extracts can be run two ways, automatically when creating a forecast or when a forecast is open in the Modeling
module.

22.4.1 Automatic Extracts
When a forecast is created, all extract groups that were set to Run as Default will automatically run. Run as Default is 
selected when you create an extract group; from the Extract Groups box, from the shortcut menu, you can toggle Run 
as Default on and off; and, from the Extract Linking section, you can also toggle Run as Default on and off.

During the creation of a forecast, as the extract process starts, an Extract tab (Figure 1) will display in the Message 
Pane of the HEC-RTS main window.
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114 Figure 1 Extract Tab

The Extract tab displays messages on the extract process. These messages include how many values were retrieved for 
each time series, where they were retrieved from, and the pathname that the time series will be stored under in the 
forecast.dss file.

22.4.2 Manual Extracts
Extract groups can be run manually for a forecast. From the Modeling module, you must have a forecast open. From the 
Forecast menu, click Extract, the Run Extract dialog will open (Figure 2). From the Group list, select the extract groups 
you would like to manually run. Click Run Now (Figure 2), the Run Extract dialog will close, and the extract process will 
begin. The Extract tab (Figure 1) will display messages as the extract process proceeds.

 

22.5 Post
A post refers to the process of saving data from the forecast.dss file to a DSS file or a WISKI database (WISKI Extract and 
Post). A post selects an output time series from the forecast.dss file and disseminates that information to an external 
data location. Compute output can be stored as historical results to be viewed or used in future forecasts. HEC-RTS 
supports posting for DSS gridded data and time series data, and WISKI (WISKI Extract and Post) time series data. From 
the Setup module, you will use the Post Editor (Figure 1) to define post groups.
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115 Figure 1 Post Editor

22.6 Post Editor
Now that you have successfully computed a forecast and reviewed results, you might want to save data from the 
forecast.dss file to other DSS files. A post is created and defined from the Post Editor. From the Setup module, from the 
Models menu, click Edit Post, the Post Editor will open.

The Post Editor is comprised of two sections: Available Output and Post Linking. The Available Output section 
contains a table that lists the output records from each model alternative. The Post Linking section contains 
information on the defined post groups, and contains a table, which lists the output records and sources records 
assigned to a post group.

22.6.1 Available Output Section
The Available Output section (Figure 1) provides a list of the model alternative output time series records that can be 
mapped to the CWMS database or other DSS files.

116 Figure 1 Post Editor - Available Output Section
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The Available Output Table provides the following information:

Model this column lists which software application created the output record.

Alternative this column lists the model alternative name that created the output record.

Location this column displays the name of the model object that is associated with the output record.

Parameter this column displays the parameter associated with the output record.

Type this column specifies if the record is times series data or gridded data. Types include GRID or TIME_SERIES. 
GRID represents DSS gridded data. TIME_SERIES represents time series data.

Model Output this column displays the actual output record pathname that a model alternative creates. This is 
the pathname that will be written to the forecast.dss file during the compute.

Index Each time series pathname is assigned an Index number when it is loaded into the Post Editor. This 
number has no real usage except keeping the initial filtered list set. There can be multiple indices for a single DSS 
pathname.

This information does not display by default in the Available Output table, you will need to set up the table view.

22.6.2 Post Linking Section
The Post Linking section (Figure 2) displays information on the post groups. Post groups link similar time series output 
data to a single data destination. The destination can be a DSS file or a WISKI database (WISKI Extract and Post). The 
destination records will be mapped to the required output records in a post group. During a forecast compute, the 
destination records will be copied into the required output pathnames when are created in the forecast.dss file.

117 Figure 2 Post Editor - Post Linking Section

The Post Linking section provides information on the following:

From forecast.dss this column lists the selected model alternative's output records for a post group. This data 
will fill the DSS record displayed in the To <data_source> column.

Model this column lists which software application generates the output data.

Alternative this column lists the model alternative that is created the output record.
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Location this column displays the name of the model location object that is associated with the output record.

Parameter this column displays the parameter associated with the output record's data.

To <data_source> this column displays the output record pathname that will be written to the To <data_source>
during the post process.

Index Each required destination pathname is assigned an Index number when it is loaded into the Post Editor. 
This number has no real usage except keeping the initial filtered list set. There can be multiple indices for a single 
DSS pathname.

This information does not display by default in the Post Linking table, you will need to set up the table view.

22.6.3 Table View Options
You can change the amount of information displayed in the tables in both the Available Output and the Post Linking

sections. Clicking on the magnifying glass icon ( ) at the top right-hand corner of the tables in each section displays 
the Pathname Filters for Post dialog (Figure 3).

118 Figure 3 Pathname Filters for Post Editor - Available Output Table

From the Column Text Filters box (Figure 3) you can filter the records to display only records that contain a certain 
phrase or string of text. Filtering can be done by Column, Index, Model, Alternative, Location, Parameter, Type, or 
Model Output. You can filter for multiple requirements by clicking +. Below are examples of several different ways that 
you can filter:

Filters can be used to retrieve only records that are an exact match. You can do this by typing a string of text in 
the Filter For: box.
Filters can be used to retrieve records that start, end, or contain a specific string. To do this, use an asterisk 
(*) after, before, or inserted into the string of text you want to filter for.

From the Display Columns box (Figure 3) you can select which columns in the table to view. For the examples in this 
chapter, Index, Model, Alternative, Location, Parameters, and Type have been selected for the tables in each section 
of the Post Editor.
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You can remove a record from a table that has already been assigned to an extract group, select Hide Assigned 
Destinations (Figure 3). The Hide Assigned Destinations option is not available for the Post Linking section. For the 
examples in this chapter, Hide Assigned Destinations has not been selected.

You can also color code the output records listed in the Available Output section (Figure 3) depending on if the output 
record is linked to a destination record. You can color code by background or text. For example, to add a background 
color to a record that is not linked, from the Background Color box (Figure 3), click Model Not Linked, a Color Chooser
dialog will open (Using the Color Chooser). Select a color, click OK, the Color Chooser will close, and from the Model 
Output column of the Available Output table, any record that has not been linked will be highlighted in the selected 
color (Figure 3).

You can also color code the records listed in the Post Linking section (Figure 4) when an output record is not used by a 
model. You can color code by background or text. For example, in Figure 4, to add a background color to a record that is 
not used by a model, from the Background Color box (Figure 4), click Not Used by Model, a Color Chooser dialog will 
open (Using the Color Chooser). Select a color, click OK, the Color Chooser will close, and from the Post Linking table, 
any record that has not been used by a model will be highlighted in the selected color.

22.7 Post Groups
Post groups map the model alternative output time series data from the forecast.dss file to a destination data source. 
The following destinations are supported:

DSS file
Remote DSS file located on a CWMS server
CWMS Database
WISKI database (KiWIS Write Extension)

From the Post Editor, from the Post Linking section (Pathname Filters for Post Editor – Post Linking Table), the Post 
Groups box (Figure 1), lists the defined post groups for a watershed. From the Post Groups box, you can create a post 
group; delete a post group; rename a post group; make a copy of a post group; select which post groups will run by 
default during the post process; and, determine the order in which post groups will run in a post process. In addition, 
you can color code the post groups that will run by default.
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119 Figure 1 Post Groups Box

22.7.1 Create a Post Group
To create a post group:

From the HEC-RTS main window, click on the Setup tab, from the Models menu, click Edit Post, the Post Editor
will open.
From the Post Linking section, from the Post Groups box (Figure 1), click New Post Group, the New Post 
Group dialog will open (Figure 2).

In the Name box (Figure 2), enter a name for your post group.
For posting data there is only one data type – Time Series.
From the Destination list (Figure 2) you can select DSS if using a DSS file or KIWIS when using a WISKI database.

The KiWIS option is detailed in WISKI Extract and Post and will not be discussed in this chapter.
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From the File box (Figure 2), click . An Open browser will open, browse to the location of the appropriate file, 
click on the filename, click Open. The Open browser will close, and you will be returned to the New Post Group
dialog (Figure 2).
Select the F-Part substitution for the output records. From the F-Part list (Figure 2) you have several options to 
select from, the default is As Specified.
If you want your post group to run automatically during a post process, select Select in Run Post List (Figure 2).
Specify the Time Window to post the data from the Start and End lists; available options are: Extract Start, 
Start of Simulation, Forecast Time, End of Simulation. Offsets for the start and end times can also be 
included, available options are hours, minutes, or seconds. In the Offset box, you will enter the offset 
increment. This time window is relative to the forecast time window the you defined when you created the 
forecast.
When you are done, click OK, the New Post Group dialog will close (Figure 2). The new post group will display at 
the bottom of the Post Groups box, and the information about the post group will display.

Note: Post groups are run in the order they are displayed in the Post Groups box. If you run more than one post group 
during the post process and there are records that are mapped in more than one of the selected post groups, the last post 
group mapping will replace all previous mappings.

22.7.2 Adding Output Data to Post Groups
Once a post group is created, you can select which model alternative output records you want to include in in the post 
group. To add model alternative output records to a post group:

From the Post Groups box (Figure 1), select the name of a post group, the Post Linking table (Post Editor - Post 
Linking Section) will display information about the selected post group.
In the Available Output section (Figure 3), select all the output records that you want to add to the post group 
from the table. You can select multiple records by clicking on one record row in the table, then pressing your 
CTRL key and clicking on any additional records you want to add (Figure 3).
Click Add to Group (Figure 3), the records selected will display in the Post Linking table (Post Editor - Post 
Linking Section).

You can select how much information you want to view in the Post Linking table by clicking . Refer to Post Editor
for further details on formatting the Post Linking table. Note: If you have the Hide Assigned Destinations selected, the 
selected records will not display in the Available Output list.
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22.7.3 Selecting Destination Records
When Available Output records are added to a post group, the name of the Available Output record is displayed under 
the To <data_source> column in the Post Linking table (Post Editor - Post Linking Section). These To <data_source>
record pathnames need to be replaced with the destination time series record name.

To select a time series record for the To <data_source> record:

From the Post Linking table, double-click the row in the To <data_source> column you would like to set the 
time series record for.
Click , which appears in the right section of the cell with the From <data_source> name. The DSS Time 
Series Record Chooser will open.
From the File menu, click Open, an Open HEC-DSS File browser will open. Browse to the location of the DSS file 
that contains the records needed, click on filename, click Open. The Open HEC-DSS File browser will close, and 
the DSS Time Series Record Chooser will display its time series records.
You can filter the time series pathnames displayed in the table by using the Search By Parts Parameters at the 
top of the DSS Time Series Record Chooser.
To select a time series record to replace the one displayed in the selected row in the Post Linking table, select 
the time series record row in the DSS Time Series Record Chooser, click Set Pathnames.
The time series record you selected will display in the Post Linking table in the row you original selected.

To set another time series record, from the DSS Time Series Record Chooser:

Click on the next row in Post Linking table that you would like to replace, click on the time series record you 
want to use in the DSS Time Series Record Chooser, click the Set Pathname.
When all of the time series records have been set in the Post Linking table, from the DSS Time Series Record 
Chooser, from the File menu, click Close.

22.7.4 Ad-Hoc Records
From the Available Output table, you can add additional time series records to the outgoing data source using the Ad-
Hoc record feature in a post group. An Ad-Hoc record allows you to save forecast.dss time series record data to a DSS file 
even if those records were not listed in the Available Output table.

To add an Ad-Hoc record:

From the Extract Editor, click Add Extract Data Set, the Adhoc: DSS Time Series Record Chooser will open.
From the Search By Parts area (Adhoc: DSS Time Series Record Chooser), use the various filter lists to locate 
the desired time series record.
Select the pathname row for the record, click Set Pathname.
Once you have selected all the pathnames for all the necessary time series records, from the File menu, click 
Close. The Adhoc: DSS Time Series Record Chooser will close.

22.8 Running Posts
There are two ways to run a post group. A post group can be set to run automatically after a successful forecast 
compute or when a forecast is open in the Modeling module.
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22.8.1 Automatic Posts
After a forecast is created and before the forecast is computed, you can automatically have the post process run after 
the forecast compute is completed. From the Modeling tab (make sure a forecast is open), from the Forecast tabs, click 
the Actions tab. Select Run Post after Successful Compute, now your post process will happen automatically once the 
forecast compute has finished.

Once a post process starts, from the Message Pane, a Post tab (Figure 1) will display. These messages include how 
many values were retrieved for each time series, where the time series were retrieved from, and the pathname that the 
time series will be stored under in the post file.

120 Figure 1 Post Message Tab

22.8.2 Manual Posts
To run a post group manually:

From the Modeling module (be sure that a forecast is open), from the Models menu, click Post, the Run Post
dialog will open (Figure 2).
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Alternatively, from the Modeling tab (make sure a forecast is open), from the Forecast tabs, click the Actions
tab (Figure 3), click Post. The Run Post dialog will open (Figure 2).

Select the post groups you would like to run, click Run Now (Figure 2).
The Run Post dialog will close, and the post process will start. Once a post process starts, from the Message 
Pane, a Post tab (Figure 1) will display. These messages include how many values were retrieved for each time 
series, where the time series were retrieved from, and the pathname that the time series will be stored under in 
the post file.
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23 Team Modeling
Team modeling facilitates collaboration between modelers working with the same watershed and forecasts. Multiple 
modelers may be sharing responsibility within a complex watershed containing several models. One modeler may only 
be responsible for the HEC-HMS model, while another oversees HEC-ResSim and HEC-RAS. Team modeling allows each 
modeling team member to contribute expertise and participate in real-time synchronized activities.

Team modeling consists of a master watershed and its associated forecasts, which are stored in a shared location (such 
as a networked drive). Team members share data by uploading and downloading changes to and from a master 
watershed, interacting with a local copy that resides on their computer. When watershed files are updated on the 
master watershed, team members working on the same watershed are notified of the changes by a real-time 
notification system.

The master watershed keeps detailed records that provide information on what files are changed, when the changes 
were made, and who modified the data. This information includes changes made to base and forecast data. Base 
data refers to the starting copies of the model alternatives that are used in forecasts. Forecast data represents the 
working copies of the model alternatives, including observed and forecast boundary condition data.

This chapter describes how to utilize the team modeling features, how to set up a master watershed; how to work with 
base data; and, how forecasts work in a team environment. Further additional details important to understanding team 
modeling, are detailed in Technical Notes on Versioning.

23.1 Master Watersheds
A master watershed is a watershed shared by multiple modelers. The master watershed consists of the watershed's 
base and forecast data. The master watershed needs to reside somewhere accessible by all participating team 
members. If team members intend to contribute updates to the data or models, then that team member must have 
write privileges on the shared drive (shared network drive).

The master watershed is not modified directly on the shared location. Instead, a copy of the master watershed is 
downloaded to each team member's computer. The team members edit their local copy of the master watershed, then 
upload changes back to the master watershed. Only files and DSS records that have been changed are uploaded and 
downloaded, this speeds up the process significantly since files that have not been changed do not need to be 
transferred.

A master watershed keeps track of the changes that each team member makes and notifies other team members of 
those changes. If the master watershed is modified by a member while others are working on the master watershed, the 
other members will receive a notification on the lower right-land side of their desktop alerting them that the files on 
their local copy of the master watershed are now out-of-date. If the watershed is closed at the time of the change, an 
out-of-sync notification will appear when the modeler next opens the watershed.

Any HEC-RTS (Version 3.1 or higher) study can become a master watershed. The master watershed may begin as a 
watershed on your computer or already exist on a networked drive. Once the master watershed has been set up, pre-
existing forecasts may be turned into team forecasts. This is further outlined in Team Forecasting.

Regular watersheds will not have access to the team modeling features that master watersheds provide until they are 
upgraded to a master watershed. The following topics provide detailed instructions on how to set up a master 
watershed and walk you through the different setup scenarios.
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23.1.1 Create a Master Watershed
Any HEC-RTS (Version 3.1 or higher) study can become a master watershed. You can turn a regular watershed on your 
computer into a master watershed and then upload it to a networked drive. After the master watershed is uploaded, 
other modelers will have access to it. You can also turn a regular watershed that already exists on a networked drive 
into a master watershed. The following sections go through each of these processes in detail.

23.1.1.1 Create Master Watershed from Watershed on Your Computer
A regular HEC-RTS (Version 3.1 or higher) watershed located on your computer can be turned into a master watershed 
and then uploaded to a network drive. To turn a watershed into a master watershed, open the watershed you would 
like to convert to a master watershed in HEC-RTS (Version 3.1.1), select the Setup tab. From the Watershed menu, click 
Watershed Properties (Figure 1)

121 Figure 1 Setup Module - Watershed Menu

The Watershed Properties dialog will open (Figure 2). From the Watershed Properties dialog, select the Team
tab.

In the Team tab, select Team Watershed (Figure 2).
To upload the master watershed to a network location, click Windows Network.
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When uploading to a local network location, the file path will need to be selected. To the right of the Watershed 
File box, click  , an Open browser will open. Browse to the folder location on the shared network where you 
would like to upload the master watershed.
Click Open, the Open file browser will close, and the selected file pathname will display in Master Watershed 
Folder box (Figure 2).
Once the upload location has been selected and defined, click Upload Now. The Enter Upload Comments
dialog will appear (Figure 3).

In the Enter Upload Comments dialog, type in a description for the upload and then click OK. The Enter Upload 
Comments dialog will close, and the upload will start. Note: The comments are part of the versioning for team 
modeling and cannot be changed later.
The Watershed Properties dialog will become inactive during the upload process and display an Uploading
indicator (Figure 4).

An Upload message tab will appear along the bottom of the CAVI screen providing status updates during the 
upload process (Figure 5).
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When the upload has completed, an Upload Complete message will appear (Figure 6), indicating the number of 
files that were uploaded for the master watershed.

Once the watershed is uploaded to the network drive, other team members can access it and download copies of the 
files to their own computers. For more instructions on this process see

23.1.1.2 Create a Master Watershed from a Watershed on a Networked Drive
Watersheds that already exist on a networked drive can be turned into master watersheds and shared with the team. 
The following steps, show how you would convert a pre-existing HEC-RTS study into a master watershed:

Start HEC-RTS Version 3.1.1, but do not open a watershed. From the HEC-RTS main window, click the Setup tab.
From the Watershed menu, point to Team, click Download Master Watershed. The Select Master Watershed
dialog will appear open (Figure 7).

Select On Networked Drive (Figure 7), to the right of the Watershed File box, click  . An Open browser will 
open. 
From the Open browser, browse to the location of the watershed, select the watershed you want to make a 
master watershed, click Open. The Open browser will close, the location and name of the selected watershed 
will display in the Watershed File box (Figure 7).
From the Select Master Watershed dialog (Figure 7), click Apply. A confirmation window will display confirming 
the watershed is now a master watershed. Now you can download the master watershed to your computer.
Close the confirmation window, click Download, the Select Destination Location dialog will open (Figure 8). 
Your preconfigured watershed location folder is displayed in the Locations list (Figure 8).
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Select the appropriate watershed location folder from the Locations list, click OK, the download of the master 
watershed will begin. The Select Master Watershed dialog (Figure 7) will become inactive during the download 
process and display a Downloading indicator (Figure 9).

A Download tab will display in the Message Pane (Figure 10), providing status updates during the download 
process.

When the download is finished a Download Complete window (Figure 11) will display. Click OK, the Download 
Complete window will close. An Open Watershed window will display (Figure 12) asking if you would like to 
open the watershed in HEC-RTS.

23.1.2 Download an Existing Master Watershed
When you are ready to share the master watershed with other team members, they will need to download a copy of the 
master watershed to their computers.

To download an existing master watershed:
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Start HEC-RTS Version 3.1.1, but do not open a watershed. From the CWMS CAVI main window, click the Setup
tab.
From the Watershed menu, point to Team, click Download Master Watershed (Figure 13). The Select Master 
Watershed dialog will appear open (Figure 14).

To continue downloading the master watershed from a networked drive see the next section – Download from 
a Networked Drive

23.1.2.1 Download from a Networked Drive
The following steps will guide you through downloading the master watershed from a network drive:

From the Select Master Watershed dialog, click On Networked Drive (Figure 14), to the right of the Watershed 
File box, click . An Open browser will display.
From the Open browser, browse to the location of the watershed, select the watershed you want to make a 
master watershed, click Open. The Open browser will close, the location and name of the selected watershed 
will display in the Watershed File box (Figure 14).
From the Select Master Watershed dialog (Figure 14), click Apply. If the watershed is already a master 
watershed, a No Changes Made window will display. If the watershed is not a master watershed, the watershed 
will be set as a master watershed and a message window will state that the watershed was successfully updated. 
Close the message window.
From the Select Master Watershed dialog (Figure 14), click Download. A Select Download Location dialog will 
display (Figure 8). Your preconfigured watershed location folder is displayed in the Locations list (Figure 8).
Select the appropriate watershed location folder from the Locations list, click OK, the download of the master 
watershed will begin. The Select Master Watershed dialog (Figure 14) will become inactive during the 
download process and display a Downloading indicator (Figure 9).
A Download tab will display in the Message Pane (Figure 10), providing status updates during the download 
process.
When the download is finished a Download Complete window (Figure 11) will display. Click OK, the Download 
Complete window will close.
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The real-time messaging systems will also display a message (Figure 15) indicating that files have been added for 
the master watershed.

When the download is done, An Open Watershed window will display (Figure 12), asking if you would like to 
open the watershed in HEC-RTS. To open the watershed, click Yes.

23.1.3 Turning Team Modeling Off
If you no longer need to use team modeling with the local copy of the watershed you can turn the feature off. Turning 
team modeling off will convert the watershed into a regular watershed and it will no longer communicate with the 
master watershed. The watershed will behave as a normal HEC-RTS study and all team modeling options will be 
disabled.

To turn team modeling off for the local copy of the watershed:

First, from the HEC-RTS main window, open the master watershed that is on your computer, click the Setup tab.
From the Watershed menu, click Watershed Properties (Figure 1), the Watershed Properties dialog will open 
(Figure 2).
Click on the Team tab (Figure 16), uncheck Team Watershed. Click OK, the Watershed Properties dialog will 
close.

From the HEC-RTS main window, from the Toolbar, click  , this will save all changes made to the watershed.

23.2 Master Watershed Base Data
Data that resides in the watershed's main folder is called base data. Base data includes all the data that supplies 
information displayed in the Setup, Acquisition, and Visualization modules. This data encompasses all data needed to 
create a forecast. Base data includes maps, layers, layouts, reports, scripts, extract post information, all model 
alternatives, shared and study information, and HEC-RTS data. Base data does not include data for the forecast, more 
detailed information on forecast data is described in Team Forecasting.

This section walks through how to determine which local base data files are up-to-date, how to download base data 
from the master watershed, and how to upload revised files back to the master watershed to share with other team 
members working on the watershed.
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23.2.1 Master Watershed Synchronization Dialog
The Master Watershed Synchronization dialog (Figure 1) is used to upload or download base data to and from the 
master watershed. From the HEC-RTS main window, click on the Setup tab, from the Watershed menu, point to Team, 
click Sync with Master Watershed, the Master Watershed Synchronization dialog will open (Figure 1).

122 Figure 1 Master Watershed Synchronization Dialog

On the Master Watershed Synchronization dialog (Figure 1), the base data is displayed in an expandable tree called 
the Synchronization Tree. Each node in the Synchronization Tree represents a data group for the watershed. The 
data groups reflect the folder structure of the current watershed folder (Figure 2).

123 Figure 2 Watershed Folders

The Watershed Data node (Figure 3), is a special data group. This data group represents three folders in the 
watershed's folder structure - study, reports, and layouts. Hovering the mouse over a node in the Synchronization Tree
displays a tooltip (Figure 3), that provides information on what watershed folder(s) represent the data group; what 
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master watershed folder(s) represent the data group; what the version is for the local copy of the watershed; what the 
version is for the server copy of the watershed; and comments.

124 Figure 3 Watershed Data Synchronization Tree Node

For example, in Figure 4, the top node is R462 (3/3). This is the name of the watershed. The top node represents all the 
data groups under the watershed's main folder. If you upload or download this node, all watershed base data will be 
transferred.

Next to a data group node, there are two numbers shown in parenthesis. For example, in Figure 5, from the 
Synchronization Tree, the Shared folder has (1/2) displayed. These numbers indicate what version of the folder is on 
your computer and what version is on the master watershed. The first number (top) represents the watershed that is on 
your computer. The second number (bottom) represents the version of the master watershed. If the top number is less 
than the bottom number, the master watershed folder has been updated and the changes need to be downloaded to 
your local copy. For example, Shared (1/2), informs you that the Shared folder on the local copy of the watershed is 
Version 1, and the master watershed is Version 2. If the numbers were "(0/0)" or "(Na/Na)", this means the folder has 
never been uploaded to the master watershed.

In addition to the displayed version numbers, the Synchronization Tree nodes will highlight in different colors 
depending on the node's revision state (Figure 5). The different colors and their meaning are listed in the Legend area 
(Figure 5) below the Synchronization Tree. The highlight colors represent the following information:
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125 Figure 5 Synchronization Tree Node Color Indicators

White Nodes highlighted in white means that the local watershed copy is up to date with the 
master watershed copy for those data groups. The version number displayed next to the 
node name will have both numbers matching, for example CAVI (3/3).

Orange Nodes highlighted in orange mean that the master watershed has a newer version of the 
files in a data group than the local watershed copy. The files will need to be downloaded 
from the master watershed. The version numbers displayed next to the node name will 
show the top number is less than the bottom number. For example, CAVI (1/3) indicates 
the local watershed copy version is 1, and the master watershed version is 3. To 
download the files, select a highlighted node (orange), the Master Watershed 
Synchronization dialog (Figure 6) now displays an Actions box, from that box, click 
Download.

Yellow Nodes highlighted in yellow mean that the data group has not been uploaded to the 
master watershed. For example, if the FIA data group displays FIA (0/0) or FIA (Na/Na), 
this means there is no version for the data group on the mater watershed.
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126 Figure 6 Master Watershed Synchronization Dialog - Actions Box

To upload the files, select a highlighted node (yellow), the Master Watershed Synchronization dialog (Figure 6) now 
displays an Actions box, from that box, click Upload.

In the Team section of the Master Watershed Synchronization dialog (Figure 6), when you select a data group, 
information about that data is displayed. In addition, the Actions box (Figure 6) provides you with commands that 
allow you to interact with the selected data group:

Upload allows you to upload the selected data group node to the master watershed.

Downl
oad

allows you to download the latest version of the selected data group node from the master watershed.

Protec
t

is only available when the status of the selected data group node is Unprotected. This option allows you 
to prevent other team members from uploading changes for a data group to the master watershed. If the 
data group node is already protected, you will see an Unprotect option. Selecting Unprotect, will allow 
others to upload changes for that data group node to the master watershed.

Unprot
ect

is only available when the status of the data group node is Protected. Selecting Unprotect, will allow 
sharing of the master watershed so you can upload changes for the selected data group.

Below the Action box (Figure 6) is the revision information for a selected data group:
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Revisio
n

displays the revision number of the local watershed on your computer and the master watershed as "# Of 
#", respectively. The first number represents the version number of the selected data group for the local 
copy of the watershed on your computer. The second number is the revision number of the selected data 
group on the master watershed. If the two numbers are the same, this means that you have the most 
recent copy of the master watershed for the selected data group. If they are not the same, then you are 
not working on the most recent copy of the selected data group and need to download the updated data 
group from the master watershed.

Update
d On

reports the date, time, and username of the person who last updated the selected data group on the 
master watershed (format - "DDMMMYYYY, HH:MM by: <username>"). The date is set by the team member 
who made the revision's (computer date and time). The username displayed is that team member's 
workstation login username.

Status reports if the version of the selected data group from the local copy of the watershed on your computer is 
Current or Out of Date. The Current status means that your computer's version of the selected data 
group and the master watershed version are the same. The Out of Date status means that the current 
master watershed version is newer than the copy of the selected data group that is currently on your 
computer.

Comm
ents

displays any comments made on the last revision on the master watershed.

History opens the Revision History dialog which provides detailed information on all the revisions made to the 
master watershed data (further details about the Revision History dialog is available in the Revision 
History section of this chapter).

23.2.2 Downloading Base Data
If base data has been changed for the master watershed or you would like to get the latest version, you can download 
the data from the Master Watershed Synchronization dialog (Figure 1).

To download base data from the master watershed:

First, from the HEC-RTS main window, open the master watershed that is on your computer, click the Setup tab.
From the Watershed menu, point to Team, click Sync with Master Watershed. The Master Watershed 
Synchronization dialog will open (Figure 1).
From the Synchronization Tree (Figure 5), select the data group node that you need to download files. Hovering 
the mouse pointer over the nodes will display information about the data group node that will be downloaded.
From the Master Watershed Synchronization dialog (Figure 1), click Download, the Download from Master 
Watershed window will open (Figure 7).
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Click Yes, the Download from Master Watershed window will close, and the download process will start.

During the download process, the Master Watershed Synchronization dialog will disable and display a 
Downloading indicator (Figure 8).

A Download tab will display in the Message Pane, providing status updates during the download process.
When the download is complete, a notification message will display (Figure 9), and the Master Watershed 
Synchronization dialog will be active again (Figure 1).

When you have downloaded all of the files that you need, close the Master Watershed Synchronization dialog 
(Figure 1).
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23.2.3 Uploading Base Data
Changes made to the base data on the local copy of the master watershed can be uploaded to the master watershed's 
base data and then shared with other team members. If other team members have the same HEC-RTS study open 
during the upload, the team members will receive real-time notification messages indicating that the master watershed 
has been updated after the upload is complete.

To upload changes to the master watershed's base data:

First, from the HEC-RTS main window, open the master watershed that is on your computer, click the Setup tab.
From the Watershed menu, point to Team, click Sync to Master Watershed. The Master Watershed 
Synchronization dialog will open (Figure 1).
From the Synchronization Tree (Figure 5), select the data group node that you need to upload the files for in the 
master watershed. Hovering the mouse over the data group node will display information about the data group 
node that will be uploaded. From the Actions box (Figure 10) click Upload.

The Enter Upload Comments dialog will display. Enter comments about the files that you are uploading. These 
comments will be seen by other team members as part of the revision.
Click OK, the upload process will start. The watershed will close in the HEC-RTS main window and the Master 
Watershed Synchronization dialog will become inactive and display an Uploading indicator (Figure 11).
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An Upload tab will display in the Message Pane (Message Pane - Upload Tab), providing status updates during 
the upload process.

When the upload is complete, the watershed will reopen in the CWMS CAVI main window and the Master 
Watershed Synchronization dialog (Figure 11) will be active again. A Real-Time Notification Message will 
display (like Download Complete - Real-Time Notification Message) indicating what files have been uploaded to 
the master watershed. Any team members that have the same master watershed open on their desktops will 
also receive a notification.
If you do not have the most recent files, and then try to upload changes, you will get an Out of Date message 
(Figure 12).

This is to prevent you from accidentally deleting another team member's changes. Click OK, then download the 
outdated files. Downloading files is further explained in the section titled Downloading Base Data.

23.2.4 Out of Date with Master Watershed
If new files have been uploaded to the master watershed since you closed the watershed an Out of Date with Master 
Watershed dialog will display (Figure 13) when you open the watershed, prompting you to update any files that are out 
of date.
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127 Figure 13 Out of Date with Master Watershed Dialog

The Out of Date with Master Watershed dialog (Figure 13) consists of the Data Group table and, Update and History
buttons. The out-of-date data groups will have a checkmark in the Update column (Figure 13) of the Data Group table 
by default. To download the latest master watershed version of the data groups, click Update (Figure 13). All the data 
groups in the Data Group table with checkmarks will be updated. The Out of Date with Master Watershed dialog 
(Figure 13) and your watershed will close as the files will begin updating.

The columns of the Data Group table (Figure 13) represent the following information:

Updat
e

Checking the box in the Update column (Figure 13) will select the row's data group that will be uploaded 
to the master watershed when uploading begins.

Model The Model column (Figure 13) displays the data group name. To view the watershed folders associated 
with the data group, hover the mouse over a data group name in the Model column row, a tooltip will 
display showing the associated data for that data group.

Local 
Rev.

displays the local revision number for the data group that is on your computer's copy of the master 
watershed.
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r Rev.

displays the master watershed's revision number for the data group.

Comm
ents

displays the last comment provided for the revision on the master watershed.

The highlight colors in the table are defined in the Legend box (Figure 13). The colors indicate the following states:

White means that data group is currently up to date. No further action needs to be taken.

Orang
e

represents data groups that are out-of-date with the master watershed, which means the master 
watershed version is newer the watershed on your computer. To resolve this, select a row that is 
highlighted in orange, then click Update.

Yellow represents a data group that has never been uploaded to the master watershed. To upload the data 
group, select a row that is highlighted in yellow, then click Upload.

At the bottom of the Out of Date with Master Watershed dialog (Figure 13) is a History button. The History button is 
active when a row is selected in the table. Clicking the History button displays the History dialog for the selected row. 
The History dialog displays a list of detailed information on the versions for the data group. For information on the 
Revision History dialog, see the section titled Revision History.

23.3 Team Forecasting
Team forecasting allows multiple modelers to work on the same forecast simultaneously. Each team member has a 
copy of the master watershed forecast on their computer. Changes that are uploaded to the master watershed forecast 
can be downloaded and modified by other team members.

The following sections go over retrieving a team forecast from the master watershed, creating a new team forecast, 
uploading, and downloading team forecast changes, and the available team tools to help with this process.

23.3.1 Retrieving a Team Forecast
Once a forecast has be uploaded to the master watershed, it can be shared with other team members as a team 
forecast. Note: When retrieving team forecasts from the master watershed, a forecast cannot be open in the Modeling
module. If a forecast is open, you will be unable to download a team.

To download a team forecast from a master watershed:

First, from the HEC-RTS main window, open the master watershed that is on your computer, click the Modeling
tab. Do not open a forecast, if you have a forecast open, close the forecast.
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From the Forecast Tabs (Figure 1), click on Team. Click Download, the Choose Forecast to Download dialog 
will open (Figure 2).

From the Existing box (Figure 2), select the forecast you would like to download from the list, click Download. A 
Download from Master Watershed confirmation message will display.

Click Yes, the download will begin. A Download tab will display in the Message Pane, providing status updates 
during the download process.
When the download is finished a Download Complete window will display. Click Yes, the forecast will open.
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23.3.2 Creating a Team Forecast
To create a team forecast, use your local copy of the master watershed, and create a forecast as you normally would. 
Once the forecast is created you can upload it to the master watershed before or after you compute it.

To create a team forecast:

First, from the HEC-RTS main window, open the master watershed that is on your computer, click the Modeling
tab. Steps for creating a new forecast are detailed in HEC-RTS Forecasts.
From the Forecast Run Details area (Figure 3), select a forecast. From the Forecast Tabs (Figure 1), click Team.

Click Upload (Figure 3), the Enter Upload Comments dialog will appear open.
In the Enter Upload Comments dialog, enter information about the upload click OK.
The forecast will temporarily close in HEC-RTS and the upload will begin. Once the upload is complete, the 
forecast will display in the Modeling tab (Figure 4). More team forecasting information will display on the Team
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tab now that the forecast is a team forecast.

23.3.3 Uploading Forecast Changes
Changes made to the team forecast on your computer can be uploaded to the master watershed and shared with other 
team members. If other team members have the forecast open in HEC-RTS, the team members will receive a 
notification message that the master watershed has been updated. The uploaded forecast changes can include all the 
forecast data or a single model alternative's data. When uploading a single model alternative's data, only the model 
alternative's data and the model alternative's DSS records will be uploaded to the master watershed. If uploading the 
entire forecast, all model alternatives and the entire forecast.dss file will be uploaded.

Note: Before making changes and uploading forecast data, the status displayed in the Team tab needs to read 
Current. The Current status means you have a copy of the most recent changes from the master watershed on your 
computer. This copy can be changed once it is downloaded. Best practice would be to download the forecast to the 
status current, and then make changes to the model alternatives. This prevents you from unintentionally erasing data 
that has been changed since you last updated your local data files.

To upload the changes for the team forecast to the master watershed:

First, from the HEC-RTS main window, open the master watershed that is on your computer, click the Modeling
tab. From the Forecast menu, open a team forecast.
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From the Forecast Run Details area (Figure 5), select a forecast. From the selected forecast tree, click on a 
model alternative. For example, in Figure 5, the MFP model alterative has been selected.

From the Actions box (Figure 5), click Upload, the Enter Upload Comments dialog will open. Enter comments 
on the upload in the text field. When you are done, click OK, the upload will begin.

Note: You can upload ALL data for the selected forecast by checking the Upload All Files checkbox located on the 
bottom left-hand side of the Enter Upload Comments dialog. This will override all the data for that forecast model in 
the master watershed, not just the changes.

If you try to upload changes for a model alternative and the current local revision number does not match what is on 
the master watershed, you will be notified that your model alternative is out-of-date and prompts you to download the 
latest changes from the master watershed.

When the upload starts, the forecast will close and an Upload tab will appear in the Message Pane on the CAVI. 
The Upload tab displays information on the files uploading.
When the upload is complete, the real-time notification messages will appear on the bottom right-hand side of 
your monitor screen and the forecast will be re-opened and displayed again in HEC-RTS.



HEC-RTS User Manual  – Team Modeling

Team Modeling
                             – 

3.

4.

1.

2.

3.
4.

If changes have been made within a team forecast, the affected model alternative's icon will display two red 
arrows, indicating that your local copy is no longer current (Figure 6).

When attempting to close a team forecast without first uploading changes to the master watershed, the Copy 
Model Changes dialog (Figure 7) will prompt you to sync your changes.

To upload the changes to the master watershed from the Copy Model Changes dialog (Figure 7):

Select the model alternatives to sync with the master watershed by selecting the check next to their name. Any 
model alternatives that do not match the copies in the master watershed will be checked by default. The MFP 
and HMS model alternatives need to be synced with the master watershed in the example (Figure 7).
Copy to Base updates changes in model files from the forecast folders back to the watershed "base" model 
folders.
Click Sync to Master, an Enter Upload Comments dialog will open for each model alternative selected to sync.
Enter upload comments and click OK to start the upload process. An Upload tab will display in the Message 
Pane. The tab will display the status message during the upload.
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If your local files are not current, you will receive an Out Of Date warning reminding you to sync with the master 
copy before making and uploading changes.

23.3.4 Downloading Forecast Changes
Changes made to the team forecast on the master watershed can be downloaded to your computer's team forecast 
copy. You can download the entire forecast or a single model alternative's data. When downloading a single model's 
data, only the model alternative's data and DSS records will be downloaded to your local copy. If downloading the 
entire forecast, all model alternatives and the entire forecast.dss file will be copied.

Note: It is important to download any files that have been updated before you start revising the files on your copy. This 
is to ensure you do not accidentally override another modeler's changes.

To download team forecast changes to your local copy of the forecast:

First, from the HEC-RTS main window, open the master watershed that is on your computer.
Select the forecast run or model alternative node in the Forecast Tree you would like to download changes for. 
For example, in Figure 8, the HEC-HMS model alternative is selected.

From the Team tab, click the Upload button in the Actions (Figure 8).
The Download from Master Watershed message will appear.
Click Yes to continue with the download. If you would like to override all files for the selected forecast node you 
are downloading, check the Download All Files checkbox before clicking Yes.
The forecast will close in the HEC-RTS main window and the download will start. A Download tab will display in 
the Message Pane that displays information about the download.
When the download is complete, the forecast will re-open in the HEC-RTS main window and a real-time message 
will display on the bottom right-hand side of your screen (Download Notification Message).
The download will replace any out-of-date files for the selected Forecast Tree node on your computer with the 
files from the master watershed and the Revision information on the Team tab will update. Only the files that 
have had a revision update on the master watershed will be downloaded.

23.3.5 Team Forecast Tab
The Team tab (Figure 9) is located at the bottom of the Modeling tab and provides access to team forecasts, and allows 
you to upload, download, and protect forecast data. It also provides detailed information on the forecast data's revision 
information and history. Each of these features are explained in more detail in the following sections.
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The Forecasts box (Figure 9) displayed at the top of the Team tab displays the Forecast Tree, which displays the 
different forecast runs and model alternatives for the forecast. When a node is selected in the Forecast Tree, the 
bottom half of the tab will populate with information about forecast teaming on that selected forecast data. For 
example (Figure 9), if a forecast run node is selected, the Team area reflects the information for that specific forecast 
run. If a model alternative is selected in the tree, the Team tab will display information on that model alternative in the 
forecast run. If there are no team forecasts open and the watershed is a master watershed, the Team tab will display a 
Download button that allows you to select a pre-existing team forecast on the master watershed and download it to 
your computer.

For example, in Figure 9, displays the MFP model alternative "No Future Rain" selected in the Forecast Tree and the 
Team tab displaying information on that model alternative. 
The following sections go over the different features provided in the Team tab in detail.

23.3.5.1 Action Buttons
Depending on what is selected in the Forecast Tree, the Actions area provides Upload, Download, Protect, and 
UnProtect buttons (Figure 10). These different options allow you to interact directly with the master watershed 
forecast.



HEC-RTS User Manual  – Team Modeling

Team Modeling –  321

The Actions box includes the following:

Upload allows you to upload a new forecast or changes made to an existing team forecast 
to the master watershed. When a forecast run is selected in the Forecast Tree, 
the Upload button will upload all changed data for the forecast run to the master 
watershed. If a single model alternative is selected in the Forecast Tree, the 
Upload button will upload only changes made to that model alternative.

Download allows you to download the whole team forecasts or its individual model 
alternative updates, depending on what is selected in the Forecast Tree. If a 
forecast is not opened in the Modeling module, the Download button allows you 
to download team forecasts available for the master watershed.

Protect prevents others from uploading any changes to the forecast on the master 
watershed. You can protect a single model alternative or the entire forecast.

If a forecast or model alternative is already protected, you will see an UnProtect option.

UnProtect allows you to begin uploading changes to the forecast or model alternatives 
on the master watershed again.

Once you unprotect the data, Protect becomes available again.

If a forecast is not open on the Modeling tab, only the Download button will be available to download team forecasts 
from the master watershed.

23.3.5.2 Revision Pane
The Team tab also displays information on team forecast revisions. This information can be found directly underneath 
the Actions box (Figure 11).



HEC-RTS User Manual  – Team Modeling

Team Modeling
                             – 

The revision information displays for the selected node in the Forecast Tree. The information includes the following:

Revisi
on

The Revision displays # Of #. The first number represents the version number you have on your local 
computer's copy. The second number is the revision number of the forecast data on the master watershed 
copy. If the two numbers are the same, this means that you have the most recent copy of the master 
watershed data. If the first number is smaller than the second, the master watershed's copy is newer than 
your copy.

Upda
ted 
On

The Updated On information, in the format "DDMMMYYYY, HH:MM by: <username>", reports the date, 
time, and username of the person who last updated the forecast data on the master watershed. The date is 
set by the team member who made the revision's computer date and time. The username displayed is that 
team member's workstation login username.

Statu
s

The Status reports if the version on your computer is Current or Out of Date. The Current status means 
that your computer's version of the watershed data and the master watershed data are the same. The Out 
of Data status means that the master watershed is newer than the copy that is currently on your computer.

Com
ment
s

this text area displays any comments made on the last revision on the master watershed.

Histo
ry

The History button will open the Revision History dialog which provides detailed information on all the 
revisions made to the master watershed data. The Revision History dialog is described in further detail in 
the next section, Revision History.

23.3.5.3 Revision History Dialog
The Revision History dialog (Figure 12) is available on the forecast's Team tab (Figure 1) from the History button. It is 
also available on the Out of Date with Master Watershed dialog. It displays detailed information on the versions for 
the watershed data selected in the forecast or Synchronization Tree.



HEC-RTS User Manual  – Team Modeling

Team Modeling –  323

Clicking on a row of the table populates the bottom section of the Revision History dialog with expanded information 
from the columns: Node, Number, Author, Date, Type, and Description. Expanded descriptions of the features of the 
Revision History dialog can be found in the following sections.

23.3.5.4 Revision Table and Details Panel
The Revision Table (Figure 13) displays information on a revision that has been made. The revisions are grouped by 
forecast and then model alternative. When a row is selected in the table (Figure 13), the information on the Details
panel (Figure 12) of the Revision History dialog is populated.

The table (Figure 13) and panel (Figure 12) contain the following information:

Node is the first column of data in the Revision Table (Figure 13) and provides information about the data group 
that was revised. Revisions are made and grouped by forecast run and models.

Num
ber

displays the revision the row represents. The number assigned is based on the order that that revision to 
the master watershed was made.

Auth
or

this column tells you which modeler submitted the revision to the master watershed data.
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Date date of the revision made by the team member who made the revision's (computer's date and time).

Type indicates what caused the revision change. There are five types that can cause a revision change: UPLOAD, 
DOWNLOAD, PROTECTED, and UNPROTECTED.

The UPLOADED option indicates the revision changed when the modeler uploaded new data to the master 
watershed. 
The PROTECTED option displays when the modeler changed the status of the data to Protected Mode. It 
prevents others from uploading changes to the master watershed data. 
The UNPROTECTED option displays when a modeler has changed the status of the data out of the 
Protected Mode. This means that others can start to upload changes to the master watershed again.

Additional information at the bottom of the Revision History dialog (Figure 13) includes: Description, Files, and File 
Changes.

Descrip
tion

The Description box (Figure 12) is filled in by the team member that made that revision. The description 
cannot be changed later.

Files The Files box (Figure 12) contains a list of the modified files in the text field. The Files box only populates 
with the information of the revision that has been selected above in the Revision Table (Figure 13).

File 
Change
s

To display a list of files that were changed between the selected revisions in the Revision Table (Figure 
12), from the Revision History dialog (Figure 12), click File Changes. The File Changes dialog (Figure 14) 
will open displaying the files that were changed between the selected revisions. File Changes is available 
to you when a revision row has been selected in the Revision Table (Figure 13).
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1.

2.

23.4 Protecting Data
Once the base data or team forecast is in a state where you do not want others to uploaded changes to it on the master 
watershed you can set the Protect flag on the data. Setting the Protect flag on watershed data will stop anyone from 
uploading changes to the master watershed. You can still download the watershed to the local computer and make 
changes to it, but you will not be able to upload the changes to protected data groups.

23.4.1 Protecting Base Data
To set protect on base data:

From the Setup tab, from the Watershed menu, point to Team, click Sync to Master Watershed, the Master 
Watershed Synchronization dialog will open.
On the Master Watershed Synchronization dialog, select a data group node in the Synchronization Tree. The 
bottom of Master Watershed Synchronization dialog) will display information on the selected group.
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3.

4.

5.

1.
2.

3.

4.

Click Protect, the Confirm Protection window (Figure 1) will display. The window is asking you would like to 
protect the selected data group's folder.

Click Yes, the Confirm Protection window will close and when the protection process is complete, you will see a 
real-time notification message at the bottom right-hand of your screen (Figure 2).

The button's label will change to "UnProtect", meaning the data is now protected from uploads and the Upload
button, pictured in Figure 3, will no longer be available when the data node is selected in the Synchronization 
Tree.

23.4.2 Protecting Forecast Data
To set Protect on forecast data:

Open a team forecast in the Modeling tab.
Select the model alternatives or forecast run in the Forecast Tree that you would like to protect. The Team
tab located in the bottom tab group will fill with information on the selected data.
Click the Protect button. A Confirm Protection window (Figure 1) will appear, confirming you would like to 
protect the forecast or model alternative folder.
Continue with the protection process by clicking Yes on the Confirm Protection dialog (Figure 1).The dialog will 
close and when the protection process is complete, you will see a real-time notification message at the bottom 
right-hand of your screen (like Figure 2).
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5.

1.

2.

3.

The button's label will change to "UnProtect", meaning the data is now protected from uploads and the Upload
button, pictured in Figure 4, will no longer be available when the forecast or model alterative is selected in the 
Forecast Tree.

23.4.3 Unprotecting Data
Unprotecting data is like protecting data, data can be set as "Unprotected". When Unprotect is set, the master 
watershed will accept uploads to the data group again. Unprotect is only available if the data has been previously 
protected.

The process is like protecting the data and is described previously. The Protect button displays as an UnProtect button 
when the protected node is selected in the synchronization or forecast trees. To unprotect data:

First open the editors you found the Protect button in by following the steps in the previous two sections, 
Protecting Base Data or Protecting Forecast Data.
Select the data you would like to turn the protection off for. Then click the UnProtect button. The Confirm 
Removal dialog (Figure 5), asking to confirm the removal of the protection flag will appear.

Clicking Yes, the Confirm Removal dialog will close. When the unprotect process is complete, you will see a 
real-time notification message at the bottom right-hand of your screen (Figure 6).
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4. The button's label will change to "Protect", meaning the master watershed is now accepting uploads for that 
data. The Upload button will be available when the data is selected in the tree.

23.5 Technical Notes on Versioning
When a watershed is configured to be a master watershed, HEC-RTS will keep track of the different versions of the 
watershed that exist, the main copy on the network drive and the local copies on the team member's workstations. 
HEC-RTS manages all the changes made to HEC-RTS files, but not files associated with the model alternatives (i.e., HEC-
HMS, HEC-ResSim, HEC-RAS). HEC-RTS does not know what changes have been made since editing is done through the 
native models' interfaces. If you update your local copy, the version number on the local copy will not change, and the 
team synchronization dialogs will not indicate that your forecast or watershed files are more recent than the master. 
Future development goals include providing more complete information about differences between the local and 
master files.

When new files for a watershed are uploaded, HEC-RTS compares the local files with those on the master watershed. 
The size and sum of the local files are compared with the size and sum of the files on the server. If there are any 
differences, the files are updated. For downloads, the local and master watershed files are compared. If the version 
numbers are different, the system updates all of files that have undergone revisions between your local version and the 
version on the network drive. The following sections provide further details on these concepts.

23.5.1 Master Watershed Team Modeling Files
As part of the upload process for master watershed, there are new files created to track versions. In the master 
watershed, the main watershed directory and all sub-directories will contain a file labeled .block.revision.dss. These
.block.revision.dss files contain a running history of all the file changes that have been made for the directory. Each time 
an upload occurs for a selected folder, the .block.revision.dss file will log a new entry that contains the name of the files 
that were changed on the master watershed, the user that performed the upload action, the date and time of the 
upload, and any comments entered at time of upload.

23.5.2 Local Watershed Team Modeling Files
In addition to the files that are created in the master watershed at the time of the upload, there are new files created for 
the local copy in the main watershed directory on your computer and all sub-directories as well. These files are 
labeled .block.revision. Unlike the DSS files on the master watershed, the local copy .block.revision files are XML files. 
The .block.revision files will contain information about the last update to the specified local folder, instead of a 
complete history like on the master watershed.

23.5.3 Version Information
CWMS manages the different master watershed .block.revision.dss and local .block.revision files to determine the proper 
versioning for your local copy of the master watershed. The Master Watershed Synchronization dialog (described in 
the section titled, Master Watershed Synchronization Dialog) will display information from both the local and master 
watershed revision files. When a team member selects a node in the Master Watershed Synchronization dialog, it will 
display the current revision number as defined locally and on the master watershed, the last updated date and time, 
the username who made the changes, Status, and Comments. If you click the History button at the bottom of the 
window, a Revision History dialog will launch. This dialog will display information from the master watershed's
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.block.revision.dss file, which contains the complete version history for the selected node. From the Revision History
dialog, you can select two different uploads and click the File Changes button to see the differences between the two 
revision numbers. Please see the section titled Revision History for more information on using this dialog.
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24 Glossary
The following are definitions of terms used in this manual. The terms are defined in context with HEC-RTS.

Term Definition

Acquisition 
module

The Acquisition module in HEC-RTS is the grouping of commands for data acquisition. These are 
commands for monitoring data acquired by HEC-RTS (and DSS files for gridded data), validating the 
quality of acquired data, and editing the data, as needed.

Arc 
shapefile

Arc shapefiles is the native data structure for the ArcGIS® software. Shapefiles store non-topological 
geometry and attribute information for the spatial features of a data set. A shapefile is a group of files 
that share a common base name and different extensions. At a minimum a shapefile has three 
component files: .dbf, .shp, and .shx. The .shp file contains the shapes (point, polylines, or polygons) 
that are displayed in the layer. Each shape has a record in the .dbf database file containing 
descriptive data called "attributes". The .shx file contains an index that links each shape to its record 
in the .dbf file.

Base data Base data for an HEC-RTS study refers to the original set of data from which copies are made to 
create forecasts.

Baseflow 
method

The baseflow method is a model for calculating the subsurface flow contribution to total runoff flow 
in a subbasin.

Basin 
model

Basin models are one of the main components in an HEC-HMS project. Basin models are composed 
of subbasins, routing reaches, junctions, and other elements. Their principal purpose is to predict 
how meteorologic inputs are transformed into streamflow at specific locations in the watershed.

Cache A cache is a temporary storage area where recently accessed watershed and data files are copied and 
stored.

Calibration Calibration is the systematic adjustment of model parameters to produce model results that more 
accurately reflect watershed and channel behavior.

Common 
schematic

A common schematic consists of a stream alignment, map layers, time series icons, computation 
points, impact areas, and projects that allow sharing of common data between HEC software (e.g., 
HEC-HMS and HEC-ResSim) for a watershed. Use of a common schematic ensures consistency of 
computation nodes, routing reaches, and so on.

Computatio
n point

A computation point is a location where time series data are exchanged between analysis 
applications.
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Coordinate
d Universal 
Time (UTC)

UTC is a time scale that is the basis for the worldwide system of civil time. To provide a consistent 
method of assigning time to data, the HEC-RTS default time zone is UTC. No matter what time zone 
the data are originally measured in, the data will always be stored in UTC in the database. The time 
assigned to data can be converted to local time or another time zone when storing or retrieving data 
from the database.

Corps Water 
Manageme
nt System 
(CWMS)

CWMS is a real-time decision support system developed by HEC. CWMS makes readily available to 
USACE staff information about the current state of watersheds, likely future state of watersheds, and 
consequences of management actions. The information helps water managers make wise operation 
decisions.

Culvert A culvert is a conduit that conveys stream flow through a roadway embankment or past some other 
type of flow obstruction.4

Data 
Storage 
System 
(DSS)

DSS is a database system developed by HEC to store and retrieve efficiently scientific data that are 
typically sequential. Such data types include, but are not limited to, time series data, curve data, 
spatial-oriented gridded data, and others. HEC designed the system to make it easy for users and 
application programs to retrieve and store data. DSS is incorporated into most of HEC's major 
software applications.

Data 
Storage 
System 
(DSS) 
Pathname

A DSS pathname is a unique reference to a record or time series in a DSS file. The pathname is 
structured so that it is easy to group related data together. A pathname is separated into six parts 
(separated by slashes) labeled "A" through "F", as follows: /A/B/C/D/E/F/.

Data 
Storage 
System 
Visual 
Utility 
Engine 
(HEC-
DSSVue)

HEC-DSSVue is a software utility developed by HEC that provides a graphical user interface for 
viewing, editing, and manipulating data in DSS files.

Data 
validation

Data validation is the process of reviewing data and editing or deleting data that are erroneous.

Datum Datum refers to the reference specifications of a measurement system, usually a system of 
coordinate positions on a surface (a horizontal datum), or heights above or below a surface (a 
vertical datum).3
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Directory A directory catalogs the computer files in a nested folder-like structure. Files are organized by storing 
related files in folders in the same directory.

Diversion A diversion removes and redirects water from its normal course in a channel.

Domestic 
Satellite 
Receive-
Only 
Terminal 
(DROT)

DROT is software that facilitates receipt of satellite data.

Easting Easting is the x coordinate of a location in the user-selected World Coordinate System.

Flood 
Impact 
Analysis 
(HEC-FIA)

HEC-FIA is an HEC analysis application that assesses consequences of flow or water surface 
elevations in the system. Inputs include computed or observed flows or water surface elevations at 
critical locations. Outputs include economic, life loss, or other measures of impact, or optionally, 
information on actions to be taken in response to flows or elevations that will be experienced.

Flow 
blending

Flow blending is the capability of CWMS to transition smoothly from observed flows during the 
"lookback period" to simulated flows during the forecast period. The lookback period is the period 
occurring prior to the time of forecast.

Forecast A CWMS forecast is a simulation of watershed processes and consequences of flooding based on 
input data and hydrologic, reservoir operation, hydraulic, and impact analysis models configured in 
CWMS. Forecast results include flow and stage in the channel from watershed runoff, reservoir 
release schedules, floodplain inundation maps, floodplain consequence reports, and reports listing 
actions for emergency responders to take. These results inform water management decision making.

Forecast 
alternative

A forecast alternative is a single forecast scenario defined by a specific set of data and model 
alternatives. A second forecast alternative would be defined by different data or model alternatives.

Freeboard Freeboard is the vertical distance from the water surface to the top of the channel, levee, or floodwall 
at design condition, and serves as a factor of safety for containing water in the stream without 
overtopping the channel, levee, or floodwall.1

Geographic 
Information 
System 
(GIS)

GIS is an integrated collection of software and data used to view and manage information about 
geographic places, analyze spatial relationships, and model spatial processes.3
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Geo-
referenced 
grid

A geo-referenced grid is a set of geographic data that are represented as a raster and have been 
linked to a coordinate system for viewing, querying, and analyzing with other geographic data.

Gridset A gridset is a sequence or time series of georeferenced grids that describe properties or states of a 
watershed as they vary spatially and through time. Examples include sequences of precipitation or 
air temperature grids.

HEC-
GridUtil

HEC-GridUtil is a software application developed by HEC that allows you to view, process, and 
analyze gridded data sets stored in DSS format.

Hydrograph A hydrograph is a relationship of stage, discharge, velocity, or other state of water with respect to 
time at a certain location.

Hydrologic 
Engineering 
Center 
(HEC)

HEC is a USACE designated Center of Expertise in the technical areas of surface and groundwater 
hydrology, river hydraulics and sediment transport, hydrologic statistics and risk analysis, reservoir 
system analysis, planning analysis, real-time water control management, and a number of other 
closely associated technical subjects. HEC is the developer of CWMS.

Hydrologic 
Modeling 
System 
(HEC-HMS)

HEC-HMS is an HEC analysis software application that simulates watershed response to 
precipitation. Inputs may include observed or forecasted precipitation, temperature, snowpack, and 
other environmental conditions. Outputs include flows throughout the watershed, including inflows 
to reservoirs.

Impact area In HEC-RTS, an impact area is a distinct portion of a watershed in which rising stage in a stream, river, 
lake, or reservoir has a consequence that is to be assessed. The boundaries of an impact area are 
defined by a closed polygon. You characterize the effects of rising stage by describing the property 
and population at risk in the area bounded by the polygon as input to HEC-FIA.

Inundation Inundation is a condition in which water covers normally dry land, primarily caused by severe events 
along rivers or the coast.6

Java 
Archive 
(JAR, .jar)

JAR is a platform-independent file format that aggregates many files into one. Multiple Java applets 
and their requisite components (.class files, images, and sounds) can be bundled in a JAR file. The 
JAR format also supports compression, which reduces file size.8

Layers Layers in HEC-RTS are like transparencies laid one on top of the other. Each includes representations 
of static physical images such as roads, county and state boundaries, rivers, and subbasins. These 
are layered in the display area as color pictures. See Chapters 3, 4, and 5 for more information about 
layers.
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Layer tree A layer tree is a list representing the hierarchical arrangement of layers displayed in HEC-RTS.

Levee A levee is a manmade barrier built along a stream to reduce flooding in the adjacent floodplain from 
rising water in the stream.

Log file A log file is a file that holds messages produced by the HEC-RTS software. The types of messages 
include information-only messages and error messages.

Lookback 
period

The lookback period is the period occurring prior to the time of forecast.

Loss 
method

The loss method is a model for calculating infiltration and other abstractions of precipitation in a 
subbasin.

Map layer A map layer is a digital map of watershed features that is configured to display in HEC-RTS. A map 
layer is displayed as a color picture. Map layers help you visualize your watershed.

Map 
projection

A map projection uses mathematical formulas to relate spherical coordinates on the globe to flat, 
planar coordinates.2

Map 
Window

The map window is the window in the HEC-RTS that displays the graphical (and usually 
georeferenced) representation of the watershed.

Meteorologi
c Forecast 
Processor 
(MFP)

MFP is an HEC analysis software application that processes meteorological forecasts for input to 
HEC-HMS. Inputs are forecasted meteorological data such as precipitation and temperature. Outputs 
are forecasted meteorological time series formatted for compatibility with HEC-HMS.

Meteorologi
c model

Meteorologic models are one of the main components in an HEC-HMS project. Their principal 
purpose is to prepare meteorologic boundary conditions for subbasin runoff computations.

Model 
alternative

A model alternative is a single model configuration with a specific set of input and parameters. A 
second model alternative would be defined by a different configuration or different input or 
parameters.

Modeling 
module

The Modeling module in the CAVI is the grouping of commands for model execution. These are 
commands for setting up and executing analysis applications and viewing results.
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Module Commands in the CAVI are organized by function: watershed setup, data acquisition, data 
visualization, and model execution. A module is the grouping of commands related to a function. The 
CAVI contains the Setup module for watershed setup, the Acquisition module for data acquisition, 
the Visualization module for data visualization, and the Modeling module for model execution. Each 
module has menus, tools, and a display area specific to its function.

Northing Northing is the y coordinate of a location in the user-selected World Coordinate System.

National 
Weather 
Service 
(NWS)

NWS is a Federal agency that makes and issues meteorologic and hydrologic forecasts. NWS 
forecasts may be used as input for HEC-RTS simulations.

Off-channel 
storage 
area

In HEC-RAS, an off-channel storage area is a modeling element used to represent ponded water in 
interior areas, adjacent ponds and lakes, urban areas next to rivers, etc.

Parameter A parameter is a representation of a watershed condition in a model of the watershed. You can set 
parameter values using HEC-RTS. Varying parameters may vary analysis results.

Precipitatio
n grid

A precipitation grid is a spatial representation of precipitation over the whole watershed for an 
interval of time.

Project 
benefit

A project benefit is a reduction in adverse flood consequences attributable to a project or projects. 
Project benefit commonly is computed as the difference between the without- and with-project 
consequences.

Projects Projects are man-made structures such as reservoirs or levees that are built to control water.

Quality 
color bar

The quality color bar is a thick, segmented line displayed in the HEC-RTS map window that 
represents the history of the data quality at a specific location within the time window you have 
established.

Quantitativ
e 
precipitatio
n forecast 
(QPF)

QPF is a spatial and temporal precipitation forecast for a specified region or area.7

Raw data Raw data are data that are acquired, transmitted, and received, but not yet subjected to quality tests 
and revised. They are preserved in an HEC-RTS DSS file and are identified as raw data.
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Regulated 
flow

Regulated flow is flow that has been changed from its natural state due to the influence of hydraulic 
constrictions or manmade influences.

Reservoir A reservoir is a structure built to control water for uses such as flood control, hydropower generation, 
and water supply. Storing water in a reservoir can reduce flood consequences by regulating flow to 
reduce flood stages.

Reservoir 
System 
Simulation 
(HEC-
ResSim)

HEC-ResSim is an HEC analysis software application that simulates behavior of reservoirs and linking 
channels, following user-specified operations for reservoir release decision making. Inputs include 
flows into reservoirs and unregulated flows downstream of reservoirs. Outputs include reservoir 
releases, downstream regulated flows, and reservoir storage conditions.

Revised 
data

Revised data are data that are validated and transformed for use in modeling. They are saved to the 
CWMS database and are identified as potentially revised data.

River 
Analysis 
System 
(HEC-RAS)

HEC-RAS is an HEC analysis software application that simulates, in one-dimension, behavior of 
channels and adjacent floodplains. This permits determination of water surface elevations 
corresponding to flows computed by HEC-HMS or HEC-ResSim. Inputs include flows, and outputs 
include water surface elevations.

River 
Analysis 
System 
Mapper 
(RAS 
Mapper)

RAS Mapper is tool that is included in the HEC-RAS software application that allows you to use and 
visualize floodplain geospatial information along with HEC-RAS analysis results.

Routing 
reach

A routing reach is a portion of a stream network. In HEC-HMS and HEC-ResSim, a routing reach is a 
modeling element used to compute behavior of flow in a channel.

Scripting Scripting is the process of automating the actions of a program, so a prescribed sequence of actions 
can be executed with a single action.

Setup 
module

The Setup module in HEC-RTS contains the watershed setup commands. These are commands for 
configuring inputs, models, and outputs that describe a watershed's behavior.

Simulation A simulation is a mathematical representation of the behavior of a system, given inputs and initial 
conditions.

Stage Stage is the vertical distance of a water surface above or below a local or national datum.
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Stream 
alignment

A stream alignment is a representation of the stream network in the watershed. The alignment shows 
routing reaches and indicates where confluences and bifurcations occur and provides a sense of 
distance and scale.

Stream 
element

A stream element is part of the representation of the stream network in the watershed. Specifically, a 
stream element is a segment of the stream alignment that is composed of vertex points (points with 
known coordinates). The beginning and ending vertex points of a stream element are stream nodes. 
Stream elements typically begin or end at a confluence, bifurcation, or at the boundary of the river 
system.

Stream 
junction

Stream junctions are part of the representation of the stream network in the watershed. Specifically, 
a stream junction is a point where two stream elements meet (two stream nodes at one location).

Stream 
node

Stream nodes are part of the representation of the stream network in the watershed. Specifically, 
stream nodes are the beginning and ending points for each stream element. Stream nodes are points 
where stream elements meet (stream junctions).

Stream 
stationing

Stream stationing is a reference system for locating features with distance along a stream. HEC-RTS 
creates and labels stream stations (or river stations) along each stream element. The station at the 
downstream end of an element is Station 0 (zero), and the stationing increases upstream along the 
element according to the linear distance between vertices on the stream element in the watershed 
coordinate system.

Subbasin A division of a watershed typically delineated based on the terrain within the watershed. The entire 
precipitation within a subbasin drains to a common point.

Supplemen
tal program

A supplemental program is a program or script that is not included with HEC-RTS. The program or 
script is developed by the user and may be added to the program order so it will be executed from 
HEC-RTS.

Threshold 
color bar

The threshold color bar is a thick, segmented line shown in an HEC-RTS map window that represents 
a linear histogram that compares current data against threshold values set for a location.

Time series A time series is an ordered sequence of values of a property or state at equally spaced time intervals. 
DSS files also support time series composed of irregularly spaced increments.

Time series 
icon

A time series icon is a symbol in the display area that provides quick access to time-series data 
assigned to the icon. The location of the time series icon on the watershed map corresponds to the 
location to which the data pertains. Time series icons can be used to view data, images, web pages, 
scripts, and document files.
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Time 
window

A time window is the duration that will be simulated. A time window is defined by starting and 
ending dates and times.

Transform 
method

The transform method is a model for calculating surface runoff from precipitation on a subbasin.

U.S. Army 
Corps of 
Engineers 
(USACE)

USACE is a Federal agency that operates about 700 water control projects in the U.S. as part of its 
water control management mission. These projects include reservoirs, navigation locks and dams, 
and levee and bypass systems with closure and diversion structures.

United 
States 
Geological 
Survey 
(USGS)

USGS is a Federal agency that collects hydrologic data with a network of gages and reports the data 
in real-time.

Validation 
list

A validation list is a way to organize data in HEC-RTS DSS files for editing or validation.

Vertex point A vertex point is a point with known coordinates on a stream element in the stream alignment.

Visualizatio
n module

The Visualization module in HEC-RTS contains commands for data visualization. These are 
commands for displaying observed and forecast data to evaluate the hydrometeorological state of 
the watershed.

Watershed In HEC-RTS, a watershed is a set of data, models, and images that represent watershed lands and the 
channels, gages, and water control features within the watershed.

Watershed 
pane

The watershed pane in the HEC-RTS refers to the set of Visualization, Acquisition, Modeling, and 
Setup module tabs (tabbed menus). Clicking a module tab opens that module in HEC-RTS.

World 
Coordinate 
System 
(WCS)

To maintain a geographic reference (also called a geo-reference), HEC-RTS uses a user-selected and 
customizable coordinate system, called the World Coordinate System. This superimposes a grid on 
layer features to establish x and y coordinates in WCS for each point on the layer. The x coordinate is 
referred to as "easting", and the y coordinate is referred to as "northing". Possible choices for the 
WCS include but are not limited to State Plane Coordinates and Universal Transverse Mercator (UTM) 
coordinates.

Zone A set of subbasins in the watershed.

Definition Sources:



HEC-RTS User Manual  – Glossary

Glossary –  339

1.

2.

3.

4.

5.

6.

7.

8.

California Department of Water Resources. (2012). Urban Levee Design Criteria. Accessed December 20, 2013.
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25 HEC-RTS Application Settings
You can configure several HEC-RTS application settings through the Options dialog (Figure 1). You can set the following: 
the directory where your HEC-RTS studies are stored; list of plug-ins related to the software applications (i.e., MFP, HEC-
FIA) that are part of an HEC-RTS study; reopen last forecast; set the forecast directory structures; add the maps folder to 
the Watershed Tree; allow multiple program orders; run debug for HEC-HMS and HEC-RAS; set several general options 
for HEC-RTS; create/edit/delete HEC-RTS system properties; review the active HEC-RTS threads; review the list of 
enabled HEC-RTS plug-ins; adjust the default colors for HEC-RTS computes; setup a scheme for archiving; and, adjust 
the debug level for DSS. This appendix provides details on the available settings that can be adjusted.

128 Figure 1 Options Dialog

25.1 Model Directories Tab
From the Model Directories tab (Options Dialog), you need to tell HEC-RTS where to look for watersheds. From the 
Model Directories tab, you can create locations, delete (remove), and edit locations. You will need to create at least on 
watershed location, the defined watershed locations display in the Open Watershed dialog (Opening an Existing 
Watershed).

25.1.1 Add a Watershed Location
To create a watershed location:

From the HEC-RTS main window, from the Tools menu, click Options, the Options Dialog opens.
Click the Model Directories tab (Options Dialog), click Add Location. The Add Watershed Location dialog will 
open (Figure 1).

Enter a name for the watershed location in the Name box (Figure 1). You can either enter the location of the 
directory in the Location box (Figure 1) or click Browse. A Select Watershed Location browser will open (Figure 
2). Navigate to the directory on your computer or network where you want a watershed stored. Click Open, the 
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Select Watershed Location browser closes.

The selected directory displays in the Location box (Figure 1). Click OK, if the directory does not exist, a Warning
window will open asking you if you want to create the directory, click Yes. Both the Warning window and the 
Add Watershed Location dialog (Figure 1) will close. From the Watershed Locations table (Options Dialog) the 
name and location of the watershed location is displayed.
In the location folder, C:\yyyyy\xxxxx\Documents\HEC-RTS\v3.1.1, three folders are created - database, forecast, 
and watershed. When a new watershed is created (i.e., WS10_HEC_RussianRiver), and a watershed location is 
selected - RR_Watersheds - the new watershed (i.e., WS10_HEC_RussianRiver) will be stored under the watershed
directory.
When you create a new watershed, HEC-RTS will generate a directory structure, and stores all files associated 
with the watershed inside that structure. The watershed directory is named according to the name you have 
given the watershed; for example, in Figure 3, the watershed directory is WS10_HEC_RussianRiver. Figure 3
shows schematically how HEC-RTS organizes the directories and files it creates in the watershed's directory ({_}
C:\yyyyy\xxxxx\Documents\HEC-RTS\v3.1.1\watershed_RR_NorthFork). The watershed's directory configuration 
files and data for the watershed, including maps and model alternative data will be stored. 
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129 Figure 3 HEC-RTS Watershed Directory Structure - C:\yyyyy\xxxxx\Documents\HEC-
RTS\v3.1.1\watershed\WS10_HEC_RussianRiver
Furthermore, when you create a new forecast for a watershed, you will give that forecast a name. Under the 
forecast directory ({_}C:\yyyyy\xxxxx\Documents\HEC-RTS\v3.1.1_forecast) for the watershed's location, HEC-
RTS will create a directory based on the dated forecast name. For example, the directory name 2017.01.26-0400
corresponds to a forecast created for 26 January 2017. Under that directory ({_}C:\yyyyy\xxxxx\Documents_HEC-
RTS\v3.1.1\forecast{}2017.01.26-0400), HEC-RTS will create a directory based on the watershed's name 
(WS10_HEC_RussianRiver) and will automatically copy all of the directories and files for your watershed (except 
for the maps directory) into the dated forecast directory (C:\yyyyy\xxxxx\Documents\HEC-RTS\v3.1.1\forecast{}
2017.01.26-0400_ _WS10_HEC_RussianRiver). This facilitates archiving of forecast information and ensures 
consistency in your model results. 

Delete (Remove) a Watershed Location
To delete (remove) a watershed location:

From the HEC-RTS main window, from the Tools menu, click Options, the Options Dialog opens.
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Click the Model Directories tab (Options Dialog), from the Watershed Locations table (Options Dialog), select a 
location. Click Remove Location (Options Dialog), a Confirm Removal window will open, asking you to confirm 
the removal of the selected location. Click Yes, the Confirm Removal window will close, and the selected 
location will no longer display in the Watershed Locations table (Options Dialog).
The directory structure for the selected watershed location remains on the hard drive, nothing is deleted.

25.1.2 Edit a Watershed Location
To edit a watershed location:

From the HEC-RTS main window, from the Tools menu, click Options, the Options Dialog opens.
Click the Model Directories tab (Options Dialog), click Edit Location. The Edit Watershed Location dialog will 
open (Figure 4).

You can change the name of the watershed location in the Name box (Figure 4). You can either change the 
location of the directory in the Location box (Figure 4) or click Browse. A Select Watershed Location browser 
will open (Figure 2). Navigate to the directory on your computer or network where you want a watershed stored. 
Click Open, the Select Watershed Location browser closes.
The selected directory displays in the Location box (Figure 4). Click OK, if the directory does not exist, a Warning
window will open asking you if you want to create the directory, click Yes. Both the Warning window and the 
Edit Watershed Location dialog (Figure 4) will close. From the Watershed Locations table (Options Dialog) the 
edits will be displayed.

25.2 RTS Options Tab
From the Options dialog, from the RTS Options tab (Figure 1), you can have the last forecast you had open in HEC-RTS 
open automatically the next time; set the structure of the forecast directories; display the Maps folder in the Watershed 
Tree; and, allow multiple programs order.
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130 Figure 1 Options Dialog - RTS Options Tab

25.2.1 Reopen Last Forecast
To reopen the last forecast, from the HEC-RTS main window, from the Tools menu, click Options, the Options
dialog opens. Click the RTS Options tab (Figure 1), the available HEC-RTS settings are displayed. To have HEC-RTS 
automatically open the last forecast that you had open during a previous HEC-RTS session, select Reopen Last 
Forecast. Click OK, the Options dialog will close (Figure 1), and the next time you open HEC-RTS, the forecast you have 
currently open, will be automatically opened by HEC-RTS.

25.2.2 Forecast Directory Structure
By default, the forecast directory structure for a watershed in HEC-RTS, is the forecast directory structure that was 
developed in HEC-RTS Version 1.2. If the Use CWMS 2.1 Forecast Directory Structure option is selected (Figure 2), 
Team Modeling will not work.

131 Figure 2 Options Dialog - RTS Options Tab - Forecast Directory Structure Box

25.2.3 Advanced Options
From the Options dialog (Figure 1), if Advanced Options is selected, two things will occur when you restart HEC-RTS. 
From the Watershed Tree, the Maps folder will now display (Figure 3).
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In addition, by default HEC-RTS only allows one Program Order (Multiple Program Orders). By selecting Advanced 
Options, you now have the capability to create multiple program orders (further details are provided in Multiple 
Program Orders). Care must be exercised when using multiple programs orders. When a model alternative is linked to a 
program for its input information, it remembers the position of the model it is receiving its data from, not the name or 
program of the specified model alternative. This can lead to potential conflicts if a model alternative is used in two 
different program orders. The recommended practice when using multiple programs orders is to configure a different 
model alternative for use in each different program order.

25.3 General Tab
From the Options dialog, from the General tab (Figure 1), the user can set the last study to be loaded during the startup 
of HEC-RTS; display a dialog box that allows the user to open or create a study; save the study automatically when 
exiting HEC-RTS; restore the default layout; synchronize the Study Tree to the active Map Window; set an interval 
(minutes) for automatically saving a study; display tooltips; set default scheme for cascading windows; and, specify the 
number of HEC-RTS watersheds to display in the Recent Studies item under the File menu.

25.3.1 Load Last Watershed at Startup
HEC-RTS by default does not automatically load the last watershed that has been opened. If you want the last 
watershed you opened to automatically load when HEC-RTS startups, from the Options dialog, from the General tab 
(Figure 1), click Load Last Watershed at startup. The next time you re-start HEC-RTS, the last watershed that was open 
will automatically load.
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25.3.2 Show Startup Screen
HEC-RTS by default does not automatically display the Getting Started dialog (Figure 2) on startup. The Getting 
Started dialog, provides you with a list of the last five HEC-RTS watersheds that were open; more watersheds can be 
accessed from the Open Watershed dialog (Opening an Existing Watershed); and, create new watersheds (Creating a 
Watershed).

132 Figure 2 Getting Started Dialog

To open a recent watershed, click on a watershed name, the Getting Started dialog will close, and the watershed will 
display in the HEC-RTS main window. To access watersheds not listed, click More Watersheds (Figure 2), the Open 
Watershed dialog will display (Opening an Existing Watershed). Select a watershed, the Open Watershed dialog will 
close, the watershed will display in the HEC-RTS main window, and the Getting Started dialog will close.

From the Getting Started dialog, you can create a new watershed, click Create New Watershed (Figure 2), the Create 
New Watershed dialog will open (details for creating a watershed are detailed in Creating a Watershed). Click OK, the 
Create New Watershed dialog will close, the new watershed will display in the HEC-RTS main window, and the Getting 
Started dialog will close.

If you want the Getting Started dialog (Figure 2) displayed when starting HEC-RTS, from the Options dialog, from the 
General tab (Figure 1), click Show Startup Screen. The next time you re-start HEC-RTS, the Getting Started dialog will 
display.

25.3.3 Automatically Save Watershed on Exit
HEC-RTS by default automatically saves the open watershed on exit. If you do not want HEC-RTS to save the current 
watershed on exit, from the Options dialog, from the General tab (Figure 1), un-select Automatically Save Watershed 
on Exit.

For example, when making changes to the watershed, you change the name of a time series icon, and you make change 
to two of the model alternatives. When closing this watershed, the Save File dialog will open (Figure 3) letting you know 
that there is a change to the time series icons layer - do you want to save that change. The Copy Model Changes dialog 
will open (Figure 4) because of the changes you made to model alternatives that are part of the watershed – do you 
want to save those changes.
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133 Figure 3 Save File Dialog

134 Figure 4 Copy Model Changes Dialog

25.3.4 Restore Layout
The capability in HEC-RTS to restore layouts is on by default, which means that information about the current layout of 
the map windows is automatically saved when exiting HEC-RTS. Layouts can be saved, managed, and restored. From 
the Options dialog, from the General tab (Figure 1), if you do not want the capability to restore layouts, un-select 
Restore Layout.

25.3.5 Sync Watershed Tree to Map Window
By default, in HEC-RTS, the watershed tree of the current watershed is synchronized with the Map Window being 
currently displayed in the HEC-RTS main window. From the Options dialog, from the General tab (Figure 1), if do not 
want the study tree to be synchronized with the active Map Window, un-select Sync Study Tree to Map Window.
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25.3.6 Watershed Save Interval
HEC-RTS by default automatically sets the interval for a watershed save to zero, which means that a watershed is not 
automatically being saved while the watershed is open. From the Options dialog, from the General tab (Figure 1), if you 
want to automatically save watersheds, from the Watershed Save Interval box, enter a time in minutes.

25.3.7 Show Tooltips
HEC-RTS by default automatically displays tooltips in the HEC-RTS interface. If you do not want to view tooltips, from 
the Options dialog, from the General tab (Figure 1), un-select Show Tooltips. Now as you hover over items in the HEC-
RTS interface you will no longer see tooltips.

25.3.8 Cascade Internal Windows
HEC-RTS by default the capability to cascade map windows is set. If you do not want map windows to cascade, from the 
Options dialog, from the General tab (Figure 1), un-select Cascade Internal Windows.

25.3.9 Recent Watersheds Menu Count
HEC-RTS by default automatically displays the last five watersheds that have recently been opened. If you want to view 
more or less watersheds, from the Options dialog, from the General tab (Figure 1), from the Recent Watersheds Menu 
Count box (Figure 1), enter a new value. The value must be 1 from 10. Any value entered that is less than the value in the 
Recent Watersheds Menu Count box (Figure 1), purges the list of recent watersheds. An upper limit of 10 is a 
recommendation, you can enter a large value, but be aware that the longer the list, how that might impact Recent 
Watersheds list.

25.4 Compute Colors Tab
When you compute a forecast in the Modeling module, the Compute Progress dialog reports on the progress of the 
forecast and presents warning and error messages generated by the forecast compute. From the Options dialog, click 
the Compute Colors tab (Figure 1). You can set colors for Normal Messages, Warning Messages, and Error Messages. 
There are thirty-two color choices in each of the lists. Change the color of messages by selecting a color from the lists. 
For any of your changes to take effect, you must re-compute a forecast.
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25.5 Debug Tab
HEC-RTS by default automatically sets the debug level for the DSS log file at three (3). From the Options dialog, click the 
Debug tab (Figure 1), pertain to settings that deal with the HEC-RTS software. From some of these tabs you can make 
changes, it is recommended that you only use this information from these tabs for debugging and viewing purposes. If 
you make changes to system properties, any changes made are not persistent and are not saved permanently.

135 Figure 1 Options Dialog - Debug Tab

25.6 HEC-RTS Properties
The System Properties, Threads, and CWMS_HOME Directory tabs from the Options dialog (Figure 1), pertain to 
settings that deal with the HEC-RTS software. From some of these tabs you can make changes, it is recommended that 
you only use this information from these tabs for debugging and viewing purposes. If you make changes to system 
properties, any changes made are not persistent and are not saved permanently.
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136 Figure 1 Options Dialog - System Properties Tab

25.6.1 System Properties Tab
The System Properties tab (Figure 1) allows you to view the system properties values set for the HEC-RTS software. If 
you have the correct user access, you can edit some or all properties. The recommendation is that you only use this 
information for debugging and viewing purposes. Editing must be done with extreme caution as any changes you make 
can directly affect the HEC-RTS functionality.

25.6.2 Add a System Property
To add a system property:

If you have the correct user access levels, the New command will be available, and you can add system 
properties. Click New, a Changes Not Saved window will display (Figure 2), letting you know that any changes 
made are not persistent and are not saved permanently. Click OK, the Changes Not Saved window will close, 
and the New Property dialog (Figure 3) will open.
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In the Property cell, enter the name of the new system property. For the parameters of the new system 
property, enter the parameters in the Property Value cell.
Click OK, and the New Property dialog closes. The new system property will display on the System Properties 
Tab (Figure 1).

25.6.3 Edit a System Property
If you have the correct user access levels then the Edit command will be available, and you can edit system 
properties. From the list, select a system property to edit.
Click Edit, a Changes Not Saved window will display (Figure 2), letting you know that any changes made are not 
persistent and are not saved permanently. Click OK, the Changes Not Saved window will close, and the Edit 
Property Value dialog (Figure 4) will open.

In the Property and Property Value boxes, edit the items, as you need to.
Click OK, the Edit Property Value dialog closes, and the changed system property will appear on the System 
Properties Tab (Figure 1).

25.6.4 Delete a System Property
If you have the correct user access levels, then the Delete command will be available, and you can delete system 
properties.
From the list, select the system property you wish to delete. To select, click on the system property, it will now 
be highlighted in blue.
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3. Click Delete, a Confirm Property Delete message will open (Figure 5). If you want to delete the selected system 
property, click Yes. The Confirm Property Delete message will close and the selected system property will be 
removed from the list.

25.6.5 Threads Tab
A thread is a single sequential flow of control within software. Within Java the user can have multiple threads in a piece 
of software all running at the same time and performing different tasks. HEC-RTS is a multi-threaded software 
application, to view HEC-RTS threads, from the Options, click the Threads tab (Figure 6). The Threads tab displays 
information regarding the threads that are actively being used by HEC-RTS. To provide an up-to-date list of the active 
threads, click Refresh (Figure 6). 



HEC-RTS User Manual  – HEC-RTS Application Settings

HEC-RTS Application Settings –  353

25.6.6 CWMS_Home Directory Tab
The CWMS_HOME Directory tab (Figure 7) pertains to two HEC-RTS system variables – CWMS_HOME and CWMS_EXE. In 
most cases, the normal user will not be doing anything to these two system variables. If you are dealing with client-side 
scripts, the tab provides an interface for overriding the values of CWMS_HOME and CWMS_EXE.

137 Figure 7 Options Dialog - CWMS_HOME Directory Tab

25.6.7 Local CWMS_HOME
To edit the CWMS_HOME variable, select Override local CWMS_HOME directory environment setting (Figure B.21). 
The Local CWMS_HOME box is now active. CWMS_HOME only needs to be overridden if client-side scripts rely on 
CWMS_HOME as a pointer to where data and models reside on the client file system. For example, CWMS_HOME might 
be set to a "watershed location", following a common convention to keep gridded DSS records in the "database" folder 
that is sister to a folder containing the watersheds.

25.6.8 Local CWMS_EXE
You should only need to override CWMS_EXE if client-side scripts rely on CWMS_EXE to locate HEC-RTS executables or 
.jar files. If you need to override *CWMS_EXE, from the Local CWMS_EXE box (Figure 7) enter the new value.

25.6.9 Archive Tab
You can archive a forecast; the archive is posted to the selected watershed's default directory as a .zip file. If you wish 
to override the default directory and or the name of the archive, from the *Options dialog, click the Archive tab 
(Figure 8).
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138 Figure 8 Options Dialog - Archive Tab

If you want to change the location of where the archive file is saved, you can enter a folder name in the Default 
Archive Folder box (Figure 8). another way to get a folder name, to the right of the Default Archive Folder box 
(Figure 8), click  , an Open browser will open. Navigate to the location where you want archives saved, once 
the name displays, click Open. The Open browser will close, and name will display in the Default Archive Folder
box (Figure 8).
To override the default archive file name, from the Default Archive Name box (Figure 8), enter the appropriate 
archive naming options which are listed on the Archive tab (Figure 8).

25.7 Plug-Ins
The RTS Plug-Ins tab provides information on the plug-ins that are currently being used in HEC-RTS for the four basic 
software applications in the default program order, plus the plug-ins for MFP, scripting, and supplemental software. 
The RTS Plug-Ins tab provides a list of the plug-ins available in HEC-RTS and from this tab you can enable and disable 
the list plugins.

25.7.1 RTS Plug-Ins Tab
From the Options dialog, from the RTS Plug-Ins tab (Figure 1), you can view whether a software application is running; 
view a software application's log file; and, restart a software application if that application has stopped.
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139 Figure 1 Options Dialog - RTS Plug-Ins Tab
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From the Options dialog, click the RTS Plug-Ins tab (Figure 1), a table will display. The information contained in 
the table (Figure 1) is all about the available software applications, supplemental software, and scripting. 
Information includes the name of the software application; the version being used; the watershed (project) that 
is open; server status; and, the capability to view the log file.
As long as the plug-in for each item in the table (Figure 1) is providing you will see a version number; server 
status will be up; and, for a log file you will be able to view. If you see unknown or N/A, that does not mean there 
is something wrong, it just means that the required information needed by HEC-RTS is not being provided.
If the ResSim, FIA, or RAS plug-in's server status is Down, select that plug-in's row, click Start Server (Figure 1), 
HEC-RTS will re-start the selected plug-in.
In the Log File column (Figure 1), if View is displayed, then you can click View and the log file for the selected 
plug-in will display (Figure 2).

25.7.2 Plugins Tab
From the Options dialog, click on the Plug-ins tab (Figure 3), a table of the plug-ins that are enabled by default for HEC-
RTS will display. Besides providing a list of the available plug-ins, you can also disable plug-ins for all watersheds. It is 
not recommended that you disable plugins.
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140 Figure 3 Options Dialog - Plugins Tab

25.8 Software Options
Further debugging information for a HEC-RTS forecast is created for two of the software applications that are part of the 
HEC-RTS default program order - HEC-HMS and HEC-RAS. The debugging information will display in the individual 
software applications' log files.

25.8.1 HMS Tab
Another debugging tool that is available to the user, is to debug the HEC-HMS software application. By default, the HEC-
HMS debugging capability is turned off. From the Options dialog, click the HMS tab (Figure 1). To turn on HMS 
debugging, select Debug (Figure 1). Now from the HMS log file, the user will be able to view XML (eXtensible Markup 
Language) calls from the HMS software application.

141 Figure 1 Options Dialog - HMS Tab
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25.8.2 RAS Plugin Tab
For the HEC-RAS software application there are two debugging tools – display debug calls for the HEC-RAS software 
application and display the HEC-RAS Computations dialog (Figure 2). From the Options dialog, click the RAS Plugin
tab (Figure 3).

To have debugging information included in the HEC-RAS log file, click Debug XML calls to RAS (Figure 3), this will debug 
XML calls in the HEC-RAS software application. To display further debugging information, click Show Native Compute 
Window (Figure 3), this will display the HEC-RAS Computations dialog (Figure 2) during a forecast run that includes 
HEC-RAS.
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142 Figure 2 HEC-RAS Computations Dialog
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143 Figure 3 Options Dialog RAS Plugin Tab
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26 Setting Up the Coordinate System
HEC-RTS performs an "on-the-fly" coordinate system transformation and related software applications. This allows 
HEC-RTS to display map layers that were created in different coordinate systems in a unified view. For example, you can 
display your watershed with background maps from Internet sources such as Google® Maps and Open Street Map. This 
feature works correctly only if you define a geo-referenced coordinate system for the watershed and include a 
coordinate system definition (*.prj file or equivalent) for each map layer included in the watershed. The positions of 
elements in the watershed's primary layers (time series icons, stream alignment, and study layers) are stored in the 
watershed coordinate system. You can set the watershed's coordinate system when creating a new watershed. This 
superimposes a grid on layer features to establish x- and y-coordinates in the World Coordinate System (WCS) for each 
point on the layer. The x-coordinate is referred to as "easting" and the y-coordinate is referred to as "northing" 
following customary use in surveying and mapping. The user can select the extent of this grid, the units of measurement 
of the grid, and even the location of the origin of the grid. This appendix provides you with information about the 
various coordinate systems that are supported by HEC-RTS.

26.1 Geographic Referencing
To maintain a geographic reference, you must specify a coordinate system for each watershed. To establish the grid size 
and coordinate system:

From the HEC-RTS main window, from Maps, click Default Map Properties. The Default Map Properties dialog 
(Figure 1) will open.
The Default Map Properties dialog contains two tabs: Map Extents and Default Map Layers. he Map Extents
tab includes:

Coordinate System This field identifies the established coordinate system for the watershed. To view the coordinate 
system, click View. The Map Coordinate Information dialog (Figure 2) will open, providing you with information about 
the coordinate system that was established when the watershed was created. You are not able to edit this information 
once a watershed is created.

Extents Easting Minimum and Maximum; Northing Minimum and Maximum. These values (Figure 1) indicate the 
location of the left, right, bottom and top borders (respectively) of the grid in the map window.
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144 Figure 1 Default Map Properties Dialog

145 Figure 2 Map Coordinate Information Dialog

Set Map Extents to Display This will set the limits of the map window. If you zoom in on an area and click Set Map 
Extents to Display, the extents on the Default Map Properties dialog (Figure 1) will change to the zoomed area. 
Grow to Map Extents When selected, HEC-RTS automatically sets the geographic extents to define the smallest 
rectangle that encompasses all the objects in the watershed.
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HEC-RTS can transform coordinates "on-the-fly" if the individual layers have coordinate systems that are defined 
properly in ways that the program can read, for example an ESRI projection (*.prj) file. Therefore, you may need to use 
GIS tools to identify or transform the layers from one coordinate system to another before using them with HEC-RTS. 
Although HEC-RTS has the ability to project different coordinate systems "on the fly", using a consistent coordinate 
system may produce more accurate placement of map elements and may result in better performance in displaying 
large maps.

26.2 Coordinate System Types
A coordinate system is a method of representing points in a space of given dimensions by coordinates. There are 
several different types of coordinate systems; including geographic coordinate systems, which are based on latitude 
and longitude coordinates, and projected coordinate systems, which represent the projection of a geographic 
coordinate system on a plane and use linear measures (like feet or meters) for coordinates. A spheroid (ellipsoid) is the 
shape of the earth used in the calculations that transform positions on the curved surface of the earth to positions on a 
flat map. It is part of the horizontal datum, which approximates the curved surface of the earth over part of the globe.

The coordinate systems available in HEC-RTS are shown in Table 1. This table also shows the units required for each 
coordinate system.

Table 1 Coordinate Systems Available in HEC-RTS

Coordinate Systems Units

X-Y Liner units (feet or meters)

Google/Bing Web Mercator Liner units (feet or meters)

Geographic Angular units (radians, degrees of arc, or seconds)

Universal Transverse Mercator Liner units (feet or meters)

State Plane Coordinates Liner units (feet or meters)

Albers Equal-Area Conic Liner units (feet or meters)

Lambert Conformal Conic Liner units (feet or meters)

Transverse Mercator Liner units (feet or meters)

Albers Equal-Area Conic (SHG) Liner units (feet or meters)

Polar Stereographic (HRAP) Liner units (feet or meters)
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Since Version 3.1.1 of HEC-RTS, the creation of a geo-referenced coordinate system for a watershed has been part of the 
creation of a HEC-RTS watershed and is done through "importing" information from coordinate system definition (*.prj
file or equivalent) for each map layer that is included in a watershed. The creation of a watershed is detailed in Creating 
a Watershed.

The following section provided information about each coordinate system that is recognized by HEC-RTS. Once a 
watershed is created, you cannot change the coordinate system. To view any of this information, from the HEC-RTS 
main window, from the File menu, click New Watershed. The Create New Watershed dialog (Figure 1) will open. To set 
the coordinate system of the watershed, to the right of the Coordinate System box (Figure 1), click Edit, the Map 
Coordinate Information dialog will open.

146 Figure 1 Create New Watershed Dialog

26.2.1 X-Y Coordinate System
The label "X-Y" can be applied to a coordinate system that is either not geo-referenced or for which the geo-referencing 
method is unknown. When the "X-Y" coordinate system is selected, HEC-RTS cannot project maps to the watershed's 
coordinate system.
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To set parameters for the X-Y coordinate system:

From the Map Coordinate Information dialog, from the System list, select X-Y (Figure 2).

From the Units list, select the units for the X-Y coordinate system.
Click OK, and the Map Coordinate Information dialog will close, and you will be returned to the Create New 
Watershed dialog box. In the Coordinate System box (Figure 1), X-Y should be displayed.

26.2.2 Google/Bing Web Mercator Coordinate System
To set parameters for the Google/Bing Web Mercator coordinate system:

From the Map Coordinate Information dialog, from the System list, select Google/Bing Web Mercator (Figure 
3).

Information about the Google/Bing Web Mercator coordinate system is provided (Figure 3).
Click OK, and the Map Coordinate Information dialog will close, and you will be returned to the Create New 
Watershed dialog box. In the Coordinate System box (Figure 1), Google/Bing Web Mercator should be displayed.
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26.2.3 Geographic Coordinate System
To set parameters for the Geographic coordinate system:

From the Map Coordinate Information dialog, from the System list, select Geographic (Figure 4).
From the System list, select Geographic.

From the Units list, select the units for the Geographic coordinate System. The only units available should be 
Radians, Degrees of Arc, and Seconds of Arc.
From the Spheroid list, select a spheroid type for the Geographic coordinate system. (The Sphere of Radius 
6371200 meters should only be used with the HRAP grid coordinate system.)
Click OK, and the Map Coordinate Information dialog will close, and you will be returned to the Create New 
Watershed dialog box. In the Coordinate System box (Figure 1), Geographic should be displayed.

26.2.4 Universal Transverse Mercator Coordinate System
The Universal Transverse Mercator (UTM) coordinate system is a projected coordinate system. UTM is used to define 
horizontal positions throughout the world by dividing the surface of the Earth into six-degree zones, with a central 
meridian in the center of each zone.

To set parameters for the Universal Transverse Mercator Coordinate System:

From the Map Coordinate Information dialog, from the System list, select Universal Transverse Mercator
(Figure 5).
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From the System list, select Universal Transverse Mercator.
From the Units list, select the units for the Universal Transverse Mercator coordinate system.
From the Spheroid list, select a spheroid type for the Universal Transverse Mercator coordinate system.
In the UTM Zone box, enter the UTM zone number. To use a UTM zone in the southern hemisphere, enter a 
negative value for the zone number.
Click OK, and the Map Coordinate Information dialog will close, and you will be returned to the Create New 
Watershed dialog box. In the Coordinate System box (Figure 1), Universal Transverse Mercator should be 
displayed.

26.2.5 State Plane Coordinates System
The State Plane Coordinates System (SPCS) was established in the 1930's and now covers all fifty states. Zones were 
established for each state using either the Lambert Conformal or Traverse Mercator projections. Units are generally in 
feet (NAD27) or meters (NAD83).

To set parameters for the State Plane Coordinates coordinate system:

From the Map Coordinate Information dialog, from the System list, select State Plane Coordinates (Figure 6).

From the System list, select State Plane Coordinates.
In the Zone box, enter the FIPS code for the state plane zone.
Click OK, and the Map Coordinate Information dialog will close, and you will be returned to the Create New 
Watershed dialog box. In the Coordinate System box (Figure 1), State Plane Coordinates should be displayed.

26.2.6 Albers Equal-Area Conic Coordinate System
The Albers Equal-Area Conic projection is used by several federal government agencies for maps of the conterminous 48 
states. HEC uses an Albers projection for the definition of the Standard Hydrologic Grid. The equal area property of this 
projection means that areas in the map are proportional to the corresponding areas on the earth's surface. Directions 
and shapes distort increasingly away from the central meridian and outside the two standard parallels.

To set parameters for the Albers Equal-Area Conic Coordinate System:
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From the Map Coordinate Information dialog, from the System list, select Albers Equal-Area Conic (Figure 7).

From the System list, select Albers Equal-Area Conic.
From the Units list, select the units for the Albers Equal-Area Conic coordinate system.
From the Spheroid list, select a spheroid type for the Albers Equal- Area Conic coordinate system.
The remaining items to be entered are the angular parameters that are required to fine-tune the projection. 
When specifying latitudes, you will enter N or S, and for longitudes, you will enter E or W. Use your tab key to 
toggle between the entries.
Click OK, and the Map Coordinate Information dialog will close, and you will be returned to the Create New 
Watershed dialog box. In the Coordinate System box (Figure 1), Albers Equal-Area Conic should be displayed.

26.2.7 Lambert Conformal Conic Coordinate System
The Lambert Conformal Conic projection is used extensively for mapping areas of the world with predominantly east-
west orientation. It is like the Albers Equal-Conic projection, but the projection is not done in an equal-area.

To set parameters for the Lambert Conformal Conic coordinate system:
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From the Map Coordinate Information dialog, from the System list, select Lambert Conformal Conic (Figure 
8).

From the System list, select Lambert Conformal Conic.
From the Units list, select the units for the Lambert Conformal Conic coordinate system.
From the Spheroid list, select a spheroid type for the Lambert Conformal Conic coordinate system.
When specifying latitudes, you will enter N or S, and for longitudes, you will enter E or W. Use your tab key to 
toggle between the entries.
Click OK, and the Map Coordinate Information dialog will close, and you will be returned to the Create New 
Watershed dialog box. In the Coordinate System box (Figure 1), Lambert Conformal Conic should be displayed.

26.2.8 Transverse Mercator Coordinate System
The Transverse Mercator projection is where a sphere is projected onto a cylinder tangent to a central meridian. It is like 
the Lambert Conformal Conic project but is used to portray large areas in a north-south orientation. Many national grid 
systems are based on the Transverse Mercator projection.

To set parameters for the Transverse Mercator coordinate system:
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From the Map Coordinate Information dialog, from the System list, select Transverse Mercator (Figure 9).

From the System list, select Transverse Mercator.
From the Units list, select the units for the Transverse Mercator coordinate system.
From the Spheroid list, select a spheroid type for the Transverse Mercator coordinate system.
Enter a scaling factor for central meridian, in the Scale factor at central meridian cell.
When specifying latitudes, you will enter N or S, and for longitudes, you will enter E or W. Use your tab key to 
toggle between the entries.
Click OK, and the Map Coordinate Information dialog will close, and you will be returned to the Create New 
Watershed dialog box. In the Coordinate System box (Figure 1), Transverse Mercator should be displayed.

26.2.9 Albers Equal-Area Conic (SHG) Coordinate System
This is a special case of the Albers Equal-Area Conic coordinate system. The projection parameters are set to match 
USGS 48-state maps, which are used for several common data sources including precipitation data on the Standard 
Hydrologic Grid. If you select this option for the coordinate system, all parameter fields will be filled in the editor. This 
coordinate system is also used by USACE's MMC, but with units of US Feet instead of meters. You can quickly set your 
watershed to MMC's coordinate system by selecting the SHG system and then switching the units to "US Feet".

To set parameters for the Albers Equal-Area Conic (SHG) coordinate system:
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From the Map Coordinate Information dialog, from the System list, select Albers Equal-Area Conic (SHG)
(Figure 10).

 
From the System list, select Albers Equal-Area Conic (SHG).
From the Units list, select the units for the Albers Equal-Area Conic (SHG) coordinate system.
From the Spheroid list (Figure 10), select a spheroid type for the Albers Equal-Area Conic (SHG) coordinate 
system.
The remaining parameters are informational and are not editable.
Click OK, and the Map Coordinate Information dialog will close, and you will be returned to the Create New 
Watershed dialog box. In the Coordinate System box (Figure 1), Albers Equal-Area Conic (SHG) should be 
displayed. Note that the (SHG) label is not part of the displayed coordinate system name, and that if you re-open 
the editor you will be able to edit all parameters of the projection.

26.2.10 Polar Stereographic (HRAP) Coordinate System
The Hydrologic Rainfall Analysis Project grid is used by the US National Weather Service for a variety of precipitation 
products. The row and column numbers in the grid are based on a Polar Stereographic projection of the northern 
hemisphere. The parameters are set to match NWS map coordinates used for radar grids, so do not change any 
parameter settings.

To use the parameters for the Polar Stereographic (HRAP) coordinate system:
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From the Map Coordinate Information dialog, from the System list, select Polar Stereographic (HRAP) (Figure 
11).

From the System list, select Polar Stereographic (HRAP).
For Version 3.1.1, ignore the items in the Axis box; this will be removed from this dialog box in a later version of 
HEC-RTS.
The remaining parameters are informational and are not editable.
Click OK, and the Map Coordinate Information dialog will close, and you will be returned to the Create New 
Watershed dialog box. In the Coordinate System box (Figure 1), Polar Stereographic (HRAP) should be 
displayed.



HEC-RTS User Manual  – Using Map Editors

Using Map Editors –  373

1.

27 Using Map Editors
There are twelve map layer formats supported by HEC-RTS, and the different map layers are described in Chapter 5 of 
this manual. In HEC-RTS you can configure several options for each type of map layer, except for AutoCAD® DXF files. 
Additional customization is in development for future versions of the software.

To access the Map Layers dialog, from the HEC-RTS main window, from the Maps menu, click Map Layers. The Map 
Layers dialog will open (Figure 1). From the Layer Tree either double-click on a map layer name, or right-click on a map 
layer name and click Properties from the shortcut menu. An editor specific to the type of map layer you selected will 
open.

147 Figure 1 Map Layers Dialog

27.1 Arc Shapefiles (.shp)
hapefiles store non-topological geometry and attribute information for geo-referenced points, lines, or polygons. The 
format is native to ESRI's ArcGIS® software. Vector GIS layers can be exported from ArcGIS databases to shapefiles for 
display in HEC-RTS studies.

To edit the display properties of a line, polygon, or point shapefile:

From the Layer Tree (Map Layers Dialog), right-click on an Arc shapefile (.shp) from the shortcut menu and 
click *Properties or double-click on the Arc shapefile filename.
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If the shapefile chosen is a polygon, the Edit Polygon Properties dialog will open (Figure 1).

 
Across the top of the dialog is displayed the location and name of the shapefile.

To edit properties of an ArcGIS® shapefile:

Click the Fill tab of the Edit Polygon Properties dialog (Figure 1).
The Draw Features using option allows you to select how the feature will be drawn, either using One Fill or the 
Attribute Values. If Attribute Values is selected, this option will associate the Field for values from the 
shapefile to a color and label. In Figure D.2, AREA has been selected, which displays the value of the AREA in the 
shapefile as blue to red gradations.
By default, the shapefile will display lines and areas (polygons). To turn off the fill, clear the Display Fill cell.
To change the style of line or polygon areas use the Style selection list
To classify the values in the Field for values check the Use Gradations cell and specify the number of classes. 
This will group the values in the Field for values into the range of classes specified.
The Transparency bar controls to what level the transparency of the shapefile will be displayed.
The properties of the Color Chooser are discussed in detail in Appendix E. From the color palette, select a color. 
If the feature is being drawn using an attribute value, select a color for the start and end value.
Click Apply, and the color for the selected field will appear in the display area. Click OK, and the Edit Polygon 
Properties dialog will close.
If you wish to save any changes, from the File menu, choose Save Watershed. Changes are saved to a file with 
the extension *.gdr. For example, if the shapefile name is subbasin.shp, and changes have been made and saved, 
a file subbasin.gdr will be created.

To change the border color, style and weight of the ArcGIS® shapefile, click the Border tab of the Edit Polygon 
Properties dialog (Figure 2). You can change the border display setting in from the Edit Polygon Properties dialog.
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148 Figure 2 Edit Polygon Properties Dialog - Border Tab

To format the labels of the ArcGIS® shapefile. click the Label tab of the Edit Polygon Properties dialog (Figure 3). If you 
wish to display labels associated with the shapefile, click on the Label features using drop down window and choose 
the attribute field which the labeling will be based on. Additionally, the Font, Size, and Placement of the label can be 
changed.

149 Figure 3 Edit Polygon Properties Dialog - Labels Tab

27.2 USGS Digital Line Graph (.dlg)
This layer type is a vector representation of the data. When HEC-RTS interacts with a dlg file it automatically creates a 
dlgbin file for use.

To edit a USGS Digital Line Graph file:

From the Layer Tree (Map Layers dialog), right-click on a USGS Digital Line Graph file. From the shortcut menu, 
click Properties, or double-click on the USGS Digital Line Graph filename.
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The USGS Digital Line Graph Editor will open (Figure 1).

Across the top of the dialog is displayed the location and name of the USGS Digital Line Graph file.
You can control the appearance of nodes, line, and areas by selecting and clearing Draw Nodes, Draw Lines, 
and Draw Areas, respectively (Figure 1).
You can also control the saturation and brightness level of the color you have selected by entering values in the 
Saturation or Brightness cells. Values entered for saturation or brightness must be between zero (0) and one 
(1).
If you wish to save any changes, from the HEC-RTS main window, from the File menu, click Save Watershed. 
The color for a USGS digital line graph file is stored in the watershed file (*.wtshd).

To set scaling for a USGS Digital Line Graph:
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Click the Scale tab of the USGS Digital Line Graph Editor (Figure 2).

Both zoom-in and zoom-out scale factors can be set. By default the digital line graph layer is set for Always 
show layer. To set visualization scales click Only show layer in the following scale range.
To set the scale so that the digital line graph layer becomes visible as you zoom-in, you can set the scale to the 
current scale by clicking Set to Current. If you wish to enter a value, from the Only visible below 1: cell enter 
the scale factor.
To set the scale so that the digital line graph layer becomes visible as you zoom-out, you can set the scale to the 
current scale by clicking Set to Current. If you wish to enter a value, from the Only visible above 1: cell enter 
the scale factor.
Click OK, the USGS Digital Line Graph Editor will close (Figure 2), and the visualization scale is set for the digital 
line graph layer.
Click OK, the Map Layers dialog closes.

27.3 Elevation Options Dialog
For the other map layer formats – USGS DEM, ASCII NetTin, and ArcGIS® DEM; they all have the same editor, the 
Elevation Options dialog.

To edit an ASCII NetTin file:

From the Layer Tree (Map Layers dialog), right-click on an ASCII NetTin file. From the shortcut menu, click 
Properties, or double-click on the ASCII NetTin name.
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The Elevation Options dialog will open (Figure 1).

Across the top of the dialog, is displayed the name of the ASCII NetTin file.
Click the Properties tab of the Elevation Options dialog (Figure 1).
From the dropdown list, there are available color contour schemes – Aspect Shading, Grayscale, Linear, 
Precipitation, Red-Green-Blue, and Terrain (default).
The Draw Edges check box is specifically for ASCII NetTin files. If selected, the edges of the triangles the make up 
an ASCII NetTin file will be drawn.
You can set the contour tic interval, by entering a value in the Tic Interval cell. The program sets the maximum 
and minimum limits of the contours automatically. You can set your own maximum and minimum limits. Clear 
System Specified Min/Max Values, the Maximum and Minimum cells (Figure 1) are now available for you to 
enter values.
You can control the brightness (amount of white), saturation (amount of black), and transparency (level of 
opacity or alpha) for the colors. You can adjust the values by using the Brightness, Saturation, and 
Transparency slider bars or cells.
By default the Aspect Shading option is on, aspect shading is where you make the map layer appear in relief by 
placing an imaginary light source above the map and shading the contours. You can adjust the angle of the light 
source by using the Angle slider bar or the cell. If you do not want aspect shading, clear Aspect Shading.
Clipping provides you a way to highlight an area based on your color choices and values. For maximum clipping, 
you would fill the contour with the clip color from the maximum value of the map to the value entered for 
Maximum Clipping. An example of where you might use maximum clipping would be smog levels, cloud cover, 
or snow level at a particular elevation. By default, maximum clipping is turned off, to select click Maximum 
Clipping. Then either enter a maximum clipping value by using the slider bar or enter a value in the cell. You can 
also set the Maximum Clipping color. Click Color, the Color Chooser will open (see Using the Color Chooser for 
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more on the color chooser). From the color palette, select a color, click OK. The Color Chooser will close and the 
selected color will now appear on the Color button and at the top of the Scale (Figure 1).
Minimum clipping will fill the contour with the clip color from the minimum value of the map to the value 
entered for Minimum Clipping. An example of where you might use minimum clipping would be to see where a 
water level would be if it flooded to a particular elevation. By default, minimum clipping is turned off, to select 
click Minimum Clipping. Then either enter a minimum clipping value by using the slider bar or enter a value in 
the cell. You can also set the Minimum Clipping color. Click Color, the Color Chooser will open (see Using the 
Color Chooser for more on the color chooser). From the color palette, select a color, click OK. The Color Chooser
will close and the selected color will now appear on the Color button and at the bottom of the Scale (Figure 1).

To set scaling for an ASCII NetTin file:

Click the Scale tab of the Elevation Options dialog (Figure 2).

Both zoom-in and zoom-out scale factors can be set. By default the ASCII NetTin layer is set for Always show 
layer. To set visualization scales click Only show layer in the following scale range.
To set the scale so that the ASCII NetTin layer becomes visible as you zoom-in, you can set the scale to the 
current scale by clicking Set to Current. If you wish to enter a value, from the Only visible below 1: cell enter 
the scale factor.
To set the scale so that the ASCII NetTin layer becomes visible as you zoom-out, you can set the scale to the 
current scale by clicking Set to Current. If you wish to enter a value, from the Only visible above 1: cell enter 
the scale factor.
Click OK, the Elevation Options dialog will close (Figure 2), and the visualization scale is set for the ASCII NetTin 
layer.
Click OK, and the Map Layers dialog closes.
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28 Using the Color Chooser
The Color Chooser window (Figure 1) affords great flexibility when you need to select default colors for map layers, 
labels, and background colors in your watershed display. The Color Chooser window has five tabs: Swatches, HSV, 
HSL, RGB, and CMYK - offering five methods for choosing a color. For each method, the preview area allows you to see 
your choice before applying changes.

150 Figure 1 Color Chooser - Swatches Tab

28.1 Swatches Tab
The Swatches tab provides a palette of pre-defined colors. From the palette, select a color. Once you have selected a 
color, the Recent field displays that color, as also does the Preview field. Click OK, and the Color Chooser dialog will 
close. Depending on where you accessed the Color Chooser, you will have to click either Apply or OK for the color 
change to appear in the display area.

For example, for a stream alignment, you would have accessed the Color Chooser from the Stream Alignment 
Properties dialog (Stream Alignment Layer). Once you have selected the color from the Color Chooser dialog and 
clicked OK, you will need to click OK or Apply from the Stream Alignment Properties dialog. Then you need to click 
OK from the Map Layer dialog for the color change to appear in the Map Window.

28.2 HSV Tab
HSV is the Hue, Saturation, and Value color model, replaces the RGB (Red, Green, and Blue) color model in graphics and 
paint software applications. The HSV representation models the way paints of different colors mix together, with the 
saturation dimension resembling various tints of brightly colored paint, and the value dimension resembling the 
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mixture of those paints with varying amounts of black or white paint. From the Color Chooser window, select the HSV
tab; and the HSV tab (Figure 1) becomes available.

151 Figure 1 Color Chooser - HSV Tab

There are several ways to adjust the hue, saturation, value, and transparency of the colors. The slider bar, in 
conjunction with the Hue, Saturation, and Value options will change the selected color. Or you can directly enter a 
value for the Hue, Saturation, and Value cells. The following rules apply to the values you can enter for each cell:

Hue: Hue is measured in a circle from zero (0) to 360 degrees as follows: 0 = red, 60 = yellow, 120 = green, 180 = 
cyan, 40 = blue, 300 = magenta.
Saturation: Saturation is the amount of black, measured from zero (0) to one hundred (100) percent.
Value: Is a measurement of the brightness of a color, measured from zero (0) to one hundred (100) percent. A 
value of zero (0) is considered black.

The final way to set a color on the HSV tab is from the color palette. Click and drag the crosshair symbol, which will 
automatically change the hue, saturation, and value items. Click OK, and the Color Chooser window will close. 
Depending on where you accessed the Color Chooser window, you will have to click either Apply or OK for the color 
change to appear in the display area.

28.3 HSL Tab
HSL is the Hue, Saturation, and Lightness color model, replaces the RGB (Red, Green, and Blue) color model in graphics 
and paint software applications. The HSL model attempts to resemble more perceptual color models such as the 
Natural Color System (NCS) or Munsell color system, placing fully saturated colors around a circle at a lightness value of 
.5, where a lightness value of zero (0) or one is fully black or white, respectively. From the Color Chooser window, select 
the HSV tab; and the HSV tab (Figure 1) becomes available.
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152 FIgure 1 Color Chooser - HSL Tab

There are several ways to adjust the hue, saturation, lightness, and transparency of the colors. The slider bar, in 
conjunction with the Hue, Saturation, and Lightness options will change the selected color. Or you can enter directly a 
value for the Hue, Saturation, and Lightness cells. The following rules apply to the values you can enter for each cell:

Hue: Hue is measured in a circle from zero (0) to 360 degrees as follows: 0 = red, 60 = yellow, 120 = green, 180 = 
cyan, 40 = blue, 300 = magenta.
Saturation: Saturation is the amount of black, measured from zero (0) to one hundred (100) percent.
Lightness: Is a measurement of the brightness of a color, measured from zero (0) to one hundred (100) percent. 
A value of zero (0) is considered black.

The final way to set a color on the HSL tab is from the color palette. Click and drag the crosshair symbol, which will 
automatically change the hue, saturation, and lightness items. Click OK, and the Color Chooser window will close. 
Depending on where you accessed the Color Chooser window, you will have to click either Apply or OK for the color 
change to appear in the display area.

28.4 RGB Tab
RGB is the Red, Green, and Blue color model, which allows you to set the red, green, and blue values of the colors you 
wish to produce. The RGB color model is an "additive" model. When 100 percent of each color is mixed together, it 
creates white light. From the Color Chooser window, select the RGB tab; and the RGB tab (Figure 1) becomes available.
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153 Figure 1 Color Chooser - RGB Tab

There are two ways to adjust the red, green, blue, and alpha value of colors. There is a slider bar for Red, Green, Blue, 
and Alpha. Alpha controls the opacity of the color. As you change the slider bar for each one, in the Preview field, the 
color you are producing is shown. Another way to affect the color is you can directly enter a value in the Red, Green, 
Blue, and Alpha cells. Click OK, and the Color Chooser window will close. Depending on where you accessed the Color 
Chooser window, you will have to click either Apply or OK for the color change to appear in the display area.

28.5 CMYK Tab
CMYK is the Cyan, Magenta, Yellow, and Black (key) color model, which are the four colors of ink used in the traditional 
method of printing hardcopies of images, call offset printing. The CMYK color model is a "subtractive" model. When 100 
percent of each color is mixed together, it creates black light. From the Color Chooser window, select the CMYK tab; 
and the CMYK tab (Figure 1) becomes available.
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154 Figure 1 Color Chooser - CMYK Tab

There are two ways to adjust the cyan, magenta, yellow, black, alpha value of colors. There is a slider bar for Cyan, 
Magenta, Yellow, Black, and Alpha. Alpha controls the opacity of the color. As you change the slider bar for each one, 
in the Preview field, the color you are producing is shown. Another way to affect the color is you can directly enter a 
value in the Cyan, Magenta, Yellow, Black, and Alpha cells. Click OK, and the Color Chooser window will close. 
Depending on where you accessed the Color Chooser window, you will have to click either Apply or OK for the color 
change to appear in the display area. 
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29 Using HEC-DSSVue
The HEC-DSSVue (Data Storage System Visual Utility Engine) software application is a graphical user interface for 
viewing, editing, and manipulating data in DSS files. With HEC-DSSVue, data may be plotted, tabulated, edited, and 
manipulated with over fifty mathematical functions. Along with these functions, HEC-DSSVue provides several utility 
functions, such as entering data sets into a database, renaming data set names, copying data sets to other database 
files, and deleting data sets.

In HEC-RTS, HEC-DSSVue will be used mainly as a viewing tool for data. This section will review some of the general 
functions in HEC-DSSVue (for further detail, see the HEC-DSSVue User's Manual).

29.1 HEC Data Storage System (DSS) Concepts
DSS is a database system that was designed to efficiently store and retrieve scientific data that is typically sequential. 
Such data types include, but are not limited to, time series data, curve data, spatial-oriented gridded data, textual data, 
and others. The system was designed to make it easy for users and application programs to retrieve and store data.

DSS data is stored in blocks, or records, within a file, and each record is identified by a unique name called a pathname. 
The pathname is formulated in a way that makes it easy to group related data together. Software from HEC can read 
from and write to DSS files. This capability facilitates data exchange among the HEC software applications. For 
example, you could use HEC-ResSim to generate the time series data input for HEC-FIA.

29.2 Overview of HEC-DSSVue in HEC-RTS
From the HEC-RTS main window, from the Tools menu, click HEC-DSSVue, the HEC-DSSVue dialog will open (Figure 1). 
The Menu Bar contains the menus for HEC-DSSVue, following is a description of the available menus.
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155 Figure 1 Figure F.1 HEC-DSSVue Dialog

File - this menu is used for file management and contains the following: New Vers 6, New Vers 7, Open, Close 
DSS File(s), Print Catalog Preview, Print Catalog, a list of most recently opened files, and Close.
Edit - this menu allows you to edit data in a tabular format or graphically thru a graphical editor, and this menu 
also provides options for manipulating records in a DSS file: renaming records, deleting records, undeleting 
records, duplicating records, copying records to another DSS file, and merging of DSS files. Also, from this menu, 
you can select all the pathnames contained in the file. The menu contains the following commands: Tabular 
Edit, Graphical Edit, Select All, Rename Records, Delete Records, Undelete, Duplicate, Copy To, Merge 
(copy) dss filename into, and Edit in Excel. 
View - this menu provides options for viewing pathnames. Available commands are: Pathname List, Pathname 
Parts, Condensed Catalog, Condensed – Group Collections, No Pathnames, Unsorted List, Search 
pathnames by string, Search pathnames by parts, Catalog using wild characters, Refresh Catalog, Unit 
System, and Time Zone.
Display - after you have selected a pathname, this menu gives you the ability to display the data for that 
pathname. Available commands are: Plot, Plot Water Quality Profile, Plot Individual Data Sets, Tabulate, 
Display Data Options, Supplemental Information, Time Window, Charts, Tabulate in Excel, Set Times for 
Sync, and Plot Synched Data Sets.
Groups - this menu provides management and commands for groups of data. Available commands are: Save 
Selected, Get, Get (add to list), Plot, Plot Individual Sets, Tabulate, Math, and Manage.
Data Entry - this menu provides options for entering and adding data. Available commands are: Manual Time 
Series, Manual Paired Data, Manual Text, Import, and Export.
Tools - this menu provides access tools for math operations, comparisons, and scripts. Available commands are: 
Math Functions, Compare, Search for Value, Check File Integrity, Squeeze, Convert to DSS Version 7, Script 
Editor, and Script Selector.
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Advanced - this menu provides options for manipulating records in a DSS file. Available commands are: Catalog 
to File, Output, Debug, and Program Options.
Help - displays current version information about HEC-DSSVue.

The Toolbar (Figure 1) contains buttons that provide you with the capability to open a DSS file, plot the data, edit the 
data in a table, edit the data from a graphical editor, and apply math functions to the data. These buttons provide a 
shortcut to the respective commands in the Display menu.

Open File - an Open HEC-DSS File browser will open, which allows you to select a DSS file.

Plot - plots the data of the selected pathname(s).

Tabulate - displays the data of the selected pathname(s) in a tabular form.

Graphical Edit - displays the data of the selected pathname(s) in a graphical editor. 

 Math Functions - allows the user to perform math functions on the data of the selected pathname(s) from 
the Math Functions dialog.

Tabulate in MS Excel – any pathnames in the Select Pathname List (Figure 1) are displayed in Microsoft 
Excel®.

The File Information panel (Figure 1) displays the DSS file and path of the opened file, and statistics about the 
pathnames in the file and the size of the file or number of datasets in a DSS file.

The Pathname Filters (Figure 1) are used to sort pathnames by parts. There is a filter list for each individual part, A 
through F for the DSS records. The Pathname Table (Figure 1) displays the filtered dataset names contained in the DSS 
file. The pathnames are displayed by individual parts. The Selected Pathname List (Figure 1) displays the pathnames 
that you selected from the Pathname Table.

The Selection Commands (Figure 1) are available after you have selected pathnames you wish to view or manipulate. 
Available commands are Select, De-Select, Clear Selections, Restore Selections, and Set Time Window. These 
commands will be detailed later in this appendix.

When you have entered time window information, the Status Bar (Figure 1) will display the time window information. A 
time window is where you give a specific time frame for viewing or manipulating data.

29.3 Opening a DSS File
There are several ways to open a DSS file from HEC-DSSVue. One way is to type in the location and filename of the DSS 
file in the File Name field of the HEC-DSSVue main window (HEC-DSSVue Dialog). After entering the correct 
information, click Enter, the Pathname Table will display the pathnames of the selected DSS file, and the File 
Information (HEC-DSSVue Dialog) field will display statistics about the DSS file.

Another way to open a DSS file is from the File menu, click Open, the Open HEC-DSS File browser will open (Figure 1). 
Browse to the DSS file you wish to use, click on the filename. The filename will display in the File name box (Figure 1), 
click Open. The Open HEC-DSS File browser will close, and the pathnames associated with the DSS file will display in 
the Pathname Table (Figure F.1HEC-DSSVue Dialog).
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156 Figure 1 Open HEC-DSS File Browser

Another way to open a DSS file is from the Main Toolbar, click , the Open HEC-DSS File browser will open (Figure 
1). Browse to the DSS file you wish to use, click on the filename. The filename will display in the File name box (Figure 
1), click Open. The Open HEC-DSS File browser will close, and the pathnames associated with the DSS file will display 
in the Pathname Table (HEC-DSSVue Dialog).

29.4 Set Time Window in HEC-DSSVue
To view the data for a certain block of time, you can set a time window:

Click Set Time Window, and the Set Time Window dialog opens (Figure 1). By default, the time window is set to 
No Time Window. You have the option of setting an exact time window or a time window that is relative to the 
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current time.

To enter a specific time frame, select Specific Time Window. Enter a Start Date and Start Time, in the format 
ddmmmyyyy (i.e., 17Jan2017). Do the same for the End Date and End Time.
You can clear all the window fields by clicking Clear. To use the current date and time, click Set Current Time
and all the time window fields will be filled. If needed, edit the ending date and time.
To set the time frame relative to the current time, select Relative to Current Time. Enter the number of time 
increments to Go Back or Go Forward from the current time. Then select the time step increment to Go Back
and Go Forward from the current date in the drop-down lists. Your choices are minutes, hours, days, months,
or years.
To set the time frame based on water year, select By Individual Water Year (Figure 1), and enter the Start Date 
of Water Year in the format dd mmm (i.e., 01 Oct). Alternately, you can click  to use a calendar tool for 
selecting the start date of the water year.
Click OK, the Set Time Window dialog closes (Figure 1). The time window is set, and it is displayed in the Status 
Bar of the HEC-DSSVue main window.

29.5 DSS Pathnames
Data is stored in blocks or records, within a file, and each record is identified by a unique name called a pathname. 
Each time that data is stored or retrieved from the file, its pathname must be given. The pathname is the key to the 
data's location in the database. A pathname is analyzed by DSS to determine an index number. This index determines 
where the dataset is stored within the database. The design ensures that very few disk accesses are made to retrieve or 
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store datasets. One dataset is not related to another, so there is no need to update other areas of the database when a 
new dataset is stored.

DSS references records (datasets) by a pathname. The pathname of a DSS record can be three hundred and ninety-one 
(391) characters or less, and is, by convention, separated into six parts. The parts can be sixty-four (64) characters or 
less and are delimited by slashes in the pathname. The pathname parts are designated A through F. Table 1 provides an 
example naming convention for regular-interval time series:

A pathname may consist of up to 391 characters and is, by convention, separated into six parts, which may be up to 
sixty-four characters each. Pathnames are automatically translated into all upper-case characters. They are separated 
into six parts (delimited by slashes "/") labeled "A" through "F," as follows: /A/B/C/D/E/F/. Table 1 provides an example 
naming convention for regular-interval time series. A typical regular-interval time series might be: 
/RED RIVER/BEND MARINA/FLOW/01JAN1995/1DAY/OBS/.

Table 1 DSS Pathname Parts

Part Description

A Project, river, or basin name

B Location

C Data parameter (e.g., FLOW, PRECIP)

D Starting date of block, in a 9-character military format (ddmmyyyy)

E Time interval

F Additional user-defined descriptive information

29.5.1 Viewing DSS Pathnames
The display of DSS pathnames in the Pathname Table (HEC-DSSVue Dialog) shows all the pathnames by their different 
parts. This display can be changed from the View menu. Available commands are Pathname List, Pathname Parts, 
Condensed Catalog, Condensed – Group Collections, No Pathnames, and Unsorted List.

The Pathname List command (Figure 1) displays the pathnames in the Pathname Table, while No Pathnames displays 
nothing. The Pathname Parts command (Figure 2) is the default view. Condensed Catalog is like the Pathname Parts
command, but Part D displays a date span for each DSS pathname. The Unsorted List command displays the same as 
the Pathname List command, but you can automatically search pathnames by a string.
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157 Figure 1 Pathname List

158 Figure 2 Pathname Parts (default)

29.5.2 Search DSS Pathnames by Parts
Another way to change the display of the DSS pathnames is by searching pathnames by pathname parts. By default, you 
can search DSS pathnames by parts (Search pathnames by part). To search by pathname parts, from the Pathname 
Filters (Figure 3), decide which DSS pathname parts will be used. There is a Filter List for each individual pathname 
part. An example is shown in Figure 3, where DSS filters are used to see all the STAGE records that are were acquired 
from USGS. From the Filter C list, select STAGE, and from the Filter F list, select USGS. The Pathname Table displays 
only the pathnames that fit the criteria selected from the Filter Lists.

 

Another way to search pathnames is by providing a "string for the search. From the View menu, click Search 
pathnames by string. The pathname filters are replaced with a Search Pathnames box (Figure 4), and a Search
button. For example, in Figure 4, in the Search Pathnames box, Big Sulphur has been entered. Click Search, the 
Pathname Table displays all records that contain Big Sulphur. Further details for this method are described in the HEC-
DSSVue User's Manual.
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159 Figure 4 Search Pathnames by String

29.5.3 Selecting Pathnames
With the appropriate list of pathnames in the Pathname Table (HEC-DSSVue Dialog) select which pathnames to view or 
manipulate. To select a pathname, double-click on a pathname in the Pathname Table, and the selected pathname 
will appear in the Selected Pathname List (HEC-DSSVue Dialog). Alternatively, click on a pathname in the Pathname 
Table, and then click Select.

To select multiple pathnames, in the Pathname Table, click on a pathname the pathname will be highlighted. Find the 
next pathname to include in a group, hold down the SHIFT key and click. The block of pathnames will be highlighted. 
Click Select, and all the pathnames within that block will be added to the Selected Pathname List. Another way to 
select multiple pathnames is from the Pathname Table. Click and drag across the pathnames, release the mouse 
button and the block of pathnames will be highlighted. Click Select, and all the pathnames within that block will be 
added to the Selected Pathname List.

Individual pathnames can be selected to be in a group for selection. From the Pathname Table, select a pathname 
which will be highlighted. To select another not in a contiguous group, hold down the CTRL key and select the next 
pathname which will be highlighted. Continue to do this until all of the desired pathnames have been selected. Release 
the CTRL key and click Select. All the selected pathnames will be added to the Selected Pathname List. 
You can select all pathnames displayed in the Pathname Table, from the Edit menu, click Select All. All of the 
pathnames available from the selected DSS file will now display in the Selected Pathname List (HEC-DSSVue Dialog).

29.5.4 Clearing Selected Pathnames
To clear a pathname from the Selected Pathname List (HEC-DSSVue Dialog), select a pathname and click De-Select. 
The pathname will be cleared from the Selected Pathname List. To clear all pathnames from the Selected Pathname 
List, click Clear Selections.

Groups of pathnames can be cleared by using the same concepts described in selecting pathnames by using the SHIFT
and CTRL keys. Once pathnames have been cleared from the Selected Pathname List, the pathnames can be restored 
to the Selected Pathname List by clicking Restore Selections.

29.6 Visualizing Data in HEC-DSSVue
After a pathname or multiple pathnames have been selected, the data associated with the pathname can be visualized. 
This can be done through a graphical means - plots, or through a tabular form - tabulate. Further details on plots and 
tables are discussed in Printing and Copying HEC-RTS Data.
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29.6.1 Plots
There are two ways to view plots from the HEC-DSSVue main window. From the Display menu, click Plot, a Plot
window will open (Figure 1). The plot window is displaying the pathnames in the Selected Pathname List (HEC-DSSVue 

Dialog). Another way to display a plot, is from the Main Toolbar (HEC-DSSVue Dialog), click , a Plot window will 
open (Figure 1).

160 Figure 1 HEC-DSSVue Plot Window

The parameters for the plots are labeled and color-coded, date ranges are specified along one axis, and the units of 
measure are specified along the other axis. The Plot window (Figure 1) can be resized by grabbing the corner of the 
window and dragging it to the desired size.

Areas of the plot can also be zoomed in on. From the Plot window (Figure 1), click  (Zoom Tool); find the area on 
the plot to zoom in on and click and drag over the area. The plot will refresh, and the area within the zoom rectangle 
will fill the plot window. To zoom out, with the Zoom Tool selected, right-click anywhere on the plot area.
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29.6.2 Table
There are two ways to view tabular results from the HEC-DSSVue main window. From the Display menu, click Tabulate, 
a Table window will open (Figure 2). The table window is displaying the pathnames in the Selected Pathname List
(HEC-DSSVue Dialog). Another way to display a tabular results, is from the Main Toolbar (HEC-DSSVue Dialog), click 

, a Table window will open (Figure 2).

161 Figure 2 HEC-DSSVue Table Window

The Tabule window displays the ordinate (starting from the start date/time), the date and time stamp, and the values 
for the selected data sets. From the Tabule window, there are several options for displaying the tabular data (e.g., 
displaying commas in the number formatting, setting the precision of decimal places for your data).

29.7 Data Management Functions
HEC-DSSVue provides several tools for manipulating DSS records. These tools provide the capability of creating DSS 
records - time series or paired data; renaming, duplicating, deleting, and undeleting records; copy records from one 
DSS file to another DSS file; merge two DSS files; perform maintenance; check the status of a DSS file; and, many more 
other data management functions. The following sections review a few of the available data management functions. 
For further details see the HEC-DSSVue User's Manual.

29.7.1 Renaming DSS Records
To change the pathname parts of a DSS pathname:
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Select one or more pathnames, from the HEC-DSSVue main window, from the Edit menu, click Rename 
Records. The Rename Record to: dialog (Figure 1) opens.

Each of the fields (A - F) represents the different pathname parts. Enter one or more of the new pathname parts 
in the appropriate field.
Click OK, and the Rename Records to: dialog closes (Figure 1). A message appears informing the user of the 
number of records renamed. The selected pathname is no longer displayed in the Selected Pathname List
(HEC-DSSVue Dialog), and the pathname will display in the Pathname Table (HEC-DSSVue Dialog) with the new 
pathname parts.

29.7.2 Duplicating DSS Records
Duplicating a DSS record allows the user to make a copy of a record, but with a pathname part that has been changed. 
To duplicate records:

Select one or more pathnames. from the HEC-DSSVue main window, from the Edit menu, click Duplicate. The 
New pathname parts for duplicate records: dialog (Figure 2) will open.

Each of the fields (A - F) represents the different pathname parts. Enter one or more of the new pathname parts 
in the appropriate field.
Click OK, and the New pathname parts for duplicate records: dialog closes (Figure 2). A message appears 
informing the user of the number of records that were duplicated. A new pathname is displayed in the 
Pathname Table (HEC-DSSVue Dialog).
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29.7.3 Deleting and Undeleting DSS Records
To delete DSS records:

Select one or more DSS pathnames, from the HEC-DSSVue main window, from the Edit menu, click Delete 
Records. A Delete Records window will open (Figure 3) asking you to confirm the deletion. Click Yes, the Delete 
Records window will close.

An HEC-DSSVue message window opens informing the user of the number of records that were deleted. Click 
OK, the HEC-DSSVue message window closes. The pathname is removed from the Selected Pathname List and 
the Pathname List (HEC-DSSVue Dialog).
If records were unintentionally deleted, before the next operation, from the Edit menu, point to Undelete, click 
Select, the Undelete Records dialog opens (Figure 4).

To select all the records displayed in the Undelete Records dialog, click Select All. To select individual records, 
under the Select column, click the checkbox that corresponds to the correct record.
To restore the selected records, either click Apply or OK. A message appears indicating that the records have 
been undeleted. Click OK, and the message closes, the Undelete Records dialog closes (Figure 4), and the 
records will be displayed in the Selected Pathname List and the Pathname List (HEC-DSSVue Dialog).
For further information on deleting and undeleting records in a DSS file, see the HEC-DSSVue User's Manual for 
further details.

29.8 Editing DSS Data
DSS data can be edited either in tabular form or from a graphical editor (with the appropriate permissions). To edit data 
in a tabular form:

Select one or more pathnames, the pathname(s) will display in the Selected Pathname List (HEC-DSSVue 
Dialog).
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From the HEC-DSSVue main window, from the Edit menu, click Tabular Edit. A Tabular Edit dialog (Figure 1) 
opens with the data for the selected pathname(s) displayed.

The columns in gray cannot be edited. The user can edit individual cells, insert (beginning of record), append 
(end of record), and delete rows (this command actual deletes the editable value of the selected row).
From the File menu, click Save. The Saved Data Set message appears, indicating that a record has been saved. 
Click OK, and the Saved Data Set message closes.
From the File menu, click Close and the Tabular Edit dialog (Figure 1) closes.
For further details on tabular editing see the HEC-DSSVue User's Manual.

To edit data using the graphical editor:

Select one or more pathnames, the pathname(s) will appear in the Selected Pathname List (HEC-DSSVue 
Dialog).
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From the Edit menu, click Graphical Edit, and the Graphical Editor (Figure 2) opens.

The Graphical Editor allows the user to edit the data in a graphical mode. This editor is like the Data Validation 
Editor from the Acquisition Module. Review Data Validation Editor for similar functionality.
From the File menu, click Save, and the Save Changes message appears asking if the changes should be saved. 
Click OK, and the Save Changes message closes.
The Saved Data Set message opens indicating which record(s) was saved. Click OK, and the Saved Data Set
message closes.
From the File menu, click Close, and the Graphical Editor (Figure 2) closes. For further details on graphical 
editing see the HEC-DSSVue User's Manual.
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30 Scripting
In HEC-RTS, scripts provide a way to automate the program for the purpose of executing a prescribed set of actions with 
a simple trigger. Scripting simplifies user operation, ensures repeatability and consistency of results, reduces time 
required to generate results, and permits schedules of an operation in the future. HEC-RTS uses the Jython scripting 
language. Jython is a special implementation of the Python scripting language that can interact with programs written 
in Java.

Some uses of scripting in HEC-RTS:

Running an existing forecast with one or more alternatives with a single button click (replacing many mouse 
clicks with one).
Creating a new forecast based on the current time and running it with one or more alternatives.
Scheduling an action such as creating a new forecast to happen sometime in the future (possibly on a recurring 
basis).
Work with a mixture of DSS files.

30.1 Scripts
Scripts can be created for all HEC-RTS modules or scripts can be specific to a HEC-RTS module. A user can schedule a 
script for execution, and you can check on the status of a script. This is accomplished from the Script Selector, which is 
accessed from the Scripts menu, click Editor, the Scripts Editor will open for the module that you are in (Figure 1). For 
example, in Figure 1, the Script Editor was opened in the Visualization module.

162 Figure 1 Select Scripts Dialog

30.1.1 Select Scripts
Available: The Available column lists all the available scripts that can be added to the Visualization Module, 
Scripts box. Use the buttons Add or Add All to add script buttons to the watershed Visualization Module. The 
Remove or Remove All buttons will delete script buttons from the watershed Visualization Module.
Selected: This column lists all script buttons that are or will be added to the Visualization Module, Scripts box.
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30.1.2 Edit Existing Script Buttons
In the Visualization Module, after creating scripts and requesting that a button be created for that script, you can edit 
the script associated with the button, delete the script associated with the button, and schedule a job for that script. All 
tasks can be accomplished through the script button shortcut menu (Figure 2).

163 Figure 2 Script Button Shortcut Menu

30.2 Script Editor
You create, edit, and delete scripts using the Script Editor. From the Tools menu click Script Editor, and the Script 
Editor will open (Figure 1). Components of the Script Editor include the Menu Bar, the Script Context Pane, the API 
Pane, and the Editor Pane. The following sections describe these components.

164 Figure 1 Script Editor

30.2.1 Menu Bar
An overview of the Script Editor's menu bar:
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File: From this menu, you create and import scripts, open, delete, print, save, and run scripts, or make a copy of 
the script. Available commands are New, Open, Run, Delete, Save, Save As, Print, and Close.
Edit: From this menu, you can modify a script or search a script. Available commands are: Cut, Copy, Paste, 
Select All, and Find.

30.2.2 Script Context Pane
The Script Context Pane (Figure 2) of the Script Editor you can navigate to folders in the CWMS directory structure and 
access scripts. The tree structure allows you to navigate through the directory structure for scripts within CWMS. Scripts 
can be stored that are applicable to all CWMS modules or to individual CWMS modules. The name of the script is also 
the script name displayed on the associated script button in the Script Selector. To edit a script, double-click on the 
script name and the script opens in the Editor Pane.

165 Figure 2 Script Context Pane

30.2.3 Editor Pane
Scripts are modified in the Editor Pane (Figure 3) of the Script Editor. The name displayed on the associated script 
button in the Script Selector is the same as the name in the Script Context Pane and the .py name (i.e. 1-USGS.py) in 
the *File box of the Editor Pane. The File box (Figure 3) also shows where the user can find the location of the 
associated file of the script. By default, a button for each script created will appear on the Script Selector. If the user 
wants an icon to appear on the script button, then from the Icon list, select an icon. If you do not want a button, you 
need to clear Display Script to User.

The Test Arguments field (Figure 3) allows you to initialize the values of variables used by the script. You can enter as 
many semicolon-separated variable assignments as your script requires (e.g., var1="abc"; var2=7.5) or leave the area 
blank.
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166 Figure 3 Editor Pane

The Description field (Figure 3) allows you to enter a description of the script. The first line of your description serves as 
tooltip for the associated script button. The field below the Description field in the Editor Pane (Figure 3) is where you 
will enter the script text and serves as an editing window. This field will be referred to as the Script Text field. By right-
clicking in the Script Text box, shortcut menu will appear (Figure 4) that contains the following commands:
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167 Figure 4 Script Text Shortcut Menu

Cut: Copies the currently selected script text to the system clipboard and removes it from the script.
Copy: Copies the currently selected script test to the system clipboard and leaves it in the current script.
Paste: Copies text from the system clipboard into the script at the current cursor location.
Select All: Selects all the text in the script.

30.3 Create a Script
You create a script by selecting either the General Scripts directory or the Watershed Directory in the Script Context 
Pane of the Script Editor. From the Script Editor, from the File menu, click New. Enter the name of the script in the 
subsequent dialog.

30.4 Save a Script
In the Script Context Pane, select the script you wish to save. From the File menu, click Save or you can click on the 
Save button. You can also save and execute the script by simply clicking on the Save/Run button from the Script 
Editor. The Editor Pane will become grey and the name of the script will appear in the Script Context Pane in the 
appropriate place.
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30.5 Delete a Script
In the Script Context Pane, select the script you wish to delete. From the File menu, click Delete. A Confirm Deletion
message will appear asking you if really want to delete the selected script, click Yes. The confirmation message will 
close, and the script will no longer appear in the Script Context Pane.

30.6 Edit a Script
There are three ways to edit a script from the Script Editor. When editing is enabled, the Editor Pane will change from 
grey to white. From the Script Context Pane, double-click the script. From the shortcut menu, click Edit Script. From 
the Script Editor, click the Edit button.

Another way to edit a script is to select a script from the Script Context Pane, and from the File menu, click Open. 

30.7 Running a Script

30.7.1 Manually Running a Script
There are three ways to manually run a script: the first way is from the Script Selector (Scripts). From the Script 
Selector, select the script you wish to run, and click Run.

The second way is to manually run a script is from the Script Editor. From the Script Editor, from the Script Context 
Pane, select a script. From the File menu, click Run, and the script will execute.

The last way to trigger a script is to assign the script to a Time Series Icon and trigger the run through the icon's 
shortcut menu. See Time Series Icons for more details.

30.7.2 Automatically Running a Script
Running scripts automatically in CWMS is accomplished by scheduling script jobs. From the Script Selector, from the 
Script menu, click Schedule Script Job. The Schedule Script Job dialog will open (Figure 1). Another way to launch 
the Schedule Script Job dialog is from the Script Selector dialog: Right-click on a script button, and from the shortcut 
menu, click Schedule Script Job.
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168 Figure 1 Schedule Script Job Dialog

30.7.3 Schedule Script Job Dialog
To schedule a script, the CAVI client must be running and logged in as a valid CWMS user. For the script to run, that valid 
user must be logged in and running the CAVI. To setup a script to run automatically:

The Job Name field (Figure 1) contains the name of the job that will run the script. The job name contains the 
name of the script, and the start date and start time that you will enter. You can change this name, but it is 
recommended that you do not change this name.
From the Script name list (Figure 1), you can select the script you wish to run automatically.
In the Location box (Figure 1), you can schedule a script to run on either the server or the client.
Enter a starting date in the Start Date cell (i.e., DDMMMYYYY format), and a start time in the Start Time cell 
(Figure 1). The date and time reference are local time of the computer running the CAVI client (usually your 
workstation), as indicated the time zone ID next to the Start Time box.
The script that you are setting up can be run automatically one or be recurring. By default, the job is setup to run 
once - Single Job (Figure 1) is selected. If you want the job to be recurring, select Recurring Job, and enter the 
interval you wish the job to recur at in the Recurrent Interval box, and from the list select Minute(s), Hour(s), 
or Day(s).
Once everything is setup, click OK, and a confirmation message will open telling you that the script has been 
scheduled. Click OK, and the confirmation message will close, and the Schedule Script Job dialog will close 
(Figure 1).

30.7.4 Checking the Status of a Scheduled Script
To check the status of an automatically schedule script, from the Script Selector dialog, from the Script menu, click 
Status; the Script Job Status dialog will open (Figure 2). The following gives an overview of what information is being 
provided to you:
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169 Figure 2 Script Job Status Dialog

The Job Name column (Figure 2) displays the name assigned to the script job when it was initially scheduled.
The Script column (Figure 2) displays the name of the script that is executed with the scheduled job runs. A 
script can be used in more than one script job at a time.
The User column (Figure 2) displays the name of the valid CWMS user that was logged into the CAVI and 
scheduled the script.
The Status column (Figure 2) displays the status of the scheduler (not the script itself). This column will display 
three states:

Pending: The scheduler is waiting to start the script job for the first time.
Successful: The scheduler started the script job successfully.
Error: The scheduler did not start the script job successfully.

To see whether the job was a single execution or a recurring execution, the Interval column (Figure 2) displays 
this information.
From the Location column (Figure 2) you will know whether the job executed on the client or the server.
If the job is recurring, the Date/Time column (Figure 2) will display the date and time of the next scheduled 
execution.

30.7.5 Deleting a Scheduled Script
From the Script Job Status dialog box, from the table, select a schedule script. From the Job menu, click Delete; and a 
message will open asking you if you really want to delete this scheduled script. Click Yes, and the message will close, 
and the scheduled script will no longer appear in the table.
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31 Plots
Plots are highly customizable and offer an array of information that will assist you with reviewing your data in HEC-RTS. 
This section covers some of the capabilities of plots within HEC-RTS. For more detail, see the HEC-DSSVue User's 
Manual.

31.1 Plot Window
The Plot window provides tools that facilitate the viewing of HEC-RTS data. The main plot window and the different 
components are illustrated in Figure 1. The Title Bar contains the name of the location that the data represents. For 
example, in Figure 1, the plot is illustrating the elevation and flow data at a reservoir location named Savage.

170 Figure 1 Plot Window

31.1.1 Menu Bar
Following is an overview of the Menu Bar (Figure 1) for the Plot window. The commands available from the menus will 
facilitate the viewing and customizing of plots.

File: From this menu you can view the plotted data in a tabular format, save the plot as a graphics file, save a 
template, use a template, copy the plot to the clipboard, and print the plot. Available commands are: Tabulate, 
Save As, Save Template, Apply Template, Save Specification, Copy to Clipboard, Print, Page Setup, Print 
Preview, Print Multiple, and Close.
Edit: From this menu you can customize the plot. Available commands are: Plot Properties, Default Line 
Styles, and Default Plot Properties.
Plot: From this menu you can select variable to plot, open and save plot type. Available commands are: Select 
Variables, Open Plot Type, and Save Plot Type.
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View: From this menu you can have the plot window always on top of your desktop, and you can choose to use 
line styles. Available commands are: Always On Top, Use Line Styles, Zoom to all, Legend Placement, Hide 
Legend, Refresh, and Live Display.

31.1.2 Tools
The Tools appear in a toolbar on the left side of the Plot window (Figure 1). The tools change the appearance of the 
mouse, as well as the functionality of the mouse.

 Pointer/Select Tool: With the Pointer/Select Tool, you can access shortcut menus that allow you to 
customize features of your plots using the plot editing tools. 

 Zoom Tool: The Zoom Tool allows you to view data closely at a specific time. To zoom in, hold the mouse 
button down and outline the area you want to enlarge. To zoom out, click the right mouse button (right-click). The 
zoom out is done by a factor of two and positions the clicked location at the center of the display area.

31.2 Customizing Plots

31.2.1 Overview
From the Plot window, several editors allow you to configure default properties for all plots, as well as customize 
individual plots. Figure 1 shows the features plot area that can be configured.

171 Figure 1 Elements of the Plot Window

Title of Plot: You can add a title to all plots or to individual plots.
Marker: You can add markers on the X- and Y-axes and customize the appearance of these markers.
Panel Background Color: You can specify the background color of the plot window (light grey is the default) for 
all plots only.
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Curve/Line Properties: You can choose the line and point styles, add labels, and specify symbols to indicate 
quality.
Label: You can add borders and backgrounds to axis and legend labels.
Spacer: You can specify the distance between viewports, between a viewport and the legend, and the width of 
side margins.
Viewport: You can customize the border around the viewport, the background color and pattern, and the 
appearance of gridlines. You can also specify the number, size, and content of viewports.
Callout: You can add descriptive callouts at specific points along a line.
Axis: You can specify either a linear or log axis type, specify the axis scale, and customize tic marks.
Legend: You can add titles to the plot legend and specify whether the legend appears below or to the right of the 
plot.

31.2.2 All Plots
You can customize all the plots for an entire watershed. From the Plot window, from the Edit menu, there are two 
commands - Default Line Styles and Default Plot Properties. These commands will allow you to customize all new 
plot windows that will be accessed for a watershed.

31.2.3 Default Line Style Options
The Default Line Style Options dialog (Figure 2) is for adjusting the curves (lines) in all of your plots. 
It allows you to add curve (line) types, change the color and fill of the curves (lines), and add labels for the curves (lines) 
for all plots. For more detailed information on Default Line Style Options dialog, refer to the HEC-DSSVue User's 
Manual. 

From the Line tab (Figure 2) you can set the color, style, and weight for your curves (lines) in all plots. If the curves have 
points, you can also set the style, color, and fill color for the points on your curves in all plots. 
From the Default Line Style Options dialog (Figure 2) you can also add labels to the curves and adjust the position of 
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the label (Label tab) for all plots. You can manually adjust the maximum and minimum values for your X-axis, set 
viewport weight, and reverse the X-axis (Defaults tab) for certain curve types such as Precip.

31.2.4 Default Plot Properties
The Default Plot Properties dialog (Figure 3) allows you to configure the other properties of your plots. The tabs for 
this dialog allow you to make adjustment to the viewport, add a title for all plots, adjust grids, labels, axes, marker lines, 
and legend, change the color of the panel background, change the layout of the legend, and adjust the size of the 
spacer.

172 Figure 3 Default Plot Properties Dialog

To add a title for all plots:

Open a Plot window.
From the Edit menu, click Default Plot Properties.
The Default Plot Properties dialog (Figure 3) opens.
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Select the Title tab (Figure 4).

To add a title, click Show Plot Title. In the Text field enter a title that will appear on all of the plots in the 
watershed. You can align the title, adjust the font size, add a border with color, and add a color background to 
the title.
Click Apply, and the title will appear on all plots.
Click OK, and the Default Plot Properties dialog closes.

To change the panel background color for all plots:

Open a Plot window.
From the Edit menu, click Default Plot Properties.
The Default Plot Properties dialog (Figure 3) opens.



HEC-RTS User Manual  – Plots

Plots
                             – 

4.

5.
6.
7.

1.
2.

Select the Layout tab (Figure 5).

To change the panel background color of the plot, from the Panel Background Color list, select a color.
Click Apply, and the new color will appear in the background panels for all the plots.
Click OK, and the Default Plot Properties dialog closes.

31.2.5 Individual Plots
To customize individual plots that you are displaying (Plot window) you can use two dialogs, or you can use shortcut 
menus to make changes through individual editors. The dialogs include Plot Properties accessible from the Edit menu 
and Select Plot Variables accessible from the Plot menu.

31.2.5.1 Individual Plot Properties
The Plot Properties dialog (Figure 6) allows you to configure multiple display properties of an individual plot. This 
includes the border and background patterns of the viewport; add a title to the plot; adjust the gridlines of the plot; edit 
the titles, tic marks, and scale of an axis; adjust the style, add points, and add quality symbols for curves; adjust the 
color, add labels, and position of marker lines; add a title, icon, and move the legend; change the color of the panel 
background; adjust the layout of the legend; and the size of the spacer.

To change the gridlines of an individual plot:

Open a Plot window.
From the Edit menu, click Plot Properties.
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The Plot Properties dialog (Figure 6) opens.

The Title Bar displays the name of the location that data is being plotted.
If your plot has multiple viewports, the Select Viewport list displays the viewport where your editing is taking 
place.
Choose the Viewport tab (Figure 7).

From the Major X Grid panel, click Draw Major X Grid. Select from the Color, Style, and Weight drop-down lists 
to modify the major X-axis gridline properties. Also, you can modify the Minor X Grid by clicking the Draw Minor 
X Grid and modifying the minor X-axis gridlines properties
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From the Major Y Grid panel, click Draw Major Y Grid. Select from the Color, Style, and Weight drop-down lists 
to modify the major Y-axis gridline properties. Also, you can modify the Minor Y Grid by clicking the Draw Minor 
Y Grid and modifying the minor Y-axis gridlines properties.
Click Apply, and the color, style, and weight changes you made will reflect on the gridlines of your plot.
Click OK, and the Plot Properties dialog (Figure 7) closes.

31.2.5.2 Select Plot Variables
The Select Plot Variables dialog (Figure 8) allows you to customize the layout of an individual plot. You can add and 
remove axes, arrange the order of viewports, add and remove viewports, and set the weight of viewports. The plot 
components are displayed in a tree structure.

To add a viewport to an individual plot:

173 Figure 8 Select Plot Variables Dialog

Open a Plot window.
From the Plot menu, click Select Variables.
The Select Plot Variables dialog (Figure 8) opens.
From Edit menu, click Add Plot Region, and a new plot region (viewport) is added to the bottom of the Selected
You now need to add data from the Available Variables tree to your new plot region. Select a curve from 
Available Variables tree and click Add.
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In this example (Figure 9), Zone Storage is added to the Reservoir tree from the Available Variables by selecting 
Plot Region 3 in the Selected tree and clicking Add.

Click Apply, and the plot region displays the curve that was added.
Click OK, and the Select Plot Variables dialog (Figure 9) closes, and your plot will display the changes that were 
made.

31.2.5.3 Shortcut Menus
When you want to edit a specific property of a plot without using the Individual Plot Properties dialog (Figure 6), you 
can use individual plot property dialogs instead. To access these dialogs, select the Pointer/Select tool, right-click the 
element of the Plot window (Figure 1) that you want to edit, and from the shortcut menu that appears, click Edit 
Properties.

31.2.5.4 Edit Title Properties
To add a title to an individual plot:

Right-click the Plot window where the title is (or will be) displayed (Figure 10).

From the shortcut menu, click Edit Properties.
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The Edit Title Properties dialog (Figure 11) opens.

Check Show Plot Title, and in the Text field, enter the title for the individual plot. From this dialog you can also 
set the alignment, the size of the font, and add a border and background colors to the title.
Click Apply, and the title is displayed on the plot.
Click OK, and the Edit Title Properties dialog (Figure 11) closes.

31.2.5.5 Edit Marker Lines Properties
To edit the marker lines of an individual plot:

Right-click the Plot window where the marker line is (or will be) displayed (Figure 12).

From the shortcut menu, click Edit Properties.
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The Edit Marker Line Properties dialog (Figure 13) opens.

To change the style of the marker line, you need to click the Draw Line You can change the color, style, and 
weight of the marker line. You can also add fill if you wish.
If you want to add a label to the marker line, click the Draw Label You can add a label, the alignment of the label, 
and the placement of the label along the marker line.
If your plot has more than one viewport, you will have to set marker line properties for each viewport.
Click Apply, and the changes to the marker line are displayed on the plot.
Click OK, and the Edit Marker Line Properties dialog (Figure 13) closes.

31.2.5.6 Edit Curve Properties
To edit the curves of an individual plot:

Right-click on the curve in the Plot window (Figure 14).

From the shortcut menu, click Edit Properties.
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The Edit Curve Properties dialog (Figure 15) opens.

To change the style of the curve, select the Style You can change the color, style, and weight of the curve. You 
can also add fill below or above the curve if you wish.
If you want to display the quality of the data that the curve represents, select the Quality Symbols tab, and click 
the Draw Quality Symbols Then, set the symbol color and size for each type of quality.
If your plot has more than one curve, you will need to edit properties for each curve individually.
If your plot has more than one viewport, you will have to set curve properties for each viewport.
Click Apply, and the changes to the marker line are displayed on the plot.
Click OK, and the Edit Curve Properties dialog (Figure 15) closes.

To add a callout to a curve of an individual plot:

Right-click the Plot window where a curve is displayed (Figure 14).
From the shortcut menu, click Add Callout.
The Add Callout dialog (Figure 16) opens.

Enter the callout you want in the Callout Text
Click Apply, and the changes to the marker line are displayed on the plot.
Click OK, the new callout is displayed on the plot, and the Add Callout Dialog (Figure 16) closes.

31.2.5.7 Edit Axis Title Properties
To edit the appearance of axis titles for an individual plot:
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Right-click the Plot window where the axis title is displayed (Figure 17).

From the shortcut menu, click Edit Properties.
The Edit Axis Properties dialog (Figure 18) opens.
To give an axis title a border, click the Axis Label In the Border panel, click Draw Border. You can set the color, 
style, and weight of the border around the axis title.
To give an axis title a background color, in the Background panel, click Draw Background. You can set the color 
and the pattern of the background for the axis title.

Click Apply, and the axis title is displayed with your changes.
Click OK, and the Edit Axis Properties dialog (Figure 18) closes.

31.2.5.8 Edit Spacer Properties
To edit the spacer properties for an individual plot:

Right-click the Plot window where the spacer is (Figure 19) located on the plot. Spacers are between viewports, 
on either side of each viewport, and at the top of the plot.
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From the shortcut menu, click Edit Properties.
The Edit Spacer Properties dialog will open (Figure 20).

Enter the size of the spacer in pixels in the Size in Pixels
Click Apply, and the changes you made to the spacer will appear on the plot.
Click OK, and the Edit Spacer Properties dialog (Figure 20) will close.

31.2.5.9 Edit Viewport Properties
To edit the viewports of an individual plot:

Right-click in the Plot window where a viewport is displayed (Figure 21).

From the shortcut menu, click Edit Properties.
The Edit Viewport Properties dialog (Figure 22) opens.

To change the viewport border’s color, pattern or transparency click Draw Border under the Border
To change the viewport background’s color, pattern or transparency click Draw Background under the 
Background
If you want to change the color, style, or weight of the gridlines of the viewport, click the Draw Major X Grid, 
Draw Major Y Grid, Draw Minor X Grid, or Minor Y Grid checkboxes under the grid section.
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If your plot has more than one viewport, you will have to set curve properties for each viewport.
Click Apply, and the changes to the viewport are displayed on the plot.
Click OK, and the Edit Viewport Properties dialog (Figure 22) closes.

31.2.5.10 Edit Axis Tics Properties
To edit the X-axis scale of an individual plot:

Right-click in the Plot window where the X-axis is displayed (Figure 23).

From the shortcut menu, click Edit Properties.
The Edit Axis Properties dialog (Figure 24) opens.

Select the Scale In the select table you can choose to automatically set the maximum, minimum, view 
maximum, view minimum, and view range. Also, you can set the number of label levels and reverse the X-axis.
To change the tic marks of the X-axis, select the Tics You can add minor tic marks, do minor tic marks only, and 
change the color of the tic mark and tic mark label.
If your plot has more than one viewport, you will have to set axis tics properties for each viewport.
Click Apply, and the changes to the X-axis are displayed on the plot.
Click OK, and the Edit Axis Properties dialog (Figure 24) closes.
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31.2.5.11 Edit Legend Panel Properties
To edit the legend panel of an individual plot:

Right-click the Plot window where the legend panel is displayed (Figure 25).

From the shortcut menu, click Edit Properties.
The Edit Legend Properties dialog (Figure 26) opens.

You can give the legend panel a title by checking the Draw Legend Title and entering information in the Text
You can also add icon information to the left and right areas of the legend bock from the Left Block and Right 
Block For example, if you want a description to display on the left side of the legend panel, click the Left Block 
tab and enter the description in the Text field.
To add an icon, you need to enter the path and filename of icon to be display in the Icon panel for either the left 
or right sides of the Legend
Click Apply, and the changes to the legend panel are displayed on the plot.
Click OK, and the Edit Legend Properties dialog (Figure 26) closes.

31.3 Exporting and Importing Templates
After you have customized a plot, you can save its settings as a template for use in other plots. Generally, you would use 
templates when scripting plots. For example, every day you might want to generate a plot of flow, stage, and 
precipitation via a script, and then apply a template that has all of the correct formatting, such as viewport placement, 
size, line colors, and fills.

To create a template from a plot:

Open a Plot window.
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From the File menu, click Save Template, and the Export Plot Template dialog will open (Figure 1).

Specify whether you want the template to be available for All Applications, This Watershed only, All Users 
Watershed, or All Users. Then enter a name for the template in the Name
Click OK, the Save Template dialog will close, and the template will be saved.

To apply (import) a template you have previously created to another plot that is currently open:

Open a Plot window.
From the File menu, click Apply Template.
The Import Plot Template dialog (Figure 2) opens.

Specify whether you want the template to be available for All Applications or This Watershed only.
Choose the template you want from the list.
When you select a template, its name will display in the Name
Click OK to apply the template to the current plot, and the Import Plot Template dialog closes.
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32 Printing and Copying HEC-RTS Data
Plots and tables in the Visualization, Acquisition, and Modeling modules offer detailed views of data and model results 
that you can print or copy and paste into other applications. In addition, you can print reports generated by the 
individual models.

32.1 Working with Plots
Plots provide a graphical representation of your data. From the Plot window (Figure 1) you can view the plot, as well as 
print, save as a graphics file, and save the properties of the plot to a template to be used by other plots. Following is an 
overview of the menu bar of the Plot window. The commands available from the menus are:

174 Figure 1 Plot Window

File: From this menu you can view the plotted data in a tabular format, save the plot as a graphics file, save a 
template, use a template, and print the plot. Available commands are: Tabulate, Save As, Save Template, 
Apply Template, Save Specification, Print, Page Setup, Print Preview, Print Multiple, and Close.
Edit: From this menu you can customize the plot. Available commands are: Plot Properties, Default Line 
Styles, and Default Plot Properties.
Plot: From this menu you can select variable to plot, open and save plot type. Available commands are: Select 
Variables, Open Plot Type, and Save Plot Type.
View: From this menu you can have the plot window always on top of your desktop, and you can choose to use 
line styles. Available commands are: Always On Top, Use Line Styles, Zoom to all, Legend Placement, Hide 
Legend, Refresh, and Live Display.
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The Tools appear in a toolbar on the left side of the Plot window (Figure 1). The tools change the appearance of the 
mouse, as well as the functionality of the mouse:

 Pointer/Select Tool. With the Pointer/Select Tool, you can access shortcut menus that allow you to 
customize features of your plots using the plot editing tools. 

 Zoom Tool. The Zoom Tool allows you to view data closely at a specific time. To zoom in, hold the mouse 
button down and outline the area you want to enlarge. To zoom out, click the right mouse button (right-click). The 
zoom out is done by a factor of two and positions the clicked location at the center of the display area.

32.1.1 Save As
The Save As command allows you to save your plot to a graphics file. HEC-RTS has four possible formats: Windows 
Metafile (.wmf), *Postscript (.ps), *JPEG (.jpg, .jpeg), and Portable Network Graphics (*.png).

To create a graphics file:

On the File menu, click Save As, and the Save browser (Figure 2) opens.

Select the location you will save your file from the Save in drop-down list.
Enter a name for the file in the File name field.
From the Files of type list, select the type of graphics file you wish to create.
Click Save, and the Save browser closes, and your plot is saved as the selected graphics file type.
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32.1.2 Print Commands
The Plot window (Figure 1) provides the user with several different commands to setup the printing process and to 
print.

32.1.3 Print
The Print command opens a standard system Print dialog (Figure 3). From the Print dialog you can select the printer, 
choose to print to a file, and the number of copies to print. Click OK, and the Print dialog closes and the plot will print 
to the selected printer.

175 Figure 3 Print Dialog

32.1.4 Page Setup
The Page Setup command opens the Page Setup dialog (Figure 4). When using this Page Setup dialog, you can setup 
the format of the printed page. Following is a list of the available options:



HEC-RTS User Manual  – Printing and Copying HEC-RTS Data

Printing and Copying HEC-RTS Data –  427

•

•

•

•

Orientation: To set the orientation, select Portrait or Landscape from the Orientation panel. By default, the 
pages are printed in Portrait.

Margins: The default margin settings are displayed in the Margins panel of the Page Setup dialog. To set the 
margins, click Set Margins, and the Printer Margins dialog (Figure 5) opens. From the Printer Margins dialog, 
you can adjust the top, left, bottom, and right margins.

176 Figure 5 Printer Margins Dialog
Additional Options: If you would like page numbers included on your printed page, select the Page Numbers
checkbox (Figure 4).
Printer Scale: The default option is Maximum Plotting Area.
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32.1.5 Print Preview
The Print Preview command opens the Print Preview dialog (Figure 6). From the Print Preview dialog, you can view 
the plot, adjust the scaling of the plot, and print the plot. The Print command automatically prints the plot to the 
default system printer.

177 Figure 6 Print Preview Dialog - Plots

32.1.6 Print Multiple
The Print Multiple command opens the Print Multiple dialog (Figure 7). To be able to print multiples plots you must 
have opened multiple individual plot windows. The opened plots are listed in the Available Plots list of the Print 
Multiple dialog.

To select plots to be printed on one page, double-click on a plot name in the Available Plots list. The plot name will 
move to the Selected Plots list. You can adjust the way the plots are arranged on a page, horizontally or vertically. Use 
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the Number Across or Number Down sliders. The grid to the right of the sliders reflects your choices. From the File
menu, the Page Setup and Print Preview commands are available.

178 Figure 7 Print Multiple Dialog

32.2 Tables
Tables provide a tabular format of your data. From the Tabulate window (Figure 1) you can view the data and results, 
as well as print the table, copy the selected contents of the Tabulate window to the clipboard, adjust the display of the 
data, and save the data to an ASCII file. Following is an overview of the menu bar of the Tabulate window.
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179 Figure 1 Tabulate Window

The commands available from the menus are:

File: From this menu, you can print the data in a tabular format and view a plot of the data. Available commands 
are: Save, Save As, Print, Print Preview, Export, Plot, and Close.
Edit: From this menu, select data to be copied to the clipboard. Available commands are: Allow Editing, Cut, 
Copy, Paste, Select All, Find, and Compare Data Sets.
View: From this menu, you can control the appearance of the data displayed in the Tabulate window. Available 
commands are: Commas, Reverse Order, Date and Time Separately, Date with 4 Digit Years, Show Decimal 
Places (up to 6 decimal places), and Show Missing As (blank, 901.00, M, -M).

32.2.1 Displaying Data
By default, data is displayed with commas and two decimal places. If you want to change the way the data is displayed, 
from the View menu there are several options. If you do not want commas displayed, from the View menu, click 
Commas.

For time series data the date and time are displayed in the following default format: ddmmmyy hhmm. You can change 
the way the date and time are displayed. From the View menu, click Date and Time Separately; and the date and time 
are now displayed in two separate columns in the table. Another way is from the View menu, click Date with 4 Digit 
Years; and the date displays a four-digit year instead of a two-digit year.
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Numbers by default are displayed with two decimal places. If you want to see more or a smaller number of decimal 
places, from the View menu, point to Decimal Places, and click on the number (up to 6 decimal places) of decimal 
places you would like displayed.

32.2.2 ASCII File
You can save the table of data to an ASCII file. Right-click on the table, and from the shortcut menu, click Export. The 
Table Export Options dialog will open (Figure 2). From this dialog, you can set certain options for the ASCII file.

180 Figure 2 Table Export Options Dialog

You can set the delimiter for the file from the Field Delimiter drop-down list. The field delimiter choices are TAB
(default), SPACE, COMMA COLON, and SEMI-COLON. You also make choices on whether the file contains fixed width 
columns, strings are set in quotes, whether to include column headers in the file, include gridlines in the file, and 
whether to include the a title in the file.

When you have all of your options set, click OK, and a Save browser opens. Find the location where you want the file 
saved, and provide a filename. Click Save, and the file is created without a filename extension. Since this is an ASCII file, 
you might want to give the file an extension of .txt.

32.2.3 Printing
The Print command opens a standard system Print dialog. From the Print dialog you can select the printer, choose to 
print to a file, and the number of copies to print. Click OK, and the Print dialog closes, and the table will print to the 
selected printer.

Another way to print is to right-click on the table. From the shortcut menu click Print, and the Properties dialog (Figure 
3) opens. From this Properties dialog, you can set up the format of the table for output. From the Page tab, you can set 
the orientation; fit the table to a page, and decide whether to include the entire table or only a selection.
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181 Figure 3 Properties Dialog

In addition, you can also choose to print the table in ASCII, add headers, add background color to headers (non-ASCII 
option), and add gridlines.

If you want to add header or footer information to the table report, click the Header/Footer tab. From the Header/
Footer tab enter header or footer information.

The title of the table report defaults to the pathname tag associated with the data. If you want to change this title, click 
the Table Title tab. From the Table Title tab, enter or change the title, and decide if you want the title to print on each 
page of the report. When you have everything set click Print, and the Print dialog opens.

To preview your table report, right-click on the table, and from the shortcut menu, click Print Preview. The Properties
dialog (Figure 3) opens. Setup your options for the table report, click Print, and the Print Preview dialog (Figure 4) 
opens.
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182 Figure 4 Print Preview Dialog

From this Print Preview dialog, you can view the table report, adjust the scaling of the report, and print the report. The 
Print command automatically prints the report.

32.3 Printing Reports from HEC-RTS

32.3.1 Setup Module
In the Setup Module, from the Reports menu there are several reports that are available that display information about 
the watershed elements. To print these reports, from the File menu of the report window, click Print, and the 
Properties dialog opens. See Tables for further details on the printing these reports.

32.3.2 Modeling Module
In the Modeling Module, from the Reports tab there are several reports that provide information by model about the 
active forecast run. Modeling Module and HEC-RTS Forecasts describe the available reports in detail.

32.3.3 Results
When a forecast run is selected, you can view the Extract and Post Reports choosing them from the Forecast menu 
Log secondary menu options. You can open and print the extract report (Figure 1). Choose Print from the File menu. 
See Working with Plots for further details about printing.
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183 Figure 1 Extract Report

32.3.4 Forecast Run
When a forecast run is selected you can choose to view the log file from the Reports tab in the Modeling Module. Click 
Extract Log and a log extract report opens displaying the report (Figure 1). You can print this report by clicking Print
from the File menu. See Working with Plots for further details about printing.

32.3.5 HEC-ResSim
All of the HEC-ResSim reports are printable, and you can export the reports to an ASCII text file. To print HEC-ResSim 
reports, from the File menu of a HEC-ResSim report, click Print, and the Properties dialog opens. See Tables for further 
details on printing these reports.

32.3.6 HEC-RAS
The HEC-RAS reports can be copied to the clipboard and are printable. To copy to the clipboard, choose Copy Plot to 
Clipboard or Copy Values to Clipboard from the File menu. To print HEC-RAS reports, from the File menu of a HEC-
RAS report, click Print, and the Print Options dialog (Figure 2) opens.
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184 Figure 2 Print Options Dialog - HEC-RAS

From this Print Options dialog, you can set up the format of the report for printing.

Following is a list of the available print options:

Setup: Click Setup, and the Print Setup dialog (Figure 3) opens. From the Print Setup dialog, you can select a 
printer and change the printer properties, you can change the paper size and source, and you can set the 
orientation.

Orientation: As with the Print Setup dialog, you set the orientation using the Print Options dialog (Figure 3). To 
set the orientation, select Portrait or Landscape from the Orientation panel. By default, the pages are printed 
in Portrait.
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Margins: The default margin settings are displayed in the Margins panel of the Page Setup dialog. To set the 
margins, from the Print Options dialog (Figure 2), click Set Margins, and the Printer Margins dialog (Figure 4) 
opens. From the Printer Margins dialog, you can adjust the left, right, top, and bottom margins.

185 Figure 4 Printer Margins Dialog - HEC-RAS
Additional Options: From the Additional Options panel in Figure 2, you can choose to Print Grey Headings, 
Print Grid Lines, include Page Numbers, and set the Starting Page.
Table Options: From the Table Options panel in Figure 2, you set the Max Font Size and choose if you want to 
print the Entire Table or a Selected Range of the table.

32.3.7 HEC-FIA
The HEC-FIA Result Reports are printable, and you can export the reports to an ASCII text file. From the HEC-FIA 
reports, click Print, the Properties dialog will open. See Tables for further details on printing these reports. To export to 
an ASCII text file, click Save To File and the Table Export Options dialog will open. See Tables for further details on 
exporting these reports.
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33 Stream Alignment
A common schematic is used to share effectively common data between HEC software (for example, HEC-HMS and HEC-
ResSim) for a watershed. Use of this common schematic ensures consistency of computation nodes, routing reaches, 
and so on.

In the Setup module, you use tools to create the common schematic. Setup module provides an overview of the setup 
module and the tools available in the module. The tools allow you to depict elements of the common schematic—but 
not change the configuration of the native models. Changes made with the tools are not accounted for in the native 
models' computations.

The first item to create in the common schematic is the stream alignment. A stream alignment is the backbone for all 
the other elements that make up a common schematic. This section will describe the tools and concepts for creating a 
stream alignment.

33.1 Definition of a Stream Alignment
Stream alignments represent the stream network in the watershed. The alignment shows flow direction and indicates 
where confluences and bifurcations occur. It can also provide a sense of distance and scale. Stream alignments are 
composed of a series of stream elements, stream nodes, and stream junctions (Figure 1). A stream element is a segment 
of the stream alignment. A stream element typically begins or ends at a confluence, bifurcation, or at the boundary of 
the river system. It is composed of vertex points, with the beginning and ending vertex points being stream nodes. 
Stream junctions are also stream nodes but are located at points where two stream elements meet. 
Stream elements are drawn in segments defined by vertex points. Each stream element must have at least two stream 
nodes, defining the beginning and end of the stream element. Stream elements, stream nodes, and stream junctions, 
are illustrated in Figure 2.

HEC-RTS creates and labels stream stations (or river stations if the user defines the stationing as such) along each 
stream element. Stream stationing is a reference system for locating features with distance along a stream. The station 
at the downstream end of an element is Station 0. The stationing increases upstream along the element according to 
the linear distance between vertices on the stream element in the watershed coordinate system. You can override the 
default stationing by editing the station values of the stream nodes at the upstream and downstream ends of the 
stream element and by adding additional nodes along the stream element.
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Figure J.1 Parts of a Stream Alignment 

Stream stationing is based on the geographic extents that are defined when a stream element is drawn. If the geo-
extents are based on a map layer, the units for the stream stationing are the same as the map layer (that is, feet or 
meters). There is no indication of what the units are. A stream alignment created without an underlying map layer will 
use the default coordinate system of X-Y. This default system does not have any units associated with it. Setting Up the 
Coordinate System describes how to set up coordinate systems.

The primary tools used to define the stream alignment are the stream alignment tool and stream node tool (Figure 3). 
The zoom tool (Setup Module) is also useful. Use it to magnify the stream network. This makes defining the vertices 
along the stream easier. The three tools are located in the map window toolbar of the setup module.
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186 Figure 3 Setup Map Window - Displaying Stream Alignment

If the stream alignment and stream node tools are not displayed in the map window tool bar, click the Setup tab. 
Expand the Stream Alignments layer in the layer tree. Double-click the Stream Alignment node.

33.2 Creating a New Stream Alignment
If your stream alignment is going to be based on a map layer, you must first add the map layer to the watershed (Map 
Layers). The map layer should contain watershed features, such as channels and reservoirs, so that it can be a guide for 
creating the stream alignment. The units of the labels on the stream alignment will be the same as the units of the map 
layer. That is, if the map layer is projected in state plane coordinates (feet), then the labels on the stream alignment will 
be in feet.

You can either create a new stream alignment by hand or import a stream alignment from an Arc shapefile. The 
following are steps for creating a new stream alignment.

To create a stream alignment:

Select the Stream Alignment Tool from the map window toolbar.
Find a location (typically by viewing a background map that you have added as a map layer) on the map window 
where you want to start a stream element. Important: Stream elements should be created from upstream to 
downstream. Hold down the CTRL key while clicking the mouse button. Each click creates a vertex point (Figure 
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1) on your stream element. The first vertex point is the upstream or beginning stream node of a stream element.

For the most downstream or last vertex point, release the CTRL key, and then click the mouse button. This 
creates the ending stream node of the stream element. You have created a single stream element.
The Create New Stream dialog will open (Figure 2). You can either accept the default name or enter a new 
name. You can also enter an optional description. Click OK.

Repeat steps 2 through 4 to add more stream elements to your stream alignment.
To connect a stream element to an existing stream element, place the first or last click of the new stream 
element on the existing stream element where you want the two stream elements to join. After naming the new 
stream element, a dialog will appear asking if you want to connect the new stream element to the existing 
stream element. Click Yes.
Once you have completed your stream alignment, save your work. On the file menu, click Save Watershed.
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33.3 Edit an Existing Stream Alignment
After drawing a stream alignment in the map window, you can rename a stream element, edit a stream element 
description, delete a stream element, reverse the direction of a stream element, disconnect a stream element at both 
the upstream or downstream end, and view the stream stationing and coordinates of the stream nodes on the stream 
element. All of these tasks are accomplished through the stream element shortcut menu (Figure 1).

187 Figure 1 Stream Element Shortcut Menu

To access the stream element shortcut menu, use the stream alignment tool to select a stream element and right click 

.

33.3.1 Rename a Stream Element
To rename a stream element:

Select the stream alignment tool from the map window toolbar.
Right-click on the stream element you want to rename, and click Rename Stream Element from the shortcut 
menu.
The Rename Stream dialog (Figure 2) opens. Enter the new name in the Name field (required) and a description 
in the Description field (optional).
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Click OK. A confirmation dialog (Figure 3) opens asking you if you really want to rename the stream.

If you answer Yes, then an Update Measure Stream References dialog (Figure 4) opens.

If you answer Yes on the Update Measure Stream References dialog, then the stream element references are 
updated, and the dialog will close. Otherwise, if you answer No, then the stream element references are not 
updated, and the dialog will close. In either case, the new name of the stream element will be shown in the map 
window.

33.3.2 Delete a Stream Element
To delete a stream element:

Select the stream alignment tool from the map window toolbar.
Right-click the stream element you want to delete, and click Delete Stream Element.
A warning and confirmation message will appear (Figure 5). If you are certain, click Yes.

33.3.3 Reverse Direction of a Stream Element
If you draw a stream element in the wrong direction, from downstream to upstream, you can reverse the direction 
instead of having to delete and redraw the stream element.

To reverse the direction of a stream element:

Select the stream alignment tool from the map window toolbar.
Right-click the stream element you want to reverse, and click Reverse Direction.
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A warning and confirmation message will appear (Figure 6). If you are certain, click Yes.

33.3.4 Disconnect a Stream Element
If you want to disconnect a stream element from another stream element, you may do so at either the upstream or 
downstream end of the stream element.

To disconnect a stream element from another stream element:

Select the stream alignment tool from the map window toolbar.
Right-click the stream you want to disconnect, and click either Disconnect Upstream or Disconnect 
Downstream.
The stream element will be disconnected from the stream element at the location you chose. In the map 
window, the upstream or downstream point will physically move away from the connecting stream element, 
and a stream node will remain on the connecting stream element.

33.3.5 Edit a Stream Element Description
The stream editor, available from the shortcut menu of a stream element, allows you to edit the stream element 
description and view the stream stationing and coordinates of the upstream and downstream stream nodes, as well as 
any stream nodes in between the two.

To edit the description of a stream element:

Select the stream alignment tool from the map window toolbar.
Right-click the stream element you want to edit, click Edit Stream Element, and the Stream Editor (Figure 7) 
opens.
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From the name drop-down or the arrow buttons select the name of the stream you want to edit.
You can either enter a new description or edit the description of the stream element in the Description field.
The table provides you with the stream stationing and coordinates of the stream nodes that are on the selected 
stream element.

33.4 Adjust a Stream Element
After drawing the stream alignment in the map window, there are many options available for adjusting the stream 
alignment. The zoom tool can be used to help magnify the stream elements. You can refine and re-shape the stream 
alignment by adding, moving, and deleting vertex points from stream elements. Adjacent vertex points are connected 
by straight lines. Thus, when you delete a vertex point, the alignment will adjust so that the two vertex points that had 
surrounded the deleted vertex point are connected by a straight line. The alignment will adjust similarly when you 
move vertex points.

33.4.1 Add Vertices to a Stream Element
To add vertex points to an existing stream element:

Select the stream alignment tool from the map window toolbar.
Double-click the stream element that you want to add a vertex point to. The stream element will turn red, and 
vertex points will be displayed in blue.
Place the pointer where you want to add a vertex point. Hold down the CTRL key, and click.

33.4.2 Move the Vertices of a Stream Element
To move vertex points on an existing stream element:

Select the stream alignment tool from the map window toolbar.
Double-click the stream element where you want to move a vertex point. The selected stream element will turn 
red. The vertex points will be displayed in blue.
Click the vertex point you wish to move, and drag it to a new location. This is illustrated in Figure 1.

188 Figure 1 Move a Vertex Point

33.4.3 Delete Vertices from a Stream Element
To delete vertex points from an existing stream element:
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Select the stream alignment tool from the map window toolbar.
Double-click the stream element where you want to delete a vertex point. The selected stream element will turn 
red. The vertex points will be displayed in blue.
Hold down the Shift + CTRL keys, and click on the vertex point to be deleted. The vertex point will disappear 
from the stream element.

33.5 Stream Nodes
Stream nodes are part of the representation of the stream network in the watershed. HEC-RTS creates a stream node at 
the beginning and ending of each stream element and where stream elements meet (stream junctions). Stream nodes 
are used to establish stationing for a stream. To modify the default stream stationing, you must edit the stream nodes.

Though they appear similar, stream nodes are not the same as computation points. A computation point is a location 
where time-series data and information is exchanged between analysis software. Stream nodes are useful in placing 
computation points.

33.5.1 Add a Stream Node
As noted above, two stream nodes are created automatically at the beginning and end of a stream element. You can 
add stream nodes to a stream element:

Select the stream node tool from the map window toolbar.
Place the pointer on the stream element where you want to add a stream node. Hold down the CTRL key, and 
click.

33.5.2 Move a Stream Node
To move a stream node:

Select the stream node tool from the map window toolbar.
Double-click the stream node that you want to move. It becomes a yellow circle with a black outline and four 
small black dots (Figure 1). Click and drag the stream node along the stream element to its new position.

33.5.3 Edit Stream Node to Establish Stream Stationing
After placing a stream node on the stream alignment, you can edit the stream node to establish stream stationing for a 
stream element. To edit a stream node:

Select the stream node tool from the map window toolbar.
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Right-click on the stream node that you want to edit. A shortcut menu will appear (Figure 2).

Click Edit Node. The Stream Node Editor (Figure 3) opens.

The default stream station for the downstream node is 0. The stream station for the upstream node is based on 
the coordinate system you used when digitizing the stream alignment. To change the default stream stationing, 
clear Use Default Stationing. Edit the station in the Station field.
Click OK. Based on what station number you enter; HEC-RTS will automatically adjust the stream stationing for 
the stream element. This includes the upstream and downstream nodes.

33.5.4 Delete Stream Node
To delete a stream node:

Select the stream node tool from the map window toolbar.
Right-click on the stream node that you want to delete. Click Delete Node.
A confirmation message opens. If you are certain, click Yes.

33.6 Stream Junction
When two stream elements are connected, a stream junction is created. A stream junction is where multiple stream 
nodes exist at one location. A stream junction is represented by a dark green circle with a light green halo around the 
circle. You can move a stream junction and edit a stream junction to adjust its stream stationing.
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33.6.1 Move a Stream Junction
To move a stream junction:

Select the stream node tool from the map window toolbar.
Double-click the stream junction that you want to move. It becomes a green circle with a black outline and four 
small black dots (Figure 1). Click and drag the stream junction along the stream element to its new position.

33.6.2 Edit a Stream Junction To edit a stream junction:
Select the stream node tool from the map window toolbar.
Right-click the stream junction that you want to edit. A shortcut menu (Figure 2) will appear.

Click Edit Junction. The Stream Junction Editor will open (Figure 3).

The editor displays information about the stream nodes associated with the stream junction. To change the 
stream stationing for a stream node, clear the checkbox for the stream node in the Use Default Stationing
column of the table. The cell in the Station column will become active. Based on what you enter, HEC-RTS will 
adjust the stream stationing for the stream associated with the stream node automatically. Click OK.
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33.7 Change Stream Alignment Properties
Stream alignment properties that can be changed include the color and width of stream elements, stream nodes, and 
stream junctions, font for the stream name, tic mark properties, and visualization scaling for the stream alignment.

To change stream alignment properties:

In the setup module, click Map Layers on the maps menu.
The Map Layers dialog will open (Figure 1).

Right-click the Stream Alignment layer in the tree. Click Properties.
The Stream Alignment Properties dialog will open (Figure 2).
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To change the color of the stream alignment layer, select a color from the Stream Color list. The preview panel 
to the right of the Edit Properties panel will preview the selected color.

Click OK, and the color change will appear in the map window.
Repeat steps 5 and 6 for any other changes you wish to make to the stream alignment properties.
To set the visualization scale, click the Scale menu.

33.8 Import a Stream Alignment
To import a stream alignment, you must have added an Arc shapefile (Map Layer Formats) map layer (Adding Map 
Layers) that represents the stream network of your watershed. This shapefile must have an attribute that is the name of 
each stream, and each stream must form a contiguous line with one upstream point and one downstream point.

To import a stream alignment:

From the Setup module, from the Watershed menu, point to Stream Alignment, click Import.
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The Import Stream Alignment dialog (Figure 1) will open.

In the Shapefile Name drop-down list, the name of the ArcGIS® shapefile that HEC-RTS has chosen is displayed. 
HEC-RTSS automatically selects the first shapefile that contains polylines. If this is not the correct shapefile, on 
the File menu, click Choose Shapefile.
A browser Choose Shapefile dialog will open (Figure 2). Use the dialog to select the shapefile to be imported 
(typically located in the maps folder of the watershed). Click Open.

Once the correct shapefile has been chosen, the program automatically searches for a database field name of 
Stream_ID. If there is no Stream_ID in the shapefile you chose, you must select the database field name that 
contains the names of each stream from the Database Field Name drop-down list. In the example shown in 
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Figure 3, for the shapefile nbpoto_rivers.shp, the database field name is NAME.

When you have selected the correct database field name, the table will list the stream names (Figure 4). HEC-RTS 
requires a stream to be a contiguous line with one upstream point and one downstream point. If a stream is a 
contiguous line, the checkbox in the Import column of the table will be set. If the line that represents a stream is 
non-contiguous, the checkbox will not be set, and a Warning message (Figure 5) will appear indicating that the 
lines are not continuous and that the streams cannot be imported. Click OK to close the message and to 
continue defining the import options. 
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You can use the Import All and Reverse Direction buttons to select each of the checkboxes in the Import and 
Reverse Direction columns, respectively.
Gap tolerance is used to connect stream elements that have a gap between the end point and the junction with 
another stream. By default, the gap tolerance is set to zero, so HEC-RTS can connect streams to other streams. 
To allow gap tolerance, check the Gap Tolerance checkbox. Enter a value larger than zero in the Gap Tolerance
field. HEC-RTS will connect streams that have a gap between them that is equal to or less than this value.
The Replace Existing Stream Alignment check box allows you to replace the existing stream alignment with 
the one you are importing.
Once everything is set, click Import. The stream alignment will be automatically drawn in the map window.
Click OK on the confirmation dialog.
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33.9 Export a Stream Alignment
If you have digitized a stream alignment, you can save that stream alignment as an Arc shapefile. To export a stream 
alignment as a shapefile, you must have a stream alignment displayed in the map window.

To export a stream alignment as an Arc shapefile:

From the Setup module, from the Watershed menu, point to Stream Alignment, click Import.
A browser will open so that you can choose where the shapefile should be saved (Figure 1). Navigate to the 
appropriate folder. The default stream alignment is stored in the watershed's main folder, but you can choose to 
export to a different folder (e.g., the watershed's maps folder). Enter a name in the File name field. Click Save.

33.10 Save Stream Alignment
To save your stream alignment, on the File menu click Save Watershed. This command will save all of the stream 
alignment revisions and all other revisions you have made to your watershed.

33.11 List of Streams
Once you have defined your stream alignment, you can review the streams included.

To view the List of Streams report:

In the Setup module, on the Watershed menu, choose List of Streams. The List of Streams report will open 
(Figure 1). The report provides a list of streams that have been input for the stream alignment, along with the 
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stream's description.

Using the File menu, you can print the report or export the report to an ASCII tab delimited file.



HEC-RTS User Manual  – WISKI Extract and Post

WISKI Extract and Post –  455

34 WISKI Extract and Post

34.1 WISKI Extract Post Integration
Kisters WISKI is a relational database designed to acquire, store, and validate data for water management. WISKI is 
comprised of an SQL database and a web application (KiWIS). HEC-RTS provides access to the WISKI database by using 
the web application KiWIS. WISKI data can be used to provide input data to an HEC-RTS forecast. HEC-RTS can also 
disseminate data from a forecast.dss file to a WISKI database through KiWIS. Together, the system can be used to edit 
and transform data.

This appendix provides instructions on how to use the WISKI database with HEC-RTS and includes: retrieving data from 
a WISKI database to provide input for a forecast compute using the Extract Editor (Figure 1), and disseminating 
forecast data to the WISKI database using the Post Editor.

189 Figure 1 Extract Editor

34.2 Extracting WISKI Time Series Data
An extract refers to the process of obtaining data from either a DSS file or a WISKI database and mapping that data to a 
model alternative's required input record. The extract retrieves the source data and copies it into records stored in a 
centralized DSS file called forecast.dss. The forecast.dss file is then used to provide input data during a forecast's 
compute process. While DSS records can contain both gridded data and time series data, the WISKI connection 
currently supports time series data. The Extract Editor is used to set up extract groups that retrieve data from a WISKI 
database.
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The Extract Editor allows you to connect required model alternative input data from multiple sources to the 
forecast.dss file that provides input data to the models during a forecast compute. The required input data is classified 
into extract groups that link the source data information to the required input records. Information about the Extract 
Editor and extract groups is detailed in Data Extract and Post Editors. This appendix will provide information on WISKI 
and KiWIS details.

34.3 WISKI Extract Editor
The Extract Editor allows you to connect required model alternative input data from multiple sources to the 
forecast.dss file that provides input data to the models during a forecast compute. The required input data is classified 
into extract groups that link the source data information to the required input records. Information about the Extract 
Editor and extract groups is detailed in Data Extract and Post Editors. This appendix will provide information on WISKI 
and KiWIS details.

34.4 KiWIS Extract Group
When an extract group is selected that is a KiWIS extract group, information displayed in the Extract Linking section 
(Extract Editor) is the data Type, KiWIS Url, and the User name and Password needed to access a WISKI database. The

TS Group Id lists all the group ID's in a WISKI database. The TS Group Id can be used to filter WISKI records, which will 
increase the speed of the query process for large databases when accessing them through HEC-RTS.

The Extract Linking table (Extract Editor) displays the following information when a KiWIS extract group has been 
selected:

From 
KiWIS

This column displays the source data pathnames that's data will fill the DSS record displayed in the To 
forecast.dss column.

Model This column lists which software application is requesting the required input record.

Alternat
ive

This column lists the model alternative name that is requesting the input record.

Locatio
n

This column displays the name of the model location object that is associated with the input record. 

Parame
ter

This column displays the parameter associated with the input record's data. 

To 
forecast
.dss

This column dipslays the actual input record pathname that the model requires. This is the pathname 
that will be written to the forecast.dss file and used by a model during the forcast compute. 
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Index Each required destination pathname is assigned an Index number when it is loaded into the Extract 
Editor. This number has no real usage except keeping the initial filtered list set. There can be multiple 
indices for a single DSS pathname.

This information does not display by default in the Extract Linking table, you will need to set up the table view, see 
Extract Editor.

34.4.1 Create a KiWIS Extract Group
A KiWIS extract group maps time series data from the WISKI database to the required model alternative's input time 
series records that will be stored in the forecast.dss file. You will need the KiWIS URL, a username, and a password to set 
up a KiWIS extract group.

To create a KiWIS extract group:

From the HEC-RTS main window, click on the Setup tab, from the Models menu, click Edit Extract, the Extract 
Editor will open (Extract Editor).
From the Extract Editor, from the Extract Groups box (Figure 1), click New Extract Group. The New Extract 
Group dialog will open (Figure 2).
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In the Name box (Figure 2), enter a name for your KiWIS extract group.
From the Type list (Figure 2), select Time Series for the data being extracted and mapped.
From the Source list (Figure 2), select KIWIS.
From the User box, enter your user login (Figure 2) and from the Password box, enter the password that is 
associated with the entered user login. Both the username and password are case sensitive. From the KiWIS Url
box, enter the url for the WISKI database.
The items in the DSS Storage Options box (Figure 2) are only applicable to Oracle and DSS source files. No 
changes to these values are necessary when using KiWIS as your data source.
By default, Run by Default (Figure 2) is selected, which means the extract group will run automatically when a 
forecast is being computed.
Specify the Time Window to extract the data from the Start and End lists (Figure 2); available options are: 
Extract Start, Start of Simulation, Forecast Time, End of Simulation. Offsets for the start and end times can 
also be included, available options are: hours, minutes, or seconds. In the Offset box, you will enter the offset 
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increment. This time window is relative to the forecast time window the you defined when you created the 
forecast.
When you are done, click OK, the New Extract Group dialog will close (Figure 2). The new extract group will 
display at the bottom of the Extract Groups box (Figure 1), and the information about the extract group will 
display.

Note: Extract groups are run in the order they are displayed in the Extract Groups box. If you run more than one extract 
group during the extract process and there are records that are mapped in more than one of the selected extract groups, 
the last extract group mapping will replace all previous mappings.

34.4.2 Adding Required Input Data to Extract Groups
Once an extract group is defined, you can select what Required Input data you want to map to the selected source 
data. In this case the source data is the WISKI database. Detailed information is provided in Extract Groups.

34.4.3 Selecting KiWIS Source Records
When Required Input records are added to a KiWIS extract group, they display the name of the required input record 
under the From KiWIS column in the Extract Linking table (Extract Editor). The From KiWIS record pathnames need to 
be replaced with WISKI database source time series records that will provide data to the To forecast.dss column of the 
Extract Linking table (Extract Editor).

To select a WISKI database time series record for the From KiWIS record:

The TS Group Id list (Figure 3), in the Extract Linking section, provides a list of all the time series groups created 
in KiWIS. The TS Group Id is used in the Extract Editor to manage the size of a WISKI database request and 
speeds up the time required to populate the list of records when selecting KiWIS records for the extract.

Double-click the row in the From KiWIS column (Figure 3) you would like to set the KiWIS time series record for. 
Click the ellipse that appears in the right section of the cell with the From KiWIS name (Figure 3). The KiWIS 
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Time Series Record Chooser dialog will open (Figure 4).

You can filter the KiWIS pathnames displayed in the table by using the Search By Parts Parameters at the top of 
the KiWIS Time Series Record Chooser.
To select a KiWIS time series record to replace the one displayed in the selected row back on the Extract Linking
table, click the time series record row in the KiWIS Time Series Record Chooser dialog (Figure 4), click Set 
Pathnames.
The WISKI database time series record you selected will display back on the Extract Linking table in the row you 
original selected.
To set another KiWIS time series record, click on the next row in the Extract Linking table where you would like 
to replace the record. From the KiWIS Time Series Record Chooser dialog (Figure 4), click on the WISKI 
database time series record you want, click Set Pathname.
When all of the KiWIS time series records have been set in the Extract Linking table, from the KiWIS Time Series 
Record Chooser dialog (Figure 4), from the File menu, click Close.

34.4.4 Ad-Hoc Records - Extract
Additional input data not listed in the Required Extract table may be required for a forecast compute. You can add 
additional time series records from the WISKI database using the Ad-Hoc Record feature. An Ad-Hoc record allows you 
to add WISKI database time series records to a DSS time series record in the forecast.dss file.

To add a WISKI Ad-Hoc record:

From the Extract Editor, click Add Extract Data Set, the Adhoc: KiWIS Time Series Record Chooser dialog will 
open.
From the Search By Parts area, use the various filter lists to locate the desired WISKI database time series 
record.
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Select the pathname row for the record, click Set Pathname.
Once you have selected all the pathnames for all the necessary time series records, from the File menu, click 
Close. The Adhoc: KiWIS Time Series Record Chooser dialog will close.

The From KiWIS and To forecast.dss time series records (Extract Linking table) will display the same pathname. The 
time series record pathname displayed in the To forecast.dss column of the Extract Linking table will need to be 
changed to a conventional DSS pathname. You can either enter the DSS pathname, or select one through the KiWIS 
Time Series Record Chooser dialog (Figure 4).

To select a DSS pathname using the KiWIS Time Series Record Chooser:

From the Extract Editor, from the Extact Linking table, select the To forecast.dss record you would like to 
change.
Click Browse To, the KiWIS Time Series Record Chooser dialog will display (Figure 4).
From the KiWIS Time Series Record Chooser dialog (Figure 4). from the File menu, click Open. An Open HEC-
DSS File browser will open, browse to location of the DSS file you will be copying time series record to, select the 
filename, click Open. The Open HEC-DSS File browser will close, the DSS file is displayed.
Select the pathname for the DSS record listed in the table, click Set Pathname. This will copy the selected 
record to the Extract Linking table (Extract Editor).
When you are finished selecting the DSS pathnames, from the File menu, click Close. The KiWIS Time Series 
Record Chooser dialog will close (Figure 4).

34.4.5 Running Extracts
Now that you have defined and setup extract groups, you can run extracts. HEC-RTS provides two ways to run extracts - 
automatic or manually. Running Extracts provides details.

34.5 Posting WISKI Time Series Data
A post refers to the process of saving data from the forecast.dss file to either a DSS file or a WISKI database. A post 
selects an output time series from the forecast.dss file and disseminates it in an external data location. Compute output 
can be stored as historical results to be viewed or used in future forecasts. HEC-RTS supports posts for DSS gridded data 
and time series data, and WISKI time series data. The Post Editor (Figure 1) is used to create and define post groups 
that disseminate data to a WISKI database.
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190 Figure 1 Post Editor

34.6 Post Editor with WISKI
Now that you have successfully computed a forecast and reviewed results, you might want to save data from the 
forecast.dss file to other DSS files. This task is done from the Post Editor Information about the Post Editor and post 
groups is detailed in Data Extract and Post Editors. This appendix will provide information on WISKI and KiWIS details.

34.7 KiWIS Post Group
When a post group is selected that is a KiWIS post group, information displayed in the Post Linking section (Post Editor) 
is the data Type, KiWIS Url, and the User name and Password needed to access the KiWIS database. The TS Group Id
lists all the time series group ID's that are in the KiWIS database. The TS Group Id can be used to filter KiWIS records, 
which will increase the speed of the query process for large databases when accessing them through HEC-RTS. The Post 
Linking table (Post Editor) displays the following information when a KiWIS post group has been selected:

From forecast.dss this column lists the selected model alternative output records for the 
post group. This data will fill with the KiWIS record displayed in the To 
KiWIS column.

Model this column lists which software application is generating the output.
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Alternative this column lists the model alternative name that is creating the output 
record.

Location this column displays the name of the model location object that is 
associated with the output record.

Parameter this column displays the parameter associated with the output record's 
data.

To KiWIS this column shows the actual input record pathname that the output 
record will be written to during the post process.

Index Each required destination pathname is assigned an Index number when 
it is loaded into the Post Editor. This number has no real usage except 
keeping the initial filtered list set. There can be multiple indices for a 
single DSS pathname.

This information does not display by default in the Post Linking table, you will need to set up the table view, see Post 
Editor.

34.7.1 Create a KiWIS Post Group
A KiWIS post group maps the model alternative output time series data from a forecast.dss file to a WISKI database. You 
will need the KiWIS URL, a username, and a password to set up a KiWIS post group. While a TS Group ID is not required, 
it can simplify the setup process.

To create a KiWIS post group:

From the HEC-RTS main window, click on the Setup tab, from the Models menu, click Edit Post, the Post Editor
will open.
From the Post Editor, from the Post Groups box (Figure 1), click New Extract Group. The New Extract Group
dialog will open (Figure 2).
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In the Name box (Figure 2), enter a name for your KiWIS post group.
For a post group the only data type is Time Series.
From the Destination list (Figure 2), select KIWIS.
From the User box, enter your user login (Figure 2) and from the Password box, enter the password that is 
associated with the entered user login. Both the username and password are case sensitive. From the KiWIS Url
box, enter the url for the WISKI database.
The items in the DSS Storage Options box (Figure 2) are only applicable to Oracle and DSS source files. No 
changes to these values are necessary when using KiWIS as your data source.
By default, Select in Run Post List (Figure 2) is selected, which means the post group will run automatically 
when a post process is running.
Specify the Time Window to post the data from the Start and End lists (Figure 2); available options are: Extract 
Start, Start of Simulation, Forecast Time, End of Simulation. Offsets for the start and end times can also be 
included, available options are: hours, minutes, or seconds. In the Offset box, you will enter the offset 
increment. This time window is relative to the forecast time window the you defined when you created the 
forecast.
When you are done, click OK, the New Post Group dialog will close (Figure 2). The new post group will display at 
the bottom of the Post Groups box (Figure 1), and the information about the post group will display.
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Note: Post groups are run in the order they are displayed in the Post Groups box. If you run more than one post group 
during the post process and there are records that are mapped in more than one of the selected post groups, the last post 
group mapping will replace all previous mappings.

34.7.2 Adding Output Data to Post Groups
Once a post group is defined, you can select which model alternative output data you want to map to the selected 
destination data. In this case the destination data is the WISKI database. Detailed information is provided in Post 
Groups.

34.7.3 Selecting KiWIS Destination Records
When Available Output records are added to a KiWIS post group, the name of Available Output record, is displayed in 
the Post Linking table (Post Editor), under the To KiWIS column. The To KiWIS record pathnames need to be replaced 
with WISKI database destination time series record names.

To select a WISKI database time series record for the To KiWIS record:

The TS Group Id list (Post Editor), in the Post Linking, provides a list of all the time series groups created in 
KiWIS. The TS Groupd Id is used in the Post Editor to manage the size of the WISKI database request and speed 
up the time required to populate the list of records when selecting KiWIS records for the post.
Double-click the row in the To KiWIS column (Figure 3) you would like to set the KiWIS time series record for.

Click the ellipse that appears in the right side of the cell with the To KiWIS name. The KiWIS Time Series Record 
Chooser dialog will open.
You can filter the KiWIS time series pathnames displayed in the table by using the Search By Parts Parameters
at the top of the KiWIS Time Series Record Chooser.
To select a KiWIS time series record to replace the one displayed in the selected row in the Post Linking table 
(Post Editor), select the time series record row in the KiWIS Time Series Record, click Set Pathnames.
The WISKI time series record you selected will display back on the Post Linking table in the row you original 
selected.
To set another KiWIS time series record, from the Post Linking table click on the WISKI time series record you 
want to replace. From the KiWIS Time Series Record Chooser dialog, click Set Pathname.
When all of the KiWIS time series records have been set in the Post Linking table, from the KiWIS Time Series 
Record Chooser dialog, from the File menu, click Close.



HEC-RTS User Manual  – WISKI Extract and Post

WISKI Extract and Post
                             – 

1.
2.
3.
4.

1.
2.
3.

4.

5.

34.7.4 Ad-Hoc Records - Post
Additional output data not listed in the Available Output table may be needed from the forecast.dss file. You can add 
additional time series records to the WISKI database using the Ad-Hoc Record feature in a post group. An Ad-Hoc 
record allows you to save forecast.dss time series record data to the WISKI database even if those records were not 
listed in the Available Output table. 

To add a WISKI Ad-Hoc record:

From the Post Editor, click Add Post Data Set, the Adhoc: KiWIS Time Series Record Chooser dialog will open.
From the Search By Parts area, use the various filter lists to locate the desired forecast.dss time series record.
Select the pathname row for the record, click Set Pathname.
Once you have selected all the pathnames for all the necessary time series records, from the File menu, click 
Close. The Adhoc: KiWIS Time Series Record Chooser dialog will close.

The From forecast.dss and To KiWIS time series records (Post Linking table) will display the same pathname. The time 
series record pathname displayed in the To KiWIS column of the Post Linking table will need to be changed to match 
the KiWIS time series name. You can either enter the KiWIS pathname, or select one through the KiWIS Time Series 
Record Chooser dialog.

To select a DSS pathname using the KiWIS Time Series Record Chooser:

From the Post Editor, from the Post Linking table, select the To KiWIS record you would like to change.
Click Browse To, the KiWIS Time Series Record Chooser dialog will display.
From the KiWIS Time Series Record Chooser dialog. from the File menu, click Open. An Open HEC-DSS File
browser will open, browse to location of the DSS file you will be copying time series record to, select the 
filename, click Open. The Open HEC-DSS File browser will close, the DSS file is displayed.
Select the pathname for the KiWIS record listed in the table, click Set Pathname. This will copy the selected 
record to the Post Linking table (Post Editor).
When you are finished selecting the KiWIS pathnames, from the File menu, click Close. The KiWIS Time Series 
Record Chooser dialog will close.

34.8 Running Posts with WISKI
Now that you have defined and setup post groups, you can run posts. HEC-RTS provides two ways to run post - 
automatic or manually. Running Posts provides more details.

34.9 KiWIS Time Series Record Chooser
The KiWIS Time Series Record Chooser dialog, allows you to browse the WISKI database to view and select data to use 
for the extract and post groups. The features supported for the KiWIS data are discussed in the following sections and 
include filtering records and viewing data in plots and tables.

34.9.1 Filtering KiWIS Time Series Records
KiWIS time series data can be filtered using pathname parts or by searching for the whole pathname.
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To search the KiWIS data using pathname parts:

From KiWIS Time Series Record Chooser dialog, from the View menu, click Search pathnames by parts
(Figure 1).

The Search By Parts filter lists will display above the table (Figure 2).

Using the Search By Parts filter lists, select the record parts you would like to search on. The table will update 
with each filter list selection.

To search the KiWIS data using pathname parts:

From KiWIS Time Series Record Chooser dialog, from the View menu, click Search pathnames by string
(Figure 1).
Enter the KiWIS pathname you are searching for in the Search Pathnames box displayed about the table (Figure 
3). You do not need to enter the whole pathname. Click the Search, the table will filter the pathnames, based on 
the string you entered.

 

34.9.2 Plotting KiWIS Time Series Records
KiWIS data can be viewed in time series plots from the KiWIS Time Series Record Chooser dialog. Select a record, from 

the toolbar, click  . A Plot dialog (Figure 4) will open, displaying the selected KiWIS data in a plot.
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34.9.3 Tabulating KiWIS Time Series Records
KiWIS data can be viewed in tabular form from the KiWIS Time Series Record Chooser dialog. Select a record, from the 
toolbar, click . A Tabulate dialog (Figure 5) will open, displaying the selected KiWIS data in a tabular form.
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191 Figure 5 Tabulate Dialog - KiWIS Data
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35 KiWIS Write Extension
The KiWIS Write Extension enables you to write time a series data into WISKI database. This is applicable for standard 
time series as well as ensemble/forecast time series. The extension does not enable editing of metadata or creating new 
time series.

This document was written by the KISTERS Group, Version 1.6.0 (20.04.2017).

35.1 Configuration
On the data source level <Datasource> of the KiWIS config.xml the connection information and the service have to be 
added:

<WAPIConnection>
  Enables a WISKI API connection. The API must be active in the WISKI Server and reachable via its network port. 
Installation and configuration will usually be done by KISTERS.
<apiURL>http://localhost:<REST API Port>/</apiURL> (1)
  The target URL. 
<apiVersion>0</apiVersion> (1)
  Only version 0 supported at the moment.
<user>ModelWrite</user> (1) 
  The WISKI user should be equal to the WDPConnection user
<password>###</password> (1)

The WISKI password (encrypted) should be equal to the WDPConnection password.
  <domain>WISKI</domain> (1)

The WISKI domain should be equal to the WDPConnection domain. </WAPIConnection>

<KiWS/>
   Enables the KISTERS WriteServices, currently without further options.

35.2 KISTERS WriteServices Functionality
Analogues to the KiQS, the WriteServices are called with service=kisters&type= writeservices in the URL. However, since 
all commands manipulate or add data, instead of a standard HTTP GET request, a POST or PUT has to be 
sent. Currently, KiWIS does not make any difference between these two verbs.

1.  setTimeseriesValues:

This command is intended to insert time series data into existing normal time series. The request requires a single 
ts_id or ts_path to identify the target time series. Optionally the flage truncate=true|false can be set, default is 
false. If set to true, the sent data will replace the content of the whole time series.

The body of the request needs to have JSON content with header 'Content- Type: application/json', the actual 
JSON equals the familiar dajson format, just without the metadata. Required is the set of columns and the data 
array containing the values:

[
     {
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     "columns":"Timestamp,Value",
     "data": [
             ["2012-05-28T00:00:00.000+01:00",236],
             ["2012-05-29T00:00:00.000+01:00",234],
             ["2012-05-30T00:00:00.000+01:00",226]
             ]
     }
]

The columns 'Timestamp' and 'Value' (case insensitive) will be sufficient to write single column data into time 
series. The quality code will be set to the default value for new values in WISKI. If a specific code should be set, the 
column name 'Status' can be used:

[
     {
     "columns":"Timestamp,Value",
     "data": [
             ["2012-05-28T00:00:00.000+01:00",236, 120],
             ["2012-05-29T00:00:00.000+01:00",234,120], 
             ["2012-05-30T00:00:00.000+01:00",226,120]
             ]
     }
]

The given quality code must be defined in WISKI or it will be ignored. Any other value or status columns can be 
written by adding the WISKI internal column name to the column's entry. This also means that it is NOT possible 
to use any other defined KiWIS return field names like 'Absolute Value' to write data, instead the actual column 
name from WISKI has to be used. Mappings may be added in the future.

Full example that utilizes the cURL command line tool:

curl -X POST -H "Content-Type: application/json" -d "[
 {
 \"columns\":\"Timestamp,Value\",
 \"data\": [
   [\"2012-05-28T00:00:00.000+01:00\",236], 
   [\"2012-05-29T00:00:00.000+01:00\",234],
   [\"2012-05-30T00:00:00.000+01:00\",226]
   ]
 }
]"
"http://localhost:8080/KiWIS/KiWIS?datasource=0&service=kisters&t ype=writeServices&req 
uest=settimeseriesvalues&ts_id=1587010"
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35.2.1 2.  setEnsembleTimeseriesValues:
This command is intended to insert time series data into existing ensemble/forecast time series. The request requires a 
single ts_id or ts_path to identify the target time series. The body of the request needs to have JSON content with 
header 'Content-Type: application/json', the actual JSON equals the familiar dajson format for ensemble time series.

Example body:

[
     {
        "ensembleDate": "2016-09-29T07:00:00+01:00",
        "ensembleDispatchInfo": "2016-09-29",
        "quality": 200,
        "columns": "Timestamp,Forecast", "data": [
          [
            "2016-09-29T07:00:00.000+01:00", "0.2"
          ],
          [
            "2016-09-29T07:15:00.000+01:00", "0.1"
          ]
        ]
     }
]

The ensembleDate is the timestamp where the ensemble will be stored. The ensembleDispatchInfo is a unique key to 
identify a single ensemble or model run, both fields are mandatory. The optional quality defines the quality code for the 
whole ensemble, default is zero (0).

The columns attribute has to list the Timestamp plus all ensemble members that should be written for an ensemble. 
Unlike with setTimeseriesValues where arbitrary WISKI defined columns may be written as long as the keys are known, 
the column list here matches the one returned by KiWIS for the same time series.

Full example that utilizes the cURL command line tool:

curl -X PUT -H "Content-Type: application/json" -d "[
 {
   \"ensembledate\": \"2016-09-29T07:00:00+01:00\",
   \"ensembleDispatchInfo\": \"2016-09-29\",
   \"quality\": 200,
   \"columns\": \"Timestamp,Forecast\",
   \"data\": [
     [
      \"2016-09-29T07:00:00+01:00\",
      \"0.2\"
     ],
   [
     \"2016-09-29T07:15:00+01:00\",
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     \"0.1\"
   ]
   ]
 }
]"
"http://localhost:8080/KiWIS/KiWIS?request=setEnsembleTimeseries Values&ts_id=1057920 
10&service=kisters&type=writeServices&datasource=0"

35.3 Recommendations
The timestamps used in all commands can be sent as any format that KiWIS understands as long as the precision 
is sufficient.
Sending data for an existing time range will overwrite all data in this time range (first and last timestamp in the 
sent data are relevant).
KiWIS currently cannot check whether a time series is editable or if the time series configuration is suitable for 
writing data. Therefore, it is very important to validate the target ID or path before writing data.
It is helpful to organize similar writable time series in a time series group or ensure in the client that only a 
certain path/shortname can be written. 
Write requests to non-writable time series may result in either an exception or a success message even though 
no data has been written.
Write requests to editable time series that have agents configured for their own calculation may trigger data loss 
or unexpected side effects depending on the agent type.
For security reasons no externally accessible datasource should have the KiWS service enabled without further 
protection.
Generally, it is recommended to configure a special WISKI user (ModelWrite) who can only access the desired 
writable time series Object Group and define a second datasource in KiWIS with the KiWS activated and with this 
user configured.
If external users should be able to post data (via Internet), recommendation 5 should be used together with an 
authentication- protected datasource (see main manual). In that case HTTP Basic Auth can be used to send 
authenticated requests.
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